
Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Denne vejledning beskriver konfiguration og drift af ILME-FR7 / ILME-FR7K Interchangeable Lens Digital Camera.

Se denne vejledning og brugsanvisningen til tilknyttede enheder som påkrævet.

Oversigt

Typiske brugsanvendelser

Systemkonfiguration

Styring af en enkelt enhed vha. den medfølgende infrarøde fjernbetjening

Styring af en enkelt enhed vha. en tablet eller computer

Styring af en enkelt enhed vha. en ekstern fjernbetjening

Styring af flere enheder vha. en ekstern fjernbetjening

Delenes placering og funktion

Visning fortil

Visning bagud

Forbindelsesblok

Sidevisning

Visning øverst

Underside

Objektivstøtte

Placering og funktion af dele af den infrarøde fjernbetjening (medfølger)

Webapp-skærm

Webapp-skærmoversigt

Strukturen i Skærmenes fælles område

Strukturen på Live-driftsskærmen

Strukturen i afspilningsfunktionsskærmen

Struktur af skærmen Indstillinger

Kameramenu
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Forberedelse

Kameras skærmvisning

Montering af enheden

Oprejst montering på et fast sted

Opretstående montering på et højt, fast sted

Montering på et loft

Montering/afmontering af et objektiv

Forholdsregler ved påsætning/fjernelse af et objektiv

Tjekker objektivets kontakter

Forholdsregler ved brug af et zoomobjektiv

Montering af et objektiv

Fjernelse af et objektiv

Tilslutning af kabler

Tilslutning af enhed til netværksenhed via ledningsforbindelse

Tilslutning af strømforsyning

Anvendelse af vekselstrøm

Anvendelse af PoE++ strøm

Nulstilling af panorering/hældning

Konfiguration før optagelse

Initialisering af enheden vha. webappen

Tilgå webappen fra en webbrowser

Start af enheden

Konfiguration af grundlæggende betjening

Forberedelse af hukommelseskort

Understøttede hukommelseskort

Isætning af hukommelseskort

Udskubning af et hukommelseskort

Formatering (initialisering) af hukommelseskort

Kontrol af den resterende optagelsestid

Gendannelse af hukommelseskort
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Billedtagning

Grundlæggende betjening

Starter/stopper optagelse

Skift mellem hukommelseskort

Tjekker lyden

Angivelse af tidsdata

Gennemsyn af optagelse (Rec Review)

Justering af indramning

Indramningsjusteringsskærm

Justering af optagelsesretning

Justering af optagelsesretning vha. webappen

Indstilling af panorerings-/hældningsdriftshastighed

Indstilling af panorerings-/hældningsdriftsacceleration

Justering af optagelsesretning vha. den medfølgende infrarøde fjernbetjening

Justering af zoom

Indstilling af zoomtype

Justering af Zoom vha. webappen

Indstilling af zoom-driftshastighed

Justering af zoom vha. den medfølgende infrarøde fjernbetjening

Gemmer/gendanner kameraets panorerings-/hældnings-/zoomposition (forudindstillet position)

Kalibrering af et E-mount-objektiv

Lagring/Gendannelse af panorering/hældning, zoomposition og fokusindstilling vha. webappen

Omdøbning af forudindstillinger af position vha. webappen

Udskiftning af en gemt forudindstillet position med en ny position vha. webappen

Sletning af en gemt forudindstillet position vha. webappen

Synkronisere panorerings-/hældnings- og zoom-/fokusfunktion, når en forudindstillet position gendannes

Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en forudindstillingsposition genoprettes

Gemmer/Gendanner panorering/hældning og zoomposition vha. den medfølgende infrarøde fjernbetjening

Optagelse/afspilning af kamera indramningsfunktioner (PTZ trace)

Optage kamera indramningsfunktioner ved hjælp af webappen
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Afspilning af kamera indramningsfunktioner ved hjælp af webappen

Sletning af optagede kamera indramningsfunktioner ved hjælp af webappen

Optagelse af kamera indramningsfunktioner vha. den medfølgende infrarøde fjernbetjening

Afspilning af kamera indramningsfunktioner vha. den medfølgende infrarøde fjernbetjening

Justering af fokus

Skærm til fokusjustering

Manuel justering af fokus (Manuel fokus)

Manuel justering vha. webappen

Manuel justering vha. den medfølgende infrarøde fjernbetjening

Fokusering ved at angive en fokusposition (Spot Focus)

Sådan bruges autofokus midlertidigt (Push Auto Focus (AF))

Anvendelse af Single-Shot-autofokus (Push Auto Focus (AF-S))

Automatisk justering af fokus (autofokus)

Automatisk justering vha. webappen

Automatisk justering vha. den medfølgende infrarøde fjernbetjening

Indstilling af autofokusområdet/-positionen (fokusområde)

Hurtig ændring af fokusområdet (fokusindstilling)

Flytning af fokusområdets ramme vha. touchbetjening (Touch Focus Area)

Justering af autofokushandlingen (AF-overgangshastighed, AF-motivskiftfølsomhed)

Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen

Manuel fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening

Midlertidig brug af manuelt fokus under autofokus (tryk manuelt fokus)

Sporing ved hjælp af ansigts-/øje-registrering (Face/Eye Detection AF)

Sådan spores et specificeret motiv (Realtime Tracking AF)

Justering af lysstyrken

Lysstyrke-justeringsskærm

Indstilling af basisfølsomhed

Indstilling af målniveau for automatisk lysstyrkejustering

Justering af iris

Automatisk justering af iris
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Nyttige funktioner

Manuel justering af iris

Justering af forstærkning

Automatisk justering af forstærkning

Manuel justering af forstærkning

Justering af lukkeren

Automatisk justering af lukkeren

Manuel justering af lukkeren

Justering af lysniveauet (ND-filter)

Om ND-filteret

Justering i forudindstillet tilstand

Automatisk justering i variabel tilstand

Manuel justering i variabel tilstand

Justering for naturlige farver (hvidbalance)

Hvidbalance-justeringsskærm

Automatisk justering af hvidbalance

Manuel justering af hvidbalance

Kørsel af automatisk hvidbalance

Konfigurering af lyd til optagelse

Konfigurationsskærm til lyd

Valg af lydinputenhed

Automatisk justering af lydoptagelsesniveauet

Manuel justering af lydoptagelsesniveauet

Direkte menubetjening

Tildelelige knapper

Langsom og hurtig bevægelse

Optagelse af video med afbrydelser (Interval Rec)

Sådan optages cachede billeder (Picture Cache Rec)

Samtidig optagelse til hukommelseskort A og B (2-slot Simul Rec)

Videosignalsmonitor
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Netværksfunktioner

Klipmærker

Åndedrætskompensation

Proxyoptagelse

Oversigt proxy-optagelse

Optagelse af en proxy

Filmning med det ønskede udseende

Oversigt over udseende

Valg af et udseende

Importering af et ønsket basisudseende

Tilpasning af et udseende

Lagring af et udseende

Sletning af et basisudseende

Filmning med justering af udseende i efterproduktion

Filmning med justering af udseende i efterproduktion

Anvendelse af en LUT til HDMI Output og Streaming

Ændring af en LUT

Ændring af fordelingen af mørke og lyse områder i optaget billede

RAW-optagelse

Optagelse af RAW-video

Optagelse af RAW Video i tilstanden Slow & Quick Motion

Sådan justeres Bokeh (Bokeh Control Function)

Sådan slås Bokeh-kontrolfunktionen til/fra

Sådan justeres graden af Bokeh

Lagring og indlæsning af konfigurationsdata

Oversigt over lagring og indlæsning af konfigurationsdata

Gemmer en ALL-fil

Indlæser en ALL-fil

Overfører filer
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Miniaturebilledskærm

Kameramenu og detaljerede indstillinger

Om filoverførsel

Registrering af en destination til filoverførsel

Valg af en fil og overførsel

Upload af en proxy-fil på et hukommelseskort fra miniatureskærmen

Upload af en original fil på et hukommelseskort fra miniatureskærmen

Kontrol af filoverførselsstatus

Upload ved hjælp af sikker FTP

Konfigurering af streaming

Om Streaming

Indstiller streamingformatet

Indstilling af Video Codec til streaming

Indstilling af Audio Codec til streaming

Start/stop af streaming

Miniaturebilledskærm

Afspiller klip og andre klipfunktioner

Afspilning af optagede klip

Bearbejdning af optagede klip

Konfiguration af kameramenu

Betjening af kameramenuen

Betjening af kameramenuen

Angivelse af en tegnstreng

Menuen User

User

Menuen Edit User

Edit User

Menuen Shooting

ISO/Gain/EI
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ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menuen Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Menuen Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

8



Detail

Matrix

Multi Matrix

Menuen Panorering/hældning

P/T Acceleration

Menuen TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Menuen Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menuen Audio

Audio Input

Audio Output

Menuen Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)
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Webmenu og detaljerede indstillinger

Filter Clips

Customize View

Menuen Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menuen Network

Wired LAN

File Transfer

Menuen Maintenance

Language

Clock Set

Hours Meter

Menuindstillinger og standardværdier for Shooting

ISO/Gain Indstillinger og standardværdier

AGC Limit Indstillinger og standardværdier

Indstillinger for billedkvalitet, der gemmes for hver optagelsestilstand

Konfiguration af webmenu

Webmenu-funktioner

Menuen Shooting

Focus

Menuen Project

Base Setting

Rec Format
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Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menuen Paint/Look

Base Look

Menuen Panorering/hældning

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menuen Monitoring

Output Format

Output Display

Menuen Audio

Audio Input

Audio Output

Menuen Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menuen Network

Camera Name

User

Wired LAN

11



Tilslutning af ekstern enhed

File Transfer

FTP Server 1 til 3

SSL

Referer Check

Brute Force Attack Protection

Stream-menu

Stream

Video Stream

Audio Stream

Menuen Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software

Tilslutning af eksterne skærme og optagelsesenheder

Tilslutning af RCP/MSU (valgfri)

Tilslutning med en RCP/MSU

Én-til-én-forbindelse mellem enheden og en RCP

Brug af enheden i et miljø med flere kameraer med en MSU/fjernbetjeningssoftware til kamera

Liste over understøttede funktioner

Betjening vha. en RM-IP500 fjernbetjening (ekstraudstyr)

Om drift vha. en RM-IP500 fjernbetjening (ekstraudstyr)
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Bilag

5-041-958-93(1) Copyright 2022 Sony Corporation

Tilslutning af en RM-IP500 Fjernbetjening

Synkronisering med en ekstern enhed

Om synkronisering med en ekstern enhed

Synkronisering af videosignalets fase (genlock)

Låsning af tidskoden til andre enheder

Tilslutning af en ekstern mikrofon eller ekstern lydenhed

Håndtering/Redigering af klip ved hjælp af en computer

Udsender et optisk fibersignal

Tilslutning af tally-signal

Udsende sporingsdata (free-d)

Tilslutning af en objektiv styreenhed

Justering af Zoom vha. en objektiv styreenhed

Forholdsregler ved brug

Output-formater og -begrænsninger

Fejlfinding

Fejl-/advarselsmeddelelser

Liste over menupunkter

Forudindstillet positions gemte punkter

Blokdiagrammer

Opdatering af software til E-mount-objektivet

Montering af objektivets dæksel over frigivelsesknappen

Licenser

Specifikationer

Varemærker
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Systemkonfiguration

Denne enhed kan kombineres med perifere enheder til forskellige systemkonfigurationer.

5-041-958-93(1) Copyright 2022 Sony Corporation

E-mount-objektiv1.

LA-EA3/LA-EA4 A-mount-adapter2.

Infrarød fjernbetjening (medfølger)3.

CFexpress Type A-hukommelseskort/SDXC-hukommelseskort4.

CFexpress Type A-kortlæser/SD-kortlæser5.

ECM-680S, ECM-678*, ECM-674* Mikrofon6.
EC-0.5X3F5M 3-ben → 5-ben XLR-adapterkabel er påkrævet.*

Vekselstrømsadapter (medfølger)7.

Videomonitor8.

RM-IP500 Fjernbetjening9.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styring af en enkelt enhed vha. den medfølgende infrarøde fjernbetjening

Du kan fjernstyre en enkelt enhed vha. den medfølgende infrarøde fjernbetjening.

 Videosignal
 Signalflow

5-041-958-93(1) Copyright 2022 Sony Corporation

Infrarød fjernbetjening (medfølger)1.

Videomonitor2.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styring af en enkelt enhed vha. en tablet eller computer

Du kan forbinde en tablet eller computer til enheden og dernæst styre enheden vha. en webbrowser.

 Videosignal
 Fjernstyringssignal

  Signalflow

5-041-958-93(1) Copyright 2022 Sony Corporation

Videomonitor1.

Tablet2.

Computer3.

Adgangspunkt4.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styring af en enkelt enhed vha. en ekstern fjernbetjening

Du kan fjernstyre enheden vha. en fjernbetjening.

 Videosignal
 Fjernstyringssignal

  Signalflow

5-041-958-93(1) Copyright 2022 Sony Corporation

Videomonitor1.

RM-IP500 Fjernbetjening2.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styring af flere enheder vha. en ekstern fjernbetjening

Du kan fjernstyre op til 100 enheder vha. en enkelt fjernbetjening.

 Videosignal
 Fjernstyringssignal
 Tally/kontaktsignal

  Signalflow

5-041-958-93(1) Copyright 2022 Sony Corporation

Videomonitor1.

Video switcher2.

Ethernet hub3.

RM-IP500 Fjernbetjening4.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Visning fortil

Dette emne beskriver placeringen og funktionen af dele på enhedens forside.

Tip!

Denne beskrivelse henviser til tegningen af enheden uden et fastgjort objektiv.

Kamerahoved

Bemærk!

Udsæt ikke kamerahovedet for stærke påvirkninger.

1.

Optagelses-/indikatorlampe
Når lampen er konfigureret som en optagelseslampe, lyser den rød under optagelse til et hukommelseskort. Lampen
blinker, når den resterende frie plads på optagelsesmediet er lav, eller når en fejl opstår.

For yderligere oplysninger se "Fejl-/advarselsmeddelelser".

2.
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Når lampen er konfigureret som en tally-lampe, lyser den rød eller grøn i overensstemmelse med det eksterne tally-
signal.

For yderligere oplysninger se "Tilslutning af tally-signal".
Billedsensor

Bemærk!

Rør ikke direkte med hænderne.

3.

Objektivudløserknap
Tryk for at fjerne objektivet.

For yderligere oplysninger se "Fjernelse af et objektiv".

4.

Objektivsignalkontakter

Bemærk!

Rør ikke direkte med hænderne.

5.

POWER-lampe6.

NETWORK-lampe
Enhedens tilstand angives af kombinationen af POWER-lampens og NETWORK-lampens farve og lysstatus (lyser,
blinker, lyser ikke).

7.

POWER-
lampe

NETWORK-
lampe Enhedsstatus

Lyser grønt*1
Lyser grønt Tændes (netværk er tilsluttet)

Lyser ikke Tændes (netværk er ikke tilsluttet)

Blinker grønt Lyser ikke Tændingsproces er i gang

Lyser orange Lyser ikke Standby-tilstand

Blinker gult Lyser ikke Softwareopdatering er i gang

Blinker
langsomt
orange*2

Blinker
langsomt
grønt*2

Enheden kan ikke fungere ordentligt. For yderligere oplysninger se systemloggen.
Hvis problemet fortsætter, selv efter enheden er sat i standby-tilstand eller
strømmen slukkes og tændes igen, så kontakt din Sony-servicerepræsentant.

Blinker hurtigt
orange*3

Blinker hurtigt
grønt*3

En funktionsfejl opstod i enheden. Kontakt din Sony-servicerepræsentant.

Blinker grønt, når en kommando modtages fra den medfølgende infrarøde fjernbetjening.*1

Blinker langsomt: Blinker én gang i sekundet*2

Blinker hurtigt: Blinker fire gange i sekundet*3

Infrarød fjernbetjeningssensor
Modtager kontrolsignalet fra den medfølgende infrarøde fjernbetjening.

8.

Luftindtag

Bemærk!

Tildæk ikke ventileringen. Hvis du gør det, vil det medføre en fejlfunktion.

9.
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Relateret emne
Fejl-/advarselsmeddelelser

Tilslutning af tally-signal

Fjernelse af et objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Visning bagud

Dette emne beskriver placeringen og funktionen af dele på enhedens bagside.

Relateret emne

Sidevisning

5-041-958-93(1) Copyright 2022 Sony Corporation

Kamerahoved låsehåndtag
Låser kamerahovedets fremad-/bagudbevægelse.

Bemærk!

Indstil altid til låsepositionen, når objektivet ikke udskiftes.

Fjern altid objektivet og indstil til låsepositionen, når enheden transporteres.

Sluk for enhedens strøm, og lås kamerahovedet vandret vha. panorerings-/hældningslåsehåndtaget, før låsehåndtaget betjenes
for at undgå kvæstelse pga. klemte fingre. For oplysninger om panorerings-/hældningslåsehåndtaget se
"Panorerings-/hældningslåsehåndtag" i "Sidevisning".

1.

Glidebase2.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forbindelsesblok

Dette emne beskriver placeringen og funktionen af dele på enhedens forbindelsesblok.

 (jord) forbindelse
Forbind til jord ved at tilslutte til kontaktens jordterminal eller til et jordspyd.

1.

DC-IN-tilslutning (standard DC-stik)
Tilslut til en vekselstrømsadapter.

Bemærk!

Brug ikke en anden vekselstrømsadapter end den medfølgende. Tilslutning af en anden adapter kan forårsage brand eller
fejlfunktion.

2.

 LAN (netværk) stik (RJ-45)
Tilslut et netværkskabel (kategori 5e eller højere) til netværkskommunikation og PoE++* strømforsyning.

Hastighed LED-skærmstatus
Angiver netværksforbindelsens hastighed.

3.

PoE++: Power over Ethernet Plus Plus. Overholder IEEE802.3bt (Type 4 klasse 8). Se strømforsyningsenhedens brugsanvisning for at få
yderligere oplysninger om forbindelse.

*
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Link/ACT LED-skærmstatus
Angiver netværksforbindelsens status.

Bemærk!

Når dette produkt kobles på internettet, skal opkoblingen ske via et system med en beskyttelsesfunktion, som f.eks. en router eller
firewall. Hvis opkoblingen sker uden en sådan beskyttelse, kan der opstå sikkerhedsproblemer.

Visning  Forbindelseshastighed

Lyser ikke
10 Mbps forbindelse

100 Mbps forbindelse

Lyser orange 1000 Mbps forbindelse

Visning  Forbindelsesstatus

 Lyser ikke Intet link

Blinker grønt Link etableret, data aktiv

Lyser grønt Aktivt link

TC IN-stik
Indtast et eksternt referencetidskodesignal.

For yderligere oplysninger se "Låsning af tidskode til andre enheder".

4.

HDMI-stik
Udsender videoen fra enheden som et HDMI-signal.

For yderligere oplysninger se "HDMI-stik (Type A-stik)" i "Tilslutning af eksterne skærme og optagelsesenheder".

5.

Monteringsskrue til HDMI-kabelholdeplade
For at forhindre, at HDMI-kablet bliver fjernet, monteres den medfølgende HDMI-kabelholdeplade vha. den medfølgende
monteringsskrue (M2.6×6), og HDMI-kablet fastgøres vha. kabelbånd eller strips, som fås i handlen.

For yderligere oplysninger om fastgørelse af HDMI-kabelholdepladen se "Tilslutning af kabler".

6.

OPTION-tilslutning
Brug til at tilknytte et tally-signal fra en ekstern enhed, eller en objektiv styreenhed.

For yderligere oplysninger se "Tilslutning af tally-signal" og "Tilslutning af en objektiv styreenhed".

7.

Ledningsklemme
Brug til at fastgøre vekselstrømsadapterledningen.

8.

RESET-kontakt
Tryk i mindst 5 sekunder vha. spidsen af en kuglepen eller lignende for at nulstille enhedens indstillinger til
fabriksstandardværdier.
Du kan vælge, om du vil nulstille netværksforbindelsesindstillinger eller alle indstillinger, der bruger SETUP-kontakt 1.

9.

OPTICAL output-tilslutning
Udsender et SDI-signal konverteret til optisk format, når et SFP+-modul (ekstraudstyr) er tilsluttet.

For yderligere oplysninger se "Udsender et optisk fibersignal".

10.

SETUP-kontakter11.
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Konfigurerer de følgende indstillinger.
Kontakt 1: Angiver, hvilke indstillinger der er nulstillet, når RESET-kontakten er trykket ned.

Kontakt 2: Indstiller, om +48 V strømforsyning (phantom power) tændes eller slukkes, når en lydinputenhed tilsluttes.
Denne indstilling anvendes straks.
Denne funktion aktiveres, når [Audio] > [Audio Input] > [AUDIO IN Select] er indstillet til [MIC] i kameramenuen.

Bemærk!

Hvis du tænder for kontakt 2 og tilslutter en mikrofon, der ikke er kompatibel med en +48 V-kilde, kan det beskadige den tilsluttede
enhed. Kontroller indstillingen, før du tilslutter enheden.

Kontakt 3: Aktiverer/deaktiverer VISCA over IP-kommunikation. Indstillingerne anvendes, når kameraet tændes.
Indstil til ON-positionen for at bruge enheden, når den er tilsluttet en fjernbetjening (RM-IP500).

Bemærk!

Hvis administratorens adgangskode ikke er blevet konfigureret, deaktiveres VISCA over IP-kommunikation, uanset kontaktens
indstilling. For yderligere oplysninger om konfiguration af administratorens adgangskode se "Start af enheden".

Kontakt 4: Ændrer hastigheden af panorerings-/hældningsfunktionerne, som sendes fra den infrarøde fjernbetjening.
Denne indstilling anvendes straks.

Indstilling Beskrivelse

OFF
(standard)

Nulstiller kun indstillingerne for netværksforbindelsen. Netværksindstillingerne,
sikkerhedsindstillingerme og brugeroplysninger (brugernavn og adgangskode) til enheden vil blive
nulstillet.

ON Nulstiller alle indstillinger til fabriksindstillingerne.

Indstilling Beskrivelse

OFF
(standard)

Anvend ikke +48 V strøm (phantom power-forsyning). Konfigurér denne indstilling ved brug af en
ekstern lydenhed (såsom en mixer), dynamisk mikrofon eller mikrofon med et indbygget batteri.

ON
Anvend +48 V strøm (phantom power-forsyning) til en phantom power-kompatibel mikrofon, der er
tilsluttet AUDIO IN-stikket (CH-1 eller CH-2).

Indstilling Beskrivelse

OFF (standard) Vil ikke besvare VISCA over IP-kommandoer.

ON Accepterer VISCA over IP-kommandoer.

Indstilling Beskrivelse

OFF (standard) Fungerer ved normal hastighed.

ON Fungerer ved maksimal hastighed.

SDI OUT-forbindelse12.
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Relateret emne

Låsning af tidskoden til andre enheder

Tilslutning af eksterne skærme og optagelsesenheder

Tilslutning af kabler

Tilslutning af tally-signal

Tilslutning af en objektiv styreenhed

Udsender et optisk fibersignal

Start af enheden

Synkronisering af videosignalets fase (genlock)

Tilslutning af en ekstern mikrofon eller ekstern lydenhed

5-041-958-93(1) Copyright 2022 Sony Corporation

Udsender videoen fra enheden som et 12G/6G/3G/HD-SDI-signal.
Enheden kan også konfigureres til RAW-signaloutput.

For yderligere oplysninger se "SDI OUT-stik (BNC-type)" i "Tilslutning af eksterne skærme og optagelsesenheder".
 Infrarød fjernbetjeningssensor (bagpå)

Infrarød sensor til den medfølgende infrarøde fjernbetjening.
13.

Blæser-/luftudtag
Udsender varme inde fra enheden.

Bemærk!

Tildæk ikke luftudtaget. Hvis du gør det, vil det medføre en fejlfunktion.

Bemærk, at området i nærheden af luftudtaget kan blive varmt.

14.

GENLOCK-stik
Brug til at isætte et eksternt synk-signal.

For yderligere oplysninger se "Synkronisering af videosignalets fase (genlock)".

15.

AUDIO IN-stik (5-benet stik af XLR-typen)
Brug til at indsende signalet fra en ekstern mikrofon eller lydenhed.
Den fungerer som et AUDIO IN CH-1-stik eller AUDIO IN CH-2-stik.

For yderligere oplysninger se "Tilslutning af en ekstern mikrofon eller ekstern lydenhed".

16.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sidevisning

Dette emne beskriver placeringen og funktionen af dele på enhedens side.

Tip!

Denne beskrivelse henviser til tegningen af enheden uden et fastgjort objektiv.

Panorerings-/hældningslåsehåndtag
Låser enhedens panorerings-/hældningsmekanisme. Brug i følgende tilfælde.

Under transport eller pakning af enheden.
Ved montering eller fjernelse af et objektiv. For yderligere oplysninger se "Montering af et objektiv" eller "Fjernelse af
et objektiv".
Når et objektiv anvendes, som ikke understøtter panorerings-/hældningsfunktion (såsom Sony
SEL100400GM/SEL200600G/SEL400F28GM/SEL600F40GM-objektiver).
Fjern altid objektivet og indstil til låsepositionen, når enheden transporteres.

Tip!

Panorerings-/hældningsbevægelsen kan fastgøres i de følgende vinkler.

1.
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Relateret emne

Montering af et objektiv

Fjernelse af et objektiv

Isætning af hukommelseskort

Tilgå webappen fra en webbrowser

5-041-958-93(1) Copyright 2022 Sony Corporation

Glidebase2.

Skruehuller til eksterne enheder (4 steder)
Til M3 skruer på op til 6 mm længde.

Bemærk!

Brug ikke skruer længere end 6 mm. Hvis du gør det, vil det medføre en fejlfunktion.

3.

Adgangsindikator A4.

Adgangsindikator B
Indikator lyser eller blinker, når optagelsesmediet er indsat.

For yderligere oplysninger se "Isætning af hukommelseskort".

5.

CFexpress Type A/SD-kortsprække (A)6.

CFexpress Type A/SD-kortsprække (B)
Brug til indsættelse af optagelsesmedie.

For yderligere oplysninger se "Isætning af hukommelseskort".

7.

QR-kode til netværksforbindelse
Brug ved konfigurering af startindstillinger.

For yderligere oplysninger se "Tilgå webappen fra en webbrowser".

8.

28



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Visning øverst

Dette emne beskriver placeringen og funktionen af dele øverst på enheden.

Tip!

Denne beskrivelse henviser til tegningen af enheden uden et fastgjort objektiv.

5-041-958-93(1) Copyright 2022 Sony Corporation

Skruehuller til eksterne enheder (2 steder)
Kompatible med 1/4-20 UNC-skruer til en trefod.
Maksimum længde på 6 mm.

1.

ɸ (billedgeneratormærke)
Billedgeneratormærket er på samme plan som billedsensoren.
Hvis du vil måle afstanden mellem enheden og motivet nøjagtigt, skal du bruge dette billedgeneratormærke som
referencepunkt.

2.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Underside

Dette emne beskriver placeringen og funktionen af dele nederst på enheden.

Tip!

Denne beskrivelse henviser til tegningen af enheden uden et fastgjort objektiv.

Huller til monteringsskruer til loftbeslag (6 steder, 5,5 mm effektiv gevinddybde)
Ved montering af enheden på et loft eller en hylde på et højt sted fastgøres beslaget til enhedens bund vha. de seks
beslagmonteringsskruer i disse skruehuller.

For yderligere oplysninger om montering se "Opretstående montering på et højt, fast sted" og "Montering på et loft".

1.

Monteringsskruer til trefod (2 steder)
Bruges når enheden monteres på en kameratrefod (1/4-20 UNC-skruer på op til 5,5 mm i længden).

Bemærk!

Brug ikke skruer længere end 5,5 mm. Hvis du gør det, vil det medføre en fejlfunktion.

2.
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Relateret emne
Opretstående montering på et højt, fast sted

Montering på et loft
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektivstøtte

Dette emne beskriver placeringen og funktionen af dele på enhedens objektivstøtte.

Tip!

Denne beskrivelse henviser til tegningen af enheden uden et fastgjort objektiv.

Objektivs støttestang (2)
Understøtter objektivet.
Kan også bruges til montering af generelt udstyr til Ø15 stang.

1.

Objektivstøtteenhed2.
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Objektivstøtten kan glide frem/bagud ifølge objektivet og dernæst fastgøres.
Objektivstøttepiedestals fastgørelsesskrue
Montér på objektivstøttens piedestal. Du kan justere skruen op/ned for at matche højden af objektivstøttens piedestal.

3.

Objektivstøttestangens klemmehåndtag (2 steder)
Sikrer positionen bagud/fremad af objektivstøtten.

4.

Klemmehåndtag til objektivstøttepiedestals fastgørelsesskrue
Sikrer objektivstøttepiedestalens fastgørelsesskrues lodrette position.

Tip!

Hvis et klemmehåndtag er i en position, der gør det svært at dreje, frigøres klemmehåndtaget, og det drejes til en vinkel, der vil
gøre funktionen nemmere. Luk klemmehåndtaget, når det er i den ønskede position.

A: Klemmehåndtag til objektivstøttepiedestals fastgørelsesskrue
B: Klemmehåndtag til objektivstøttestang

Bemærk!

For at forhindre objektivstøtten i at afbryde panorerings-/hældningsfunktionen, flyttes objektivstøtten op mod kamerahovedet, når
den ikke bruges, og objektivstøttepiedestalens fastgørelsesskrue flyttes til den højeste position (tættest på objektivet).

5.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Placering og funktion af dele af den infrarøde fjernbetjening (medfølger)

Dette emne beskriver placeringen og funktionen af dele på den infrarøde fjernbetjening (medfølger).

Knappen REC● (START/STOP af optagelse)
Tryk for at starte eller stoppe optagelse.

1.

Knappen MENU
Tryk for at vise eller skjule kameramenuen.

2.

GUI-betjeningsknapper
Tryk for at foretage driftsfunktioner i kameramenuen, i meddelelsesdialogbokse der omfatter knapper og andre
skærmfunktioner.

3.

Knappen CANC./BACK
Tryk for at annullere en indstilling eller vende tilbage til den forrige skærm på enhedens kameramenu.

4.

Pan- og Tilt-kontrolknapper5.
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Infrarødt fjernbetjeningsbatteri

Den infrarøde fjernbetjening kræver to AA (LR6) batterier.
Indsæt batterierne i den infrarøde fjernbetjening som vist i det følgende diagram.

Tryk på piletasterne for at styre kameraets panorering/hældning. Tryk på HOME-knappen for at vende kameraets retning
mod forsiden.
Forindstil positionsbetjeningsknapper
Tryk og hold PRESET-knappen nede, og tryk på en af knapperne 1 til 3 for at gemme kameraets retnings-, zoom- og
fokusjusteringsstatus på den talknap, der trykkes på.
Tryk på en talknap med gemte indstillinger for at genkalde den gemte tilstand.

6.

Fokus-betjeningsknapper
Brug til at justere fokus.
Tryk på AF-knappen for at justere fokus automatisk.
For at justere fokus manuelt trykkes MF-knappen ned, dernæst trykkes ned på enten knappen F (Far) til at fokusere på
motiver langt væk eller knappen N (Near) til at fokusere på motiver tæt på.

7.

Tildelelige knapper 1 til 3
Udfører de funktioner der er tildelt de tildelelige knapper vha. kameramenuen.
Hvis du tildeler funktionen [Direct Menu] til en tildelelig knap, kan du justere billedkvaliteten såsom eksponering og
hvidbalance vha. GUI-betjeningsknapperne.

For yderligere oplysninger om tildeling vha. kameramenuen se "Tildelelige knapper".

For yderligere oplysninger om den direkte menu se "Direkte menubetjening".

8.

 (tænd/sluk)-knap
Tryk for at tænde for enheden eller for at tænde for strømforsyningens standbytilstand.

9.

Knappen THUMBNAIL
Viser miniatureskærmen, der viser de optagede klip på enhedens hukommelseskort.

For yderligere oplysninger om miniaturebilledskærmen se "Miniaturebilledskærm".

Du kan vælge klip og styre afspilning på miniatureskærmen vha. GUI-betjeningsknapperne.

For yderligere oplysninger om at vælge klip og styre afspilning se "Afspilning af optagede klip" og "Bearbejdning af
optagede klip".

10.

Knappen SLOT SEL (valg af hukommelseskortsprække (A)/(B))
Når to hukommelseskort indsættes, trykkes på knappen for at skifte mellem hukommelseskort til optagelse.
Tryk på denne knap, mens miniatureskærmen vises, for at skifte mellem de hukommelseskort, der skal vises.

11.

Knappen P/T RESET (nulstilling af panorering/hældning)
Nulstiller panorerings-/hældningsfunktionerne. Tryk på knappen, når POWER-lampen og NETWORK-lampen blinker
samtidigt, eller når [Execute Pan-Tilt Reset]-knappen vises i indramningskontrolpanelet i webappen.

12.

Zoom-betjeningsknapper
Tryk på -knappen T (telefoto) for at zoome ind.
Tryk på -knappen W (wide) for at zoome ud.

13.
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Bemærk!

Brug ikke andre batterier end mangan eller alkaliske batterier, da de kan briste.

Bortskaf brugte batterier ifølge landets eller regionens lovgivning og regler.

Relateret emne

Tildelelige knapper

Direkte menubetjening

Miniaturebilledskærm

Afspilning af optagede klip

Bearbejdning af optagede klip

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Webapp-skærmoversigt

Ved at tilslutte en tablet eller en computer kan du panorere/vippe, zoome, optage, afspille optaget video og konfigurere
enheden fra en webbrowser (herefter kaldes denne funktion "webapp").

For yderligere oplysninger om lancering af webappen se "Tilgå webappen fra en webbrowser".

Bemærk!

Webappen understøtter ikke kameraets lydoutput.

Når webappen starter, og følgende skærm til live betjening vises.

Skærm til live betjening

For yderligere oplysninger om skærmen til live betjening se "Strukturen på Live-driftsskærmen".
Knapper og ikoner, der er fælles for skærmen til live betjening og afspilningsskærmen, vises øverst på skærmen.

For yderligere oplysninger om skærmenes fælles område se "Strukturen i Skærmenes fælles område".
Du kan skifte mellem skærme ved at trykke på skærmens skiftende faner i det fælles område.
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Skærm til afspilningsfunktion

Tryk på [Playback]-fanen for at vise skærmen til afspilningsfunktion.

For yderligere oplysninger om skærmen til afspilningsfunktion se "Strukturen i afspilningsfunktionsskærmen".

Skærmen Indstillinger

Tryk på [Settings]-fanen for at vise skærmen indstillinger (herefter kaldet webmenuen).

38



Bemærk!

I webmenuen anvendes indstillingerne ikke, før du trykker på [OK]-knappen. Hvis du ændrer indstillingerne på en side, der har en
[OK]-knap, skal du sørge for at trykke på [OK]-knappen.

For yderligere oplysninger om skærmen til indstillinger se "Struktur af skærmen Indstillinger".
I denne vejledning til hjælp kaldes skærmen Indstillinger i webappen for webmenuen.

Relateret emne
Tilgå webappen fra en webbrowser

Strukturen på Live-driftsskærmen

Strukturen i Skærmenes fælles område

Strukturen i afspilningsfunktionsskærmen

Struktur af skærmen Indstillinger
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Strukturen i Skærmenes fælles område

Dette emne beskriver strukturen i skærmenes fælles område.

Kameranavn
Viser kameraets navn.
Du kan ændre navnet vha. [Network] > [Camera Name] i webmenuen.
Baggrundsfarven ændres ifølge det eksterne tally-signal.

1.

Tænd- og slukknap
Når enheden tændes, vises [Power ON]. Du kan trykke kontakten ned og vælge [Power Standby] for at indstille
strømforsyningen til standby-tilstand.
Når [Power Standby] vises, kan du trykke på kontakten og vælge [Power ON] for at tænde for enhedens strømforsyning.

2.

Driftsskærmens skiftefaner
Tryk på en fane for at vise den tilsvarende driftsskærm.
[Live]-fane: Vis den live driftsskærm.
[Playback]-fane: Vis afspilningsfunktionsskærmen.
[Settings]-fane: Vis skærmen indstillinger (webmenu).

3.

Underretninger-mærke
Når en meddelelse kommer, ændres indikationsmærket som vist herunder.

 (Notifikationer On)
Foretag de nødvendige handlinger ifølge meddelelsen vist i kameraets billedpanel.

Bemærk!

Meddelelser vises ikke, når [Monitoring] > [Output Display] > [HDMI/Stream] er indstillet til [Off] i webmenuen. Sæt på [On] for at
tjekke indholdet i meddelelserne.

4.

 (Kamerastatus)-knap
Tryk på knappen for at vise kameraoptaget billede/outputbilledets signaloplysninger, objektivinformation og objektiv
styreenhed (valgfri) status på en separat skærm.

5.
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Når der forekommer notifikationer for objektiv styreenhed (valgfri), ændres indikationsmærket som vist herunder.

Låsekontakt skærmfunktion
 (Drift oplåsning): Sæt kontakten i den venstre position for at styre funktioner på live-driftsskærmen og

afspilningsskærmen.
 (Driftslås): Sæt kontakten i den højre position for at låse funktioner på live-driftsskærmen og afspilningsskærmen

mhp. at forhindre utilsigtede funktionsfejl.

6.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Strukturen på Live-driftsskærmen

Dette emne beskriver strukturen på Live-driftsskærmen.

Forindstil positionskontrolpanel
Viser den registrerede position af en forindstilling vha. et miniaturebillede. Dobbelttryk på miniaturebilledet for at vende
tilbage til den position, der er gemt i forindstillingen.

For yderligere oplysninger om den forindstillede position se "Lagring/Gendannelse af panorering/hældning,
zoomposition og fokusindstilling vha. webappen".
For oplysninger om PTZ trace, se "Optage kamera indramningsfunktioner ved hjælp af webappen".

1.

Kameraets billedpanel
Viser det nuværende kamerabillede og enhedens status.
Det viser det samme billede som HDMI-outputtet.
Den følgende status vises over billedet. En rød eller grøn ramme vises også rundt om billede ifølge det modtagede
eksterne tally-signal.

2.
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[Display]-knap
Tryk på denne knap for at vise kameraoplysninger på billedet.
Tryk igen, mens kameraoplysningerne vises, for at skjule kameraoplysningerne.

Ud over markører vises nogle autofokusrelaterede indikatorer og meddelelser i henhold til statussen, og disse kan ikke
skjules ved at trykke på knappen [Display].

For yderligere oplysninger om den viste kamerainformation se "Kameras skærmvisning".

Knappen til at stoppe sporings-AF i realtid
Tryk på knappen for at stoppe sporing af et emne.

Nr. Visning Beskrivelse

2-
1

Indikator for fokustilstand Se "Focus mode indicator" i "Kameras skærmvisning".

2-
2

Optagelsestilstand, sprække A/B, Interval
Rec-optagelsesintervalindikator

Se "Optagelsestilstand, sprække A/B, Interval Rec-
optagelsesintervalindikator" i "Kameras skærmvisning".

2-
3

Statusindikator for streaming
Vist under streaming (kun når [Stream Setting] kun er indstillet til
[RTMP] eller [SRT-Caller]).

2-
4

Statusindikator for RAW-outputfunktion
Viser outputstatus for RAW-signalet. For yderligere oplysninger
om RAW se "Optagelse af RAW-video".

2-
5

Indikator for resterende mediekapacitet
Se "Resterende mediekapacitetsindikator" i "Kameras
skærmvisning".

2-
6

Indikator for zoomposition
Se "Zoompositionsindikator" i "Kameras skærmvisning".
Når en objektiv styreenhed (valgfri) er tilsluttet, vises . Hvis der
opstår en fejl på objektivets styreenhed (valgfri), vises .

2-
7

Indikator for AE-tilstand/AE-niveau
Se "Indikator for AE-tilstand/AE-niveau" i "Kameras
skærmvisning".
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For yderligere oplysninger henvises til "Sådan spores et specificeret motiv (Realtime Tracking AF)".
Knap til START/STOP af optagelse
Tryk på knappen for at starte optagelse. Under optagelses lyser optagelsesknappen START/STOP rødt.
Tryk under optagelse for at stoppe optagelse.
Du kan indstille kontakten HOLD til HOLD-tilstanden for at forhindre forkert betjening af optagelsesknappen
START/STOP.

3.

Kameraets grundlæggende konfigurationspanel
Viser indstillinger for grundlæggende funktioner, der er påkrævet til optagelse, på knapper. Tryk på en knap for at vise
den tilhørende opsætningsskærm for hver funktion i kameraets grundlæggende konfigurationsjusteringspanel herunder
(5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

For nærmere oplysninger henvises til beskrivelsen af hver funktion.

4.

Funktion Reference

FPS "Langsom og hurtig bevægelse"

ISO/Gain
"Indstilling af basisfølsomhed", "Automatisk justering af forstærkning" og "Manuel justering af
forstærkning" i "Justering af forstærkning"

Exposure
Index

"Indstilling af basisfølsomhed" og "Ændring af fordelingen af mørke og lyse områder i optaget billede"

Shutter "Automatisk justering af lukkeren" og "Manuel justering af lukkeren" i "Justering af shutter"

Iris "Automatisk justering af iris" og "Manuel justering af iris" i "Justering af iris"

ND Filter "Om ND-filteret" i "Justering af lysniveauet (ND-filter)"

Scene File "Oversigt over udseende" og andre emner i "Filmning med det ønskede udseende"

Base
Look/LUT

"Filmning med justering af udseende i efterproduktion"

White
Balance

"Hvidbalance-justeringsskærm"
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Tildelelige knapper/Kameras grundlæggende konfigurationsjusteringspanel
Viser tildelelige knapper under normal drift. Tryk på kameraets grundlæggende konfigurationspanel (element 4) for at få
vist de tilsvarende opsætningspunkter. Tryk på [X]-knappen, eller tryk på kameraopsætningens panelknap igen for at
vende tilbage til den tildelelige knapvisning.

For yderligere oplysninger om tildelelige knapper se "Tildelelige knapper".
For yderligere oplysninger om kameraets grundlæggende konfigurationsjusteringspanel se beskrivelsen af hver
funktion.

5.

Indramningskontrolpanel / GUI-betjeningspanel
Skift mellem indramningskontrolpanelet/GUI-kontrolpanelet vha. fanerne øverst.
Du kan trykke på  (Luk) øverst på skærmen for at skjule kontrolpanelet for at forhindre utilsigtet betjening. Hvis
kontrolpanelet ikke vises, skal du trykke på knappen  (Åbn) for at vise det.
Brug indramningskontrolpanelet for at justere indramningen. Tryk på  (panorering/hældnings/zoom) for at vise
indramningskontrolpanelet.

For yderligere oplysninger om betjening se "Justering af indramningen".

Tip!

Joystick-delen af indramningskontrolpanelet vises som vist herunder, når panorerings-/hældningsfunktionen er deaktiveret, og når
panorerings-/hældningsinitialisering er påkrævet.

Når panorerings-/hældningsfunktionen er låst vha. panorerings-/hældningslåsehåndtaget

Når panorerings-/hældningsfunktionen ikke er initialiseret

6.
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Når panorerings-/hældningsfunktionen skal nulstilles

Når panorerings-/hældningsfunktionen er deaktiveret

Når panorering/hældning ikke er initialiseret eller har brug for at blive nulstillet, kan du hurtigt få adgang til  (nulstilling af
panorering/hældning) i kameraets kontrolpanel ved at trykke på meddelelsen, der er vist under joysticket.

Brug GUI-kontrolpanelet til at betjene kameramenuen, klippe afspilning og andre funktioner. Tryk på  (Kam
GUI)-fanen for at vise GUI-kontrolpanelet.

For yderligere oplysninger om drift se "Betjening af kameramenuen" og "Afspilning af optagede klip".
Kamerakontrolpanel
Brug til at konfigurere de funktioner, der er påkrævet til at betjene kameraet.
Skift mellem skærmene for at vise vha. fanerne øverst.
Du kan trykke på  (Luk) øverst på skærmen for at skjule kontrolpanelet for at forhindre utilsigtet betjening. Hvis
kontrolpanelet ikke vises, skal du trykke på knappen  (Åbn) for at vise det.

7.
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For nærmere oplysninger henvises til beskrivelsen af hver funktion.

  (Main)-fanen
Viser opsætningspunkter for hyppigt anvendte funktioner.
De øverste og nederste skyderfunktioner kan ændres ved at trykke på [▼]-knappen og vælge fra den viste liste.
Følgende funktioner kan vælges.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus)-fanen
Viser opsætningspunkter relateret til fokus.

  (Audio)-fanen

Viser opsætningspunkter relateret til lyd.

Vist i henhold til menuindstillinger.*
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 (Stream)-fanen
Viser opsætningspunkter relateret til streaming.
De viste punkter vil variere afhængigt af streamingformatets indstilling.
Når streaming er indstillet til [RTMP] eller [SRT-Caller], kan den startes/stoppes på denne skærm.

For yderligere oplysninger se "Om Streaming" og andre emner i "Konfigurering af streaming".
Fejlinformation vises, hvis der opstår en forbindelsesfejl. For yderligere oplysninger om fejlinformation, se
"Fejl-/advarselsmeddelelser".

 (Others)-fanen
Viser opsætningspunkter relateret til andre funktioner.

Hvis du trykker på knappen [Full Screen Display], åbnes en ny fane i webbrowseren, og billedet af kameraets
billedpanelet vises i fuld skærm.
Kun billedvisning finder sted; touch AF og andre funktioner er ikke tilgængelige.
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Relateret emne
Lagring/Gendannelse af panorering/hældning, zoomposition og fokusindstilling vha. webappen

Optage kamera indramningsfunktioner ved hjælp af webappen

Kameras skærmvisning

Optagelse af RAW-video

Sådan spores et specificeret motiv (Realtime Tracking AF)

Langsom og hurtig bevægelse

Indstilling af basisfølsomhed

Automatisk justering af forstærkning

Manuel justering af forstærkning

Ændring af fordelingen af mørke og lyse områder i optaget billede

Automatisk justering af lukkeren

Manuel justering af lukkeren

Automatisk justering af iris

Manuel justering af iris

Om ND-filteret

Oversigt over udseende

Filmning med justering af udseende i efterproduktion

Hvidbalance-justeringsskærm

Tildelelige knapper

Afspilning af optagede klip

Betjening af kameramenuen

Om Streaming

Fejl-/advarselsmeddelelser

5-041-958-93(1) Copyright 2022 Sony Corporation

Bemærk!

Skærmen til live betjening på den oprindelige fane fungerer fortsat. Det anbefales, at du lukker fanen for at reducere antallet af
samtidige forbindelser, hvis der ikke er brug for betjening.

Tryk på -knappen (start objektiv styreenhed) for at starte objektiv styreenheden (tredjepart valgmulighed).
Denne knap aktiveres kun, når [Technical] > [Lens Controller] > [Zoom] > [Setting] er indstillet til [On] i webmenuen.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Strukturen i afspilningsfunktionsskærmen

Dette emne beskriver strukturen i afspilningsfunktionsskærmen.

Kameraets billedpanel
Viser afspilningsbilledet og de tilknyttede oplysninger. Når afspilning er stoppet, kommer kameraets billedskærm frem.

1.
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1-1 Optagelse dato og tid
1-2 Indikator for afspilningsstatus
1-3 Indikator for afspilningsformat (billedstørrelse)
1-4 Indikator for afspilningsformat (codec)
1-5 Visning af klipnavn
1-6 Klipnummer/Samlet antal klip
1-7 Visning af LUT-navn
1-8 Indikator for streamingstatus
1-9 Indikator for afspilningsformat (rammehastighed og scanningsmetode)
1-10 Optagelsesindikator for udseende

Kontrolpanel afspilning

Viser afspilningskontrolknapperne.

[Display]-knap
Tryk for at skifte mellem skærmvisningen på billedet.
[Thumbnail]-knap
Viser de klip, der er optaget på hukommelseskortet på kameraets billedpanel, som miniaturebilleder.

2.

Knap Funktion

 (Afspil/Pause)-knap Afspiller et klip. Under afspilning, sætter klippet på pause.

 (Hurtig fremspoling)-knap,  (Hurtig
tilbagespoling)-knap

Afspiller et klip ved høj hastighed. Når knappen er trykket ned,
ændres afspilningens hastighed i tre trin.

 (Næste)-knap,  (Forrige)-knap Spring til starten af et klip eller det forrige/næste klip.

 (Stop)-knap Stopper afspilning.
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Relateret emne

Miniaturebilledskærm

Tildelelige knapper

Afspilning af optagede klip

5-041-958-93(1) Copyright 2022 Sony Corporation

Hvis du trykker på [Thumbnail]-knappen under visning af miniaturebilledskærmen, lukkes miniaturebilledskærmen, og der
vendes tilbage til kamerabilledet.

For yderligere oplysninger om miniaturebilledskærmen se "Miniaturebilledskærm".

[Slot Select]-knap
Skifter mellem motivafspilningsmediet.

Tildelelige knapper
Viser de tildelelige knapper, der er tildelt til hver af enhedens funktioner.

For yderligere oplysninger om tildelelige knapper se "Tildelelige knapper".

3.

GUI-kontrolpanel
Brug GUI-kontrolpanelet til at betjene kameramenuen, klippe afspilning og andre funktioner.

For yderligere oplysninger om drift se "Betjening af kameramenuen" og "Afspilning af optagede klip".

4.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur af skærmen Indstillinger

Brug skærmen indstillinger til at konfigurere de forskellige opsætningspunkter på enheden, inklusive de første indstillinger,
netværksindstillinger, optagelses-/afspilningsindstillinger vha. webmenuen.

Bemærk!

I webmenuen anvendes indstillingerne generelt ikke, før du trykker på [OK]-knappen. Hvis du ændrer indstillingerne på en side, der
har en [OK]-knap, skal du sørge for at trykke på [OK]-knappen.

For yderligere oplysninger om skærmen indstillinger se "Webmenu og detaljerede indstillinger".

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameramenu

Tryk på [Menu]-knappen i GUI-kontrolpanelet på livedriftsskærmen eller afspilningsskærmen for at vise kameramenuen i
kameraets billedpanel.

Du kan konfigurere de påkrævede indstillinger for at optage og afspille vha. kameramenuen.
Tryk på knappen [Menu], mens kameraets fulde menu vises, for at skjule kameramenuen.
Kameramenuen betjenes vha. GUI-kontrolpanelet.

For yderligere oplysninger om kameramenuen se "Kameramenu og detaljerede indstillinger".

Bemærk!

Når [Monitoring] > [Output Display] > [HDMI/Stream] er indstillet til Off i webmenuen (deaktiverer informationsoverlejring), vises
kameramenuen ikke længere i kameraets billedpanel. Vær dog opmærksom på, at menufunktionerne i GUI-kontrolpanelet stadig er
aktive. For at undgå utilsigtet funktion skal du undlade at foretage menufunktioner vha. GUI-kontrolpanelet, når [HDMI/Stream] er
indstillet til Off.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameras skærmvisning

Du kan vise status og indstillinger for enheden overlejret på outputbilledet fra kameraet. Du kan indstille outputs, for hvilke
skærmvisning er aktiveret vha. [Monitoring] > [Output Display] i webmenuen.
Du kan få vise/skjule oplysningerne ved hjælp af knappen [Display]. Selv når den er skjult, vises den, mens du udfører
handlinger på den direkte menu.
Du kan vise/skjule punkter enkeltvis vha. [Monitoring] > [Display On/Off] i kameramenuen.

Oplysninger der vises på skærmen under optagelse

Indikator for upload/Indikator for resterende filer

For oplysninger om overførsel af filer se "Om filoverførsel" og andre emner i "Overfører filer".

1.

Indikator for fokusområde
Viser fokusområdet for autofokus.

For oplysninger om auto fokus se "Automatisk justering vha. webappen" og andre emner i "Automatisk justering af
fokus (autofokus)".

2.

Optagelsestilstand, sprække A/B, Interval Rec-optagelsesintervalindikator

For yderligere oplysninger om Interval Rec se "Optagelse af video med afbrydelser (Interval Rec)".

3.

Visning Betydning

●Rec Optagelse

Stby Optager i standby

Feltdybdeindikator4.

Indikator for imager-scanningstilstand
Et  (mismatch) mærke vises, hvis der er en uoverensstemmelse mellem objektivets billedcirkelstørrelse og den
effektive indstilling for billedstørrelsens billedscanningstilstand.

5.
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Når tilstanden Imager Scan er indstillet til FF, vises et "C"-mærke i tilstande med en smallere synsvinkel (beskåret).
Beskæring sker i følgende tilstande.

Når optagelsesformatet er 3840×2160 og S&Q Motion-billedhastighed er 100 fps eller 120 fps
Når [Codec] i er indstillet til RAW eller RAW & XAVC-I, og RAW-outputformatet er 3840×2160
For yderligere oplysninger om billedscanningstilstanden se "Indstilling af imager-scanningstilstand" i "Konfiguration af
grundlæggende betjening".

Statusindikator for RAW-outputfunktion
Viser outputstatus for RAW-signalet.

For yderligere oplysninger om RAW se "Optagelse af RAW-video".

6.

Indikator for optagelsesbilledhastighed i langsom og hurtig bevægelse

For yderligere oplysninger om hurtig og langsom bevægelse se "Langsom og hurtig bevægelse".

7.

Indikator for fokuspositionen

Viser fokuspositionen.

8.

Indikator for fokustilstand

Ansigts-/øjeregistrering AF

For yderligere oplysninger om ansigts-/øjeregistrering AF se "Sporing ved hjælp af ansigts-/øje-registrering (Face/Eye
Detection AF)".

9.

Visning Betydning

Focus Hold Focus Hold-tilstand

MF MF-tilstand

AF AF-tilstand

 (AF-sporingstilstand i realtid) AF-sporingstilstand i realtid

Visning Betydning

 (Ansigts-/øjeregistrering AF) Angiver, at ansigts-/øjeregistrering AF er aktiv

 (Ansigts-/øje kun AF) Angiver, at kun ansigts-/øjeregistrering AF er aktiv

 (gemt sporingsansigt) Angiver, at et sporingsansigt er blevet gemt

 (AF sat på pause) Angiver, at AF var sat på pause*

Vises, når der ikke er gemt noget sporingsansigt, og der ikke registreres et ansigt, eller når der er et gemt sporingsansigt, men
sporingsmålansigtet ikke registreres.

*

Indikator for zoomposition
Viser zoompositionen i området 0 (vidvinkel) til 99 (telefoto) (hvis der er monteret et objektiv, der understøtter visning af
zoomindstilling).
Du kan også ændre indikatoren til en bjælkevisning eller fokal længdevisning vha. [Technical] > [Lens] > [Zoom Position
Display]-indstillingen i kameramenuen.
Følgende elementer føjes til visningen, når Clear Image Zoom er aktiveret.

10.
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For yderligere oplysninger om zoom se "Indstilling af zoomtype" og andre emner i "Justering af zoom".

Visning Betydning

 (Clear Image Zoom er aktiveret) Clear Image Zoom er aktiveret

Forstørrelsesværdi Ved brug af Clear Image Zoom

Indikator for billedstabiliseringstilstand11.

Statusindikator for SDI-output/HDMI-output Rec Control
Viser outputstatus for REC-kontrolsignalet.

For yderligere oplysninger se "Tilslutning af eksterne skærme og optagelsesenheder".

12.

Fokusindikator

For yderligere oplysninger se "Anvendelse af Single-Shot-autofokus (Push Auto Focus (AF-S))" i "Justering af fokus".

13.

Indikator for resterende mediekapacitet
Et  (beskytte) ikon vises, hvis hukommelseskortet er skrivebeskyttet.

14.

Indikator for hvidbalancetilstand15.

Visning Betydning

 (ATW) Automatisk tilstand

 (ATW Hold) Automatisk tilstand pauseret

W:P Forudindstillingstilstand

W:A Hukommelse A-tilstand

Visning af ekstern låseindikator for tidskode/tidsdata
Viser "EXT-LK", når den er låst til tidskoden på en ekstern enhed.

For yderligere oplysninger om tidskode se "Angivelse af tidsdata".

16.

ND-filterindikator

For yderligere oplysninger om ND-filtre se "Justering af lysniveauet (ND-filter)".
For yderligere oplysninger om bokeh-kontrol, se "Sådan justeres Bokeh (Bokeh Control Function)".

17.

Visning Betydning

 (A) Automatisk tilstand

 (B) Bokeh-kontroltilstand

Indikator for scenefil

For yderligere oplysninger om scenefiler se "Oversigt over udseende" og andre emner i "Filmning med det ønskede
udseende".

18.

Iris-indikator
Viser iris-positionen (F-værdi) (hvis der er monteret et objektiv, der understøtter visning af iris-indstilling).

For yderligere oplysninger om iris se "Automatisk justering af iris" og "Manuel justering af iris".

19.
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Advarselsindikator for videoniveau20.

Forstærkningsindikator
Viser EI-værdien når i tilstanden Cine EI/Cine EI Quick-tilstand.

For yderligere oplysninger om forstærkningen se "Automatisk justering af forstærkning" og "Manuel justering af
forstærkning".
For yderligere oplysninger om Cine EI/Cine EI Quick-tilstand, se "Indstilling af optagelsestilstand" i "Konfiguration af
grundlæggende betjening".

21.

Visning Betydning

 (A) Automatisk tilstand

L Forudindstillet L-tilstand

 (Midlertidig justeringstilstand) Midlertidig justeringstilstand

 (B) Bokeh-kontroltilstand

Visning af klipnavn
Viser navnet på det klip, der bliver optaget, eller som skal optages derefter.
Hvis den blinker er en uoverensstemmelse mellem det sidste klip på optagelsesmediet og [Camera ID] eller [Reel
Number] indstillingerne. For oplysninger se beskrivelsen [Clip Name Format] > [Auto Naming].

22.

Shutterindikator

For yderligere oplysninger om shutteren se "Automatisk justering af lukkeren" og "Manuel justering af lukkeren".

23.

Indikator for AE-tilstand/AE-niveau

For yderligere oplysninger om auto eksponering (AE) se "Indstilling af målniveau for automatisk lysstyrkejustering".

24.

Indikator for vaterpas
Viser det horisontale niveau i intervaller på ±1° op til ±15°.

25.

Lydniveaumåler
Viser lydniveauet for hver kanal.

26.

Videosignalsmonitor
Viser en bølgeform, vektorskop og histogram.
Den orange linje angiver den indstillede værdi for lysstyrkens niveaumarkør.
I Log-optagelsestilstande, vises monitormål LUT-typen over visningen.

For mere information se "Videosignalsmonitor".
For yderligere oplysninger om Log optagelsestilstande, se "Indstilling af optagelsestilstand" i "Konfiguration af
grundlæggende betjening".

27.

Base Sensitivity-indikator/Base ISO-indikator
I tilstanden Custom vises den indstillede basisfølsomhed vha. knappen [ISO/Gain / Exposure Index] i kameraets
grundlæggende konfigurationspanel eller [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] i kameramenuen.
I Log-optagelsestilstande vises Base ISO-følsomhed vha. knappen [ISO/Gain / Exposure Index] i kameraets
grundlæggende konfigurationspanel eller [Shooting] > [ISO/Gain/EI] > [Base ISO] i kameramenuen.

For yderligere oplysninger om basisfølsomheden se "Valg af basisfølsomhed".
For yderligere oplysninger om Log optagelsestilstande, se "Indstilling af optagelsestilstand" i "Konfiguration af
grundlæggende betjening".

28.

Overvågning af låseindikator
I Log-optagelsestilstande vises monitor-LUT-indstillingen.

29.
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Oplysninger der vises på skærmen under afspilning

Følgende oplysninger overlejres på afspilningsbilledet.

For yderligere oplysninger om LUT-indstillingen se "Filmning med justering af udseende i efterproduktion" og
tilhørende emner.
For yderligere oplysninger om Log optagelsestilstande, se "Indstilling af optagelsestilstand" i "Konfiguration af
grundlæggende betjening".

Basisudseende/Optagelseslåseindikator
Viser indstillingen for basisudseendet.
I Log-optagelsestilstande vises videosignalet for optagelse på hukommelseskortene.

For yderligere oplysninger om basisudseendet se "Oversigt over udseende" i "Filmning med det ønskede udseende".
For yderligere oplysninger om Log optagelsestilstande, se "Indstilling af optagelsestilstand" i "Konfiguration af
grundlæggende betjening".

30.

Statusindikator for proxy31.

Indikator for optagelsesformat (codec)
Viser navnet på det format, der skal optages på hukommelseskortet.
Indstil optagelsesformat (codec) vha. [Project] > [Rec Format] > [Codec] i webmenuen eller kameramenuen.

32.

Indikator for optagelsesformat (billedhastighed og scanningsmetode)33.

Indikator for optagelsesformat (billedstørrelse)
Viser billedstørrelsen for optagelse på hukommelseskort.
Indstil optagelsesformat (billedstørrelse) vha. [Project] > [Rec Format] > [Codec] i webmenuen eller kameramenuen.

34.

Tally-indikator
En rød eller grøn ramme vises rundt om billedet ifølge det modtagede eksterne tally-signal.

35.

Indikator for upload/Indikator for resterende filer1.

Klipnummer2.

Indikator for afspilningsstatus3.

Indikator for afspilningsformat (billedhastighed og scanningsmetode)4.

Indikator for afspilningsformat (billedstørrelse)5.
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Relateret emne
Om filoverførsel

Automatisk justering vha. webappen

Optagelse af video med afbrydelser (Interval Rec)

Konfiguration af grundlæggende betjening

Optagelse af RAW-video

Langsom og hurtig bevægelse

Sporing ved hjælp af ansigts-/øje-registrering (Face/Eye Detection AF)

Indstilling af zoomtype

Tilslutning af eksterne skærme og optagelsesenheder

Anvendelse af Single-Shot-autofokus (Push Auto Focus (AF-S))

Angivelse af tidsdata

Oversigt over udseende

Automatisk justering af iris

Manuel justering af iris

Automatisk justering af forstærkning

Manuel justering af forstærkning

Automatisk justering af lukkeren

Manuel justering af lukkeren

Indstilling af målniveau for automatisk lysstyrkejustering

Videosignalsmonitor

Filmning med justering af udseende i efterproduktion

Clip Name Format

5-041-958-93(1) Copyright 2022 Sony Corporation

Indikator for afspilningsformat (codec)6.

Medieindikator
Et  (beskytte) ikon vises, hvis hukommelseskortet er skrivebeskyttet.

7.

Visning af tidsdata8.

Visning af klipnavn9.

Indikator for Gamma-displayhjælp10.

Lydniveaumåler
Viser lydniveauet for afspilning.

11.

Basisudseende/Optagelseslåseindikator12.

Tally-indikator13.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Oprejst montering på et fast sted

Dette emne beskriver montering af enheden på et skrivebord eller en trefod.

Installationsbemærkning
For at beskytte objektivet og objektivets forbindelsesblok holdes dækslet og hætten til enheden fastmonteret, indtil du
monterer objektivet.
For at forhindre at objektivet svigter, må man ikke holde på objektivets dele under arbejdet.
For at forhindre at enheden svigter, må man ikke holde på kamerahovedet under arbejdet.

Tjek monteringspladsen.

Ved montering på et skrivebord
Montér denne enhed på en flad overflade, og husk den nødvendige plads til at dreje objektivet og ledningerne bag på
enheden.

Bemærk!

Montér den på et stabilt sted, der ikke er udsat for vibrationer. Steder udsat for vibrationer kan forårsage vibrationer i billedet.

Hvis enheden skal monteres på en skrå overflade, skal den holdes inden for ±15°, og der skal tages foranstaltninger for at sikre,
at enheden ikke falder ned.

Ved montering på en trefod
Montér trefoden på skruehullet i bunden.
Brug en trefodmonteringsskrue med følgende mængde fremspring fra monteringsfladen, og stram den med en
skruetrækker.

A: Trefod-monteringsskruer 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Fremspring (4,5 mm til 5,5 mm)

1
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Montér så objektivet. Se "Montering af et objektiv", og husk informationen i "Forholdsregler ved påsætning/fjernelse af et
objektiv", "Tjekker objektivets kontakter" og "Forholdsregler ved brug af et zoomobjektiv".

Relateret emne

Forholdsregler ved påsætning/fjernelse af et objektiv

Tjekker objektivets kontakter

Forholdsregler ved brug af et zoomobjektiv

Montering af et objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation

Brug ikke trefodskruer til montering af enheden på et højt sted.

Bemærk!

Vælg en trefod, der ikke vil vippe, når objektivet drejer.

62



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Opretstående montering på et højt, fast sted

Dette emne beskriver proceduren for montering af enheden opretstående på et højt sted vha. loftsbeslaget (CIB-PCM1
(ekstraudstyr)).

Spørg en professionel for at montere enheden på et højt sted.
Ved montering på et højt sted skal du sørge for, at monteringsoverfladen og monteringsmaterialet (eksklusiv tilbehør) kan
understøtte 200 kg eller mere og montere enheden som beskrevet i denne vejledning til hjælp. Hvis montering ikke er
stærk nok, kan enheden falde ned og forårsage alvorlige kvæstelser.
Montér det medfølgende faldsikringsreb på CIB-PCM1-loftsbeslaget (ekstraudstyr) for at forhindre enheden i at falde ned.
Når enheden er monteret et højt sted, skal du mindst en gang om året tjekke, at monteringen ikke er blevet løs. Forkort
inspektionsintervallet ifølge brugsbetingelserne.

Installationsbemærkning
For at beskytte objektivet og enhedens forbindelsesblok skal man beholde objektivets hætte og dæksel på, indtil
objektivet er påsat.
For at forhindre at objektivet svigter, må man ikke holde på objektivets dele under arbejdet.
For at forhindre at enheden svigter, må man ikke holde på kamerahovedet under arbejdet.

Tjek monteringstilbehøret og det høje monteringssted.

CIB-PCM1 loftbeslagsæt (ekstraudstyr)
Før du starter, skal du tjekke, at du har de følgende dele.

Kropsbeslag (1)
Loftsbeslag (1)
Dæksel til objektets udløserknap (1)
Faldsikringsreb (1)
+PSW M3×8 skruer (9)
+PSW M4×8 skrue af rustfri stål til faldsikringsreb (1)

Bemærk!

1
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Faldsikringsreb er designet til at støtte enheden, når den er ophængt. Sæt ikke en belastning på den udover enhedens vægt.

Monteringssted
Se den følgende tegning ved bestemmelse af monteringssted og retning, og husk den nødvendige plads til at dreje
objektivet og ledningerne på enhedens bagside.

A: Kamerahovedets bevægelsesområde (f.eks. SEL70200GM2 (med SEL20TC påsat): Ø370)
B: Loftsbeslag (hul på monteringsfladens side (Ø150))
C: Monteringsjusteringshul

Bemærk!

Montér den på et stabilt sted, der ikke er udsat for vibrationer. Steder udsat for vibrationer kan forårsage vibrationer i billedet.

Hvis enheden skal monteres på en skrå overflade, skal den holdes inden for ±15°, og der skal tages foranstaltninger for at sikre,
at enheden ikke falder ned.

Før panorerings-/hældningslåsehåndtaget til LOCK-positionen for at låse kamerahovedets
panorering/hældning.

2

64



Bemærk!

Hvis kamerahovedets panorering/hældning ikke låser, når låsehåndtaget er i LOCK-position, flyttes kamerahovedet manuelt,
indtil det låser i position.

Fastgør kropsbeslaget til bunden af enheden vha. de seks medfølgende skruer (M3×8).3
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Brug de medfølgende skruer. Brugen af skruer udover de medfølgende kan beskadige enhedens inderside.

Montér faldsikringsrebet på kropsbeslaget.4
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A: Medfølgende reb　
B: Medfølgende Philips-skrue (M4×8)
C: Metalreb

Brug den medfølgende skrue. Brugen af en skrue udover den medfølgende kan reducere effektiviteten af rebets
funktion.

Montér loftsbeslaget på fladen, såsom en hylde, hvor enheden vil blive monteret.5
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A: Væg　
B: △ mærke (kamera retning fremad)
C: Hul til tilslutningskabler
D: Hylde eller anden monteringsflade

Montér faldsikringsrebet til et punkt nær monteringsfladen.

Brug en M5 (3/16 tommer) sekskantet hætteskrue (ekstraudstyr), og montér den på et objekt nær hylden eller fladen,
som loftsbeslaget er monteret på.

6
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A: Reb　
B: Sekskantet hætteskrue (M5, 3/16 tommer)

Afstem 〇 skruehullet på forsiden af kropsbeslaget med ◇ hullet i loftsbeslaget, indsæt enheden, og fastgør
midlertidigt kropsbeslaget i loftsbeslaget ved at dreje enheden med uret.

7
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A: 〇 hul
B: ◇ hul

Fastgør kropsbeslaget og loftsbeslaget vha. de tre medfølgende rotationslåseskruer (M3×8).8
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Montér så objektivet. Se "Montering af et objektiv", og husk informationen i "Forholdsregler ved påsætning/fjernelse af et
objektiv", "Tjekker objektivets kontakter" og "Forholdsregler ved brug af et zoomobjektiv".

Bemærk!

Efter montering af et objektiv skal man tjekke, at objektivet er ordentligt fastgjort.
Objektivet har ingen beskyttelses mod fald. Sony hæfter ikke for et objektiv, der falder af enheden.

Relateret emne

Forholdsregler ved påsætning/fjernelse af et objektiv

Tjekker objektivets kontakter

Forholdsregler ved brug af et zoomobjektiv

Montering af et objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation

Tjek monteringsstatus.

Tjek især de følgende genstande. 

Monteringsskruer er korrekt monteret.
Faldsikringsreb er korrekt påsat og ikke drejet.
Enheden er monteret jævnt (uden at hælde eller slingre).
Enheden drejer ikke frit rundt, når den drejer.

9
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montering på et loft

Dette emne beskriver proceduren for montering af enheden på et loft vha. loftsbeslaget (CIB-PCM1 (ekstraudstyr)).

Spørg en professionel for at montere enheden på et loft.
Ved montering på et loft skal du sørge for, at monteringsoverfladen og monteringsmaterialet (eksklusiv tilbehør) kan
understøtte 200 kg eller mere og montere enheden som beskrevet i denne vejledning til hjælp. Hvis montering ikke er
stærk nok, kan enheden falde ned og forårsage alvorlige kvæstelser.
Montér det medfølgende faldsikringsreb på CIB-PCM1-loftsbeslaget (ekstraudstyr) for at forhindre enheden i at falde ned.
Når enheden er monteret et loft, skal du en gang om året tjekke, at monteringen ikke er blevet løs. Forkort
inspektionsintervallet ifølge brugsbetingelserne.

Installationsbemærkning
For at beskytte objektivet og enhedens forbindelsesblok skal man beholde objektivets hætte og dæksel på, indtil
objektivet er påsat.
For at forhindre at objektivet svigter, må man ikke holde på objektivets dele under arbejdet.
For at forhindre at enheden svigter, må man ikke holde på kamerahovedet under arbejdet.

Tjek loftets monteringstilbehør og monteringsstedet.

CIB-PCM1 loftbeslagsæt (ekstraudstyr)
Før du starter, skal du tjekke, at du har de følgende dele.

Kropsbeslag (1)
Loftsbeslag (1)
Dæksel til objektets udløserknap (1)
Faldsikringsreb (1)
+PSW M3×8 skruer (9)
+PSW M4×8 skrue af rustfri stål til faldsikringsreb (1)

Bemærk!

1
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Faldsikringsreb er designet til at støtte enheden, når den er ophængt. Sæt ikke en belastning på den udover enhedens vægt.

Monteringssted
Se den følgende tegning ved bestemmelse af monteringssted og retning, og husk den nødvendige plads til at dreje
objektivet og ledningerne på enhedens bagside.

A: Kamerahovedets bevægelsesområde (f.eks. SEL70200GM2 (med SEL20TC påsat): Ø370)
B: Loftsbeslag (hul på loftets side (Ø150))
C: Monteringsjusteringshul

Bemærk!

Montér på et loft (som cement) med tilstrækkelig styrke.

Sørg for tilstrækkelig forstærkning for at montere enheden på et loft med utilstrækkelig styrke.

Montér den på et stabilt sted, der ikke er udsat for vibrationer. Steder udsat for vibrationer kan forårsage vibrationer i billedet.

Hvis enheden skal monteres på en skrå overflade, skal den holdes inden for ±15°, og der skal tages foranstaltninger for at sikre,
at enheden ikke falder ned.

Siden overfor △ hullet på loftsbeslaget er optagelsesretningen (kameraets forside).

Før panorerings-/hældningslåsehåndtaget til UNLOCK-positionen for at låse op for panorering/hældning. Drej
kamerahovedet 180° i hældningsretningen.

2

Før panorerings-/hældningslåsehåndtaget til LOCK-positionen for at låse kamerahovedets
panorering/hældning.

3
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Kamerahoved drejet 180°

Bemærk!

Hvis kamerahovedets panorering/hældning ikke låser, når låsehåndtaget er i LOCK-position, flyttes kamerahovedet manuelt,
indtil det låser i position.

Fastgør kropsbeslaget til bunden af enheden vha. de seks medfølgende skruer (M3×8).4
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Brug de medfølgende skruer. Brugen af skruer udover de medfølgende kan beskadige enhedens inderside.

Fastgør loftsbeslaget på en monteringsplade (ekstraudstyr), og montér så pladen på loftet.5
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A: Loftsbeslag
B: Loft
C: Monteringsplade
D: △ hul
Montér beslaget i overensstemmelse med loftsbeslagets retning
Bemærk, at ved montering på et loft er kameraets forside på den modsatte side af loftsbeslaget til sammenligning med
en normalt oprejst montering. Montér korrekt ved at referere til diagrammet, der angiver monteringsretningen.

A: Forside til oprejst montering (△ hullets retning)
B: Forside til loftsmontering

Bemærk!

Monteringsfladens materiale er kundens ansvar.

Montér faldsikringsrebet på loftet.

A: Loftsbeslag
B: Sekskantet hætteskrue (M5, 3/16 tommer)
C: Reb (medfølger)
D: Monteringsplade
E: Loft

6

Træk faldsikringsrebet igennem hullet i midten af loftsbeslaget, og montér det på loftsbeslaget.

Før faldsikringsrebet igennem metalrebets løkke på kropsbeslaget, og fastgør det på beslaget vha. den medfølgende
skrue af rustfrit stål (M4×8).

7
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A: Medfølgende reb
B: Medfølgende Philips-skrue (M4×8)
C: Metalreb

Brug den medfølgende skrue. Brugen af en skrue udover den medfølgende kan reducere effektiviteten af rebets
funktion.

Bemærk!

Det anbefales, at en person holder enheden som vist i det følgende diagram, mens en anden person monterer enheden.

Hold ikke på kamerahovedet eller objektivstøtten under montering af enheden. Der er risiko for beskadigelse eller kvæstelse,
hvis enheden tabes eller falder.

Pas på ved tilslutning af ledninger, at elektriske stik og kabler ikke bliver kortsluttet af faldsikringsrebet.
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Monteringen kan understøtte en ophængt masse på op til 8,8 kg (inklusive objektivet). For at forhindre at enheden falder ned,
må maksimum forventet masse ikke overstiges.

Afstem skruehullet (A) på kropsbeslaget med ◇ hullet (B) på loftsbeslaget, indsæt enheden, og drej den ca. 60
grader med uret, indtil skruehul (A) og skruehul (C) er afstemt.

A: Skruehul på kropsbeslaget
B: Skruehul på loftsbeslag (◇ hul)
C: Skruehul
D: Loft
E: Monteringsplade

8

Fastgør kropsbeslaget og loftsbeslaget vha. de tre medfølgende rotationslåseskruer (M3×8).9
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Montér så objektivet. Se "Montering af et objektiv", og husk informationen i "Forholdsregler ved påsætning/fjernelse af et
objektiv", "Tjekker objektivets kontakter" og "Forholdsregler ved brug af et zoomobjektiv".

Bemærk!

For at betjene panorering/hældning korrekt, når enheden er monteret på et loft, indstilles [Pan-Tilt] > [Direction] > [Ceiling] til [On] i
webmenuen.

Efter montering af et objektiv skal man tjekke, at objektivet er ordentligt fastgjort.
Objektivet har ingen beskyttelses mod fald. Sony hæfter ikke for et objektiv, der falder af enheden.

Relateret emne

Forholdsregler ved påsætning/fjernelse af et objektiv

Tjekker objektivets kontakter

Forholdsregler ved brug af et zoomobjektiv

Tjek monteringsstatus.

Tjek især de følgende genstande.

Monteringsskruer er korrekt monteret.
Faldsikringsreb er korrekt påsat og ikke drejet.
Enheden er monteret jævnt (uden at hælde eller slingre).
Enheden drejer ikke frit rundt, når den drejer.

10
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Montering af et objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forholdsregler ved påsætning/fjernelse af et objektiv

Efterlad ikke objektivet med retning mod solen. Direkte sollys kan trænge ind gennem objektivet, blive fokuseret i enheden og
forårsage brand.

Bemærk!

Monter/fjern objektivet, mens enheden er slukket.

Et objektiv er en præcisionskomponent. Placer ikke objektivet på et underlag med objektivfatningen nedad. Sæt det medfølgende
objektivdæksel på.

Tip!

Kontakt din Sony-servicerepræsentant for at få oplysninger om objektiver, der understøttes af enheden.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tjekker objektivets kontakter

De følgende tjek og indstillinger er påkrævet, afhængigt af objektivtypen.

For et objektiv med en fokuskontakt

Indstil kontakten til AF/MF eller AF.
Hvis kontakten er indstillet til MF eller Full MF, kan fokus kun justeres ved hjælp af objektivringen.

Bemærk!

Når du bruger et A-mount-objektiv, er manuel justering fra en fjernbetjeningsenhed muligvis ikke tilgængelig.

For et objektiv med en zoomkontakt

Indstil kontakten til SERVO.
Hvis kontakten er indstillet til MANUAL, kan zoom kun justeres ved hjælp af zoomringen. Zoomstyring fra enheden har ingen
effekt.

For et objektiv med en Auto Iris-kontakt

Indstil kontakten til AUTO.
Når iris er indstillet til AUTO, kan den kun justeres ved hjælp af objektivringen. Irisbetjening fra enheden har ingen effekt.

For et objektiv med en billedstabiliseringskontakt

Indstil kontakten til OFF.
Hvis kontakten er på ON, kan uventet adfærd opstå under panorerings-/hældningsfunktion.

SELP28135G

A: Flyt fokusringen til fremad-positionen (AF/MF-tilstand).
B: Indstil ZOOM-kontakten i SERVO-positionen.
C: Indstil irisringen til "A" og IRIS LOCK-kontakten til LOCK-positionen.
D: Indstil billedstabilisatorkontakten til OFF.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forholdsregler ved brug af et zoomobjektiv

Ved brug af et andet zoomobjektiv end et power zoomobjektiv kan zoompositionen ændres, afhængigt af monteringsmiljøet.
Fastgør zoomringen i positionen vha. tape i overensstemmelse med brugsformålet.

Filmtape i plastik: 471 BLA 50 eller tilsvarende

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montering af et objektiv

Dette emne beskriver, hvordan man monterer et E-mount-objektiv eller A-mount-objektiv.

Bemærk!

Enheden må ikke transporteres mens objektivet er monteret.

Når du bruger et A-mount-objektiv, indstilles iris manuelt, og fokus indstilles til MF.

Før panorerings-/hældningslåsehåndtaget til LOCK-positionen for at låse kamerahovedets
panorering/hældning.

Bemærk!

Hvis kamerahovedets panorering/hældning ikke låser, når låsehåndtaget er i LOCK-position, flyttes kamerahovedet manuelt,
indtil det låser i position.

1

Drej klemmehåndtaget til objektivets støttepiedestals fastgørelsesskrue i retning mod uret for at løsne låsen,
og flyt så objektivets støttepiedestals fastgørelsesskrue til en position, der ikke forstyrrer objektivet.

A: Korrekt
B: Ukorrekt

2
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Drej kamerahovedets låsehåndtag i retning af pilen for at låse op for kamerahovedet.

Bemærk!

Indtil kamerahovedet er låst igen, er der en risiko for, at kamerahovedet kan bevæge sig under sin egen vægt. Støt
kamerahovedet med din hånd, mens opgaven udføres.

3

Før kamerahovedet til den forreste position.4

Drej kamerahovedets låsehåndtag i retning af pilen for at låse kamerahovedet.5
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Bemærk!

Sørg for, at kamerahovedets låsehåndtag ikke kommer i kontakt med andre dele, for at undgå at forstyrre hældningsfunktionen.

Fjern hætten og dækslet fra enheden og objektivet.6

Afstem objektivets monteringsmærke (hvid) med enheden, sæt omhyggeligt objektivet ind i kamerahovedet, og
drej så objektivet med uret, indtil det klikker ind i den låste position.

A: Monteringsmærker (hvid)

Bemærk!

Hvis du vil bruge et A-mount-objektiv, skal du montere en objektivmonteringsadapter (ekstraudstyr) på enheden og derefter
montere A-mount-objektivet.

7

Drej kamerahovedets låsehåndtag i retning af pilen for at låse op for kamerahovedet.8
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Bemærk!

Indtil kamerahovedet er låst igen, er der en risiko for, at kamerahovedet kan bevæge sig under sin egen vægt. Støt
kamerahovedet med din hånd, mens opgaven udføres.

Oprethold kamerahovedets fremad/bagud-balance, så glidebasen er vandret.

Hvis du bruger et af de følgende objektiver, kan du balancere enheden og objektivet ved at referere til skalaen på
glidebasen.

9

Skalaposition Objektivnavn

0,5 SEL70200GM (med SEL20TC fastgjort)

1,7 SEL70200GM

2,0 SEL70200GM2 (med SEL20TC fastgjort)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G

5,0 eller højere SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G
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Bemærk!

Brug glidebaseskalaen som en reference for balance.

Under montering af objektivet skal man lave passende justeringer af balancen, så enheden ikke vipper frem og tilbage.

Justér balancen på en vandret flade.

Fjern objektivstøtteenheden under brug af SELC1635G.

Drej kamerahovedets låsehåndtag i retning af pilen for at låse kamerahovedet.

Bemærk!

Sørg for, at kamerahovedets låsehåndtag ikke kommer i kontakt med andre dele, for at undgå at forstyrre hældningsfunktionen.
Bekræftelsesmetode: Skub låsen for panorering/hældning til UNLOCK-positionen, drej kamerablokken med hånden, så den
vender opad, og bekræft visuelt, at den ikke er i kontakt med andre dele. Hvis der er kontakt, skal du dreje kamerahovedets
låsehåndtag igen i pilens retning.

10

Drej objektivets støtteklemmes håndtag i retning mod uret for at løsne objektivets støtteenhed.

A: Objektivstøttestangs klemmehåndtag (2 steder)
B: Objektivs støtteenhed

11

Flyt objektivets støtteenhed, så objektivets støttepiedestal afstemmes med objektivets støttepiedestals
fastgørelsesskrue, dernæst drejes skruen med uret for at sikre objektivets støttepiedestal.

12
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Bemærk!

Sørg for, at objektivets støttepiedestal er vinkelret på objektivets støttepiedestals fastgørelsesskrue, og stram.

Drej klemmehåndtaget til objektivets støttepiedestals fastgørelsesskrue med uret for at låse objektivets
støttepiedestals fastgørelsesskrue.

A: Objektivs støttepiedestals fastgørelsesskrue
B: Hul fastgørelsesskrue
C: Klemmehåndtag objektivs støttepiedestals fastgørelsesskrue

Tip!

Hvis et klemmehåndtag er i en position, der gør det svært at dreje, frigøres klemmehåndtaget, og det drejes til en vinkel, der vil
gøre funktionen nemmere. Luk klemmehåndtaget, når det er i den ønskede position.

A: Klemmehåndtag til objektivstøttepiedestals fastgørelsesskrue
B: Klemmehåndtag til objektivstøttestang

13

Drej de to objektivstøtte-klemmehåndtag med uret for at fastgøre objektivets støtteenhed.14

Tjek, at begge håndtag er strammet og ikke løse, objektivet er fastgjort korrekt, og at objektivets kontakter er
indstillet korrekt.

Hvis et håndtag er løst, eller objektivet ikke er fastgjort korrekt, kan objektivet falde og blive beskadiget.
Ved brug af et E-mount-zoom-objektiv skal objektivet også kalibreres separat for nøjagtigt at gendanne
zoompositionerne, der er gemt i kameraet som forindstillede positioner. For yderligere oplysninger se "Kalibrering af

15
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Relateret emne

Kalibrering af et E-mount-objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation

et E-mount-objektiv".
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fjernelse af et objektiv

Fjern et objektiv vha. den omvendte procedure af påsætning af objektivet.

Bemærk!

Hold godt fast i objektivet i hånden for at forhindre objektivet i at falde.

Hvis et andet objektiv ikke skal monteres med det samme, skal du altid sætte hætten til hoveddelen på.

Relateret emne

Montering af et objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation

Tjek, at panoreringen/hældningen er låst.1

Drej klemmehåndtaget til objektivets støttesokkels fastgørelsesskrue i retning mod uret for at løsne låsen.2

Fjern objektivets støttesokkels fastgørelsesskrue på objektivets støttesokkel, og flyt den til en position, der
ikke forstyrrer objektivet.

3

Lås op for kamerahovedet, og før det hen til den forreste position.

For yderligere oplysninger se trin 3 til 5 i "Montering af et objektiv".

4

Tryk på objektivets udløserknap, og hold den nede, og drej objektivet mod uret, mens du holder objektivet.5

Med monteringsmærker (hvide) på kameraet afstemt med objektivet, trækkes objektivet ud mod fronten.6
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Vejledning til hjælp
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Tilslutning af kabler

Dette emne beskriver kabelforbindelser.

5-041-958-93(1) Copyright 2022 Sony Corporation

Forbind de påkrævede kabler til stikkene på bagpanelet.

For at forhindre HDMI-kablet i at blive fjernet, fjernes monteringsskruen til HDMI-kabelholdeplade (M2.6×6 sort) fra
forbindelsesblokken, og det medfølgende HDMI-kabel, der fastholder pladen, påføres vha. monteringsskruen. Fastgør
HDMI-kablet til HDMI-kabelholdeplade vha. en kabelbinder eller et bånd.

A: Monteringsskrue til HDMI-kabelholdeplade (M2.6×6, sort)
B: Kabelbinder eller bånd som fås i handlen
C: HDMI-kabelholdeplade (medfølger)

1
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Tilslutning af enhed til netværksenhed via ledningsforbindelse

Dette emne beskriver tilslutning af enhed til en netværksenhed via en ledningsforbindelse.

5-041-958-93(1) Copyright 2022 Sony Corporation

Slut enheden til netværksenheden (som f.eks. et wifi-adgangspunkt eller en omstillingshub) ved hjælp af et
LAN-kabel af kategori 5e eller højere.

1
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Anvendelse af vekselstrøm

Dette emne beskriver proceduren for at tænde enheden vha. vekselstrøm.

Før panorerings-/hældningslåsehåndtaget til LOCK-positionen for at låse kamerahovedets
panorering/hældning.

1

Tilslut vekselstrømsadapteren (medfølger) til DC IN-stikket på enheden, og tilslut strømkablet (medfølger) til en
vekselstrømskilde.

A: DC IN-stik
B: Netledning
C: Vekselstrømsadapter

2

Fastgør vekselstrømsadapterens ledning vha. ledningsklemmen, hvis du vil forhindre ledningen i at blive
frakoblet.

Lås ledningsklemmen op, før ledningen igennem klemmen som vist nedenfor, og lås den.

3
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Bemærk!

Brug ikke en vekselstrømadapter eller strømledning udover dem, der kommer med enheden. Tilslutning af en anden adapter eller
strømledning kan forårsage brand eller funktionsfejl.

Tilslut og brug ikke en vekselstrømsadapter på steder med begrænset plads, f.eks. mellem en væg og møbler.

Kortslut ikke metaldelene i vekselstrømsadapterens stik. Hvis du gør det, vil det medføre en fejlfunktion.

Tilslut vekselstrømsadapteren til den nærmeste vekselstrømskilde. Hvis der opstår et problem under drift, skal du straks frakoble
strømkablet fra vekselstrømskilden.

A: Ledningsklemme
B: Ledningsklemmelås
C: Ledning vekselstrømsadapter

Tjek, at POWER-lampen foran på enheden skifter fra blinkende grønt til fast grønt, og at opstart er færdig.

Når enheden er startet normalt og tilsluttet netværket, vil NETWORK-lampen lyse grønt.

Når et objektiv bruges, som ikke understøtter panorerings-/hældningsfunktionen, låses
panorerings-/hældningslåsehåndtaget, og de følgende trin springes over. Kontakt din forhandler eller Sony-
servicerepræsentant for at få oplysninger om objektiver, der understøtter panorering/hældning.

4

Før panorerings-/hældningslåsehåndtaget til UNLOCK-positionen for at låse panorering/hældning på
kamerahovedet op.

5

Nulstil panorering/hældning.

For yderligere oplysninger se "Nulstilling af panorering/hældning".

6
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Tag fat om stikket, og træk det lige ud, når vekselstrømsadapteren kobles fra enheden. Hvis der trækkes i kablet, kan det medføre en
fejlfunktion.

Relateret emne

Nulstilling af panorering/hældning

5-041-958-93(1) Copyright 2022 Sony Corporation
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Anvendelse af PoE++ strøm

Når enheden er tilsluttet en PoE++ kompatibel strømleveringsenhed, leveres strømmen til enheden via et almindeligt
netværkskabel.
Denne metode medfører, at strøm leveres til enheden uden behov for strømforsyningsledninger i miljøer, hvor der ikke er
strømstik i nærheden af monteringsstedet.

Før panorerings-/hældningslåsehåndtaget til LOCK-positionen for at låse kamerahovedets
panorering/hældning.

1

Tilslut enheden og en PoE++ kompatibel strømleveringsenhed vha. et almindeligt tilgængeligt netværkskabel.

A: Netværkskabel
B: PoE++ kompatibel strømleveringsenhed

2

Tjek, at POWER-lampen foran på enheden skifter fra blinkende grønt til fast grønt, og at opstart er færdig.

Når enheden er startet normalt og tilsluttet netværket, vil NETWORK-lampen lyse grønt.

Bemærk!

Når strøm leveres af PoE++, udføres indledende godkendelse i løbet af intervallet, indtil opsætning er afsluttet.

3
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Bemærk!

Enheden overholder IEEE802.3bt Type 4 klasse 8. Kontakt din forhandler eller Sony-servicerepræsentant for at få oplysninger om
godkendte kompatible PoE++ strømleveringsenheder.

Enheden overholder blød godkendelse (LLDP), men det er måske nødvendigt at konfigurere netværksenheder (der overholder
IEEE802.3bt).

Tilslut ikke en vekselstrømsadapter under brug af PoE++ strømlevering med blød godkendelse (LLDP) aktiveret.

Hvis en vekselstrømsadapter og PoE++ strømleveringsenhed er tilsluttet på samme tid, leveres strøm igennem
vekselstrømsadapteren.

Ved forsyning af strøm igennem PoE++ benyttes et netværkskabel af kategori 5e eller højere.

Vent 10 sekunder efter at have tændt enheden, når den er strømført via PoE++.

Når du bruger PoE++ strømforsyning, skal du forbinde jordterminalen til jorden.

Ved tilslutning via PoE++ strømlevering skal man ikke føre ledningerne udendørs.

Relateret emne
Nulstilling af panorering/hældning

5-041-958-93(1) Copyright 2022 Sony Corporation

Når et objektiv bruges, som ikke understøtter panorerings-/hældningsfunktionen, låses panorerings-/hældningslåsehåndtaget,
og de følgende trin springes over. Kontakt din forhandler eller Sony-servicerepræsentant for at få oplysninger om objektiver, der
understøtter panorering/hældning.

Før panorerings-/hældningslåsehåndtaget til UNLOCK-positionen for at låse panorering/hældning på
kamerahovedet op.

4

Nulstil panorering/hældning.

For yderligere oplysninger se "Nulstilling af panorering/hældning".

5
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Nulstilling af panorering/hældning

Du kan nulstille panorering/hældning, for eksempel når du placerer objektiverne igen vha. den følgende procedure.

5-041-958-93(1) Copyright 2022 Sony Corporation

Før panorerings-/hældningslåsehåndtaget til UNLOCK-positionen, og tjek at panorering/hældning på
kamerahovedet er låst op.

1

Udfør panorering/hældningsnulstillingsfunktion.

Panorerings-/hældningsnulstilling kan udføres fra den infrarøde fjernbetjening, webapp eller RM-IP500 fjernbetjening
(ekstraudstyr).

Drift vha. den infrarøde fjernbetjening: Tryk på P/T RESET-knappen.
Drift vha. webappen: Tryk på  (nulstilling af panorering/hældning)-knappen på  (Others)-fanen i
kameraets kontrolpanel på live funktionsskærmen.
Funktion vha. RM-IP500: Se brugsanvisningen til RM-IP500.

Bemærk!

Udførsel af panorering/hældning får kamerahovedet og objektivet til at dreje. Tjek, at objektivet ikke er forhindret før udførsel.

Enheden har en funktion, der begrænser panorerings-/hældningsrækkevidden, men denne funktion er deaktiveret, når enheden
er tændt, eller panorerings-/hældningsnulstilling er udført.

Tip!

Når panorerings-/hældningsnulstilling er udført, vender enheden tilbage til positionen før udførsel.

2
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Tilgå webappen fra en webbrowser

Ved at tilslutte enheden til en tablet eller computer kan du betjene og konfigurere enheden fra en webbrowser.

Tjek, om din tablet eller pc understøtter webapp-funktioner.

Bemærk!

Hvis det nødvendige miljø ikke findes eller afhængigt af brugen af tabletten/pc'en, kan videovisning i en webbrowser blive
påvirket negativt.

Webappen til denne enhed bruger JavaScript. Hvis der bruges antivirussoftware på din tablet/pc, vises hjemmesiden måske ikke
korrekt.

1

Punkt Krav

Visning
1080×810 pixel eller højere anbefales
Tablet-skærmstørrelse: 10 tommer eller større
anbefales

Understøttet OS og
webbrowser

Windows
OS Windows 10 eller senere

Webbrowser Google Chrome

Mac

OS macOS 10.15 eller senere

Webbrowser
Google Chrome
Safari

iPad

OS iPadOS 15 eller senere

Webbrowser
Google Chrome
Safari

Android
OS Android 12 eller senere

Webbrowser Google Chrome

Tjek, at enheden, tabletten eller pc'en samt perifere enheder er tændt.2

Tjek, at enheden og tabletten eller pc'en er forbundet via wifi eller lokal LAN-forbindelse.3

Tilslut til enheden fra webbrowseren på din tablet eller pc.

Tilslutning vha. en QR-kode
Scan QR-koden, som er trykt på siden af enhedens mediedæksel, ved hjælp af kameraet på tabletten.

4
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Bemærk!

Hvis HTTP-portnummeret blev ændret fra en værdi på 80, indtastes "http://Enhedens IP-adresse:Portnummer" i adressebjælken.

Ved tilslutning via en QR-kode eller ved at indtaste URL-adressen i adressebjælken i en webbrowser, benyttes en enhed, der
understøtter mDNS*.

Tip!

Du kan efterfølgende tilgå enheden hurtigt ved at bruge bogmærkefunktionen i webbrowseren.

5-041-958-93(1) Copyright 2022 Sony Corporation

Åbn det viste link på tabletten.
Webbrowseren på tabletten lanceres og viser enhedens webapp-skærmbillede.

Tilslutning ved at indtaste en URL-adresse i adressebjælken i en webbrowser
Lancér en webbrowser på tabletten eller computeren, og indtast URL-adressen trykt på mediedækslet på enhedens
side.
Webbrowseren bør vise enhedens webapp-skærmbillede.

Tilslutning ved at indtaste IP-adressen på enheden i adressebjælken i en webbrowser
Lancér en webbrowser på din tablet eller computer, og indtast "http://Enhedens IP-adresse" i adressebjælken.
Webbrowseren bør vise enhedens webapp-skærmbillede.

mDNS: En kommunikationsprotokol der bruges til at bestemme IP-adressen fra et værtsnavn på et lokalt netværk.*
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Start af enheden

Sørg for at konfigurere enheden vha. følgende procedure, når enheden benyttes for første gang.

Tip!

Hvis backup-batteriet bliver helt afladet, vil du skulle konfigurere den indledende opstart igen.

Forbind til enheden fra en tablet eller pc, og lancér webappen.

Når enheden benyttes for første gang, vil du blive bedt om at indtaste et brugernavn og en adgangskode i
webbrowseren. Indtast de følgende indstillinger.

Brugernavn: admin
Adgangskode: (efterlad tom)

Følg instruktionerne på skærmen for at konfigurere den indledende opsætning.

1

Angiv administrator (Administrator) brugernavn og adgangskode, og tryk på [OK]-knappen.

1: Indtast administratorbrugernavnet.
2. Indstil administratoradgangskoden.
3. Indtast den samme adgangskode igen for bekræftelse.

Bemærk!

Følgende tegn kan bruges i brugernavnet og adgangskoden. Adgangskoden skal indeholde mindst ét stort bogstav, ét lille
bogstav og ét tal, og det skal bestå af mellem 8 og 64 tegn.

Alfanumeriske tegn
Symboler (!$%`*+-./<=>?@[]^_{|}~)

2
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Live skærm til optagelse af funktioner kommer frem. Fortsæt for at konfigurere enhedens grundlæggende drift ifølge
funktionstilstanden.

Tip!

I visse tilfælde, såsom når enheden bruges som en tablet som en parring, kan det være lettere at bruge en fast IP-adresse til
enheden.

For at indstille en fast IP-adresse, sluk først for [Network] > [Wired LAN] > [IPv4] > [DHCP] (skyderkontakten i den venstre position) i
webmenuen.

Din webbrowser vil genindlæse, og du vil blive bedt om at indtaste brugernavn og adgangskode.

Indtast det brugernavn og den adgangskode, der blev konfigureret i trin 2.

Skærmen til konfiguration af sprog og ur vises.

3

Angiv følgende elementer, og tryk på knappen [OK].

[Language]
Vælg det sprog, der skal bruges til webappen og kameraskærmvisningen. Ændring af sproget ændrer også sproget i
webappen.
[Date & Time Format]
Vælg visningsformatet til dato og klokkeslæt blandt de følgende muligheder.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
"yyyy" angiver året, "mm" angiver måneden, "dd" angiver dagen, "hh" angiver timen, "mm" angiver minuttet, og "ss"
angiver sekundet.
[12 h/24 h]
Vælg [12 h] (12-timers ur) eller [24 h] (24-timers ur) til visning af klokkeslæt.
[Time Setting]
Vælg metoden til indstilling af dato/klokkeslæt.
[Synchronize with PC]: Synkronisér til computer eller tablets dato/klokkeslæt.
[Manual setting]: Indstil manuelt. Når denne metode vælges, kommer indtastningsfelter til dato og tid frem.
[Time Zone]
Vælg tidszonen.

4
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Opsætningspunkter knyttet til en fast IP-adresse vises. Konfigurer punkterne og tryk derefter på [OK]-knappen på skærmen.

5-041-958-93(1) Copyright 2022 Sony Corporation

105



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfiguration af grundlæggende betjening

Dette emne beskriver, hvordan man konfigurerer enheden til grundlæggende funktioner.

Indstilling af optagelsestilstand

Du kan vælge enhedens optagelsestilstand, så den matcher arbejdsgangen.

Custom-tilstand: Skab billeder fleksibelt under optagelse.
Log-optagelsestilstande: Optager S-Log-indhold.

Flexible ISO-tilstand: Eksponeringsindstillinger indstilles af en ISO-værdijusteringer, der matcher scenen der optages.
Cine EI-tilstand/Cine EI Quick-tilstand: Betjen enheden på samme måde som et filmkamera (der ikke skaber billeder
når der optages) med optaget film der fremkaldes i efterproduktion.

In Cine EI Quick-tilstand, en basisfølsomhed som er egnet til eksponeringsindeksindstillingen vælges automatisk.
Skift optagelsestilstand vha. [Project] > [Base Setting] > [Shooting Mode] i webmenuen eller kameramenuen.

Custom -tilstand
Du kan vælge videostandarden.
Skift vha. [Project] > [Base Setting] > [Target Display] i webmenuen eller kameramenuen.

[SDR(BT.709)]: Optagelse i henhold til HD-udsendelsesstandard
[HDR(HLG)]: Optagelse i henhold til 4K-sendestandard af næste generation

For yderligere oplysninger se "Oversigt over udseende" og andre emner i "Filmning med det ønskede udseende".

Log-optagelsestilstande
(Flexible ISO-tilstand/Cine EI-tilstand/Cine EI Quick-tilstand)
I Log-optagelsestilstande kan du vælge basis farveskala for optagede signaler og outputsignaler. Farveskalaen der vælges
her, er farveskalaen for videooutputtet, når [LUT On/Off] indstillingerne er indstillet til [MLUT Off].
Du kan skifte farveskala vha. [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] i kameramenuen.

[S-Gamut3.Cine/SLog3]: Farveskala der er let at justere til digital biograf (DCI-P3).
[S-Gamut3/SLog3]: Sony-bred farveskala der dækker ITU-R BT.2020- farveskala.

For yderligere oplysninger se "Filmning med justering af udseende i efterproduktion".
 
Understøttede funktioner i hver optagelsestilstand vises i følgende tabel.
●: Understøttet, –: Ikke understøttet

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (forbundet til EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –
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Tip!

I Cine EI Quick og Cine EI-tilstanden forekommer optagelse ved en ISO-basisfølsomhed uden at benytte forstærkning for at
maksimere billedsensorens ydeevne. Lysstyrken justeres vha. lys og ND-filteret til at justere mængden af lys, der når billedsensoren.

Indstiller systemfrekvensen

Skift vha. [Project] > [Rec Format] > [Frequency] i webmenuen eller kameramenuen. Enheden genstarter muligvis automatisk
efter skift, afhængigt af den valgte værdi.

Bemærk!

Du kan ikke skifte systemfrekvensen under optagelse eller afspilning.

Indstilling af billedscanningstilstanden

Du kan indstille den effektive billedstørrelse og -opløsning for billedsensoren.
Skift vha. [Project] > [Rec Format] > [Imager Scan Mode] i webmenuen eller kameramenuen.
[FF]: Fuld billedstørrelse.
[S35]: Super 35mm-størrelse.

Bemærk!

Du kan ikke skifte tilstanden Imager Scan under optagelse eller afspilning.

Når indstillet til S35 er videoformatet begrænset til 1920×1080.

Indstilling af codec

Du kan indstille codec til optagelse.
Skift vha. [Project] > [Rec Format] > [Codec] i webmenuen eller kameramenuen.

Bemærk!

Du kan ikke skifte codec under optagelse eller afspilning.

Indstiller videoformatet

Du kan indstille videoformatet til optagelse og outputformatet til output fra kameraet.

Skift videoformatet til optagelse vha. [Project] > [Rec Format] > [Video Format] i webmenuen eller kameramenuen.
Skift outputformat fra SDI OUT- og HDMI OUT-stik vha. [Monitoring] > [Output Format] i webmenuen eller
kameramenuen.

Bemærk!

Du kan ikke skifte videoformat under optagelse eller afspilning.

Der kan gælde begrænsninger for signalet fra SDI OUT- og HDMI OUT-tilslutninger, afhængigt af videoformatindstillingen.

Custom Flexible ISO Cine EI Cine EI Quick

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(eksklusiv Base Look)

● – – –
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Relateret emne
Oversigt over udseende

Filmning med justering af udseende i efterproduktion

5-041-958-93(1) Copyright 2022 Sony Corporation
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Understøttede hukommelseskort

Enheden optager lyd og video på CFexpress Type A-hukommelseskort (købes separat) eller SDXC-hukommelseskort (købes
separat), der er sat i kortsprækkerne. Hukommelseskort bruges også til proxy-optagelse.

CFexpress Type A-hukommelseskort

Brug Sony CFexpress Type A-hukommelseskort* angivet i "Anbefalede optagelsesmedier" i enheden.
Du kan finde oplysninger om betjening med medier fra andre producenter i brugsanvisningen til mediet eller se producentens
oplysninger.

SDXC-hukommelseskort

Brug SDXC-hukommelseskort* angivet i "Anbefalede optagelsesmedier" i enheden.

Anbefalede optagelsesmedier

De garanterede driftsforhold varierer afhængigt af indstillingerne Rec Format og Recording.

CFexpress Type A
Overholder VPG400
Understøttet til alle enhedens optagelsesformater.

SDXC
Understøttet under betingelserne i den følgende tabel. "●" angiver, at drift er blevet bekræftet, og "–" angiver, at drift ikke er
garanteret.

RAW Out & XAVC-I, 4096×2160 Klasse 300, Normal tilstand

RAW Out & XAVC-I, 3840×2160 Klasse 300, Normal tilstand

Benævnes som "CFexpress-kort" i denne vejledning til hjælp.*

Benævnes som "SD-kort" i denne vejledning til hjælp.*

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 Klasse 300, S&Q (60 fps eller lavere)

RAW Out & XAVC-I, 3840×2160 Klasse 300, S&Q (100 fps, 120 fps)
Bekræftet medie ikke tilgængeligt.

XAVC-I, 4096×2160 Klasse 300, Normal tilstand

XAVC-I, 4096×2160 Klasse 300, S&Q (60 fps eller lavere)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●

23.98P – – – – – – ●
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XAVC-I, 3840×2160 Klasse 300, Normal tilstand

XAVC-I, 3840×2160 Klasse 300, S&Q (60 fps eller lavere)

XAVC-I, 3840×2160 Klasse 300, S&Q (100 fps, 120 fps)
Bekræftet medie ikke tilgængeligt.

XAVC-I, 1920×1080 Klasse 100, Normal tilstand

XAVC-I, 1920×1080 Klasse 100, S&Q (60 fps eller lavere)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●
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XAVC-I, 1920×1080 Klasse 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Klasse 100, S&Q (150 fps, 180 fps)
Bekræftet medie ikke tilgængeligt.

XAVC-I, 1920×1080 Klasse 100, S&Q (200 fps, 240 fps)
Bekræftet medie ikke tilgængeligt.

XAVC-L, 3840×2160 420, Normal tilstand

XAVC-L, 3840×2160 420, S&Q (60 fps eller lavere)

XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●
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XAVC-L, 1920×1080 HD50, Normal tilstand

XAVC-L, 1920×1080 HD50, S&Q (60 fps eller lavere)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

25P – – – – – – ●

23.98P – – – – – – –

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, Normal tilstand

XAVC-L, 1920×1080 HD35, S&Q (60 fps eller lavere)

XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●
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XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-958-93(1) Copyright 2022 Sony Corporation

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Isætning af hukommelseskort

Dette emne beskriver forholdsreglerne ved isætning af hukommelseskort.

Åbn mediedækslet til kortsprækkesektionen.1

Indsæt et hukommelseskort.

For CFexpress-kort vender etiketten opad.

Bemærk!

På en loftsmonteret enhed vender etiketten ned.

For SD-kort vender etiketten nedad.

Bemærk!

På en loftsmonteret enhed vender etiketten opad.

Adgangsindikatoren lyser rødt og skifter derefter til grønt, hvis kortet kan bruges.

Bemærk!

2
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Bemærk!

Hukommelseskortet, hukommelseskortsprækken og billeddata på hukommelseskortet kan blive beskadiget, hvis kortet tvinges ind i
sprækken i den forkerte retning.

Når du optager på medier indsat i både CFexpress Type A/SD, kortsprækker A og B, skal du indsætte medier i begge sprækker, der er
anbefalet til drift med optagelsens format.

5-041-958-93(1) Copyright 2022 Sony Corporation

Hvis adgangsindikatoren blinker kontinuerligt rødt og ikke skifter til grøn, skal der midlertidigt slukkes for enheden, og
hukommelseskortet skal fjernes og sættes i igen.

Luk mediedækslet.3
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Udskubning af et hukommelseskort

Åbn mediedækslet på kortsprækkesektionen, og tryk hukommelseskortet let ind for få kortet skubbet ud.

Bemærk!

Hvis enheden slukkes, eller hukommelseskortet fjernes, mens hukommelseskortet tilgås, kan integriteten af data på kortet ikke
garanteres. Alle data optaget på kortet kan blive kasseret. Sørg altid for, at adgangsindikatoren er grøn eller slukket, før du slukker for
enheden eller fjerner hukommelseskortet.

Når du fjerner et hukommelseskort umiddelbart efter, at optagelsen er færdig, kan hukommelseskortet være varmt, men det indikerer
ikke et problem.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formatering (initialisering) af hukommelseskort

Hvis der indsættes et uformateret hukommelseskort eller et hukommelseskort, der blev formateret med en anden
specifikation, vises meddelelsen "Media Needs to be Formatted" i kameraets billedpanel.
Formater kortet ved hjælp af følgende procedure.

Bemærk!

Formatering af et hukommelseskort sletter alle data, herunder optagede videodata og opsætningsfiler.

Meddelelser kan blive vist under udførelsen, afhængigt af formateringsprocessens varighed.

Hvis formateringen mislykkes
Hukommelseskort, der ikke understøttes af enheden, kan ikke formateres.
Der vises en advarselsmeddelelse. Følg instruktionerne for at udskifte kortet med et understøttet hukommelseskort.

Sådan bruges et kort, der er formateret på enheden, i en anden enheds sprække
Tag først en sikkerhedskopi af kortet, og omformater derefter kortet i den enhed, der skal bruges.

5-041-958-93(1) Copyright 2022 Sony Corporation

Vælg [TC/Media] > [Format Media] i kameramenuen.1

Vælg Media(A) (sprække A) eller Media(B) (sprække B), dernæst vælges formatteringsmetoden (Full Format
eller Quick Format).

Der vises en bekræftelsesmeddelelse.
[Full Format]: Initialiserer mediet helt, herunder dataområdet og dataadministrationsoplysningerne.
[Quick Format]: Initialiserer kun mediets dataadministrationsoplysninger.

2

Vælg [Execute].

Der vises en meddelelse, mens formateringen er i gang, og adgangsindikatoren lyser rødt.
Når formatteringen er afsluttet, vises en meddelelse om fuldførelse.

3
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrol af den resterende optagelsestid

Når du filmer (optagelse/standby), kan du overvåge den resterende kapacitet på hukommelseskortet i hver sprække, der
bruger A/B-sprækkens indikatorer for resterende medier i kameraets billedpanel.
Den resterende optagelsestid beregnes ud fra den resterende kapacitet af mediet i hver sprække og det aktuelle
optagelsesformat (optagelsesbithastighed) og vises i minutenheder.

Timing for udskiftning af hukommelseskort
Når den samlede resterende optagelsestid på de to hukommelseskort bliver mindre end 5 minutter, vises meddelelsen
"Media Near Full", og optagelses-/tallylampen begynder at blinke for at advare dig.
Erstat med medier, der har ledig plads.
Hvis du fortsætter med at optage, indtil den samlede resterende optagelsestid når nul, ændres meddelelsen til "Media Full",
og optagelsen stopper.

Bemærk!

Der kan optages op til ca. 600 klip på ét hukommelseskort.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gendannelse af hukommelseskort

Hvis der af en eller anden grund opstår en fejl på et hukommelseskort, skal kortet gendannes før brug.
Når du indsætter et hukommelseskort, der skal gendannes, vises der en meddelelse i kameraets billedpanel for at spørge,
om du vil gendanne det.

Sådan gendannes et kort
Vælg [Execute] vha. piletasterne i GUI-kontrolpanelet, og tryk på [Set]-knappen.
Der vises en meddelelse og forløbsstatus (%), mens formateringen er i gang, og adgangsindikatoren lyser rødt.
Når gendannelsen er afsluttet, vises en meddelelse om fuldførelse.

Hvis gendannelsen mislykkes
Hukommelseskort, hvor der er opstået hukommelsesfejl, kan ikke gendannes. Der vises en advarselsmeddelelse. Følg
instruktionerne for at udskifte hukommelseskortet.
Hukommelseskort, hvor der er opstået hukommelsesfejl, kan blive brugbare, hvis de omformateres.
I nogle tilfælde kan nogle klip gendannes, mens andre ikke kan. De gendannede klip kan afspilles normalt.

Bemærk!

Hvis du vil genoprette medier, der er optaget med denne enhed, skal du sørge for at bruge denne enhed.

Medier, der er optaget med en anden enhed end denne eller med en anden version (selv af den samme model), gendannes muligvis
ikke ved hjælp af denne enhed.

Klip, der er kortere end 2 sekunder, kan ikke gendannes.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Starter/stopper optagelse

Dette emne beskriver, hvordan man starter/stopper optagelse.

Forbind de nødvendige enheder, og kontroller, at enheden og de perifere enheder får strøm.1

Isæt hukommelseskortet/-kortene.2

Tjek enhedens strømstatus i øverste venstre hjørne i webappens skærm.

Når strømforsyning er tændt
Når enheden er tændt, vises [Power ON] på strømkontakten øverst på webapp-skærmen.

POWER-lampen lyser op foran på enheden, og kamerabilledet kommer frem på betjeningsskærmen i webappen.

Bemærk!

Hvis administratoradgangskoden ikke er blevet indstillet, vil en skærm komme frem med en anmodning om at indstille den. Se
"Start af enheden".

Når strømforsyning er i standby-tilstand
Når enhedens strømforsyning er i standby-tilstand, vises [Power Standby] på strømknappen i webappen.

I denne tilstand skal du trykke på strømkontakten og vælge [Power ON]. Enheden tænder, POWER-lampen lyser grønt
foran på enheden, og kamerabilledet kommer frem på livedriftskærmen i webappen.

Tip!

Du kan også tænde for enheden vha. tænd og sluk-knappen på den medfølgende fjernbetjening.

3

Tryk på knappen til START/STOP af optagelse.4
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For at skifte enhedens strømforsyning til standby
Tryk på kontakten i webappen, og vælg [Power Standby] for at indstille enhedens strømforsyning til standby-tilstand.

Tip!

Du kan også sætte strømforsyningen på standby vha. tænd og sluk-knappen på den medfølgende infrarøde fjernbetjening.

Relateret emne

Start af enheden

5-041-958-93(1) Copyright 2022 Sony Corporation

Optagelse starter, og optagelses-/tally-lampen (2 steder) på enheden lyser.
Under optagelse lyser START/STOP-knappen. Et ikon for motivoptagelsesmediet og [●Rec] vises også.

For at stoppe optagelsen, tryk på knappen START/STOP af optagelse igen.

Optagelse stopper, og optagelses-/tally-lampen (2 steder) på enheden slukker.
Under optagelse af standby-tilstand lyser START/STOP-knappen ikke. Et ikon for motivoptagelsesmediet og [Stby] vises
også.

Tip!

Du kan også starte/stoppe optagelsen vha. START/STOP-knappen på den medfølgende infrarøde fjernbetjening.

5
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Skift mellem hukommelseskort

Når to hukommelseskort er sat i, kan du trykke på [Slot Select]-knappen på afspilningskontrolpanelet i webappen for at skifte
hukommelseskort.

Tip!

Du kan også trykke på knappen SLOT SEL (hukommelseskortsprække (A)/(B) vælg) på den medfølgende infrarøde fjernbetjening for
at skifte hukommelseskort.

Om relæoptagelse

Under optagelse skifter enheden automatisk til det andet hukommelseskort, lige før den resterende kapacitet på det første
kort reduceres til nul (relæoptagelse). Du kan fortsætte med at optage uden afbrydelse, når der skiftes hukommelseskort, ved
at udskifte det fulde hukommelseskort, med et nyt hukommelseskort.

Bemærk!

Du kan ikke skifte mellem hukommelseskort under afspilning. Desuden understøttes kontinuerlig afspilning af et klip, der spænder
over et medie i sprække A og sprække B, ikke.

Om registrerede data

Når du stopper optagelsen, gemmes video-, lyd- og ledsagende data fra start til slut af optagelsen som et enkelt "klip" på et
hukommelseskort.

Registrerede datas klipnavn

Navnet på hvert klip, som er registreret af enheden, er automatisk tildelt vha. [TC/Media] > [Clip Name Format] i
kameramenuen.

Maksimal varighed af klip

Op til 6 timer pr. klip.
Den maksimale varighed for kontinuerlig optagelse er den samme som den maksimale varighed for et klip. Hvis
optagelsestiden overstiger den maksimale varighed for et klip, oprettes der automatisk et nyt klip, og optagelsen fortsætter.
Det nye klip vises som et separat klip på miniatureskærmbilledet.
Der optages flere klip efter hinanden under relæoptagelse, men optagelsen stopper automatisk efter ca. 24 timer.

Bemærk!

Skub ikke et hukommelseskort ud, mens der er en optagelse i gang på det. Når du optager, skal du kun skifte hukommelseskort i
sprækker, hvor indikatoren for adgang til sprækker er slukket.

Når den resterende kapacitet på det hukommelseskort, der optages på, bliver mindre end et minut, og der indsættes et
hukommelseskort, der kan optages på i den anden sprække, vises meddelelsen "Will Switch Slots Soon". Meddelelsen forsvinder, når
du har skiftet hukommelseskortsprække.

Relæoptagelse fungerer muligvis ikke, hvis optagelsen startes, når den resterende kapacitet på hukommelseskortet er mindre end et
minut. For at opnå korrekt relæoptagelse skal du kontrollere, at den resterende kapacitet på hukommelseskortet er mere end et minut,
før du starter optagelsen.

Video lavet vha. enhedens relæoptagelsesfunktion kan ikke afspilles problemfrit på enheden.

Brug softwaren "Catalyst Browse" til at kombinere video, der er oprettet ved hjælp af relæoptagefunktionen på enheden.

124



5-041-958-93(1) Copyright 2022 Sony Corporation

125



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tjekker lyden

Lyden er sendt ud fra SDI- og HDMI-stik på enheden. Vælg kombinationen af lydkanaler, der sendes ud fra HDMI-stikket vha.
[Audio] > [Audio Output] > [HDMI/Stream Output CH] i kameramenuen.
CH1/CH2: CH1 og CH2 kombination
CH3/CH4: CH3 og CH4 kombination
Ved overvågning af lyden i webappen bruges lydniveaumåleren til højre i bunden af kamerabilledet.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Angivelse af tidsdata

Dette emne beskriver, hvordan man indstiller tidsdata.

Indstilling af tidskode

Indstil tidskoden til at optage vha. [TC/Media] > [Timecode] i kameramenuen.

Indstilling af bruger bits

Du kan tilføje et 8-cifret hexadecimalt tal til det optagede billede som bruger-bit. Du kan også indstille bruger-bittene til det
aktuelle klokkeslæt. Indstil vha. [TC/Media] > [Users Bit] i kameramenuen.

Visning af tidsdata

Indstil tidskoden til at optage vha. [TC/Media] > [TC Display] > [Display Select] i kameramenuen.
Ved at trykke på en tildelelig knap med [DURATION/TC/U-BIT] tildelt skiftes visningen mellem tidskoden, brugerbit og
varighed fortløbende.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gennemsyn af optagelse (Rec Review)

Du kan gennemse det sidst optagede klip på skærmen (optagelsesgennemsyn).

Bemærk!

Optagelsesgennemsyn understøttes ikke, hvis videoformatet ændres efter optagelse af et klip.

Indstilling af Rec Review-startpositionen

Du kan indstille afspilningens startposition til en af følgende vha. [Technical] > [Rec Review] i kameramenuen.

Sidste 3 sekunder af klippet
Sidste 10 sekunder af klippet
Begyndelsen af klippet

Tip!

Hvis du vil gennemse et bestemt klip, efter du har optaget flere klip, skal du trykke på knappen [Thumbnail] for at få vist
miniaturebilledskærmen og vælge klippet for at starte afspilningen.

Du kan også trykke på THUMBNAIL-knappen på den medfølgende infrarøde fjernbetjening for at vise miniatureskærmen.

Rec Review-metode

Tildel Rec Review-funktionen til en af de tildelelige knapper på det grundlæggende konfigurationsjusteringspanel på forhånd.

For yderligere oplysninger om tildeling se "Tildelelige knapper" i "Nyttige funktioner".

Stop optagelsen, og tryk så på en tildelelig knap, som er tildelt med Rec Review-funktionen for at starte afspilningen af det
tidligere optagede klip.
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Klippet afspilles til det er færdigt, Rec Review slutter, og enheden vender tilbage til Stby-tilstand (standby).

For at stoppe optagelsesgennemsynet
Tryk på den tildelelige knap med Rec Review tildelt, eller tryk på knappen [Cancel/Back].
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Tip!

Du kan også trykke på knappen [Cancel/Back] på den medfølgende infrarøde fjernbetjening for at stoppe Rec Review-funktionen.

Relateret emne

Tildelelige knapper
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Indramningsjusteringsskærm

Indramning justeres vha. de følgende dele af den live driftsskærm.

Bemærk!

Afhængigt af kameraets retning kan objektivets brændvidde, zoompositionen og dele af enheden eller kablerne forbundet med
styreblokken være synlige. Før optagelse skal man tjekke synsfeltet for den brændvidde, som du bruger. Du kan også kontrollere
panorerings-/hældningsintervallet vha. [Pan-Tilt] > [P/T Range Limit] i webmenuen. Når enheden er tændt, eller
panorerings-/hældningsnulstilling er udført, ignoreres denne grænseindstilling for intervallet. For yderligere oplysninger se [Pan-Tilt] >
[P/T Range Limit] i webmenuen.

Tip!

Du kan også styre indramningen vha. den medfølgende infrarøde fjernbetjening.
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Forindstil positionskontrolpanel1.

 (Main)-fane /  (Others)-fane2.

Indramningskontrolpanel3.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justering af optagelsesretning vha. webappen

Vandret flytning af kameraet kaldes panorering (pan), og lodret flytning kaldes vipning (tilt).
Du kan justere optagelsesretningen vha. panorerings-/hældningsfunktionen.

Tip!

Hvis [Execute Pan-Tilt Reset] vises under joysticket, er der opstået en manglende sammenhæng i enhedens
panorerings-/hældningsoprindelsesinformation. Udfør panorerings-/hældningsnulstillingsfunktionen for at opdatere
oprindelsesinformationen. For yderligere oplysninger se "Nulstilling af panorering/hældning".

At vende kameraets bagside foran
Tryk på  (panorerings/hældnings startposition) på fanen  (Others) i kameraets kontrolpanel.

Bemærk!

Afhængigt af kameraets retning kan objektivets brændvidde, zoompositionen og dele af enheden eller kablerne forbundet med
styreblokken være synlige. Før optagelse skal man tjekke synsfeltet for den brændvidde, som du bruger. Du kan også kontrollere
panorerings-/hældningsintervallet vha. [Pan-Tilt] > [P/T Range Limit] i webmenuen. Når enheden er tændt, eller
panorerings-/hældningsnulstilling er udført, ignoreres denne grænseindstilling for intervallet. For yderligere oplysninger se [Pan-Tilt] >
[P/T Range Limit] i webmenuen.

Relateret emne
Nulstilling af panorering/hældning
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Tryk på  (panorering/hældning/zoom) i indramningskontrolpanelet for at vise joysticket.1

Træk midten af joysticket i den retning, du ønsker at se, mens kameraets billedpanel overvåges.

Kameraets retning og hastighed ændres som respons på trækkeretningen og niveauet.
Du kan justere panorering/hældning mere præcist ved at trykke på joystickets perifere områder.

2
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Indstilling af panorerings-/hældningsdriftshastighed

Du kan ændre panorerings-/hældningsdriftshastigheden vha. [Pan-Tilt Speed]-skyderen i kameraets kontrolpanel ved at
betjene joysticket i indramningskontrolpanelet.

Bemærk!

Hvis der er en væg eller en anden forhindring inden for kameraets bevægelsesområde, skal du passe på ikke at ramme kameraet eller
objektivet under panorerings-/hældningsfunktionen.

Panorerings-/hældningsaccelerationen afhænger af fysiske egenskaber, såsom objektivets vægtbalance. Du kan ændre
accelerationsindstillingen vha. [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i webmenuen eller kameramenuen.
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Tryk på fanen  (Main) i kameraets kontrolpanel.1

Vælg [Pan-Tilt Speed]-skyderen fra listen.

Hvis [Pan-Tilt Speed]-skyderen ikke vises, vælges en af de to skyderfunktionsknapper til at vise skyderen.

2

Flyt skydergrebet til venstre eller højre.

Flytning af grebet til venstre får hastigheden til at aftage, mens flytning af grebet til højre øger driftshastigheden.

3

133



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Indstilling af panorerings-/hældningsdriftsacceleration

Du kan indstille accelerationen i ni trin vha. [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i webmenuen eller kameramenuen.
Øg værdien for hurtigere ændringer af hastigheden, eller reducér værdien for mere gradvise ændringer af hastigheden.
For større lydhørhed ved betjening af panorering/hældning vælges en værdi mellem 7 og 9.
For større positionsmæssig nøjagtighed i starten/slutningen af bevægelsen til en forindstillet position anbefales en værdi
mellem 1 og 6.

For yderligere oplysninger om forindstillet position se "Lagring/Gendannelse af panorerings-/hældnings- og
zoomposition".

Bemærk!

Når værdien er sat højt, virker funktionen måske ikke ordentligt, hvis et tungt objektiv er monteret. Tjek funktionen før ibrugtagning.

Forholdet mellem [Ramp Curve]-indstilling og panorerings-/hældningsfunktion

Når panorering/hældning betjenes

Når en forindstillet position genkaldes
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justering af optagelsesretning vha. den medfølgende infrarøde fjernbetjening

Du kan justere optagelsesretningen vha. panorerings-/hældningsfunktionsknapperne på den medfølgende infrarøde
fjernbetjening.

At vende kameraets bagside foran
Tryk på HOME-knappen.

Bemærk!

Afhængigt af kameraets retning kan objektivets brændvidde, zoompositionen og dele af enheden eller kablerne forbundet med
styreblokken være synlige. Før optagelse skal man tjekke synsfeltet for den brændvidde, som du bruger. Du kan også kontrollere
panorerings-/hældningsintervallet vha. [Pan-Tilt] > [P/T Range Limit] i webmenuen. Når enheden er tændt, eller
panorerings-/hældningsnulstilling er udført, ignoreres denne grænseindstilling for intervallet. For yderligere oplysninger se [Pan-Tilt] >
[P/T Range Limit] i webmenuen.
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Tryk på piletasterne for at styre panorering/hældning.

Tryk på piletasten for den retning, du ønsker at se, mens kamerabilledet overvåges.
Tryk kortvarigt på piletasten for at flytte en kort afstand.
Tryk og hold piletasten nede for at flytte en stor afstand.
For at flytte diagonalt tryk og hold  (pil op) eller  (pil ned)-knappen, og tryk på  (venstre pil) eller  (højre pil)-
knappen.

1
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Indstilling af zoomtype

Indstil zoomtypen vha. [Technical] > [Zoom] > [Zoom Type] i kameramenuen.
Zoomtypen varierer afhængigt af den type objektiv, der er monteret.

Bemærk!

Clear Image Zoom er ikke tilgængelig i følgende tilfælde.

Når [Shooting] > [S&Q Motion] > [Setting] er indstillet til On og [Frame Rate]-indstillingen i kameramenuen er højere end 60 fps
Når [Project] > [Rec Format] > [Codec] i kameramenuen er indstillet til [RAW] eller en indstilling, der inkluderer RAW

Betjening af valgkontakten SERVO/MANUAL på et objektiv nulstiller forstørrelsen af Clear Image Zoom til 1×.

AF-S understøttes ikke under Clear Image Zoom.

Clear Image Zoom

Enheden er udstyret med en zoomfunktion, der anvender billedsignalbehandling kaldet Clear Image Zoom. Når Clear Image
Zoom er aktiveret, understøttes zoom selv for objektiver med fast fokus. Det kan også bruges til at udvide området ud over
det optiske område på et power zoom-objektiv.
Det maksimale zoomforhold ved hjælp af Clear Image Zoom varierer afhængigt af optagelsesopløsningen.

For QFHD/4K-optagelsesopløsning: 1,5×
For HD-optagelsesopløsning: 2×
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Type påsat objektiv
[Zoom Type]-indstilling

[Optical Zoom Only] [On(Clear Image Zoom)]

Fast fokus-objektiv/Manuelt
zoomobjektiv

Zoomfunktion understøttes
ikke.

Clear Image Zoom understøttes.

Power-zoom-objektiv Optisk zoom understøttes kun.
Optisk zoom og Clear Image Zoom
understøttes.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justering af Zoom vha. webappen

Du kan justere enhedens zoom vha. optisk zoom eller Clear Image Zoom. Dette emne beskriver, hvordan man foretager
justeringer vha. webappen. For yderligere oplysninger om Clear Image Zoom, se "Indstilling af zoomtype".

Bemærk!

Afhængigt af kameraets retning kan objektivets brændvidde, zoompositionen og dele af enheden eller kablerne forbundet med
styreblokken være synlige. Før optagelse skal man tjekke synsfeltet for den brændvidde, som du bruger. Du kan også kontrollere
panorerings-/hældningsintervallet vha. [Pan-Tilt] > [P/T Range Limit] i webmenuen. Når enheden er tændt, eller
panorerings-/hældningsnulstilling er udført, ignoreres denne grænseindstilling for intervallet. For yderligere oplysninger se [Pan-Tilt] >
[P/T Range Limit] i webmenuen.

Den faktiske zoomhastighed og -nøjagtighed vil variere alt efter objektivet. Tjek funktionen før ibrugtagning.

Tip!

Du kan styre zoom for et manuelt zoom-objektiv ved hjælp af en objektiv styreenhed (valgfri), der er kompatibel med denne enhed. For
yderlige oplysninger, se "Tilslutning af en objektiv styreenhed" og "Justering af Zoom vha. en objektiv styreenhed".

Relateret emne

Indstilling af zoomtype

Tilslutning af en objektiv styreenhed

Justering af Zoom vha. en objektiv styreenhed
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Tryk på  (panorering/hældning/zoom)-fanen i indramningskontrolpanelet for at vise
panorerings-/hældningskontrolpanelet.

1

Før [Zoom]-skydergrebet i [T] (Telefoto)-retningen eller [W] (Wide)-retningen for at justere zoom.

Zoomhastigheden varierer efter skyderens bevægelser.

2
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Indstilling af zoom-driftshastighed

Du kan ændre zoomhastigheden af [Zoom]-skyderen i indramningskontrolpanelet vha. [Zoom Speed]-skyderen i kameraets
kontrolpanel.

Bemærk!

Den faktiske zoomhastighed og -nøjagtighed vil variere alt efter objektivet. Tjek funktionen før ibrugtagning.
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Tryk på fanen  (Main) i kameraets kontrolpanel.1

Vælg [Zoom Speed]-skyderen fra listen.

Hvis [Zoom Speed]-skyderen ikke vises, vælges en af de to skyderfunktionsknapper til at vise skyderen.

 

2

Flyt [Zoom Speed]-skydergrebet til venstre eller højre.

Flytning af grebet til venstre får hastigheden til at aftage, mens flytning af grebet til højre øger driftshastigheden.

3
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justering af zoom vha. den medfølgende infrarøde fjernbetjening

Du kan justere enhedens zoom vha. optisk zoom eller Clear Image Zoom. Dette emne beskriver, hvordan man foretager
justeringer vha. den medfølgende infrarøde fjernbetjening. For yderligere oplysninger om Clear Image Zoom, se "Indstilling af
zoomtype".

Bemærk!

Afhængigt af kameraets retning kan objektivets brændvidde, zoompositionen og dele af enheden eller kablerne forbundet med
styreblokken være synlige. Før optagelse skal man tjekke synsfeltet for den brændvidde, som du bruger. Du kan også kontrollere
panorerings-/hældningsintervallet vha. [Pan-Tilt] > [P/T Range Limit] i webmenuen. Når enheden er tændt, eller
panorerings-/hældningsnulstilling er udført, ignoreres denne grænseindstilling for intervallet. For yderligere oplysninger se [Pan-Tilt] >
[P/T Range Limit] i webmenuen.

Tip!

Du kan styre zoom for et manuelt zoom-objektiv ved hjælp af en objektiv styreenhed (valgfri), der er kompatibel med denne enhed. For
yderlige oplysninger, se "Tilslutning af en objektiv styreenhed" og "Justering af Zoom vha. en objektiv styreenhed".

Relateret emne
Indstilling af zoomtype

Tilslutning af en objektiv styreenhed

Justering af Zoom vha. en objektiv styreenhed
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Tryk på zoomknappen for at justere zoom.

Tryk på T (telephoto) eller W (wide)-knappen under overvågning af skærmen for at justere zoom.
For at zoome ind tryk på T-knappen.
For at zoome ud tryk på W-knappen.

1
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kalibrering af et E-mount-objektiv

Kalibrering korrigerer for forskelle i zoompositionen pga. forskelle i individuelle objektiver ved brug af et E-mount-
zoomobjektiv.
For at beregne zoompositionen nøjagtigt skal du kalibrere dit objektiv til at korrigere for individuelle forskelle i objektivet vha.
den følgende procedure.

Kalibreringsdata
Kalibreringsdata til op mod fem objektiver kan gemmes i enheden. De ældste data vil blive overskrevet, når et 6. eller
efterfølgende objektiv kalibreres.
Du kan tjekke, om kalibreringsdata er tilgængelige for det monterede objektiv ved at trykke på  (Kamerastatus)-
knappen i det fælles område i webapp-skærmen og vælge [Lens] > [Calibration Data].
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Hvis objektivet har en SERVO/MANUAL-kontakt skal du indstille det i SERVO-positionen.

Bemærk!

Objektivet vil ikke kunne modtage zoominstruktioner fra enheden, hvis kontakten er sat på MANUAL.

1

Kør kalibreringen vha. [Technical] > [Lens] > [Lens Calibration] i kameramenuen.

Under kalibrering flyttes zoomobjektivet automatisk og måles.

2
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Vejledning til hjælp

Interchangeable Lens Digital Camera
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Lagring/Gendannelse af panorering/hældning, zoomposition og fokusindstilling vha.
webappen

Du kan gemme panorering/hældning, zoomposition og fokusindstilling og genkalde dem efter behov vha. webappen
(forudindstillet positioneringsfunktion).

For yderligere oplysninger om de emner, der kan gemmes/gendannes se "Forudindstillet positions gemte punkter".

Bemærk!

En forudindstillet position kan ikke gemmes, hvis Clear Image Zoom-forholdet overstiger 1×.

Hvis [Pan-Tilt] > [P/T Direction] > [Ceiling]-indstillingen i webmenuen er ændret, slettes alle de gemte forudindstillede positioner.

Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Bestem positionen, som du vil gemme vha. panorerings-/hældnings- og zoom-funktionerne.2

Tryk på [+]-knappen i det forudindstillede positionskontrolpanel.

Billedet med den gemte position vises i det forindstillede positionskontrolpanel.

Tip!

Hvis den forindstillede positionskontrolpanel ikke vises, skal du trykke på  (Åbn)-knappen for at vise den.

Positioner gemmes i rækkefølge fra [Preset1].

Hvis der er ubrugte forindstillinger indenfor en sekvens af forindstillinger, vil position blive gemt i forindstillinger, med start fra de
ubrugte forindstillinger. For eksempel hvis positionsforudindstillinger er gemt i [Preset1] og [Preset3] men ikke i [Preset2], vil de
næste positionsforudindstillinger blive gemt i [Preset2] og dernæst i [Preset4].

Op til 100 positionsforudindstillinger kan gemmes.

3
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Sådan annulleres gendannelse af forudindstillet position
Tryk på  (annuller gendannelse)-knappen vist på forudindstillingskontrolpanelet under gendannelse af forudindstillet
position, for at annullere gendannelsen. Brug joysticket og [Zoom]-skyderen til at justere indramningen:

Du kan omdøbe hver positionsforudindstilling. For yderligere oplysninger se "Omdøbning af forudindstillinger af position vha.
webappen".

Gendan en gemt position.

Dobbelttryk på positionens miniaturebillede, som du ønsker at gendanne i den forindstillede positionskontrolpanel for at
gendanne den tilsvarende position.

Tip!

Du kan også gendanne en position ved at trykke på billedet, trykke på  (positionsforudindstillingsmenu)-knappen, der kommer
frem, og vælge [Recall].

Overførselshastigheden af en gemt position bestemmes af [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for Common]-
indstillingen i webmenuen, når positionen blev gemt. Du kan også ændre transitionshastigheden efter at have gemt. For
oplysninger, se "Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en forudindstillingsposition
genoprettes".

Ændringsgraden i panorerings-/hældningspositionen ved bevægelse til en forindstillet position kan justeres vha.
overførselshastigheden og [Ramp Curve]-indstillingerne. For yderligere oplysninger se "Ændring af overførselshastigheden
(panorering-hældning/zoom/fokus), når en forudindstillingsposition genoprettes" og "Indstilling af
panorerings-/hældningsdriftsacceleration".

Hvis en anden forudindstilling genkaldes under en forudindstillet afspilning, stopper afspilningen af de første genkaldte
forudindstillinger og drift af de efterfølgende genkaldte forudindstillinger starter.

Bemærk!

Hvis temperaturen i miljøet har ændret sig betydeligt mellem lagring af den forudindstillede position og dens afspilning, kan der
opstå afvigelse i indramningen.

Når en forudindstillet position gendannes, kan du ikke udføre nogen andre handlinger end gendannelse eller annullering af den
forudindstillede position.

4
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Relateret emne
Forudindstillet positions gemte punkter

Omdøbning af forudindstillinger af position vha. webappen

Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en forudindstillingsposition genoprettes

Indstilling af panorerings-/hældningsdriftsacceleration
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Omdøbning af forudindstillinger af position vha. webappen

Du kan omdøbe gemte positionsforudindstillinger.
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Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Tryk på den forudindstillingsposition, som du ønsker at omdøbe.

Knappen  (forudindstillingspositionsmenu) ses øverst til højre på billedet.

2

Tryk på knappen  (forudindstillingspositionsmenu), og vælg [Rename] fra den viste menu.3

Indtast et nyt forindstillet navn.4
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Udskiftning af en gemt forudindstillet position med en ny position vha. webappen

Du kan udskifte en gemt forudindstillet position med en ny position.
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Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Bestem positionen, som du vil gemme vha. panorerings-/hældnings- og zoom-funktionerne.2

Tryk på det positionsbillede, som du vil udskifte i det forindstillede positionskontrolpanel.

Knappen  (forudindstillingspositionsmenu) ses øverst til højre på billedet.

3

Tryk på knappen  (forudindstillingspositionsmenu), og vælg [Replace] fra den viste menu.

Den nye position erstatter den nuværende indstilling.

4
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sletning af en gemt forudindstillet position vha. webappen

Du kan slette gemte positionsforudindstillinger.
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Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Tryk på det positionsbillede, som du vil slette i det forindstillede positionskontrolpanel.

Knappen  (forudindstillingspositionsmenu) ses øverst til højre på billedet.

2

Tryk på knappen  (forudindstillingspositionsmenu), og vælg [Delete] fra den viste menu.

Den gemte position er slettet.

3
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Interchangeable Lens Digital Camera
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Synkronisere panorerings-/hældnings- og zoom-/fokusfunktion, når en forudindstillet
position gendannes

Du kan synkronisere panorerings-/hældningsfunktion og zoomfunktion, når der gendannes en gemt forudindstillet position for
glattere indramning.

Tip!

Du kan angive indstillinger brugt til registrering af en forudindstillet position på forhånd. Indstil [Pan-Tilt] > [P/T Preset] > [Default] >
[Zoom Sync] til [On] i webmenuen.

Når [Pan-Tilt] > [P/T Preset] > [Speed Select] er indstillet til [Common], vil alle forudindstillede positioner blive gendannet ved den
hastighed vha [Pan-Tilt] > [P/T Preset] > [Common Speed].

Efter zoom-bevægelsen er udført, flytter kameraet til den gemte fokusposition.

Efter bevægelsen er udført, vender [AF Transition Speed] tilbage til dens oprindelige indstilling.

Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Tryk på billedet for den forudindstillede position, for hvilken du vil ændre overførselshastigheden.

Knappen  (forudindstillingspositionsmenu) ses øverst til højre på billedet.

2

Tryk på knappen  (forudindstillingspositionsmenu), og vælg [Edit…] fra den viste menu.

Opsætningsskærmen for den valgte forudindstillingsposition vises.

3

Før [Zoom Sync]-kontakten til højre for at aktivere funktionen og tryk på [OK]-knappen.

Den næste gang en gemt position er gendannet, vil kameraet bevæge sig ved den konfigurerede hastighed.

4
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en
forudindstillingsposition genoprettes

Du kan ændre overførselshastigheden (panorering/hældning, zoom, fokus), når en gemt forudindstillingsposition gendannes.

Tip!

Når [Pan-Tilt] > [P/T Preset] > [Speed Select] er indstillet til [Common], vil alle positioner blive gendannet ved den indstillede hastighed
vha. [Pan-Tilt] > [P/T Preset] > [Common Speed].

Efter zoom-bevægelsen er udført, flytter kameraet til den gemte fokusposition.

Efter bevægelsen er udført, vender [AF Transition Speed] tilbage til dens oprindelige indstilling.

Indstil [Pan-Tilt] > [P/T Preset] > [Speed Select] til [Separate] i webmenuen.1

Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position.2

Tryk på billedet for den forudindstillede position, for hvilken du vil ændre overførselshastigheden.

Knappen  (forudindstillingspositionsmenu) ses øverst til højre på billedet.

3

Tryk på knappen  (forudindstillingspositionsmenu), og vælg [Edit…] fra den viste menu.

Opsætningsskærmen for den valgte forudindstillingsposition vises.

4

Indstil overførselshastighederne (panorering-hældning/zoom/fokus) du ønsker at ændre vha. skyderne eller ved
at indtaste værdierne direkte og trykke på [OK]-knappen.

Den næste gang en gemt position er gendannet, vil kameraet bevæge sig ved den konfigurerede hastighed.

5
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Interchangeable Lens Digital Camera
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Gemmer/Gendanner panorering/hældning og zoomposition vha. den medfølgende
infrarøde fjernbetjening

Du kan gemme panorering/hældning og zoompositionen og genkalde dem, når det er nødvendigt, vha. den medfølgende
infrarøde fjernbetjening.

Relateret emne

Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en forudindstillingsposition genoprettes

5-041-958-93(1) Copyright 2022 Sony Corporation

Justér panorering/hældning og kameraets zoom.1

Indstil PTZ-assistancetilstanden til [Pos.] i rullelisten i toppen af kontrolpanelet for forudindstillet position i
webappen.

2

Tryk og hold PRESET-knappen nede, og tryk på en af de 1 til 3 knapper.

Positionen er gemt.

3

Gendan en gemt position.

Tryk på en af knapperne fra 1 til 3 for at gendanne den forudindstillede position.

Tip!

Overførselshastigheden under gendannelse af den forudindstillede position bestemmes af den gemte [Pan-Tilt] > [P/T Preset] >
[Pan-Tilt Speed] værdi i webmenuen. Du kan ændre overførselshastigheden efter at have gemt en værdi. For oplysninger, se
"Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en forudindstillingsposition genoprettes".

4
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Optage kamera indramningsfunktioner ved hjælp af webappen

Du kan optage kamera indramningsfunktioner ved hjælp af webappen.

Juster kameraets startposition under funktionen.1

Indstil PTZ-assistancetilstanden til [Trace] i rullelisten i toppen af kontrolpanelet for forudindstillet position.2

Tryk på [+]-knappen i det forudindstillede positionskontrolpanel.

Der tilføjes en miniatureskærm og kameraet skifter til optagelse i standby-tilstand.

Tip!

Du kan trykke på  (luk)-knappen på miniatureskærmen for at forlade optagelses standby-tilstand og vende tilbage til normal
drift.

3
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Tip!

Den resterende optagelsestid vises øverst på kamerabilledpanelet under optagelse.

Bemærk!

De optagede indramningsfunktioner vil blive slettet, hvis du skifter til loftsmontering

Ændring af systemfrekvensen kan slette optagede indramningsfunktioner.

Zoomfunktion optages ikke, når en objektiv styreenhed ikke er tilsluttet.

Den maksimale varighed for optagelse af en enkelt indramningsfunktion er 3 minutter. Optagelsen stopper automatisk, når
optagelsens varighed når 3 minutter.

Optagelse af en indramningsfunktion må ikke startes, hvis Clear Image Zoom hastigheden er større end 1×.

Hvis kameraet styres fra en anden enhed under optagelse af en indramningsfunktion, optages funktionerne fra den anden enhed
også. For oplysninger om optagelsesfunktioner, der anvendes en tredjeparts ekstern styreenhed, skal du kontakte den pågældende
producent.

Fokus og billedkvalitetsindstillinger optages ikke af denne funktion.

Panorerings-/hældningsfunktioner optaget under optagelse af en indramningsfunktion kan ikke afspilles nøjagtigt under afspilning af
indramning.

Hvis du indstiller panorerings-/hældningsintervalgrænsen, efter optagelse af en indramningsfunktion, ved hjælp af [Pan-Tilt] > [P/T
Range Limit] i webmenuen, vil panorerings-/hældningsintervalgrænsen ikke blive anvendt under afspilning af indramning. Hvis du
ønsker at bruge en indramningsfunktion og panorerings-/hældningsgrænsefunktionen sammen, skal
panorerings-/hældningshastighedsgrænsen indstilles før der optages en indramningsfunktion.

Start indramningsfunktion ved hjælp af joysticket og [Zoom]-skyderen.

Optagelse starter fra det øjeblik indramningsfunktionen starter.

4

Tryk på  (Stop optagelse)-knappen på miniaturebilledskærmen for at stoppe optagelse.5
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Optagede indramningsfunktioner kan ikke afspilles, når RAW-videooutput er valgt.

Optagede indramningsfunktioner kan ikke afspilles, når videosignalet ikke udsendes fra SDI-output-tilslutningen.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Afspilning af kamera indramningsfunktioner ved hjælp af webappen

Du kan afspille en optaget kamera indramningsfunktion ved hjælp af webappen.

Indstil PTZ-assistancetilstanden til [Trace] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Vælg en miniatureskærm med indramningsfunktionen du ønsker at afspille.

 (Forberedelse)-knappen vises på miniatureskærmen.

2

Tryk på  (Forberedelse)-knappen.

Kameraet flytter til indramningsfunktionens startposition og skifter til afspilning i standby-tilstand.

3

Tryk på  (Afspil)-knappen på miniatureskærmen.

Afspilning af indramning starter.

4
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Tip!

Ved afspilning i standby-tilstand og under afspilning, kan du annullere afspilning og vende tilbage til normal drift ved at udføre en af
følgende handlinger.

Tryk på  (Stop)-knappen i det forudindstillede positionskontrolpanel.
Betjen joysticket.
Betjen [Zoom]-skyderen.

Den forløbne afspilningstid vises øverst på kamerabilledpanelet under afspilning.

Bemærk!

Der kan forekomme uventet adfærd, hvis Clear Image Zoom-indstillingen varierer mellem optagelse og afspilning af
indramningsfunktioner.

Zoomfunktionafspilning understøttes ikke, når en objektiv styreenhed er tilsluttet. Betjening af zoom vil stoppe afspilning af
indramningsfunktioner.

Under afspilning af indramningsfunktion har ændring af panorerings-/hældningsgrænsehastighed vha. [Pan-Tilt] > [P/T Range Limit] i
webmenuen ingen effekt. Indstil panorerings-/hældningsgrænsehastighed før optagelse af en indramningsfunktion.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sletning af optagede kamera indramningsfunktioner ved hjælp af webappen

Du kan slette optagede kamera indramningsfunktioner ved hjælp af webappen.
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Indstil PTZ-assistancetilstanden til [Trace] i rullelisten i toppen af kontrolpanelet for forudindstillet position.1

Vælg en miniatureskærm med indramningsfunktionen du ønsker at slette.

 (Trace menu)-knappen vises på miniatureskærmen.

2

Tryk på  (Trace menu)-knappen.

Menuen vises.

3

Vælg [Delete] fra den viste menu.

Den valgte indramningsfunktion slettes.

4
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Interchangeable Lens Digital Camera
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Optagelse af kamera indramningsfunktioner vha. den medfølgende infrarøde
fjernbetjening

Du kan styre kamera indramningsfunktioner vha. den medfølgende infrarøde fjernbetjening.

For oplysninger om afspilning af en optaget indramningsfunktion, se "Afspilning af kamera indramningsfunktioner vha. den
medfølgende infrarøde fjernbetjening".

Bemærk!

Den maksimale varighed for optagelse af en enkelt indramningsfunktion er 3 minutter. Optagelsen stopper automatisk, når
optagelsens varighed når 3 minutter.

Hvis kameraet styres fra en anden enhed under optagelse af en indramningsfunktion, optages funktionen fra den anden enhed også
som en del af indramningsfunktionen.

Hvis billedkvaliteten justeres under optagelse af en indramningsfunktion, optages denne ændring ikke.

Relateret emne

Afspilning af kamera indramningsfunktioner vha. den medfølgende infrarøde fjernbetjening
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Tilgå skærm til live betjening i webappen.1

Indstil PTZ-assistancetilstanden til [Trace] i rullelisten i toppen af kontrolpanelet for forudindstillet position.2

Juster kameraets startposition under funktionen, vha. den infrarøde fjernbetjening.3

Tryk og hold PRESET-knappen nede, og tryk på en af knapperne for POSITION1 til 3.

Kameraet skifter til optagelse i standby-tilstand.

4

Udfør den indramningsfunktion du ønsker at optage.5

For at afslutte optagelse, tryk og hold PRESET (forudindstilling)-knappen nede og tryk på POSITION-knappen
valgt i trin 4.

6
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Afspilning af kamera indramningsfunktioner vha. den medfølgende infrarøde
fjernbetjening

Du kan afspille en optaget kamera indramningsfunktion vha. den medfølgende infrarøde fjernbetjening.

Bemærk!

Betjening af panorering/hældning/zoom på kameraet vil stoppe afspilning.

Relateret emne

Optagelse af kamera indramningsfunktioner vha. den medfølgende infrarøde fjernbetjening
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Tilgå skærm til live betjening i webappen.1

Indstil PTZ-assistancetilstanden til [Trace] i rullelisten i toppen af kontrolpanelet for forudindstillet position.2

Vælg og tryk på en af knapperne for POSITION1 til 3 for hvilke indramningsfunktionen blev optaget.

Panorering/hældning/zoom for kameraet flytter til afspilningens startposition.

3

Efter kameraet flytter til afspilningens startposition, tryk på den samme POSITION-knap igen.

Afspilning starter.

4
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Vejledning til hjælp

Interchangeable Lens Digital Camera
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Skærm til fokusjustering

Fokus justeres vha. de følgende dele af den live driftsskærm.
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Kameraets billedpanel
Du kan justere fokus ved at røre ved kamerabilledet. Du kan deaktivere berøringsfunktionen i webappen ved at slukke for
[Touch Focus]-kontakten på  (Focus)-fanen i kameraets kontrolpanelet.

1.

Kameras kontrolpanel –  (Focus)-fane2.

GUI-kontrolpanel3.
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Interchangeable Lens Digital Camera
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Manuel justering vha. webappen

Du kan justere fokus manuelt, for eksempel i de følgende tilfælde.

Motiver delvist formørket af vanddråber
Motiver med lav kontrast mod baggrunden
Motiver, der er længere væk end motiver i nærheden

Bemærk!

Manuel fokusering kan ikke styres fra webappen, mens en zoomfunktion er i gang.

Tip!

Du kan også bruge autofokus, når manuel justering er den primære betjeningsmetode. For yderligere oplysninger se "Indstilling af
fokusmotivet manuelt (AF Assist) vha. webappen".

Relateret emne

Tjekker objektivets kontakter

Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen
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Hvis objektivet er udstyret med en fokusvælgerkontakt, skal du indstille kontakten til "AF/MF"- eller "AF"-
positionen.

Bemærk!

Hvis kontakten er indstillet til positionen "Full MF" eller "MF", kan objektivfokusering ikke betjenes fra enheden. Se "For et
objektiv med en fokuskontakt" i "Tjekker objektivets kontakter".

1

Før kontakten [Auto Focus] til venstre position i kameraets kontrolpanel for at slukke for autofokus.

Manuel fokustilstand er aktiveret.

 (MF)

2

Justér vha. skyderen i bunden af  (Focus)-fanen.3
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Manuel justering vha. den medfølgende infrarøde fjernbetjening

Du kan justere fokus manuelt vha. den medfølgende infrarøde fjernbetjening.

Tip!

Du kan også bruge autofokus, når manuel justering er den primære betjeningsmetode. For yderligere oplysninger se "Manuel
fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening".

Relateret emne

Manuel fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening
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Tryk på MF-knappen på den infrarøde fjernbetjening.1

Justér fokus manuelt vha. knappen F (Far)-knappen og N (Near)-knappen.

Tryk på F-knappen for at fokusere på et motiv, der er langt væk.
Tryk på N-knappen for at fokusere på et motiv, der er tæt på.

2
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Interchangeable Lens Digital Camera
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Fokusering ved at angive en fokusposition (Spot Focus)

I manuel fokustilstand kan du angive den position, hvor du ønsker at justere fokus i kameraets billedpanel.

Bemærk!

Funktionen Spot Focus fungerer ikke, hvis objektivet er indstillet til manuel fokusering.

Tip!

I spotfokustilstanden kan du trykke på en tildelelig knap, der er tildelt med [Push AF/MF], for midlertidigt at stoppe spotfokus og
aktivere autofokus, mens der trykkes på knappen. Fokus vender tilbage til manuel fokus, når du slipper knappen.
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Indstil [Shooting] > [Focus] > [Touch Function in MF] til [Spot Focus] i webmenuen eller kameramenuen.1

Før [Touch Focus]-kontakten på  (Focus)-fanen til den højre position for at tænde den.2

Før [Auto Focus]-kontakten på  (Focus)-fanen til den venstre position for at slukke den.3

Angiv fokuspositionen.

Spot Focus-markøren kommer frem, og billedet justeres til at være i fokus i den position.

Eksempel på angivelse af positionen med touch-betjening

4
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Interchangeable Lens Digital Camera
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Sådan bruges autofokus midlertidigt (Push Auto Focus (AF))

I manuel fokustilstand kan du justere fokus midlertidigt med auto fokus ved at trykke på [Push AF/MF]-knappen for at
fokusere automatisk, mens knappen er trykket ned.
Dette er nyttigt, når du vil flytte fokus langsomt fra et motiv til et andet under manuel fokus.

Bemærk!

Funktionen Push Auto Focus fungerer ikke, hvis objektivet er indstillet til manuel fokusering.

Tip!

Den samme handling understøttes ved hjælp af en tildelelig knap, som tildeles med [Push AF/MF].
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Indstil [Shooting] > [Focus] > [Push AF Mode] til [AF] i kameramenuen.1

Før [Auto Focus]-kontakten på  (Focus)-fanen til den venstre position for at slukke den.2

Tryk på [Push AF/MF]-knappen.

Autofokus er aktiv, mens der trykkes på knappen.

Skub på autofokus-knappen, og fokus vender tilbage til manuelt fokus, når du slipper knappen.

3
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Interchangeable Lens Digital Camera
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Anvendelse af Single-Shot-autofokus (Push Auto Focus (AF-S))

Tryk på knappen [Push AF/MF] i manuel fokustilstand for at fokusere automatisk ved høj hastighed.
Denne funktion er bekvem, når du fokuserer på et emne før optagelse.

Bemærk!

Funktionen Push Auto Focus fungerer ikke, hvis objektivet er indstillet til manuel fokusering.

Fokusområderammen er ikke skjult, når du bruger knappen [Display].

Under funktionen Clear Image Zoom kan rammepositionen for [Focus Area (AF-S)] ikke indstilles. Under funktionen Push auto focus
giver AF-funktionen prioritet til midterdelen.

Tip!

Indstil [Shooting] > [Focus] > [Push AF Mode] til [Single-shot AF(AF-S)] i webmenuen eller kameramenuen.1

Angiv positionen for hvilken, du ønsker at justere fokus vha. [Shooting] > [Focus] > [Focus Area (AF-S)] i
kameramenuen.

Tip!

Du kan ændre positionen ved at trykke på en tildelelig knap, som er tildelt med [Focus Setting] for at vise en orange ramme
rundt om fokusområdet og vælge en position vha. touch-betjening.

2

Før [Auto Focus]-kontakten på  (Focus)-fanen til den venstre position for at slukke den.3

Tryk på [Push AF/MF]-knappen.

Hvis du slipper knappen, før fokusering er færdig, vil push auto focus stoppe.

Under push auto focus vises fokusstatus af fokusindikatoren.
Tændt: Fokus er fast på fokuspositionen.
Blinker: Ude af fokus. Da enheden ikke vil fokusere automatisk, skal du ændre kompositions- og fokusindstillingerne for
at opnå fokus.
Fokus vender tilbage til manuel fokus, når du slipper knappen.

4
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Den samme handling understøttes ved hjælp af en tildelelig knap, som tildeles med [Push AF/MF].

Du kan også tildele [Push AF Mode] til en tildelelig knap.

Du kan også tildele [Focus Area (AF-S)] til en tildelelig knap.

Du kan vise/skjule fokusområdets ramme vha. [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] i kameramenuen.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Automatisk justering vha. webappen

Enheden bruger faseregistrering AF til hurtig fokusering og kontrast AF til præcisionsfokusering.
Kombinationen af disse to AF-metoder giver autofokus med både høj hastighed og høj nøjagtighed.

Bemærk!

Der kræves et objektiv, der understøtter autofokus.

Nøjagtighed opnås muligvis ikke afhængigt af filmningsforholdene.

Fokus kan ikke justeres automatisk på et A-mount-objektiv.

Tip!

Under autofokus-tilstand kan du justere fokus ved at bruge Focus-skyderen i kameraets kontrolpanel. For yderligere oplysninger se
"Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen".

Relateret emne
Tjekker objektivets kontakter

Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen
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Hvis objektivet er udstyret med en fokusvælgerkontakt, skal du indstille kontakten til "AF/MF"- eller "AF"-
positionen.

Bemærk!

Hvis kontakten er indstillet til positionen "Full MF" eller "MF", kan objektivfokusering ikke betjenes fra enheden. Se "For et
objektiv med en fokuskontakt" i "Tjekker objektivets kontakter".

1

Før kontakten [Auto Focus] til højre position i kameraets kontrolpanel for at tænde den.

Autofokustilstand er aktiveret.

 (AF)

2
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Automatisk justering vha. den medfølgende infrarøde fjernbetjening

Du kan justere fokus automatisk vha. den medfølgende infrarøde fjernbetjening.

Bemærk!

Du kan også bruge autofokus, når manuel justering er den primære betjeningsmetode. For yderligere oplysninger se "Manuel
fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening".

Relateret emne
Manuel fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening
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Tryk på AF-knappen på den infrarøde fjernbetjening.

Fokus på et subjekt justeres automatisk.

1
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Indstilling af autofokusområdet/-positionen (fokusområde)

Du kan indstille målområdet til auto fokus og justere fokus for det område.

Tryk på [Menu]-knappen på GUI-kontrolpanelet for at åbne kameramenuen.1

Indstil målområdet for autofokus vha. [Shooting] > [Focus] > [Focus Area] i kameramenuen.

[Wide]:
Søger efter et motiv over en bred vinkel af billedet, når der fokuseres. Der vises ikke nogen ramme.

[Zone]:
Søger automatisk efter en fokusposition inden for den angivne zone.
Efter valget angives positionen vha. piletasterne i GUI-kontrolpanelet.

Du kan vende tilbage til midterpositionen ved at trykke på [Set] og holde den nede.
[Flexible Spot]:
Fokuserer på en angivet position i billedet.
Efter valget angives positionen vha. piletasterne i GUI-kontrolpanelet.

2
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Bemærk!

Fokusområderammen er ikke skjult, når du bruger knappen [Display] på kameraets billedpanel.

Under funktionen Clear Image Zoom er fokusområdet indstillet til [Wide] (fast).

Tip!

Du kan vise/skjule fokusområdets ramme vha. [Monitoring] > [Display On/Off] > [Focus Area Indicator] i kameramenuen.
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Du kan vende tilbage til midterpositionen ved at trykke på [Set] og holde den nede.
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Hurtig ændring af fokusområdet (fokusindstilling)

Du kan hurtigt ændre placeringen og størrelsen af autofokusområdet under optagelse ved at tildele [Focus Setting] til en
tildelelig knap.

For yderligere oplysninger om tildelelige knapper se "Tildelelige knapper".

Betjeningen varierer afhængigt af indstillingen for fokusområdet.

Når [Shooting] > [Focus] > [Focus Area] er indstillet til [Flexible Spot] eller [Zone] i
kameramenuen

Du kan ændre placeringen af fokusområdet ved at trykke på en tildelelig knap, som tildeles med [Focus Setting], og
justere vha. piletasterne i GUI-kontrolpanelet. Du kan flytte fokusområdets position tilbage til midten, mens du justerer
positionen ved at trykke på [Set]-knappen.
Du kan ændre størrelsen af fokusområdet ved at trykke på og holde en tildelelig knap nede, som tildeles med [Focus
Setting]. Når du har ændret størrelsen, skal du indstille fokusområdets position ved at trykke på [Set]-knappen. Når du er
færdig, skal du trykke på den tildelelige knap, der tildeles med [Focus Setting], for at vende tilbage til den oprindelige
skærm.

Når [Shooting] > [Focus] > [Focus Area] er indstillet til [Wide] i kameramenuen

Du kan kun ændre størrelsen af fokusområdet ved at trykke på og holde en tildelelig knap nede, som er tildelt med [Focus
Setting]. Positionen kan også ændres ved først at ændre typen til [Flexible Spot] eller [Zone].

Tip!

Når både [Shooting] > [Focus] > [Push AF Mode] er indstillet til [Single-shot AF(AF-S)] i kameramenuen og [Auto Focus]-kontakten er
sat i off-position (manuel fokustilstand), kan du ændre [Focus Area (AF-S)]-fokusområdets position.

Fokusområdets ramme vises orange, når placeringen af fokusområdet kan ændres.

Relateret emne

Tildelelige knapper
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Flytning af fokusområdets ramme vha. touchbetjening (Touch Focus Area)

Du kan ændre fokusområdets placering ved at trykke på en tildelelig knap, der er tildelt [Focus Setting], for at ændre
fokusområdevisningen til orange og derefter flytte fokusområdets ramme vha. touchbetjening i kameraets billedpanel.
Tryk på skærmen for at flytte fokusområdet med fokusområdet centreret på trykpositionen. Træk på skærmen for at flytte
fokusområdet til den position, som din finger markerer.

Tip!

Du kan aktivere/deaktivere touch focus-området på optagelsesskærmen ved hjælp af en tildelelig knap, som er tildelt [Focus Setting].

Berør en vilkårlig position.

Den berørte position bliver midten af fokusområdet.

1

Træk for at flytte fokusområdet til den position, din finger markerer.2
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Bemærk!

Hvis du trykker på en position eller trækker fokusområdet til en position, der overskrider indstillingsområdet, sættes fokusområdet til
den øverste/nederste/venstre/højre kant af indstillingsområdet.

Denne funktion er ikke tilgængelig i følgende tilfælde.

Når kontakten [Touch Focus] er slukket i kameraets kontrolpanel.
Når fokusområdets ramme vises i gråt eller slet ikke vises
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Justering af autofokushandlingen (AF-overgangshastighed, AF-motivskiftfølsomhed)

Du kan justere autofokusfunktionen ved at ændre overgangshastigheden og motivskiftfølsomheden.

Indstilling af AF-overgangshastighed

Du kan indstille hastigheden for fokusdrevet, til når motivet ændres, ved hjælp af knappen [AF Transition Speed] i kameraets
kontrolpanel.

Vælg hastigheden i intervallet mellem [Speed 1] (langsom) til [Speed 7] (hurtig) i stigninger af 1. Tryk på < knappen for at
formindske værdien (langsommere) eller > knappen for at øge værdien (hurtigere).
Når indstillet til lav hastighed, bevæger fokus sig langsomt, når motivet, der skal fokuseres på, ændrer sig, hvilket giver
mulighed for at filme med imponerende billedudtryk.
Når indstillet til høj hastighed, skifter fokus hurtigt mellem motiver. I eksemplet herunder ændres fokus hurtigt fra bygningen i
baggrunden til den person, der går i forgrunden. Motivet, der kommer ind i billedet, fokuseres straks, hvilket gør denne
indstilling ideel til dokumentarfilmning, der kræver hurtig fokusering.

AF-motivskiftfølsomhed

Du kan indstille følsomheden for at skifte mellem motiver ved hjælp af knappen [AF Subj. Shift Sens.] i kameraets
kontrolpanel.
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Vælg følsomheden i intervallet mellem [Sens 1] (låst på) til [Sens 5] (lydhør) i stigninger af 1. Tryk på < knappen for at
formindske værdien (skifte langsomt) eller > knappen for at øge værdien (skifte hurtigt).
Når indstillet til lav følsomhed, skifter fokus ikke let, selvom et andet motiv bevæger sig ind foran det fokuserede motiv.

Når indstillet til en høj følsomhed, skifter fokus for at give prioritet til det motiv, der bevæger sig ind foran.

Tip!

Hvis [AF Speed/Sens.] er tildelt en tildelelig knap, vises niveaubjælkerne til justering af værdier i kameraets billedpanel i følgende
rækkefølge, hver gang der trykkes på knappen, så du kan ændre indstillingerne for AF-overgangshastighed og AF-
motivskiftfølsomhed.
AF-overgangshastighed → AF-motivskiftfølsomhed → Ingen visning …
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Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen

Efter skift og justering af fokus manuelt kan du skifte fokusstyring til auto fokus for fin fokusjustering.

Bemærk!

I AF assist-tilstanden bliver det svært at skifte fokus, uanset [Shooting] > [Focus] > [AF Subj. Shift Sens.]-indstillingen i
kameramenuen.

AF-hjælpetilstanden annulleres af følgende.

Når motivet, der blev fokuseret ved hjælp af [Focus]-skyderen, ikke længere er synligt
Når du skifter til manuel fokus
Når sporings-AF i realtid er startet

Tip!

AF Assist-tilstanden kan annulleres hurtigt ved hjælp af en tildelelig knap tildelt [Push AF/MF].

Sporings-AF i realtid stopper, når [Focus]-skyderen betjenes.

I tilstanden Face/Eye Only AF fokuserer autofokus på det ansigt, der er tættest på [Focus]-skyderens position.

Indstil [Shooting] > [Focus] > [AF Assist] til [On] i kameramenuen.1

Indstil [Shooting] > [Focus] > [AF Assist Control] til [On] i webmenuen.2

Før kontakten [Auto Focus] til højre position i kameraets kontrolpanel for at tænde den.

Autofokustilstand er aktiveret.

3

Indstil motivfokus vha. [Focus]-skyderen i kameraets kontrolpanel.

[Near]: Fokus på et nært motiv.
[Far]: Fokus på et fjernt motiv.

I AF Assist-tilstanden vil et fjernt motiv, som er indstillet med [Focus]-skyderen, blive fokuseret automatisk.

4
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Manuel fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening

Når [Shooting] > [Focus] > [AF Assist] er indstillet til [On] i kameramenuen, kan du bruge F (Far)-knappen og N (Near)-
knappen på den medfølgende infrarøde fjernbetjening, selv under autofokus, for at justere fokus på et motiv.
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Midlertidig brug af manuelt fokus under autofokus (tryk manuelt fokus)

Tryk på knappen [Push AF/MF] i autofokustilstand for at fokusere manuelt, mens der trykkes på knappen. Fokus vender
tilbage til autofokus, når du slipper knappen.
Dette giver dig mulighed for midlertidigt at stoppe autofokus og fokusere manuelt, når noget, der ikke er genstand for
optagelse, krydser ind foran motivet.

Tip!

Den samme handling understøttes ved hjælp af en tildelelig knap, som tildeles med [Push AF/MF].
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Sporing ved hjælp af ansigts-/øje-registrering (Face/Eye Detection AF)

Enheden kan registrere folks ansigter og øjne som et mål, der skal spores, og derefter justere fokus på ansigter og øjne
inden for fokusområdet.
Når ansigter registreres, vises der grå rammer til registrering af ansigt/øjne. Når autofokusering er mulig, skifter rammerne til
hvid, og sporing starter. Når der registreres øjne, og fokus justeres, vises rammen til registrering af ansigt/øjne på øjnene.
Når der registreres flere personer, bestemmes hovedmotivet automatisk.
Denne funktion er kun tilgængelig, når fokustilstanden er AF-tilstand eller under tryk autofokus.

Tip!

Når fokusområdet er indstillet til [Zone] eller [Flexible Spot], og ansigter eller øjne overlapper inden for det angivne fokusområde,
skifter rammerne til registrering af ansigt/øjne til hvid, og enheden fokuserer automatisk på disse ansigter/øjne.

Når der anvendes skub autofokus (AF-S), skifter rammerne til registrering af ansigt/øjne, for de ansigter/øjne der er i fokus, til grøn.

Indstilling vha. [Face/Eye Detection AF]-knappen i kameraets kontrolpanel

Tryk på [Face/Eye Detection AF]-knappen, og indstil ansigts-/øjeregistrering AF-drift.

[Face/Eye Only AF]: Kameraet registrerer ansigtet/øjnene på motiver (personer), og fokuserer på og sporer kun deres
ansigter/øjne. Mens et ansigt eller øje ikke registreres, stopper AF midlertidigt, og ikonet  (autofokus pauseret i tilstanden
Face/Eye Only AF) vises. Denne tilstand er effektiv, når du kun vil autofokusere på og spore ansigter/øjne.
[Face/Eye Priority AF]: Kameraet registrerer ansigter/øjne på motiver (personer) og prioriterer fokusering/sporing på
ansigter/øjne. Når et ansigt eller øje ikke registreres, er fokusering i AF-tilstand (standardindstilling).
[AF]: Ansigts/øje-registrering AF er deaktiveret.

Bemærk!

Under push autofokus-funktion aktiveres [Face/Eye Priority AF], selv hvis [Face/Eye Only AF] er valgt i øjeblikket.

Når kontakten [Auto Focus] er på off, deaktiveres ansigts-/øjeregistrering AF (undtagen under brug af push autofokus).

Hvis du slukker for camcorderen, mens [Face/Eye Only AF] er valgt, skifter tilstanden automatisk til [Face/Eye Priority AF], når
camcorderen tændes næste gang.

Tip!

Indstil ansigts-/øjeregistrering AF-funktion ved hjælp af [Shooting] > [Focus] > [Face/Eye Detection AF] i kameramenuen.
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For at skjule rammer til registrering af ansigt/øjne
Du kan vise/skjule ansigts-/øjeregistreringsrammer vha. [Monitoring] > [Display On/Off] > [Face/Eye Detection Frame] i
kameramenuen.

Bemærk!

Grønne rammer til registrering af ansigt/øjne vises for ansigter og øjne, der er i fokus vha. push autofocus (AF-S), og de skjules ikke
ved hjælp af knappen [Display], eller når [Face/Eye Detection Frame] er indstillet til [Off].

Skift af ansigts-/øjeregistrering AF-funktion ved hjælp af en tildelelig knap
Tildel [Face/Eye Detection AF] til en tildelelig knap. Du kan derefter skifte ansigts-/øjeregistrering AF-funktion i rækkefølgen
[Face/Eye Priority AF], [Face/Eye Only AF] og [AF] hver gang du trykker på knappen.

Indstilling ved hjælp af den direkte menu

Du kan også indstille ansigts-/øjeregistrering AF-funktion ved hjælp af den direkte menu.

For yderligere oplysninger om den direkte menu se "Direkte menubetjening".

Relateret emne

Direkte menubetjening
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Sådan spores et specificeret motiv (Realtime Tracking AF)

Du kan opretholde fokus på et motiv ved at specificere motivet ved hjælp af touch-funktionen eller ved at vælge en
ansigtsregistreringsramme i kameraets kontrolpanel.
Når der er valgt et motiv, vises en hvid sporingsramme, og sporing starter.

Tip!

Sporing sker over hele billedområdet, uanset fokusområdeindstillingen.

Når [Shooting] > [Focus] > [Touch Function in MF] er indstillet til [Tracking AF] i webmenuen eller kameramenuen, er AF-sporing i
realtid understøttet, selv når fokustilstand er MF-tilstand.

Følgende handlinger forekommer for sporingsmotivet, afhængigt af AF-funktionstilstanden ansigts-/øjeregistrering.

[Face/Eye Only AF] eller [Face/Eye Priority AF]: Sådan fokuseres og spores det specificerede motiv.
Hvis sporingsmålet er en person, og der registreres et ansigt/øje, fokuserer kameraet på det ansigt/øje.
Når der registreres et sporingsmål-ansigt/øje, gemmes sporingsmålansigtet. Når det er gemt, vises et  (ikon for gemt
sporingsansigt).

Bemærk!

Hvis sporings-AF startes under manuelt fokus, gemmes sporingsmålansigtet ikke.

[AF]: Brug til fokusering og sporing af et specifikt motiv. Ansigts/øje-registrering sker ikke, selv hvis sporingsmålet er en
person.

Bemærk!

Funktionen AF-sporing i realtid fungerer ikke, hvis objektivet er indstillet til manuel fokusering.

Sådan startes sporings-AF i realtid

Når et specifikt motiv specificeres som sporingsmålet, starter sporing af målet.

Sådan specificerer du ved hjælp af touchfunktionen
Skub [Touch Focus]-kontakten på  (Focus)-fanen i kameraets kontrolpanel til den højre position for at tænde den, tryk så
på motivemnet for at spore i en af de følgende tilstande.
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Under manuelt fokus eller under push manuelt fokus, og når [Shooting] > [Focus] > [Touch Function in MF] er indstillet til
[Tracking AF] i webmenuen eller kameramenuen
Under autofokus eller under push autofokus (AF)

Sådan specificerer du valg af ansigtsregistreringsramme
Flyt ansigtsvælgermarkøren (orange understregning) til målmotivet for at spore ved hjælp af piletasterne i GUI-
kontrolpanelet, og tryk på [Set]-knappen.

A: Ansigtsregistreringsrammer (grå)
B: Sporingsramme
C: Markør til valg af ansigt (orange)

Bemærk!

Under manuelt fokus kan sporing ikke startes ved at vælge ansigtsregistreringsramme.

Tip!

Du kan også ændre det mål, der skal spores, under sporings-AF i realtid.

Sådan stoppes sporings-AF i realtid

Tryk på  (AF-sporing i realtid stop)-knappen.

Tip!

Sporings-AF i realtid vil stoppe i følgende tilfælde:

Når kontakten [Auto Focus] eller betjeningen AUTO/MANUAL på objektivet skiftes
Når fokustilstanden ændres
Når AF assist er udført
Når fokusområdeindstillingen eller handlingen ansigts/øje-registrering AF ændres
Når der trykkes på en tildelelig knap, der er tildelt med [Push AF/MF]
Når sporingsmålet ikke er inden for optagelsesskærmen, eller når motivet er uden for fokus i få sekunder.
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Når et sporingsansigt er gemt (når  (ikon for gemt sporingsansigt) vises), vil sporings-AF i realtid genoptages, når det gemte
sporingsansigt kommer ind i billedområdet. Stop sporings-AF i realtid som beskrevet ovenfor for at rydde sporingsansigtet.
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Lysstyrke-justeringsskærm

Du kan justere lysstyrken ved at justere iris, forstærkning, shutterhastighed og ved at justere lysniveauet ved hjælp af ND-
filtre i de følgende kontrolpaneler i webappens live-skærm. Du kan også justere lysstyrken automatisk.

Bemærk!

Forstærkningen kan ikke justeres, når [Shooting Mode] er indstillet til [Cine EI Quick] eller [Cine EI]. Lysstyrken kan heller ikke justeres
automatisk ved hjælp af lukkerhastigheden, når den er indstillet til [Cine EI Quick] eller [Cine EI]. Automatisk justering af lysstyrke med
iris og ND-filteret understøttes.

Tip!

Kameras kontrolpanel –  (Main)-fane1.

Kameraets grundlæggende konfigurationspanel
Viser indstillingsstatus for de grundlæggende funktioner, der er nødvendige til at optage med knapper. Tryk på en knap
for at vise den tilhørende opsætningsskærm for hver funktion i kameraets grundlæggende konfigurationsjusteringspanel
herunder.

2.

Kameras grundlæggende konfigurationsjusteringspanel
Viser justeringspanelet for det opsætningspunkt, der er valgt på kameraets grundlæggende konfigurationspanel.

3.
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Cine EI-tilstand er en indstilling til optagelse ved en basisfølsomhed uden at bruge forstærkning for at maksimere billedsensorens
ydeevne. Lysstyrken justeres vha. lys og ND-filteret til at justere mængden af lys, der når billedsensoren. For yderligere oplysninger
om Exposure Index (EI) se "Ændring af fordelingen af mørke og lyse områder i optaget billede".

Relateret emne

Ændring af fordelingen af mørke og lyse områder i optaget billede
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Indstilling af basisfølsomhed

Du kan indstille basisfølsomheden, før du begynder at justere lysstyrken.

Når [Shooting Mode] er indstillet til [Custom]

Tryk på [ISO/Gain]-knappen i kameraets grundlæggende konfigurationsrude, og indstil [Base Sensitivity] på ISO/Gain-
justeringspanelet til [High] eller [Low].
Vælg [Low] i normale lysforhold, og vælg [High] i lav belysning.
Skærm når [AGC] er slået fra

Skærm når [AGC] er slået til

Når [Shooting Mode] er indstillet til [Flexible ISO] eller [Cine EI]

Tryk på [Base ISO/Exposure Index]-knappen i kameraets grundlæggende konfigurationsrude, og indstil [Base ISO] på Base
ISO/Exposure Index-justeringspanelet til [ISO 12800] eller [ISO 800].
Vælg [ISO 800] i normale lysforhold, og vælg [ISO 12800] i lav belysning.

Tip!

Du kan også indstille denne på  (Main)-fanen i kameraets kontrolpanel.
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Kan også indstilles vha. [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] eller [Base ISO] i kameramenuen.

Du kan også tildele [Base ISO/Sensitivity] til en tildelelig knap.

I [Cine EI Quick]-optagelsestilstand, indstilles basisfølsomhed automatisk i henhold til eksponeringsindeksindstillingen.
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Indstilling af målniveau for automatisk lysstyrkejustering

Målniveauet for automatisk lysstyrkejustering indstilles vha. [AE Level]-skyderen i kameraets kontrolpanel.
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Tryk på fanen  (Main) i kameraets kontrolpanel.

Hvis [AE Level]-skyderen ikke vises, vælges en af de to skyderfunktionsknapper samt [AE Level]-skyderen fra listen.

[AE Level]-skyderen kommer frem.

1

Indstil målniveau vha. skyderen.

Flyt skyderknappen til venstre for at gøre billedet mørkere. Flyt skyderknappen til højre for at gøre billedet lysere.

Tip!

Kan også indstilles vha. [Shooting] > [Auto Exposure] > [Level] i kameramenuen.

2
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Automatisk justering af iris

Du kan justere lysstyrken automatisk alt efter motivet. Et kompatibelt objektiv er påkrævet.

Bemærk!

Iris kan ikke justeres automatisk på et A-mount-objektiv.

Tip!

Du kan også tildele [Auto Iris] til en tildelelig knap.
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Hvis der monteres et objektiv med kontakten Auto Iris, skal du indstille kontakten til AUTO.1

Tryk på knappen [Iris] i kameraets grundlæggende konfigurationspanel.

Rammen til [Iris]-knappen skifter til orange.

Iris-justeringspanelet kommer frem.

2

Før kontakten [Auto] til den højre position for at tænde den.

Iris skifter til auto justeringstilstand. Den autojusterede irisværdi vises på højre side af kontakten.

3
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Manuel justering af iris

Du kan justere lysstyrken manuelt.

Midlertidig automatisk justering af iris
Du kan også trykke på [Push Auto]-knappen på Iris-justeringspanelet for at justere iris automatisk, mens knappen er trykket
ned.

Hvis der monteres et objektiv med kontakten Auto Iris, skal du indstille kontakten til AUTO.

Bemærk!

Når objektivets Auto Iris-kontakt er indstillet til MANUAL, har funktionerne [Auto Iris] og [Push Auto Iris] på enheden ingen effekt.
Manuelle irisjusteringer på enheden har heller ingen effekt.

1

Tryk på knappen [Iris] i kameraets grundlæggende konfigurationspanel.

Rammen til [Iris]-knappen skifter til orange.

Iris-justeringspanelet kommer frem.

2

Før [Auto]-kontakten til den venstre position for at slukke den.

Iris skifter til manuel justeringstilstand.

3

Justér iris vha. [Iris]-skyderen eller [Iris]-justeringsknapperne.

Tip!

Skyderen og justeringsknappens indstillinger er forbundet.

Du kan også tildele iris til skyderen på  (Main)-fanen i kameraets kontrolpanel.

4
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Tip!

Tryk på en tildelelig knap, der er tildelt funktionen [Push Auto Iris], for at justere iris automatisk, mens der trykkes på knappen.
Iriss vender tilbage til manuel tilstand, når du slipper knappen.
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Automatisk justering af forstærkning

Du kan justere lysstyrken automatisk vha. forstærkningsindstillingen, når [Shooting Mode] er indstillet til [Custom] eller
[Flexible ISO].
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Indstil [Project] > [Shooting Mode] til [Custom] i webmenuen eller kameramenuen.1

Tryk på knappen [ISO/Gain] i kameraets grundlæggende konfigurationspanel.

Rammen til [ISO/Gain]-knappen skifter til orange.

ISO/Gain-justeringspanelet kommer frem.

2

Før kontakten [AGC] til den højre position for at tænde den.

Forstærkningen skifter til autojusteringstilstand. Den autojusterede forstærkningsværdi vises på højre side af kontakten.

Tip!

Du kan også udføre den samme handling ved at indstille [Shooting] > [Auto Exposure] > [AGC] til [On] i kameramenuen.

Du kan også tildele [AGC] til en tildelelig knap.

3
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Manuel justering af forstærkning

Du kan justere lysstyrken manuelt vha. forstærkningsindstillingen, når [Shooting Mode] er indstillet til [Custom] eller [Flexible
ISO].
Du kan styre forstærkningen, når du vil justere eksponeringen, mens du bruger en fast iris-indstilling, eller når du vil forhindre
forstærkningen i at stige på grund af AGC.

Midlertidig manuel justering af forstærkning
Du kan også justere forstærkningen midlertidigt ved at tildele [ISO/Gain] til en skyderfunktionsknap på  (Main)-fanen i
kameraets kontrolpanel og bruge skyderen.
Dette er nyttigt, når du vil justere eksponeringen med ét trin uden at ændre dybdeskarpheden.
Justeringsresultatet vender tilbage til den forindstillede værdi, konfigureret vha. [ISO/Gain<L>] efter udførsel af en af de
følgende funktioner.

Ændring af ISO/Gain-justeringspunkter
Skift af basisfølsomhed

Indstil [Project] > [Shooting Mode] til [Custom] i webmenuen eller kameramenuen.1

Tryk på knappen [ISO/Gain] i kameraets grundlæggende konfigurationspanel.

Rammen til [ISO/Gain]-knappen skifter til orange.

ISO/Gain-justeringspanelet kommer frem.

2

Før [AGC]-kontakten til den venstre position for at slukke den.

Forstærkningen skifter til manuel justeringstilstand.

3

Justér forstærkningen vha. [ISO/Gain]-skyderen eller [ISO/Gain]-justeringsknapperne.

Tip!

Skyderen og justeringsknappens indstillinger er forbundet.

4
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Sæt AGC-kontakten i positionen On
For at skifte enhedens strømforsyning til standby

For midlertidigt at justere forstærkningen automatisk vha. en tildelelig knap
Tryk på en tildelelig knap, der er tildelt funktionen [Push AGC], for at justere forstærkning automatisk, mens der trykkes på
knappen.
Forstærkningen vender tilbage til manuel tilstand, når du slipper knappen.
Justeringsresultatet vender tilbage til den forindstillede værdi, konfigureret vha. [ISO/Gain<L>] efter udførsel af en af de
følgende funktioner.

Ændring af ISO/Gain-justeringspunkter
Skift af basisfølsomhed
Sæt AGC-kontakten i positionen On
For at skifte enhedens strømforsyning til standby

Bemærk!

Denne funktion kan ikke udføres, når [Shooting] > [Iris] > [Bokeh Control] er indstillet til [On] i kameramenuen.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Automatisk justering af lukkeren

Du kan justere lukkeren automatisk som svar på billedets lysstyrke.

5-041-958-93(1) Copyright 2022 Sony Corporation

Tryk på knappen [Shutter] i kameraets grundlæggende konfigurationspanel.

Rammen til [Shutter]-knappen skifter til orange.

Shutter-justeringspanelet kommer frem.

1

Tryk på [Shutter Type]-knappen, og vælg [Auto] fra listen.

Tip!

Du kan også udføre den samme handling ved at indstille [Shooting] > [Auto Exposure] > [Auto Shutter] til [On] i kameramenuen.

Du kan også tildele [Auto Shutter] til en tildelelig knap.

2
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Manuel justering af lukkeren

Du kan justere lukkeren manuelt.
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Tryk på knappen [Shutter] i kameraets grundlæggende konfigurationspanel.

Rammen til [Shutter]-knappen skifter til orange.

Shutter-justeringspanelet kommer frem.

1

Tryk på [Shutter Type]-knappen, og vælg [Speed] fra listen.2

Justér shutter vha. [Speed]-skyderen eller [Speed]-justeringsknapperne.

Hvis du vil justere eksponeringstiden, så den passer til billedintervallet, skal du vælge [Off] i trin 2. Du kan også indstille
en fast værdi vha. [ECS] (frekvens) eller automatisk justere den vha. [Auto].
Eksempel: Indstil vha. [ECS] (frekvens)

Tip!

Skyderen og justeringsknappens indstillinger er forbundet.

For at bruge [Angle] i stedet for [Speed] eller [Off] indstilles [Shooting] > [Shutter] > [Mode] til [Angle] i kameramenuen.

3
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Om ND-filteret

Under forhold, hvor belysningen er for lys, kan du indstille den korrekte lysstyrke ved at ændre ND-filteret.
Hvis du, når du filmer et meget belyst motiv, lukker iris for meget, kan det forårsage diffraktionssløring, hvilket kan få et
billede til at gå ud af fokus (typisk fænomen i kameraer). Du kan undertrykke denne effekt for at opnå bedre filmresultater ved
hjælp af ND-filteret.
Enheden har følgende ND-filtertilstande.
Forudindstillingstilstand

Se "Justering i forudindstillet tilstand".

Variabel tilstand (automatisk justering)

Se "Automatisk justering i variabel tilstand".

Variabel tilstand (manuel justering)

Se "Manuel justering i variabel tilstand".

Relateret emne

Justering i forudindstillet tilstand

Automatisk justering i variabel tilstand

Manuel justering i variabel tilstand

5-041-958-93(1) Copyright 2022 Sony Corporation
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Justering i forudindstillet tilstand

Du kan vælge tre ND-filtertransmittansværdier på forhånd og hurtigt skifte mellem dem, mens du optager.

Tip!

Når en tildelelig knap, som er tildelt [ND Filter Position], er trykket ned, ændres ND-filtret i rækkefølgen [Clear] → [Preset1] →
[Preset2] → [Preset3] → [Clear].
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Indstil [Shooting] > [ND Filter] > [Mode] til [Preset] i kameramenuen.1

Tryk på knappen [ND Filter] i kameraets grundlæggende konfigurationspanel.

Rammen til [ND Filter]-knappen skifter til orange.

ND Filter-justeringspanelet kommer frem.

2

Tryk på [ND Filter]-knappen, og vælg en af de følgende fra listen.

[Clear]: Intet ND-filter.
[Preset1]: Transmission indstillet af [Shooting] > [ND Filter] > [Preset1] i kameramenuen.
[Preset2]: Transmission indstillet af [Shooting] > [ND Filter] > [Preset2] i kameramenuen.
[Preset3]: Transmission indstillet af [Shooting] > [ND Filter] > [Preset3] i kameramenuen.

Når en af [Preset1] til [Preset3] er valgt for ND-filteret, vises transmissionsværdien ved siden af ND-filternavnet.

3
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Automatisk justering i variabel tilstand

Du kan aktivere automatisk eksponeringsjustering ved hjælp af ND-filteret.

Bemærk!

Når ND-filtret skiftes til eller fra [Clear] under optagelse, vises ND-filterrammen på billedet, og en driftslyd udsendes.

Tip!

Du kan også tildele [Auto ND Filter] til en tildelelig knap, og trykke på knappen for at skifte mellem [Auto] og [Manual].
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Indstil [Shooting] > [ND Filter] > [Mode] til [Variable] i kameramenuen.1

Tryk på knappen [ND Filter] i kameraets grundlæggende konfigurationspanel.

Rammen til [ND Filter]-knappen skifter til orange.

ND Filter-justeringspanelet kommer frem.

2

Tryk på [ND Filter]-knappen, og vælg [Auto] fra listen.

Den automatisk justerede ND-filtertransmissionsværdi er vist ved siden af [ND Filter]-knappen.

3
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Manuel justering i variabel tilstand

Du kan foretage manuel eksponeringsjustering vha. ND-filteret.

Midlertidig automatisk justering
Du kan tildele [Push Auto ND] til en tildelelig knap, og indstille Auto ND-filter midlertidigt til On ved at holde knappen nede.
Når knappen slippes, sættes Auto ND-filter til Off igen.
Indstil ND-filtret til [Manual].

Bemærk!

Når ND-filtret skiftes til eller fra [Clear] under optagelse, vises ND-filterrammen på billedet, og en driftslyd udsendes.

Tip!

Du kan også tildele [ND Filter Position] til en tildelelig knap, og trykke på knappen for at skifte mellem [Manual] og [Clear].

Indstil [Shooting] > [ND Filter] > [Mode] til [Variable] i kameramenuen.1

Tryk på knappen [ND Filter] i kameraets grundlæggende konfigurationspanel.

Rammen til [ND Filter]-knappen skifter til orange.

ND Filter-justeringspanelet kommer frem.

2

Tryk på [ND Filter]-knappen, og vælg [Manual] fra listen.3

Justér transmissionen af ND-filteret vha. [ND Filter]-skyderen eller [ND Filter]-justeringsknapperne.

Tip!

Skyderen og justeringsknappens indstillinger er forbundet.

Du kan også justere ND-filtret på  (Main)-fanen i kameraets kontrolpanel.

4
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Du kan også trykke på [Push Auto]-knappen på ND Filter-justeringspanelet for at indstille Auto ND-filter til On, mens knappen er
trykket ned.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Hvidbalance-justeringsskærm

Du kan justere hvidbalancen vha. live driftsskærmen i webappen for at indhente en hvidbalance, der får billedet til at se mere
naturligt ud.

5-041-958-93(1) Copyright 2022 Sony Corporation

Kameraets grundlæggende konfigurationspanel1.

Kameras grundlæggende konfigurationsjusteringspanel
Viser justeringspanelet for det opsætningspunkt, der er valgt på kameraets grundlæggende konfigurationspanel.

2.
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Automatisk justering af hvidbalance

Du kan altid opnå en passende justeret hvidbalance vha. ATW (auto tracking white balance).
Når ATW er aktiveret, justeres hvidbalancen justeres automatisk, når lyskildens farvetemperatur ændres.

Bemærk!

ATW kan ikke bruges, når [Shooting Mode] er indstillet til [Cine EI] eller [Cine EI Quick].

Det er muligvis ikke muligt at justere til den korrekte farve ved hjælp af ATW, afhængigt af belysningen og motivforholdene.
Eksempler:

Når en enkelt farve dominerer motivet, f.eks. himmel, hav, jord eller blomster.
Når farvetemperaturen er ekstremt høj eller ekstremt lav.

Hvis ATW auto tracking speed er langsom, eller den passende effekt ikke kan opnås, tryk på [WB SET]-knappen for at køre
autohvidbalance.

Tip!

Du kan vælge responshastigheden i ATW-tilstand fra fem trin (1, 2, 3, 4, 5) vha. [Shooting] > [White Setting] > [ATW Speed] i
kameramenuen. Jo lavere tallet er, desto hurtigere er responshastigheden.

Du kan fryse den aktuelle hvidbalanceindstilling ved at tildele funktionen [ATW Hold] til en tildelelig knap og trykke på den tildelelige
knap for at sætte ATW-tilstanden midlertidigt på pause.
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Tryk på knappen [White Balance] i kameraets grundlæggende konfigurationspanel.

Rammen til [White Balance]-knappen skifter til orange.

White Balance-justeringspanelet kommer frem.

1

Tryk på [White Mode]-knappen, og vælg [ATW] fra listen.2
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Manuel justering af hvidbalance

Du kan justere hvidbalancen manuelt.

Tryk på knappen [White Balance] i kameraets grundlæggende konfigurationspanel.

Rammen til [White Balance]-knappen skifter til orange.

White Balance-justeringspanelet kommer frem.

1

Tryk på [White Mode]-knappen, og vælg en af de følgende fra listen.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Justér hvidbalancen vha. skyderne eller justeringsknapperne.

Tip!

Skyderen og justeringsknappens indstillinger er forbundet.

Forskellen mellem [Memory A(T/T)] og [Memory A(R/B)] er, at justeringsaksen er anderledes, men justeringsresultaterne er
forbundet.

Til [Memory A(T/T)]
Denne tilstand justerer hvidbalancen gemt i hukommelse A ved at justere farvetemperaturen (Temp) og Tint.
Du kan indstille farvetemperaturen i 20 K stigninger i intervallet 2000 K til 5600 K. Værdier over 5600 K kan indstilles i
intervaller, der er lig med mængden af farveændring fra 5580 K til 5600 K.
Hvis der trykkes på [Reset]-knappen til højre for [Temp] eller [Tint], gendannes den tilhørende indstilling til
standardværdien.

3
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Til [Memory A(R/B)]
Denne tilstand justerer hvidbalancen gemt i hukommelse A ved at justere R Gain og B Gain.
Ved at trykke på [Reset]-knappen gendannes den tilsvarende forstærkningsindstilling til standardværdien.
Til [Preset]
Denne tilstand justerer farvetemperaturen til en forindstillet værdi.
Du kan indstille værdien i 100 K stigninger.
I forindstillet tilstand kan du også tildele [Preset White Select] til en tildelelig knap og trykke på knappen for at ændre til
en på forhånd konfigureret værdi.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Kørsel af automatisk hvidbalance

I tilstanden Hukommelse A justeres hvidbalancen, der skal gemmes automatisk.

Tryk på knappen [White Balance] i kameraets grundlæggende konfigurationspanel.

Rammen til [White Balance]-knappen skifter til orange.

White Balance-justeringspanelet kommer frem.

1

Tryk på [White Mode]-knappen og vælg [Memory A(T/T)] eller [Memory A(R/B)] fra listen.

[Memory A(T/T)]

[Memory A(R/B)]

2

Placer hvidt papir (eller en anden genstand) på et sted med samme lyskilde og forhold som motivet, og zoom
derefter ind på papiret for at vise hvidt på skærmen.

3

Juster lysstyrken.

Justér iris vha. proceduren i "Manuel justering af iris".

4

Tryk på [WB SET]-knappen på hvidbalance-justeringspanelet.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Bemærk!

Hvis justeringen ikke lykkes, vises der en fejlmeddelelse på skærmen i ca. tre sekunder. Hvis fejlmeddelelsen bliver ved efter
gentagne forsøg på at indstille hvidbalancen, skal du kontakte din Sony-servicerepræsentant.

Tip!

Du kan også køre den i ATW-tilstand. Du kan bruge denne, når du hurtigt vil justere hvidbalancen under ATW-drift. Efter justering
vender tilstanden tilbage til normal ATW-drift.

Relateret emne

Manuel justering af iris

5-041-958-93(1) Copyright 2022 Sony Corporation

Hvis automatisk hvidbalance køres i hukommelsestilstand, gemmes resultatet af automatisk justering i hukommelse A.
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Konfigurationsskærm til lyd

Du kan justere lydniveauet til at blive optaget af enheden på livedriftskærmen i webappen. Konfigurér kontakterne på
enhedens konnektorblok, og konfigurér lyden vha. kameramenuen eller webmenuen.

5-041-958-93(1) Copyright 2022 Sony Corporation

Kameras kontrolpanel –  (Audio)-fane1.

210



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Valg af lydinputenhed

Indstil de følgende kontakter ifølge enheden, der er tilsluttet AUDIO IN-stikket.

Bemærk!

Lyd optages ikke i Interval Rec Mode eller Slow & Quick Motion Mode.

5-041-958-93(1) Copyright 2022 Sony Corporation

Når en mikrofon er tilsluttet, indstilles SETUP-kontakt 2 på konnektorblokken på bagsiden af enheden.

CH-1 og CH-2 har fælles indstillinger.

1

Indstilling Beskrivelse

OFF
(standard)

Vælg ved brug af en dynamisk mikrofon eller batteridrevet mikrofon. Dette slukker for +48 V phantom
power-forsyningen og indstiller LINE- eller MIC-indgang som CH-1 og CH-2 lydkilde.

ON
Vælg, når der bruges en +48 V phantom power-forsyning, der er en kompatibel mikrofon. Dette
tænder for +48 V phantom power-forsyningen, og indstiller phantom power-forsyningens kompatible
mikrofon som CH-1 og CH-2 lydkilde.

Indstil typen af tilsluttet enhed vha. [Audio] > [Audio Input] > [AUDIO IN Select] i kameramenuen.2

Vælg lydindgang vha. [Audio] > [Audio Input] > [CH1 Input Select] til [CH4 Input Select] i webmenuen eller
kameramenuen.

3
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Automatisk justering af lydoptagelsesniveauet

Indstil kanalen for hvilken, du ønsker at justere lydoptagelsesniveauet automatisk til [Auto] på siden [Audio] i webmenuen
eller vha. [Audio] > [Audio Input] > [CH1 Level Control] til [CH4 Level Control] i kameramenuen.
Kanalerne, der er angivet til auto justering, er indikeret med et  (Auto) ikon ved siden af de tilsvarende kanaler på 
(Audio)-fanen på live driftskærmen.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Manuel justering af lydoptagelsesniveauet

Du kan justere lydoptagelsesniveauet manuelt.
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Indstil kanalen for hvilken, du ønsker at justere lydoptagelsesniveauet manuelt til [Manual] på [Audio]-siden i
webmenuen eller vha. [Audio] > [Audio Input] > [CH1 Level Control] til [CH4 Level Control] i kameramenuen.

1

Tryk på  (Audio)-fanen i kameraets kontrolpanel.2

På skærmen [Audio] i kameraets kontrolpanel indstilles lydens optagelsesniveau vha. glideren eller
justeringsknapperne til kanalen, hvis lydoptagelsesniveau du ønsker at indstille manuelt.

Bemærk!

Kanaler, for hvilke  (Auto)-ikonet vises, justeres automatisk. Ændringer af værdier vha. skyder eller knapper anvendes ikke på
den optagne lyd.

Tip!

Skyderen og justeringsknappens indstillinger i hver række er forbundet.

Du kan tjekke lydindgangsniveauet i realtid vha. lydniveaumålerskærmen på optagelsesskærmen.

3
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Direkte menubetjening

Du kan tjekke status og indstillinger for enheden, som er vist overlejret på kamerabilledet, og vælge og ændre indstillingerne
vha. GUI-betjeningsknapperne på den infrarøde fjernbetjening.
Følgende elementer kan konfigureres.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter]-værdi
[Auto Iris]
[Iris]-værdi
[AGC]
[Gain]-værdi
[ISO]-værdi
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]-værdi
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] og [Frame Rate]

Tip!

Du kan også udføre den samme funktion vha. en tildelelig knap og GUI-kontrolpanelet i webappen.
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Tryk på en tildelelig knap, der er tildelt [Direct Menu] på den infrarøde fjernbetjening.

[Direct Menu]-knappen er tildelt den tildelelige knap 1 som fabriksstandard.
Kun de elementer på skærmen, der kan konfigureres ved hjælp af Direct Menu kan vælges ved hjælp af den orange
markør.

1

Flyt markøren til det punkt, som du ønsker at indstille vha. piletasterne i GUI-kontrolpanelet, og tryk på [Set]-
knappen.

Der vises en menu, eller elementet vises på en hvid baggrund.

2

Vælg en indstilling vha. piletasterne, og tryk på [Set]-knappen.

Menuen eller den hvide baggrund forsvinder, og den nye indstilling vises med en orange markør.
Tryk på en tildelelig knap, der er tildelt via [Direct Menu] igen, eller vent 3 sekunder uden at udføre nogen handling for at
forlade Direct Menu.

3
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Tildelelige knapper

Der er ti tildelelige knapper i enhedens webapp, som du kan tildele funktioner til.
De tildelelige knapper vises på live skærmen og afspilningsskærmen.

Bemærk!

Listen over tildelelige knapper vises ikke under konfigurering af indstillinger i kameraets grundlæggende driftspanel på live skærmen.
For at afslutte funktionen skal man trykke på [X]-knappen øverst til højre i justeringspanelet.

De følgende funktioner er tildelt knapperne som fabriksstandard.
Knap 1: [Direct Menu]
Knap 2: [Focus Setting]
Knap 3: [Rec Review]

Knapperne 1 til 3 svarer til det samme antal knapper på den medfølgende infrarøde fjernbetjening.

Knap 4: [Push Auto ND]
Knap 5: [Crop Select]
Knap 6: [Marker]
Knap 7: [Video Signal Monitor]
Knap 8: [Clip Flag OK]
Knap 9: [Color Bars]
Focus Hold-knappen: [Focus Hold]

Focus Hold-knappen svarer til Focus Hold-knappen på et E-mount-objektiv.

Ændring af knapfunktionen
Brug [Project] > [Assignable Button] i kameramenuen.
Når du ændrer en opgave, ændres visningen af listen med tildelelige knapper.
For yderligere oplysninger om de tildelelige funktioner se "Assignable Button" i "Kameramenu og detaljerede indstillinger".

Relateret emne

Assignable Button

5-041-958-93(1) Copyright 2022 Sony Corporation
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Langsom og hurtig bevægelse

Når optageformatet er indstillet til følgende værdier, kan du angive forskellige værdier for optagelsesbilledhastigheden og
afspilningsbilledhastigheden.
Den følgende tabel viser de konfigurerbare billedhastigheder.

Systemfrekvens: 59.94/50/29.97/25/23.98, billedgenerator-scanningstilstand: FF

Systemfrekvens: 59.94/50/29.97/25/23.98, billedgenerator-scanningstilstand: S35

Systemfrekvens: 24, billedgenerator-scanningstilstand: FF

Bemærk!

Slow & Quick Motion kan ikke indstilles under optagelse, afspilning eller mens miniaturebilledet vises.

Lydoptagelse understøttes ikke i tilstanden Slow & Quick Motion.

Autoiris-funktionen og autolukker-funktionerne er deaktiveret i tilstanden Slow & Quick Motion.

Autofokus har følgende begrænsninger i tilstanden Slow & Quick Motion.

Begrænsninger på grund af objektivmodel, systemfrekvens og optagelseshastigheden

Codec Videoformat Konfigurerbare optagelseshastigheder

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Videoformat Konfigurerbare optagelseshastigheder

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Videoformat Konfigurerbare optagelseshastigheder

XAVC-I 4096×2160P 1–60

Sony objektiv Systemfrekvens AF-tilgængelighed

Andre end SEL16F28 – 7 fps eller højere understøttet
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Autofokusfunktionen deaktiveres midlertidigt, hvis iris er indstil til F18 eller højere.

For yderligere oplysninger om anvendelse af RAW-output se "Optagelse af RAW-video".

Relateret emne
Optagelse af RAW-video

5-041-958-93(1) Copyright 2022 Sony Corporation

Sony objektiv Systemfrekvens AF-tilgængelighed

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps understøttet

50,00/25,00 25, 50, 100, 200 fps understøttet

24,00 Ikke understøttet
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Optagelse af video med afbrydelser (Interval Rec)

Interval Rec-funktionen giver dig mulighed for at optage video sporadisk i enhedens interne hukommelse. Denne funktion er
en effektiv måde at filme motiver i langsom bevægelse på.
Når du starter optagelsen, optager enheden automatisk et bestemt antal billeder (Number of Frames) i et angivent tidsinterval
(Interval Time).

A: Optagelsesinterval (Interval Time)
B: Antal billeder i én optagelse (Number of Frames)

Bemærk!

Der kan kun bruges én særlig optagelsesfunktion, såsom Interval Rec-optagelse kan bruges ad gangen.

Hvis en anden særlig optagelsestilstand er aktiveret, mens Interval Rec er i brug, frigøres Interval Rec automatisk.

Interval Rec-tilstanden frigøres automatisk, når du har ændret systemindstillinger, f.eks. videoformatet.

Interval Rec-indstillinger kan ikke indstilles under optagelse eller afspilning eller mens miniaturebilledet vises.

Begrænsninger under optagelse
Der optages ikke lyd.
Det er ikke muligt at gennemse optagelsen (Rec Review).

Hvis enheden slukkes under optagelse
Hvis enhedens strømforsyning er indstillet til standby, tilgås mediet i flere sekunder for at optage de billeder, der er gemt i
hukommelsen indtil det øjeblik, og derefter slukkes der automatisk for standby-tilstanden.
Hvis jævnstrømsledningen blev frakoblet, blev strømmen slukket fra vekselstrømsadapteren, eller PoE++
strømleveringen frakobles, kan billeder, som er optaget op til det tidspunkt, gå tabt (maksimum 10 sekunder). Der bør
udvises omhu.

Indstilling af antallet af rammer og intervallet mellem optagelse

Indstil [Project] > [Interval Rec] > [Setting] til [On] i webmenuen, og indstil [Number of Frames] og [Interval Time].
Enheden forlader tilstanden Interval Rec, når den slukkes, men indstillingerne [Number of Frames] og [Interval Time]
bibeholdes. Du behøver ikke at indstille dem igen, næste gang du filmer i Interval Rec-tilstanden.
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Tip!

Kan også indstilles vha. [Project] > [Interval Rec] i kameramenuen.

Starter optagelse

Tryk på knappen START/STOP af optagelse for at starte optagelsen. "Int●Rec" og "Int●Stby" ses skiftevis.

Stopper optagelse

Stop optagelsen.
Når filmoptagelsen slutter, skrives de videodata, der er gemt i hukommelsen op til dette punkt, til mediet.
Gør et af følgende for at forlade Interval Rec-tilstand:

Skifte enhedens strømforsyning til standby.
I optagelsesstandby-tilstand indstilles [Project] > [Interval Rec] > [Setting] til [Off].

Desuden udløses tilstanden Interval Rec automatisk, når enheden genstartes.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Sådan optages cachede billeder (Picture Cache Rec)

Funktionen Picture Cache Rec lader dig optage video retroaktivt, når du starter optagelse ved at opretholde en intern
cachehukommelse med en specificeret varighed, når du optager.

Indstilling af cache-størrelsen

Indstil [Project] > [Picture Cache Rec] > [Setting] til [On] i webmenuen, og indstil cache-størrelsen vha. [Cache Size].

Bemærk!

Picture Cache Rec kan ikke bruges sammen med Interval Rec, samtidig optagelse i to sprækker eller proxyoptagelse. Når Picture
Cache Rec er indstillet til On, bliver disse andre særlige optagelsestilstande tvunget til at være indstillet til Off.

Tilstanden Picture Cache Rec kan ikke vælges, mens optagelse eller Rec Review er i gang.

Når Picture Cache Rec er indstillet til On, er tidskoden optaget i [Free Run]-tilstanden, selv hvis den er indstillet til [Regen] eller [Rec
Run].

Indstillingen [Output Format] er muligvis ikke konfigurerbar i tilstanden Picture Cache Rec. Hvis det sker, skal Picture Cache Rec
midlertidigt indstilles til Off, og derefter skal indstillingen ændres.

Tip!

Cachetiden kan være kortere, afhængigt af optagelsesformatet. Tjek tiden vist i [Project] > [Picture Cache Rec] > [Cache Rec Time] i
webmenuen.

Kan også indstilles vha. [Project] > [Picture Cache Rec] i kameramenuen.

Du kan også skifte [Picture Cache Rec] mellem On og Off ved hjælp af en tildelelig knap.

Sådan startes Picture Cache Rec

Når [Picture Cache Rec] er indstillet til On, "●Cache" (● er grøn) vises.
Når du trykker på knappen til START/STOP af optagelse, starter optagelse, og video skrives til hukommelseskort med start
fra den video, der er gemt i cachehukommelsen.

Bemærk!

Hvis optagelsesformatet eller basisudseendet ændres, rydder det den video i cachehukommelsen, der er gemt op til det punkt, og
starter med at cache en ny video. Derfor er billedcacheoptagelse af billeder, inden formatet ændres, ikke mulig, selv hvis du starter
med at optage umiddelbart efter, formatet ændres.

Hvis Picture Cache Rec indstilles til On eller Off, umiddelbart efter et hukommelseskort er blevet indsat, vil cachedata muligvis ikke
blive optaget på kortet.

[Cache Size]-indstilling Cachetid (ca.)

[Short] 5 sekunder

[Medium] 10 sekunder

[Long] 20 sekunder

[Max] Maksimumværdi for hvert optagelsesformat
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Video gemmes i cachehukommelsen, når funktionen Picture Cache Rec er indstillet til On. Video, inden funktionen indstilles til On,
bliver ikke cachet.

Video gemmes ikke i cachehukommelsen, mens der tages adgang til et hukommelseskort som f.eks. under afspilning, Rec Review
eller visning af miniaturebilledet. Billedcacheoptagelse af video i det interval er ikke mulig.

Annullerer Picture Cache Rec

Indstil [Project] > [Picture Cache Rec] > [Setting] til [Off] i webmenuen, eller tryk på en tildelelig knap, der er tildelt [Picture
Cache Rec]-funktionen.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Samtidig optagelse til hukommelseskort A og B (2-slot Simul Rec)

Du kan optage til både hukommelseskort A og B samtidigt ved at indstille [Project] > [Simul Rec] > [Setting] til [On] i
webmenuen eller kameramenuen.

Sådan optages der separat til hukommelseskort A og hukommelseskort B

Du kan starte/stoppe optagelse til hvert hukommelseskort uafhængigt ved hjælp af knappen START/STOP eller [2nd Rec
START/STOP]-knappen på fanen  (Others).
Som fabriksstandard er begge knapper indstillet til start/stop til samtidig optagelse til både hukommelseskort A og B.
Når knapperne indstilles til at betjene optagelse til forskellige hukommelseskort, følger [SDI/HDMI Rec Control] start/stop-
styring af optagelse optagelsestilstanden for sprække A.

For at ændre indstillingen

Indstil følgende vha. [Project] > [Simul Rec] > [Rec Button Set] i kameramenuen.

5-041-958-93(1) Copyright 2022 Sony Corporation

[Rec Button Set]-
indstilling Knapper og hukommelseskort

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Starter/stopper samtidig optagelse til hukommelseskort A og B ved hjælp af en af knapperne.

Rec Button:<Slot A>
2nd Rec Button:
<Slot B>

Knappen START/STOP til optagelse starter/stopper af optagelse til hukommelseskort A, og
knappen [2nd Rec START/STOP] på fanen  (Others) starter/stopper optagelse til
hukommelseskort B.

Rec Button:<Slot B>
2nd Rec Button:
<Slot A>

Knappen START/STOP til optagelse starter/stopper optagelse til hukommelseskort B, og knappen
[2nd Rec START/STOP] på fanen  (Others) starter/stopper optagelse til hukommelseskort A.
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Videosignalsmonitor

Du kan indstille typen af videosignal, der skal vises i kameraets billedpanel, til bølgeform, vektorskop eller histogram ved
hjælp af [Monitoring] > [Video Signal Monitor] > [Setting] i kameramenuen.
Den orange linje angiver de indstillede værdier af [Level Marker 1] og [Level Marker 2].
Du kan også tildele funktionen [Video Signal Monitor] til en tildelelig knap.

Visning af overvågningsmål
I Log-optagelsestilstande farveskalaindstillingen eller oplysninger om monitor-LUT-indstilling øverst til højre på
videosignalskærmen for at angive monitoreringsmålet.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Klipmærker

Du kan tilføje et [OK]-klipflag til et klip ved at trykke på knappen, der er tildelt funktionen [Clip Flag OK] og vælge [Add OK].
Du kan slette et [OK]-klipflag ved at trykke to gange på knappen og vælge [Delete Clip Flag].

Tip!

Du kan også tilføje et klipflag vha. [Thumbnail] > [Set Clip Flag] i kameramenuen.

Miniaturebilledskærmen kan vises sorteret efter klipmærketype (miniaturebilledskærm for filtrerede klip). For yderligere oplysninger se
"Bearbejdning af optagede klip" i "Miniaturebilledskærm".

Relateret emne

Bearbejdning af optagede klip

5-041-958-93(1) Copyright 2022 Sony Corporation
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Åndedrætskompensation

Du kan indstille, om der skal foretages åndedrætskompensation for objektivet vha. [Technical] > [Lens] > [Breathing
Compensation] i kameramenuen.
Denne funktion korrigerer det fænomen, hvor ændringer i synsvinklen forekommer, efterhånden som fokuspositionen
ændres.
Når åndedrætskompensation udføres, bliver en del af billedet elektronisk beskåret for at opretholde en konstant synsvinkel,
så åndedrætsfænomenet ikke forekommer.

Bemærk!

Når åndedrætskompensation er aktiveret, vil synsvinklen og billedkvaliteten muligvis ændre sig en anelse.

Afhængigt af objektivet vil det muligvis ikke være muligt at korrigere ændringen af synsvinklen, når åndedrætskompensation er
aktiveret.

Kompensation er ikke mulig, når et objektiv, der ikke understøtter åndedrætskompensation, er monteret.

Denne funktion er indstillet til Off (fast) i følgende tilfælde.

Når [Technical] > [Lens] > [Distortion Comp.] er indstillet til [Off] i kameramenuen
Når [Shooting] > [S&Q Motion] > [Setting] er indstillet til [On] i webmenuen eller kameramenuen
Når [Project] > [Rec Format] > [Codec] er indstillet til [RAW] eller [RAW & XAVC-I] i webmenuen eller kameramenuen

5-041-958-93(1) Copyright 2022 Sony Corporation
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Oversigt proxy-optagelse

Med denne funktion kan du samtidigt optage proxydata i lav opløsning på samme tid som optagelse af original datavideo i
høj opløsning.

For yderligere oplysninger om understøttede hukommelseskort, formatering af hukommelseskort og kontrol af den
resterende kapacitet, se "Understøttede hukommelseskort" i "Forberedelse af hukommelseskort".

Om den optagede fil
Filtypenavnet er ".mp4".
Tidskoden optages også samtidigt.

Den optagede fils lagringsdestination
Den optagede fil gemmes i følgende mappe.

Om filnavnet
Filnavnet består af det klipnavn, der er registreret på hukommelseskortet, og et "S03"-suffiks.
For klipnavne se [TC/Media] > [Clip Name Format] i kameramenuen.

Relateret emne

Understøttede hukommelseskort
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Optagelsesmedie Mappesti

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Optagelse af en proxy

Du kan starte med at optage, når proxy-optagelsen er aktiveret.

For at stoppe optagelsen
Stop optagelsen.

Indstilling af lydkanalen til proxyoptagelse
Indstil lydkanalen til proxydataoptagelse vha. [Project] > [Proxy Rec] > [Audio Channel] i kameramenuen.
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Indstil [Project] > [Proxy Rec] > [Setting] til [On] i webmenuen eller kameramenuen.1

Indsæt et hukommelseskort i CFexpress Type A/SD-kortsprækken.

For CFexpress-kort indsættes med etiketten opad.
For SD-kort indsættes med etiketten nedad.

Bemærk!

Proxyoptagelse kan ikke indstilles til On på samme tid som S&Q Motion eller Interval Rec. Når Proxy Rec er indstillet til On,
indstilles disse andre optagelsestilstande ufravigeligt til Off.

2

Tryk på knappen til START/STOP af optagelse.

Proxyoptagelse begynder.

Bemærk!

Hvis enheden slukkes, eller hukommelseskortet fjernes, mens hukommelseskortet tilgås, kan integriteten af data på kortet ikke
garanteres.
Alle data optaget på hukommelseskortet kan blive kasseret. Sørg altid for, at hukommelseskortets adgangsindikator er slukket,
før du slukker for enheden eller fjerner hukommelseskortet.

Sørg for, at hukommelseskortet ikke springer ud, når du isætter eller fjerner det.

3

227



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Oversigt over udseende

Når enheden er i Custom, kan du føje justeringer til de sorte, matrix og andre parametre for at skabe et "udseende" baseret
på basisudseendet.

Du kan også hurtigt vælge et andet udseende ved at gemme forskellige kombinationer af indstillinger i scenefiler.
Enheden har i alt syv forudindstillede udseender.
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Valg af et udseende

Dette emne beskriver, hvordan man vælger et udseende.

Tjek, at [Project] > [Base Setting] > [Shooting Mode] er indstillet til [Custom] i webmenuen eller kameramenuen.

Tip!

I tilstanden [Custom] er knapperne [ISO/Gain] og [Scene File] vist i kameraets grundlæggende konfigurationspanel.

1

Tryk på knappen [Scene File] i kameraets grundlæggende konfigurationspanel.

Rammen til [Scene File]-knappen skifter til orange.

Scene File-justeringspanelet kommer frem.

2

Tryk på knappen [Scene File] på justeringspanelet, og vælg en scenefil med det ønskede udseende fra listen.

Følgende forudindstillinger er konfigureret som standard fra fabrikken.

Tip!

Du kan også vælge et udseende ved at bruge [Paint/Look] > [Scene File] > [Recall] i kameramenuen. Du kan også tilbagekalde
et forudindstillet udseende vha. [Scene File] > [Preset Recall].

Bemærk!

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scenefil 1 [S-Cinetone] [HLG Live]

Scenefil 2 [Standard] [HLG Natural]

Scenefil 3 [Still] (Ikke registreret)

Scenefil 4 [ITU709] (Ikke registreret)

Scenefil 5 [709tone] (Ikke registreret)

Scenefiler 6 til 16 (Ikke registreret) (Ikke registreret)
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Scenefil 5 forudindstilling er indstillet til [709tone] med softwareversion 2.0 eller senere. Den vises når [Maintenance] > [Reset] >
[Factory Default] i webmenuen udføres.
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Importering af et ønsket basisudseende

Du kan importere en 3D LUT-fil, der er oprettet på en computer eller en anden enhed, som et basisudseende. Der kan
importeres op til 16 filer.
Filformat: CUBE-file (*.cube) for et 17-punkts eller 33-punkts 3D LUT oprettet med Catalyst Browse, RAW Viewer, eller
DaVinci Resolve* (af Blackmagic Design Pty. Ltd.).

Input farveskala/Gamma: [S-Gamut3.Cine/S-Log3] eller [S-Gamut3/S-Log3]

Justering for undereksponering

Bekræftet med Resolve V9.0, V10.0 og V11.0.*

Gem 3D LUT-filen på enheden, der kører webappen.1

Åbn [Paint/Look] > [Base Look] i webmenuen.

En liste over registrerede basisudseender kommer frem.

2

Tryk på [Import] i rækken, hvor du ønsker at importere filen.

Dialogboksen til filvalg kommer frem.

3

Vælg den forberedte 3D LUT-fil.

Den importerede 3D LUT-fil bliver enhedens basisudseende.

4

Vælg den importerede 3D LUT-fil vha. [Paint/Look] > [Base Look] > [Select] i kameramenuen.5

Konfigurér [Paint/Look] > [Base Look] > [Input] og [Output] i kameramenuen for at matche den importerede 3D
LUT-fils attributter.

6
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Hvis der er en tendens til undereksponering, når automatisk eksponering er valgt, når du bruger det importerede
basisudseende, skal du justere udseendet ved at bruge [Paint/Look] > [Base Look] > [AE Level Offset] i webmenuen.

Bemærk!

Hvis du blot importerer en 3D LUT-fil, påvirker det ikke billedet. Indlæs den importerede 3D LUT-fil ved at bruge [Paint/Look] > [Base
Look] > [Select] i kameramenuen.

Hvis [Input] ikke er indstillet korrekt, opnås det korrekte udseende ikke.

Indstillingerne for menupunkterne [Input], [Output] og [AE Level Offset] anvendes på det basisudseende, der er valgt ved hjælp af
[Select]. Hvis der importeres flere 3D LUT-filer, skal du vælge hver 3D LUT-fil ved at bruge [Select] og konfigurere [Input], [Output] og
[AE Level Offset] individuelt for hver fil.

De konfigurerede indstillinger [Input], [Output], og [AE Level Offset] gemmes for hver 3D LUT-fil.

Basisudseende-/LUT-valgmulighederne for importerede 3D LUT-filer er fælles for optagelsestilstandene [SDR(BT.709)], [HDR(HLG)]
og Log, men farveskala og gammakonvertering udføres ikke i henhold til disse tilstande.

3D LUT-filer slettes ikke, når [Maintenance] > [Reset] > [All Reset (except for Network Settings)] udføres i webmenuen.

En  (3D LUT-fil vedhæftningsfejl) vist foran [Base Look Name] visning angiver, at 3D LUT-filer ikke kan fastgøres til klip optaget i
Log-optagelsestilstande. Importér 3D LUT-filen igen.
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Tilpasning af et udseende

Du kan tilpasse udseendet baseret på basisudseendet, der bruger [Master Black], [R Black] og [B Black]-skyderne i Scene
File-justeringspanelet i kameraets grundlæggende konfigurationspanel og [Paint/Look] > [Matrix] og andre
opsætningspunkter i kameramenuen.
Slut enheden til et fjernsyn eller en monitor, og juster billedkvaliteten, mens du holder øje med billedet på fjernsynet eller
monitoren.

1: [R Black]-skyder-/justeringsknapper
2: [B Black]-skyder-/justeringsknapper
3: [Master Black]-skyder-/justeringsknapper

Bemærk!

Når du importerer en 3D LUT-fil og anvender den på billedet, opnås det ønskede udseende, der er defineret i 3D LUT-filen, ikke, hvis
[Paint/Look] > [Matrix] og indstillinger ud over basisudseende i kameramenuen ændres.

Du kan nulstille alle tilpassede indstillinger vha. [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] i kameramenuen.
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Lagring af et udseende

Du kan gemme det nuværende udseende som en scenefil i intern hukommelse vha. [Paint/Look] > [Scene File] > [Store] i
kameramenuen.
Du kan hurtigt genkalde et gemt udseende vha. Scene File-justeringspanelet eller ved at bruge direkte menufunktioner.

Bemærk!

Hvis du vælger et andet udseende uden at gemme det aktuelle udseende, kasseres det aktuelle udseende.

Tip!

Du kan overskrive de forudindstillede scenefiler. Hvis du vil gendanne en forudindstillet scenefil, skal du indlæse det udseende, der
skal gendannes, vha. [Paint/Look] > [Scene File] > [Preset Recall] i kameramenuen, og dernæst gemme scenefilen vha. [Scene File] >
[Store].

Sletning af et gemt udseende
Du kan slette en scenefil gemt i intern hukommelse vha. [Paint/Look] > [Scene File] > [Delete] i kameramenuen.

Tip!

Når den slettes, vises den ikke længere i Scene File-justeringspanelet eller den direkte menu.
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Sletning af et basisudseende

Du kan slette importerede 3D LUT-filer individuelt ved at bruge [Paint/Look] > [Base Look] > [Delete] i kameramenuen.
Du kan slette alle importerede 3D LUT-filer vha. [Paint/Look] > [Base Look] > [Delete All] i kameramenuen.

Bemærk!

Før du sletter, skal du kontrollere, at basisudseendet ikke bruges i nogen scenefiler. Hvis et basisudseende, der bruges, slettes, vil
udseendet af de tilsvarende scenefiler være forkert.

Importerede 3D LUT-filer slettes ikke, når [Maintenance] > [Reset] > [All Reset (except for Network Settings)] udføres i webmenuen.

Et slettet basisudseende kan ikke længere bruges som en LUT i Log-optagelsestilstande.
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Filmning med justering af udseende i efterproduktion

Ved at bruge enheden i Log-optagelsestilstande*1 og optage gradueringer jævnt fra mørke områder til lyse områder kan du
foretage finjusteringer, f.eks. lokal gendannelse af gradueringer af mørke områder og lyse områder, i efterproduktionen.
Når du ser de optagne billeder på en almindelig skærm, vil den overordnede kontrast dog fremstå lav, hvilket gør det
vanskeligt at justere fokus og eksponering.
Du kan anvende en LUT til enhedens monitormål som hjælp til forskellige justeringer under optagelse. Du kan også anvende
den LUT der anvendes, når der optages automatisk efter afspilning for hurtigt at kontrollere det endelige resultat.
LUT'er anvendes af følgende systemer. Der kan dog kun anvendes én LUT.

SDI output
HDMI output og streaming
Proxy-klip optaget på optagelsesmedier
Høj opl. (hoved) klip optaget på optagelsesmedier

5-041-958-93(1) Copyright 2022 Sony Corporation

Generisk udtryk for Flexible ISO-tilstand/Cine EI-tilstand/Cine EI Quick-tilstand*1
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Anvendelse af en LUT til HDMI Output og Streaming

Du kan anvende en LUT til HDMI Output og Streaming.

Bemærk!

Billedet i webappens kamerabilledpanel er også inkluderet i streamingbilledet.

Tip!

Dette kan også indstilles vha. [Shooting] > [LUT On/Off] > [HDMI/Stream] i kameramenuen.

SDI-output kan indstilles på samme måde.

For video på optagelsesmedier kan du indstille dette vha. [Shooting] > [LUT On/Off] > [Internal Rec] og [Proxy] i kameramenuen.

En  (3D LUT-fil vedhæftningsfejl) vist foran [Base Look/LUT] visning angiver, at 3D LUT-filer ikke kan fastgøres til klip optaget i Log-
optagelsestilstande. Importér 3D LUT-filen igen.
Dette ikon vises også, når vedhæftning mislykkedes på grund af midlertidig behandlingstilstopning.
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Tjek, at [Project] > [Base Setting] > [Shooting Mode] er indstillet til [Flexible ISO], [Cine EI], eller [Cine EI Quick]
i webmenuen eller kameramenuen.

Tip!

I optagelsestilstande er knappen [Base ISO/Exposure Index] og knappen [Base Look/LUT] vist i kameraets grundlæggende
konfigurationspanel.

1

Tryk på knappen [Base Look/LUT] i kameraets grundlæggende konfigurationspanel.

Rammen til [Base Look/LUT]-knappen skifter til orange.

Base Look/LUT-justeringspanelet kommer frem.

2

Vælg [HDMI/Stream] > [MLUT].3
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Ændring af en LUT

Du kan ændre LUT'en for at anvende.

Tip!

Enheden giver [s709], [709(800%)], og [S-Log3] som forudindstillede LUT'er.

Du kan også importere og anvende en 3D LUT-fil. For yderligere oplysninger se "Importering af et ønsket basisudseende" og "Sletning
af et basisudseende".

Dette kan også indstilles vha. [Paint/Look] > [Base Look] > [Select] i kameramenuen.

Relateret emne
Importering af et ønsket basisudseende

Sletning af et basisudseende
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Tryk på knappen [Base Look/LUT] i kameraets grundlæggende konfigurationspanel.

Rammen til [Base Look/LUT]-knappen skifter til orange.

Base Look/LUT-justeringspanelet kommer frem.

1

Tryk på knappen [Base Look/LUT], og vælg basisudseendet, der skal anvendes.2
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Ændring af fordelingen af mørke og lyse områder i optaget billede

I Cine EI og Cine EI Quick-optagelsestilstande, kan du ændre fordelingen af mørke og lyse områder, f.eks. hvis du vil
prioritere tonen i mørke områder over lyse områder, ved at ændre Exposure Index fra basisfølsomheden.

Tryk på knappen [Base Look/LUT] i kameraets grundlæggende konfigurationspanel.

Rammen til [Base Look/LUT]-knappen skifter til orange.

Base Look/LUT-justeringspanelet kommer frem.

1

Vælg [HDMI/Stream] > [MLUT].

En LUT anvendes på HDMI output og streaming.

2

Tryk på knappen [Base ISO/Exposure Index] i kameraets grundlæggende konfigurationspanel.

Rammen til [Base ISO/Exposure Index]-knappen skifter til orange.

Base ISO/Exposure Index-justeringspanelet kommer frem.

3

Justér eksponeringsindekset ifølge den ønskede fordeling af mørke og lyse områder vha. [Exposure Index]-
skyderen eller [Exposure Index]-justeringsknapperne.

Til [Cine EI]

Til [Cine EI Quick]
Basisfølsomheden indstilles automatisk i henhold til det specifikke eksponeringsindeks.

4
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Tip!

Dette kan også indstilles vha. [Shooting] > [ISO/Gain/EI] > [Exposure Index] i kameramenuen.

SDI-output kan indstilles på samme måde.

Den anden numeriske værdi af indstillingen angiver, hvor mange trin med oplysning om lysstyrke der er tildelt for lyse områder
(lysstyrke højere end 18% grå). Områder, der er lysere end disse, er overeksponerede.
Eksempel: I "400EI/5.0E", tildeles der 5,0-trin på den lyse side.

Du kan også bruge dette som en vejledning til at kontrollere tonen i mørke og lyse områder under optagelse. Husk at vende tilbage til
den oprindelige EI-værdi efter kontrol af eksponeringen. Også i Cine EI Quick-tilstand, skal du være forsigtig ikke at påvirke
basisfølsomheden negativt.
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Justér belysningen og/eller ND-filteret, så kameraets billedoutput fra [HDMI/Stream] har den rette eksponering.5
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Optagelse af RAW-video

Du kan optage RAW-videosignaloutputtet fra SDI OUT-tilslutningen på enheden til en understøttet ekstern optagelsesenhed.
De understøttede RAW-outputformater er vist nedenfor.

Systemfrekvens [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Tilslut en ekstern RAW-optager til SDI OUT-tilslutningen på enheden.1

Indstil [Project] > [Base Setting] > [Shooting Mode] til [Cine EI], [Cine EI Quick], eller [Flexible ISO] i
webmenuen eller kameramenuen.

2

Indstil synsvinklen (kun FF) vha. [Project] > [Rec Format] > [Imager Scan Mode] i webmenuen eller
kameramenuen.

3

Indstil [Project] > [Rec Format] > [Codec] til [RAW] i webmenuen eller kameramenuen.

Hvis du vælger [RAW & XAVC-I], så optages der samtidigt video til en ekstern RAW-optager og video til
hukommelseskortene i enheden.

4

Indstil opløsningen vha. [Project] > [Rec Format] > [RAW Output Format] i webmenuen eller kameramenuen.5

Kontroller, at den eksterne optagelsesenhed er tændt, og tryk derefter på knappen START/STOP af optagelse på
live-skærmen.

RAW-videooptagelsesstatus er angivet af et ikon i kameraets billedpanel.

6
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Bemærk!

Når optagelse startes på en ekstern optagelsesenhed uden brug af knappen START/STOP af optagelse på live skærmen, optages klip
muligvis ikke korrekt.
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Bemærk!

Optagelseskontrolsignalet kommer fra SDI OUT-forbindelsen på enheden, men det er ikke muligt at få statussen for den
eksterne optagelsesenhed. Enheden kan derfor angive, at RAW-videooptagelse er i gang, når den eksterne optagelsesenhed
faktisk ikke optager. Kontroller indikatoren på den eksterne optagelsesenhed for at opnå den korrekte driftsstatus.
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Optagelse af RAW Video i tilstanden Slow & Quick Motion

Du kan optage RAW-video i tilstanden Slow & Quick Motion.

For yderligere oplysninger om understøttede billedhastigheder for optagelse se "Langsom og hurtig bevægelse".

Relateret emne

Langsom og hurtig bevægelse
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Sådan slås Bokeh-kontrolfunktionen til/fra

Du kan nemt justere graden af bokeh ved at forbinde ND-filteret og -forstærkningen med irisbetjeningen.

Sådan slås bokeh-kontrolfunktionen til/fra

Denne funktion kan kun aktiveres, når eksponeringen justeres manuelt. Indstil ND-filteret til variabel tilstand, og indstil
derefter iris, forstærkning, lukker og ND-filter til manuel justering.
Du kan slå bokeh-kontrolfunktionen til/fra vha. [Shooting] > [Iris] > [Bokeh Control] i kameramenuen.
Når bokeh-kontrolfunktionen er indstillet til On, vises et -ikon (B) på ND-filteret og forstærkningsindikatorerne.

Bemærk!

Denne funktion er kun aktiveret på E-mount-objektiver, der kan kommunikere med enheden.

Denne funktions maksimale effekt kan opnås ved hjælp af et Sony E-mount-objektiv.

Bokeh-kontrolfunktionen er indstillet til Off, når nogen af følgende handlinger finder sted.

Når enheden er slukket
Når iris, forstærkning, lukker eller ND-filter er indstillet til Auto
Når optagelsestilstanden skiftes
Når ND-filteret er indstillet til clear eller forudindstillet tilstand
Når objektivet er fjernet
Når enheden genstartes, f.eks. efter frekvensen er skiftet

Tip!

Du kan også tildele funktionen [Bokeh Control] til en tildelelig knap og skifte bokeh-kontrolfunktionen mellem On og Off vha. knappen.
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Sådan justeres graden af Bokeh

Juster indstillingerne i trin 2 til 4 efter behov.

Bemærk!

Udseendet kan variere afhængigt af betjeningshastigheden, objektivet, optagelsesindstillingerne, og lysklarheden kan også ændre sig.
Det anbefales på det kraftigste at udføre en kameratest inden optagelse.

Lysklarheden kan ændre sig, når irisbetjeningsretningen ændrer sig som f.eks. når iris åbnes, efter den har været lukket, eller når iris
lukkes efter at have været åbnet. I dette tilfælde skal den justeres en anelse mere, end hvad der var nødvendigt inden. Hold lidt igen,
kontrollér lysklarheden, og start så optagelsen. For eksempel hvis du ønsker at åbne iris til F8-åbning og sløre baggrunden, skal du
først lukke åbningen forbi F8 og så vende tilbage til F8, kontrollere lysklarheden og starte optagelsen.

Udfør bokeh-kontrolbetjeninger langsomt. Hvis du har brug for at fremskynde handlingen, kan du prøve at justere den gradvist, mens
du kontrollerer ændringerne af billedet.

Tip!

Når bokeh-kontrolfunktionen er indstillet til On, fungerer ND-filteret og forstærkningen sammen for at forskyde ændringer i
eksponering, der skyldes irisjustering, hvilket lader dig ændre graden af bokeh.

Bokeh-kontrollen forbindes først til ND-filteret som reaktion på irisbetjeningen. Når ND-filteret ikke længere kan ændres, er
forstærkningen forbundet.

I MF-tilstanden anbefales det, at du først åbner iris og derefter justerer fokus.

Hvis du bruger auto ND-filteret i stedet for bokeh-kontrolfunktionen, følger ND-filteret ændringen i motivets lysklarhed.

Visning under forbindelsen af forstærkning
Når bokeh-kontrolfunktionen er indstillet til On, kan forstærkningen ændres, når iris justeres.
Når forstærkningsforbindelsen er aktiv, og forstærkningen ændres, vises en meddelelse øverst på skærmen, og -ikonet
(B) på forstærkningsindikatoren blinker.

Indstil bokeh-kontrolfunktionen til On.1

Åbn iris helt.2

Indstil ND-filteret til 1/128.3

Indstil forstærkningen til 0 dB, og brug belysning til at få den korrekte eksponering.4

Juster fokus.5

Juster iris.

Graden af bokeh-ændringer.

6
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Oversigt over lagring og indlæsning af konfigurationsdata

Du kan gemme enhedens indstillinger som konfigurationsdata vha. webappen. Dette muliggør hurtigt at genkalde et
passende sæt af menuindstillinger for den nuværende situation.
Med denne enhed kan du gemme næsten alle indstillinger relateret til kamerafunktioner, udover den følgende bemærkning,
som en ALL-fil (fil med alle indstillinger).

Bemærk!

Netværksfunktionsindstillinger og godkendelsesinformation gemmes ikke. For yderligere oplysninger om gemte punkter se "Liste over
menupunkter".

Relateret emne

Liste over menupunkter
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Gemmer en ALL-fil

Dette emne beskriver, hvordan man gemmer en ALL-fil.
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Åbn [Project] > [All File] i webmenuen.1

Tryk på [Save All File] > [Save]-knappen.

Webbrowseren vil downloade en fil ved navn all-file.ALL øjeblikkeligt.

2

Angiv en placering og filnavnet på den downloadede all-file.ALL-fil, og gem filen.

Se enhedens brugsanvisning for at få yderligere oplysninger om filfunktionerne.

3
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Indlæser en ALL-fil

Dette emne beskriver, hvordan man indlæser en ALL-fil.

Bemærk!

Enheden genstarter automatisk efter indlæsning af konfigurationsdata. Efter genstart genindlæses siden i webbrowseren.

5-041-958-93(1) Copyright 2022 Sony Corporation

Åbn [Project] > [All File] i webmenuen.1

Tryk på [Load All File] > [Load]-knappen.

Åbn fil-dialogboksen kommer frem på enheden, der kører webappen.

2

Åbn den fil, du ønsker at indlæse.

Se enhedens brugsanvisning for at få yderligere oplysninger om filfunktionerne.

3

Når indlæs filnavn-bekræftelsesskærmen kommer frem, tryk på [OK]-knappen.4

Når udførselsresultat-skærmen kommer frem, tryk på [OK]-knappen.5

Vent på, at enheden genstarter, og forbind igen til webappen.6
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Om filoverførsel

Du kan uploade en proxy-fil eller en original fil, der er optaget på enheden, til en server på internettet eller en server på et
lokalt netværk.

Bemærk!

Når strømforsyningen er indstillet til standby-tilstand, placeres filoverførslerne på hold, selv om enheden stadig er strømført.
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Registrering af en destination til filoverførsel

Du kan registrere en overførselsdestinationsserver, før filoverførslen startes.

Vælg [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (eller [Server Settings2], [Server
Settings3]) i webmenuen.

Tip!

Navnet på valgmuligheden vil ændre sig i overensstemmelse med [Display Name] konfigureret i det næste trin.

1

Konfigurér de følgende punkter for [Network] > [FTP Server 1] til [FTP Server 3] i webmenuen.

[Display Name]
Angiv navnet på den server, der skal vises på listen over overførselsjobs ved valg af en overførselsdestinationsserver.
[Service]
Viser servertypen.
[FTP]: FTP-server
[Host Name]
Angiv adressen på serverens værtsnavn.
[Port]
Angiv portnummeret på den server, der skal oprettes forbindelse til.
[User Name]
Indtast brugernavnet.
[Password]
Indtast adgangskoden.
[Passive Mode]
Sæt passiv tilstand til On/Off.
[Destination Directory]
Indtast navnet på mappen på destinationsserveren.

Bemærk!

Hvis tegn, der er ugyldige på destinationsserveren, angives i [Destination Directory], overføres filerne til brugerens
hjemmemappe. Ugyldige tegn varierer afhængigt af serveren.

[Using Secure Protocol]
Angiv, om du vil udføre sikker FTP-overførsel.
[Root Certificate]
Indlæs/Ryd et certifikat.
[Load]: Indlæse et CA-certifikat. Indlæser certifikater i PEM-format.
[Clear]: Ryd CA-certifikatet.
[None]: Indlæs eller ryd ikke et certifikat.

Bemærk!

Indstil enhedens ur til det korrekte klokkeslæt, før du indlæser et CA-certifikat.

Ved optagelse i XAVC-I 4096×2160P/3840×2160P 59.94/50P kan [Load] ikke vælges.

[Root Certificate Status]: Viser certifikatets indlæsningsstatus.
[Reset]: Nulstiller Server Settings-indstillingerne til standarderne.

2
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Upload af en proxy-fil på et hukommelseskort fra miniatureskærmen

Du kan uploade proxy-filer på et hukommelseskort fra miniatureskærmen.

Bemærk!

Der kan registreres op til 200 overførselsjob.
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Tryk på [Thumbnail]-knappen på live driftsskærmen i webappen.

Visningen skifter fra kamerabilledet til miniatureskærmen.

1

Vælg [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] i kameramenuen.

For at overføre alle proxy-filer samtidigt vælg [Transfer Clip (Proxy)] > [All Clips].
Klip kan overføres fra miniaturebilledskærmen eller fra miniaturebilledskærmen for filtrerede klip.

2

Vælg det klip, du ønsker at overføre vha. [Set]-knappen og tryk på [Menu]-knappen.

Der vises en skærm til bekræftelse af overførslen.

3

Vælg [Execute].

Den proxyfil, der svarer til det valgte klip, registreres som et overførselsjob, og overførslen begynder.
Når overførselsjobbet er registreret, vises skærmen med overførselsresultatet.

4

Tryk på [OK]-knappen.5
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Upload af en original fil på et hukommelseskort fra miniatureskærmen

Du kan uploade en original fil på et hukommelseskort fra miniatureskærmen.

Bemærk!

Der kan registreres op til 200 overførselsjob.
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Tryk på [Thumbnail]-knappen på live driftsskærmen i webappen.

Visningen skifter fra kamerabilledet til miniatureskærmen.

1

Vælg [Thumbnail] > [Transfer Clip] > [Select Clip] i kameramenuen.

For at overføre alle originale filer samtidigt vælges [Transfer Clip] > [All Clips].
Klip kan overføres fra miniaturebilledskærmen eller fra miniaturebilledskærmen for filtrerede klip.

2

Vælg det klip, du ønsker at overføre vha. [Set]-knappen og tryk på [Menu]-knappen.

Der vises en skærm til bekræftelse af overførslen.

3

Vælg [Execute].

Den originale fil, der svarer til det valgte klip, registreres som et overførselsjob, og overførslen begynder.
Når overførselsjobbet er registreret, vises skærmen med overførselsresultatet.

4

Tryk på [OK]-knappen.5
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Kontrol af filoverførselsstatus

Du kan tjekke status af filoverførslen ved at vælge [Network] > [File Transfer] > [View Job List] i kameramenuen.

Bemærk!

Der kan registreres op til 200 overførselsjob.

Overførselsjobbene tilbageholdes, når enheden skiftes til standby-tilstanden, men op til 10 minutter af ny fremgangsinformation kan gå
tabt, hvis strømmen frakobles på andre måder.

Hvis der opstår en fejl under filoverførsel, genoptages overførslen af et klip med samme navn som et overført klip muligvis ikke,
afhængigt af indstillingerne og status for overførselsdestinationsserveren. I det tilfælde skal du kontrollere indstillingerne og status for
overførselsdestinationsserveren.

Tip!

Hvis [Network] > [File Transfer] > [Auto Upload (Proxy)] er indstillet til [On] i kameramenuen, og der findes en netværksforbindelse,
uploades proxyfiler automatisk til den server, der er angivet ved hjælp af [Default Upload Server], når optagelsen afsluttes.
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Upload ved hjælp af sikker FTP

Du kan overføre filer med kryptering ved hjælp af FTPS i Explicit-tilstand (FTPES) for forbindelsen til destinationsfilserveren.
For sikker FTP-overførsel skal du indstille [Using Secure Protocol] til [On] i destinationsfilens serverindstillinger og indlæse et
certifikat.

For yderligere oplysninger om konfiguration se "Registrering af en destination til filoverførsel".

Relateret emne
Registrering af en destination til filoverførsel
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Om Streaming

Enheden kan samtidigt streame video og lyd, der udsendes fra HDMI-stikket.

Bemærk!

For at bruge streaming som den primære video indstilles [Monitoring] > [Output Display] > [SDI] til [On] og [HDMI/Stream] til [Off] i
webmenuen, og kamerastatus overvåges på en SDI-monitor.

Hvis en monitor, som er tilsluttet HDMI-stikket, ikke understøtter HDMI-outputformatet, som er konfigureret vha. [Monitoring]-menuen i
webmenuen eller kameramenuen, vil kamerabilledet ikke blive vist i webappen. Der kan heller ikke streames video.

Streamingopløsningen kan ikke indstilles højere end HDMI-outputsignalopløsningen.

Når billedet ses af flere brugere, kan det blive forvrænget, afhængigt af codec-indstillingerne.

Enheden understøtter de følgende streamingmetoder. Video-codecs, som er tilgængelige, vises i parentes.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Konfigurér indstillingen af streamingformatet, indstilling af video-codec og lyd-codec i den rækkefølge.

●: Aktiveret, –: Deaktiveret

Tip!

Billedet i webappens kamerabilledpanel er også et streamingsystem.

5-041-958-93(1) Copyright 2022 Sony Corporation

Streamingformat
Codec-indstilling

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Webapp – – ● –

RTMP kan vælges, når [Stream] > [Audio Stream] er indstillet til [On] i webmenuen.*1

Når systemfrekvensen er 59.94 eller 50, og HDMI-outputformatet er 3840×2160 eller højere, er video 2-outputtet ikke tilgængeligt.*2
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Indstiller streamingformatet

Indstil streamingformatet vha. [Stream] > [Stream] > [Stream Setting] > [Setting] i webmenuen.

Når [Setting] er indstillet til [RTSP]

I RTSP-streaming kan billedet fra et enkelt kamera ses samtidigt af op til fem brugere.
Du kan indstille op til to video codec-tilstande.
[Port Number]
Indstiller portnummeret til brug med RTSP-streaming. Standardværdien er 554.
Ændring af indstillingen vil genstarte RTSP-serveren.
[Time Out]
Angiver timeout for Keep-Alive-kommandoen til RTSP-streaming. Timeout kan indstilles i intervallet 0 sekunder til 600
sekunder. Standardværdien er 60 sekunder.
Når den indstilles til 0 sekunder, forekommer timeout pga. Keep-Alive-kommandoen ikke.
[Authentication]
Indstiller om godkendelse påkrævet.
[Video Port Number 1], [Video Port Number 2]
Angiver billeddatas kommunikationsportnummer til brug med RTSP-unicaststreaming. Fabriksstandardværdien for Video Port
Number 1 er 51000. Fabriksstandardværdien for Video Port Number 2 er 53000. Angiv et lige tal i intervallet 1024 til 65534.
Tallet, der er indstillet her, og det efterfølgende ulige tal, opnået ved at tilføje 1, bliver de to portnumre, der bruges til
billeddatakommunikation og kontrol.
[Video Port Number 1] og [Video Port Number 2] svarer til [Stream] > [Video Stream] > [Video Stream 1] og [Video Stream 2].
[Audio Port Number]
Angiver lyddatas kommunikationsportnummer til brug med RTSP-unicaststreaming. Standardværdien er 57000. Angiv et lige
tal i intervallet 1024 til 65534. Tallet der er indstillet her og det efterfølgende ulige tal, opnået ved at tilføje 1, bliver de to
portnumre, der bruges til lyddatakommunikation og kontrol.

Når [Setting] er indstillet til [RTMP]

Videoens codec-tilstand der kan bruges til RTMP er kun H.264. For at bruge RTMP, skal [Stream] > [Audio Stream] være
indstillet til [On] i webmenuen.
[Server URL]
Indstiller URL for destinationen for overførsel. Angiv en tegnstreng der starter med "rtmp://" eller "rtmps://".
[Stream Key]
Indtast stream key fra det websted du bruger. Ved tryk på [Clear]-knappen ryddes indtastningen.

Bemærk!

Vær forsigtig når du håndterer stream key. Hvis stream key kendes af en tredjepart, er der risiko for at forfalske streamen.

[Root Certificate]
Importerer rodcertifikatet der kræves for streaming ved hjælp af RTMPS-protokol. For at importere rodcertifikatet, tryk på
[Load]-knappen og vælg et rodcertifikat. Tryk på [OK]-knappen i dialogboksen til filvalg for at importere den valgte fil i
enheden. Hvis der findes et importeret rodcertifikat i enheden, vil rodcertifikatet blive opdateret. For at slette et importeret
rodcertifikat, tryk på [Delete]-knappen på opsætningsskærmen. Rodcertifikatstatus vises i [Root Certificate Status].

Bemærk!

Importer rodcertifikatet, der er nødvendigt for streamingtjenesten.

Når [Setting] er indstillet til [SRT-Caller] eller [SRT-Listener]
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Videoens codec-tilstand er kun H.264.
[Destination]
Vises, når streamingtilstanden er indstillet til [SRT-Caller]. Indstiller forbindelsesdestinationens URL.
[Port Number]
Vises, når streamingtilstanden er indstillet til [SRT-Listener]. Indstiller portnummeret, på hvilket der skal lyttes.
Standardværdien er 4201.
[Latency]
Indstiller reaktionstiden i intervallet 20 ms til 8000 ms. Standardværdien er 120.
[TTL]
Angiver TTL-værdien i intervallet 1 til 255. Standardværdien er 64.
[Encryption]
Vælger krypteringsmetoden. Vælg Off, AES128 eller AES256. Standardværdien er Off.
[Passphrase]
Indstiller adgangssætning anvendt til kryptering. Ved tryk på [Clear]-knappen vil den konfigurerede adgangssætning
nulstilles.
[ARC]
Sæt på On for at aktivere funktionen Adaptive Rate Control.
Når Adaptive Rate Control er aktiveret, kan afbrydelser i billedet, som er forårsaget af overbelastning af
kommunikationslinjerne, blive reduceret.

Når [Setting] er indstillet til [NDI|HX]

Enheden overholder NDI|HX version 2 fra NewTek.
For at bruge NDI|HX skal en licensnøgle købes.
Køb af en licensnøgle
Køb på følgende NewTek-URL.
https://www.newtek.com/ndihx/products/upgrade/

Bemærk!

Download den seneste NDI|HX-driver, og installér den i et NewTek-produkt.

For yderligere oplysninger om NDI|HX-registrering og drift se brugsanvisningen til NewTek-produktet.

[License]
Viser licensoplysninger til en aktiveret licens.
[Source Name]
Viser kildens navn.
[Group]
Sæt på On for at aktivere NDI-grupperingsfunktionen.
[Group Name]: Indstiller NDI-gruppenavnet. Flere indstillinger kan konfigureres adskilt af et komma.
[Discovery Server 1], [Discovery Server 2]
Indstiller NDI discovery server 1 og NDI discovery server 2.
[Reliable UDP Mode]
Sæt på On for at aktivere Reliable UDP-tilstand.
[Multicast Mode]
Sæt på On for at aktivere multicast streaming.
[Multicast Prefix]: Indstiller præfiks til brug med multicast streaming.
[Multicast Netmask]: Indstiller netmasken, der bestemmer multicast-adresseintervallet.
[Multicast TTL]: Angiver TTL-værdien til multicast streaming i intervallet 1 til 256. Standardværdien er 3.
[Multi-TCP Mode]
Sæt på On for at aktivere Multi-TCP-tilstand.
[Unicast UDP Mode]
Sæt på On for at aktivere Unicast UDP-tilstand.

Om tredjepartsydelser og -software
Forskellige brugsvilkår kan gælde.

Ydelser og softwareopdateringer kan afbrydes eller afsluttes uden varsel.
Beskrivelsen af ydelser og software kan ændres uden varsel.
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Adskilt registrering og abonnement kan være nødvendigt.

Sony hæfter ikke for erstatningskrav foretaget af brugere eller tredjeparter, som skyldes brugen af ydelser og software fra
andre virksomheder.
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Indstilling af Video Codec til streaming

Indstil video codec vha. [Stream] > [Video Stream] i webmenuen.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Du kan indstille op til tre billed-codec-tilstande. Konfigurér de følgende indstillinger separat for hver billedtilstand.
[Video Stream 3] bruges til visning af webappens kamerabilledpanel.

Bemærk!

Når [Stream] > [Stream Setting] > [Setting] er indstillet til [RTMP], [SRT-Caller], eller [SRT-Listener], har nogle af [Video Stream 1],
[Video Stream 2], og [Video Stream 3]-indstillingerne ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) standardværdier.

[Codec 1], [Codec 2], [Codec 3]
Vælg [H.264], [H.265], eller [Off]. Bemærk, at [Codec 1] ikke kan indstilles til [Off]. Også [Codec 3] indstilles til [JPEG] (fast).

Bemærk!

De følgende symptomer kan opstå afhængigt af kombinationen af forskellige indstillinger, såsom billedstørrelse, rammehastighed og
bithastighed af [Codec 1], [Codec 2] og [Codec 3].

Øget videoreaktionstid.
Rammespring under videoafspilning.
Afbrudt lyd.
Langsom kamerarespons på forskellige kommandoer.
Langsom kamerarespons på funktioner fra en fjernbetjening.
Langsom monitor-skærmvisning og konfigurationsfunktioner.

Hvis du oplever disse symptomer, reducerer værdierne af billedstørrelsen, rammehastighed og bithastighedsparametre eller ændre
værdierne af andre opsætningsparametre for at løse problemet.

Når [Stream] > [Stream Setting] > [Setting] er indstillet til [RTMP], [SRT-Caller] eller [SRT-Listener], [Codec 1] er indstillet til [H.264]
(fast). [Codec 2] er indstillet til [Off] (fast).

Når billedstørrelsen eller systemfrekvensen af HDMI-outputtet er ændret, er [Codec 2] indstillet til [Off].

[Size 1], [Size 2], [Size 3]
Vælger billedstørrelsen for at streame fra kameraet.
De tilgængelige billedstørrelser vil variere afhængigt af billedstørrelsen af HDMI-outputtet.

Bemærk!

Når billedstørrelsen eller systemfrekvensen af HDMI-outputtet er ændret, vil den maksimale billedstørrelse blive valgt.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Indstiller billedets rammehastighed.
"fps"-enheder angiver antallet af rammer streamet pr. sekund.
De tilgængelige rammehastigheder vil variere afhængigt af billedstørrelsen af HDMI-outputtet.

Bemærk!

Når billedstørrelsen eller systemfrekvensen af HDMI-outputtet er ændret, vil den maksimale rammehastighed blive valgt.

[I-Picture Mode 1], [I-Picture Mode 2]
Vælger metoden til at specificere I-picture-indsættelsesinterval for H.264 og H.265 til [Time] eller [Frame].

261



Kan ikke indstilles for [Codec 3].
[Time]: Indstiller I-picture-indsættelsesinterval som en tid.
[Frame]: Indstiller I-picture-indsættelsesinterval som et antal rammer.
[I-Picture Interval 1], [I-Picture Interval 2]
Indstiller I-picture-indsættelsesinterval i sekundenheder. Indstiller en værdi i intervallet 1 til 5 sekunder. Standardværdien er 1
sekund.
Kan ikke indstilles for [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Indstiller I-picture-indsættelsesintervallet for H.264 og H.265 som et antal rammer i intervallet 15 til 300. Standardværdien er
300 rammer.
Kan ikke indstilles for [Codec 3].
[Profile 1], [Profile 2]
Indstiller H.264 eller H.265 billed-codec-profil.
[H.264]: Vælg [high], [main], eller [baseline]-profil.
[H.265]: Vælg [main] eller [main10]-profil. Når to video-codecs aktiveres, er kun [main]-profilvalget tilgængeligt.
Billedkomprimeringseffektivitet øges i rækkefølgen [high], [main], og [baseline]. Vælg en profil understøttet af dit system.
Når [H.265] er indstillet til [main10], drift er i [main10], når HDMI-outputtet er YCrCb eller i [main], når HDMI-outputter er RGB.
Kan ikke indstilles for [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Vælg [CBR] eller [VBR].
For at opretholde en konstant bithastighed vælges [CBR]. For at opretholde billedkvalitet vælges [VBR].
Kan ikke indstilles for [Codec 3].

Bemærk!

Rammehastigheden og bithastigheden, som streames, kan være anderledes end de indstillede værdier, afhængigt af billedstørrelsen,
optagelsesscenen, netværksmiljøet og andre faktorer.

Når [Stream] > [Stream Setting] > [Setting] er indstillet til [RTMP], [SRT-Caller] eller [SRT-Listener], [Bit Rate Compression Mode 1] er
indstillet til [CBR] (fast).

[Bit Rate 1], [Bit Rate 2]
Du kan indstille bithastigheden pr. videostream, når [Bit Rate Compression Mode] er indstillet til [CBR]. Indstilling af en høj
bithastighed tillader dig at streame video af høj billedkvalitet.
Kan ikke indstilles for [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Indstiller billedkvaliteten i intervallet 1 til 10. En værdi på 10 indstiller den højeste billedkvalitet. Standardværdien er 6.
For [Quality 1] og [Quality 2], kan du indstille H.264 billedkvalitet ved at indstille [Bit Rate Compression Mode] til [VBR] og
[Codec] til [H.264]. Du kan indstille H.265 kvalitet ved at indstille [Bit Rate Compression Mode] til [VBR] og [Codec] til [H.265].
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Indstilling af Audio Codec til streaming

Indstil audio codec vha. [Stream] > [Audio Stream] i webmenuen.
[Setting]
Indstil til On for at aktivere lydstreaming.

Bemærk!

For at vælge RTMP, indstil altid til On på forhånd.

[Codec]
Vælg den type codec, der skal bruges til streaming af lyd.
[AAC (256kbps)]: Vælg for at prioritere lydkvaliteten.
[AAC (128kbps)]: Vælg for at prioritere datakapaciteten.
Denne indstilling påvirker ikke klippet, som er optaget af enheden, eller lydsignalet, som er indlejret i HDMI-/SDI-signalet.
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Start/stop af streaming

For [RTSP], [SRT-Listener], og [NDI|HX]

Enheden venter på en streaming-leveringsanmodning.
Lancér en klientapp til at vise streaming, og tilgå URL'en vist i den følgende tabel.
Indtast værdier for brugernavn og adgangskode, der er konfigureret på enheden.

<camera_address>: Enhedens IP-adresse
<Port>: Lytterport konfigureret vha. [Port Number]

Bemærk!

Afspilning i alle programmer eller enheder er ikke garanteret.

For [RTMP] og [SRT-Caller]

Tryk på [Stream now]-knappen på  (Stream)-fanen på live driftsskærmen for at starte streaming. Knappen skifter til [Stop
stream] og [Stream]-ikonet kommer frem øverst på kameraets billedpanel.
Tryk på [Stop stream]-knappen under streaming for at stoppe streaming. Knappen skifter tilbage til [Stream now] og [Stream]-
ikonet øverst på kameraets billedpanel forsvinder.

Bemærk!

Afspilning i alle programmer eller enheder er ikke garanteret.
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Streamingformat URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-lytter srt://<camera_address>:<Port>

NDI|HX Se brugsanvisningen til NDI|HX-kompatibel klientenhed.
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Miniaturebilledskærm

Når du trykker på [Thumbnail]-knappen på afspilningsskærmen eller THUMBNAIL-knappen på den infrarøde fjernbetjening,
vises klip, der er optaget på hukommelseskortet, i kameraets billedpanel. Denne visning på kameraets billedpanel kaldes
miniatureskærmen.
Du kan vælge et klip på miniature-skærmen og starte afspilningen af det pågældende klip.
Hvis du trykker på [Thumbnail]-knappen under miniatureskærmvisningen, lukker miniatureskærmen og vender tilbage til
kamerabilledet.

Bemærk!

Kun de klip, der er optaget i det aktuelt valgte optagelsesformat, vises på miniaturebilledskærmen. Hvis et forventet optaget klip ikke
vises, skal du kontrollere optagelsesformatet. Vær særligt opmærksom på dette, før du formaterer (initialiserer) medier.

Skærmlayout

Miniaturebilledet af et udvalgt klip er vist med en orange baggrund.
Oplysninger om det valgte klip vises nederst på skærmen.
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Valgt hukommelseskort
Et låseikon vises til højre, hvis hukommelseskortet er skrivebeskyttet.

1.

Klipnummer/Samlet antal klip2.

Miniaturebilled (indeksbillede)
Viser et klips indeksbillede. Når et klip optages, indstilles dets første billede automatisk som indeksbilledet.
Klip/Billed-oplysninger vises under miniaturebilledet. Du kan ændre den viste information vha. [Thumbnail] > [Customize
View] > [Thumbnail Caption] i kameramenuen.

3.

Klipnavn
Viser navnet på det valgte klip.

4.

Optagelsesformat
Viser det valgte klips filformat.

5.

Særlige optagelsesoplysninger
Viser kun optagelsestilstanden, hvis klippet blev optaget med en særlig optagelsestilstand.
For Slow & Quick Motion-klip vises billedhastigheden til højre.

6.

Klipvarighed7.

Oprettelsesdato8.
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Afspilning af optagede klip

Du kan afspille optagede klip, når enheden er i standby-tilstand (Stby) for optagelse.
Dette emne beskriver, hvordan man spiller optagede klip vha. GUI-kontrolpanelet.

Indsæt hukommelseskortet for at afspille det.1

Tryk på [Thumbnail]-knappen.

Miniaturebilledet til klippet kommer frem.

2

Brug piletasterne i GUI-kontrolpanelet til at flytte markøren til miniaturebilledet for det klip, du vil afspille.3
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Bemærk!

Der kan forekomme kortvarige billedafbrydelser eller visning af stillbilleder ved overgangen mellem klip. Du kan ikke betjene enheden i
denne periode.

Når du vælger et klip på miniaturebilledskærmen og starter afspilningen, kan der forekomme kortvarige billedforstyrrelser i starten af
klippet. Hvis du vil se starten af klippet uden forstyrrelser, skal du sætte afspilningen på pause, trykke på knappen  (Forrige) for at
vende tilbage til starten af klippet og starte afspilningen igen.
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Bemærk!

Klip kan ikke vælges med touch-betjening.

Tryk på [Set]-knappen i GUI-kontrolpanelet.

Afspilningen begynder fra starten af det valgte klip.

4

Betjen afspilningskontrolpanelet som påkrævet.

Tip!

Du kan også styre betjeningen vha. GUI-kontrolpanelet.

Afspil: Tryk på [Set]-knappen.
Afspilningspause: Tryk på [Set]-knappen under afspilning. Tryk igen for at vende tilbage til normal afspilning.
Spring til starten af et klip/starten af næste klip: Tryk på den venstre knap/højre knap.
Fast forward/reverse: Tryk og hold den venstre knap/højre knap nede. Afspilningen vender tilbage til normal hastighed, når du
slipper knappen.
Stop afspilning: Tryk på [Cancel/Back]-knappen.

5

Knap Funktion

 (Afspil/Pause)-knap Afspiller et klip. Under afspilning, sætter klippet på pause.

 (Hurtig fremspoling)-knap,  (Hurtig
tilbagespoling)-knap

Afspiller et klip ved høj hastighed. Når knappen er trykket ned,
ændres afspilningens hastighed i tre trin.

 (Forrige)-knap,  (Næste)-knap Spring til starten af et klip eller det forrige/næste klip.

 (Stop)-knap Stopper afspilning og skifter til optagelsesskærmen.
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Bearbejdning af optagede klip

På miniaturebilledskærmen kan du bearbejde klippene eller kontrollere klipegenskaberne vha. menuen [Thumbnail] i
kameramenuen.
Tryk på [Menu]-knappen på afspilningsskærmen for at vise kameramenuen i kamerabilledpanelet.
Du kan udføre de følgende driftsfunktioner vha. [Thumbnail]-menuen i kameramenuen.
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Tip!

Du kan også trykke på [Menu]-knappen på driftsskærmen for at vise kameramenuen.

Driftsfunktioner der bruger [Thumbnail]-menuen i kameramenuen

Vælg en funktion for at betjene vha. piletasterne i GUI-kontrolpanelet, og tryk på [Set]-knappen.
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Tryk på [Cancel/Back]-knappen for at vende tilbage til den forrige skærm.

Bemærk!

Nogle emner kan ikke vælges, afhængigt af tilstanden, da menuen blev vist.

Menupunkter for klipbearbejdninger

Menuen [Thumbnail] i kameramenuen har de følgende menupunkter relateret til klipfunktionerne.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Du kan finde oplysninger om hvert menupunkt i "[Thumbnail]"-menuen.

For at vise skærmen med klipegenskaber
Vælg [Thumbnail] > [Display Clip Properties] i kameramenuen for at vise skærmen med klipegenskaber.
Tryk på  (Forrige) knappen eller  (Næste) knappen for at hoppe til det forrige/næste klip.

For at tilføje klipmærker
Du kan tilføje klipmærker (OK-, NG- eller KP-mærker) til klip for at filtrere visningen af klip baseret på klipmærkerne.
Vælg miniaturebilledet for det klip, du vil føje et klipmærke til, og vælg derefter klipmærket vha. [Thumbnail] > [Set Clip Flag] i
kameramenuen.

Tip!

Du kan også bruge en tildelelig knap, der tildeles med klipmærkefunktionen, for at tilføje klipmærker.

Visning af miniaturebilledskærmen med filtreret klip
Vælg [Thumbnail] > [Filter Clips] i kameramenuen, og vælg en klipmærketype for kun at få vist de klip, der har det
specificerede mærke.
Hvis du vil have vist alle klip, skal du vælge [All].
Du kan også trykke på [Display]-knappen for at sortere miniaturevisningen efter mærker.

Sletning af klip
Du kan slette klip fra hukommelseskort.
Vælg [Thumbnail] > [Delete Clip] > [Select Clip] eller [All Clips] i kameramenuen.
[Select Clip]: Sletter det valgte klip. Valg af flere klip understøttes.
[All Clips]: Sletter alle de viste klip.

Ændring af de oplysninger, der vises på miniaturebilledskærmen
Du kan ændre de klip/billed-oplysninger, der vises under miniaturebilledet.
Vælg [Thumbnail] > [Customize View] > [Thumbnail Caption] i kameramenuen, og vælg informationen der skal vises.
[Date Time]: Viser dato og klokkeslæt for oprettelse og seneste ændring af klippet.
[Time Code]: Viser tidskoden.

Indstilling Tilføjet klipmærke

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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[Duration]: Viser varigheden af klippet.
[Sequential Number]: Viser et fortløbende nummer på hvert miniaturebillede.
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Konfiguration af kameramenu

Når [Menu]-knappen i GUI-kontrolpanelet eller MENU-knappen på den infrarøde fjernbetjening er trykket ned, vises
kameramenuen til konfigurering af de forskellige påkrævede indstillinger for optagelse og afspilning i kameraets billedpanel.

Menuen består af følgende menuer.

Menukonfiguration

[User]-menu
Indeholder menupunkter konfigureret af brugeren.
Kan redigeres vha. [Edit User Menu].
[Edit User]-menu
Indeholder menupunkter til redigering af menuen [User].
[Shooting]-menu
Indeholder indstillinger relateret til filmning.
[Project]-menu
Indeholder grundlæggende projektindstillinger.
[Paint/Look]-menu
Indeholder indstillinger relateret til billedkvalitet.
[Pan-Tilt]-menu
Indeholder indstillinger relateret til panorering/hældning.
[TC/Media]-menu
Indeholder indstillinger relateret til tidskoder og optagelsesmedier.
[Monitoring]-menu
Indeholder indstillinger relateret til video-output og skærmvisning.
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[Audio]-menu
Indeholder indstillinger relateret til lyd.
[Thumbnail]-menu
Indeholder indstillinger relateret til miniaturevisning.
[Technical]-menu
Indeholder indstillinger for tekniske elementer.
[Network]-menu
Indeholder indstillinger relateret til netværk.
[Maintenance]-menu
Indeholder enhedsindstillinger, f.eks. ur og sprog.

Kameras menukonfiguration og hierarki

Niveau 1 Niveau 2

User
(Fabriksindstillinger)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Niveau 1 Niveau 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt P/T Acceleration
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Niveau 1 Niveau 2

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network
Wired LAN

File Transfer
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Niveau 1 Niveau 2

Maintenance

Language

Clock Set

Hours Meter
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Betjening af kameramenuen

Når [Menu]-knappen i GUI-kontrolpanelet eller MENU-knappen på den infrarøde fjernbetjening er trykket ned, vises
kameramenuen til konfigurering af de forskellige påkrævede indstillinger for optagelse og afspilning i kameraets billedpanel.
Menuen betjenes vha. knapper i GUI-kontrolpanelet.

[Menu]-knappen: Tryk for at vise kameramenuen. Tryk igen, mens kameraets menu vises, for at skjule menuen.
Piletaster: Tryk på piletasterne for at flytte markøren op/ned/venstre/højre i kameramenuen for at vælge menupunkter eller
indstillinger.
[Set]-knap: Tryk for at anvende det valgte punkt.
[Cancel/Back]-knap: Tryk for at vende tilbage til den forrige menu. En ikke gennemført ændring annulleres.

Bemærk!

Nogle emner kan ikke vælges, afhængigt af tilstanden, da menuen blev vist.

Indstilling af menupunkter

Flyt markøren til det punkt, som du ønsker at indstille vha. piletasterne i GUI-kontrolpanelet, og tryk på [Set]-knappen for at
anvende indstillingen.

Området til valg af menupunkter viser op til otte linjer. Hvis de tilgængelige indstillinger for et element ikke kan vises
samtidigt, skal du rulle gennem visningen ved at flytte markøren op/ned.
For underelementer med et stort indstillingsinterval (f.eks. −99 til +99) vises indstillingsområdet ikke. Den aktuelle
indstilling fremhæves for at angive, at værdien kan ændres.
Hvis du vælger [Execute] for en funktion, udføres den tilsvarende funktion.
Hvis du vælger et element, der skal bekræftes før udførelse, skjules menuen midlertidigt, og der vises en
bekræftelsesmeddelelse. Kontroller meddelelsen, og vælg derefter, om funktionen skal udføres eller annulleres.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Angivelse af en tegnstreng

Når du vælger et element, f.eks. et filnavn, som kræver angivelse af tegn, vises skærmen til angivelse af tegn.

5-041-958-93(1) Copyright 2022 Sony Corporation

Tryk på piletasterne i GUI-kontrolpanelet for at vælge tegntypen og anvende indstillingen.

[ABC]: Store, alfabetiske bogstaver
[abc]: Små, alfabetiske bogstaver
[123]: Numeriske tegn
[!#$]: Specialtegn

1

Vælg et tegn, og tryk på [Set]-knappen for at anvende indstillingen.

Markøren flyttes til det næste felt.
[Space]: Indsætter et mellemrumstegn ved markørens position.
[←] [→]: Flytter markørens position.
[BS]: Sletter tegnet til venstre for markøren (mellemrum).

2

Når den er færdig, tryk på [Done]-knappen for at anvende indstillingen.

Tegnstrengen bekræftes, og skærmen til angivelse af tegn forsvinder.

3
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Dette emne beskriver funktionen og indstillingerne for hvert menupunkt.

Bemærk!

Du kan tilføje og fjerne menupunkter i [User]-menuen vha. [Edit User]-menuen. Der kan konfigureres op til 20 elementer.

5-041-958-93(1) Copyright 2022 Sony Corporation

Punkt Beskrivelse

Base Setting Project > Base Setting punkt

Focus Shooting > Focus punkt

S&Q Motion Shooting > S&Q Motion punkt

LUT On/Off Shooting > LUT On/Off punkt

Simul Rec Project > Simul Rec punkt

Proxy Rec Project > Proxy Rec punkt

Interval Rec Project > Interval Rec punkt

Picture Cache Rec Project > Picture Cache Rec punkt

Assignable Button Project > Assignable Button punkt

Scene File Project > Scene File punkt

Base Look Paint/Look > Base Look punkt

P/T Acceleration Pan-Tilt > P/T Acceleration punkt

Clip Name Format TC/Media > Clip Name Format punkt

Format Media TC/Media > Format Media punkt

Video Signal Monitor Monitoring > Video Signal Monitor punkt

Marker Monitoring > Marker punkt

Zoom Technical > Zoom punkt

Lens Technical > Lens punkt

Edit User Menu Viser menuen Edit User.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Edit User

Menuen [Edit User] vises på det øverste niveau, når [Edit User Menu] er valgt i [User]-menuen.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Add Item
Tilføj et punkt til menuen
[User]

– – Tilføjer et menupunkt 2 til menuen [User].

Customize Reset
Nulstil punkterne i
menuen [User]

– –
Gendanner de menupunkter, der er registreret i
menuen [User], til fabriksindstillingerne.

Niveau 2 menupunkt valgt
under redigering

Delete –
Sletter det registrerede menupunkt 2 fra menuen
[User].

Move –
Omarrangerer de registrerede menupunkter i
menuen [User].

Edit Sub Item –
Redigerer (registrer/slet) det registrerede 3 menu-
underpunkt i [User]-menuen.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ISO/Gain/EI

Indstiller forstærkningsindstillinger.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Mode ISO/dB dB
Vælger tilstanden for indstilling
af forstærkning.

ISO/Gain<L>

For yderligere oplysninger om
indstillinger se "ISO/Gain Indstillinger
og standardværdier".

– Indstiller den forudindstillede
værdi for forstærkning <L>.

Exposure
Index<L>

Når Base ISO er indstillet til ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Når Base ISO er indstillet til ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Når Base ISO er indstillet
til ISO 800: 800EI / 6.0E
Når Base ISO er indstillet
til ISO 12800: 12800EI /
6.0E

Indstiller-værdien Exposure
Index<L>.

Shockless
Gain

On / Off Off
Sætter funktionen stødfri
forstærkning til On/Off.

Base
Sensitivity

High / Low Low
Indstiller basisfølsomheden for
Custom-tilstand.

Base ISO ISO 12800 / ISO 800 ISO 800
Indstiller ISO
basisfølsomheden for Cine
EI/Flexible ISO-tilstand.
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Relateret emne
ISO/Gain Indstillinger og standardværdier
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ND Filter

Indstiller de forudindstillede værdier for ND-filteret.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Mode Preset / Variable Variable Vælger ND-filtertilstanden.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Indstiller den forudindstillede værdi 1 for ND-filteret.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Indstiller den forudindstillede værdi 2 for ND-filteret.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Indstiller den forudindstillede værdi 3 for ND-filteret.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Shutter

Indstiller den elektroniske lukkers driftstilstand.
Bruges til at filme motiver i hurtig bevægelse.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Mode Speed / Angle Speed

Vælger tilstanden til indstilling af
shutter-hastigheden i sekunder
(Speed) eller som en shutter-vinkel
(Angle).

Shutter
Speed
On/Off

On / Off Off

Indstiller, om eksponeringstiden, når
tilstanden Speed vælges, følger
[Shutter Speed] eller den indstilles til
fuld eksponering.

Shutter
Speed

64F til 1/8000
De tilgængelige indstillinger varierer afhængigt
af rammefrekvensen for det valgte videoformat.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120
/ 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000
/ 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 /
1/96 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Indstiller shutter-hastigheden, når
tilstanden Speed er valgt.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Indstiller shutter-vinklen, når
tilstanden Angle er valgt.

ECS On/Off On / Off Off
Sætter funktionen Extended Clear
Scan til On/Off.

ECS
Frequency

23.99 til 8000
De tilgængelige indstillinger varierer afhængigt
af rammefrekvensen for det valgte
optagelsesformat.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Indstiller ECS-frekvensen, når
tilstanden er indstillet til ECS.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Iris

Indstiller iris-indstillinger.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Bokeh Control On / Off Off Slår bokeh-kontrolfunktionen til/fra.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Auto Exposure

Sætter indstillinger for automatisk eksponeringsjustering.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 /
±0 / −0.25 / −0.5 / −0.75 / −1.0 / −1.25 /
−1.5 / −1.75 / −2.0 / −2.25 / −2.5 / −2.75 /
−3.0

±0
Indstiller lysstyrkeniveauet for den
automatisk registrerede eksponering.

Mode Backlight / Standard / Spotlight Standard

Indstiller driftstilstanden for automatisk
eksponeringsjustering.
Backlight: Baggrundslystilstand (tilstand
med reduceret formørkning af et motiv,
når motivet er baggrundsbelyst)
Standard: Standard tilstand
Spotlight: Spotlight-tilstand (tilstand med
reduceret belysning, når motivet er oplyst
med spotlight)

Speed −99 til +99 ±0 Indstiller justeringshastigheden for
automatisk eksponeringsjustering.

AGC On / Off Off
Sætter AGC-funktionen (automatisk
forstærkningskontrol) til On/Off.

AGC Limit

For yderligere oplysninger om
indstillinger se "AGC Limit Indstillinger
og standardværdier".

– Indstiller den maksimale forstærkning for
AGC-funktionen.

AGC Point F2.8 / F4 / F5.6 F2.8
Indstiller F-stopværdien for iris, hvor AGC-
drift starter, når AGC-funktionen er On.

Auto
Shutter

On / Off Off Sætter den automatiske lukkerfunktion til
On/Off.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Indstiller den hurtigste lukkerhastighed for
den automatiske lukkerfunktion.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Indstiller F-stopværdien for iris, hvor
automatisk lukkerfunktion starter.

Clip High
light

On / Off Off
Sætter den funktion, der ignorerer de
klareste områder for at give en fladere
reaktion ved høj luminans til On/Off.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 Custom 1

Indstiller lysmålingsintervallet for
automatisk justering af eksponeringen i
henhold til motivets lysstyrke. (Ikke
tilgængelig ved manuel justering af
eksponering)
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Relateret emne
AGC Limit Indstillinger og standardværdier
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Detect
Window
Indication

On / Off Off
Sætter indikatoren for
lysmålingsintervallet til On/Off.

Custom
Width

40 til 999 500 Indstiller bredden af lysmålingsintervallet.

Custom
Height

70 til 999 500 Indstiller højden af lysmålingsintervallet.

Custom H
Position

−479 til +479 ±0 Indstiller den horisontale position for
lysmålingsintervallet.

Custom V
Position

−464 til +464 ±0
Indstiller den vertikale position for
lysmålingsintervallet.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White

Sætter hvidbalanceindstillinger.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Preset
White

2000K til 15000K 3200K Sætter den forudindstillede værdi for hvidbalance.

Color
Temp <A>

2000K til 15000K 3200K

Sætter farvetemperaturen for hvidbalance, der er gemt i hukommelse
A.

Bemærk!

Da Color Temp klippes ved 2000K og 15000K under R Gain/B Gain-
drift, er det muligvis ikke muligt at vise den korrekte Color Temp-værdi
for R Gain/B Gain-værdien.

Tint<A> −99 til +99 ±0

Indstiller farvetoneværdien for hvidbalance, der er gemt i hvid
hukommelse A.

Bemærk!

Da Tint klippes ved ±99 under R Gain/B Gain-drift, er det måske ikke
muligt at vise den korrekte farvetoneværdi for R Gain/B Gain-værdien.

R Gain
<A>

−99.0 til +99.0 ±0.0
Indstiller værdien for R-forstærkning for hvidbalance, der er gemt i
hukommelse A.

B Gain
<A>

−99.0 til +99.0 ±0.0
Indstiller værdien for B-forstærkning for hvidbalance, der er gemt i
hukommelse A.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White Setting

Justerer hvidbalanceindstillinger.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Shockless
White

Off 1 / 2 / 3 2

Indstiller reaktionshastigheden for hvidbalance, når du skifter
hvidbalancetilstand.
Off: Skifter øjeblikkeligt.
1 til 3: Skifter langsommere, jo højere tallet er.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Indstiller reaktionshastigheden i ATW-tilstand.
Den hurtigste responshastighed er 1, og den mest
langsomme responshastighed er 5.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Offset White

Sætter forskydningsindstillinger for hvidbalance.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Offset White <A> On / Off Off
Vælger, om der skal tilføjes (On) eller ikke tilføjes (Off) en
forskydningsværdi til hvidbalancen i hukommelse A.

Offset Color
Temp<A>

−99 til +99 ±0
Indstiller den farvetemperaturforskydning, der skal føjes til
hvidbalancen i hukommelse A, når [Offset White <A>] er
indstillet til On.

Offset Tint<A> −99 til +99 ±0
Indstiller den farvetoneværdiforskydning, der skal føjes til
hvidbalancen i hukommelse A, når [Offset White <A>] er
indstillet til On.

Offset
White<ATW>

On / Off On
Vælger, om der skal tilføjes (On) eller ikke tilføjes (Off) en
forskydningsværdi til ATW-hvidbalancen.

Offset Color
Temp<ATW>

−99 til +99 ±0
Indstiller den farvetemperaturforskydning, der skal føjes til
ATW-hvidbalancen, når [Offset White<ATW>] er indstillet til
On.

Offset
Tint<ATW>

−99 til +99 ±0 Indstiller den farvetoneværdiforskydning, der skal føjes til ATW-
hvidbalancen, når [Offset White<ATW>] er indstillet til On.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Focus

Indstiller fokusindstillinger.

Relateret emne
Indstilling af autofokusområdet/-positionen (fokusområde)

Sporing ved hjælp af ansigts-/øje-registrering (Face/Eye Detection AF)

Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen

Manuel fokusering under autofokus vha. den medfølgende infrarøde fjernbetjening

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

AF Transition
Speed

1(Slow) / 2 / 3 / 4 / 5 /
6 / 7(Fast)

5
Indstiller hastigheden for fokusdrevet til når motivet ændres
under autofokus.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3 /
4 / 5(Responsive)

5(Responsive)
Indstiller følsomheden for ændring af motivfokus under
autofokus.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Indstiller målområdet for autofokus og skub autofokus (AF).

Se "Automatisk justering af fokus (autofokus)" og
"Indstilling af autofokusområdet/-positionen
(fokusområde)".

Wide: Søger efter et motiv over en bred vinkel af billedet, når
der fokuseres.
Zone: Søger automatisk efter et fokuspunkt inden for den
angivne zone.
Flexible Spot: Fokuserer på en angivet position i billedet.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Indstiller målområdet for skub autofokus (AF-S).

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF
/ Off

Face/Eye Priority
AF

Aktiverer/Deaktiverer ansigtsregistrering AF.

Se "Sporing ved hjælp af ansigts-/øje-registrering
(Face/Eye Detection AF)".

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Indstiller skub autofokus-tilstand.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Indstiller driften, når der røres ved kamerabilledet på
webappens skærm til live betjening i MF-tilstand.

AF Assist On / Off On

Når den er indstillet til On, kan du midlertidigt tilsidesætte
autofokus og indstille fokus manuelt.

Se "Indstilling af fokusmotivet manuelt (AF Assist) vha.
webappen" og "Manuel fokusering under autofokus vha.
den medfølgende infrarøde fjernbetjening".
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

S&Q Motion

Indstiller Slow & Quick Motion-indstillinger (se "Langsom og hurtig bevægelse").

Relateret emne

Langsom og hurtig bevægelse
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter tilstanden Slow & Quick Motion til On/Off.

Frame
Rate

1fps til 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Indstiller billedhastigheden for filmning med Slow &
Quick Motion.

Bemærk!

De tilgængelige indstillinger varierer afhængigt af
den valgte systemfrekvens, codec og videoformat.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

LUT On/Off

Indstiller LUT-indstillinger.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

SDI MLUT On / MLUT Off MLUT Off
Vælger, om der skal anvendes monitor LUT på
SDI-outputvideoen.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Vælger, om der skal anvendes Monitor LUT på
HDMI- og streaming-outputvideoen.

Proxy MLUT On / MLUT Off MLUT Off
Vælger, om der skal anvendes monitor LUT på
proxy-optagelsesvideo.

Internal Rec MLUT On / MLUT Off MLUT Off Vælger, om der skal anvendes Monitor LUT på
den primære optagelsesvideo.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI &
HDMI/Stream

HDMI/Stream
Indstiller mål-output styret af en tildelelig knap, der
er tildelt med LUT On/Off.
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Noise Suppression

Sætter indstillinger for støjreduktion.

Tip!

Indstillingerne for [Setting(Custom)] og [Level(Custom)] afspejles i [Target Display]-indstillingen.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting(Custom) On / Off On
Sætter støjreduktionsfunktionen til On/Off i
tilstanden Custom.

Level(Custom) Low / Mid / High Mid Sætter støjreduktionsniveauet i tilstanden Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Sætter støjreduktionsfunktionen til On/Off i Log-
optagelsestilstand.

Level (Cine EI/Flex.
ISO) Low / Mid / High Mid

Sætter støjreduktionsniveauet i Log-
optagelsestilstanden.
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Flicker Reduce

Sætter indstillinger for flimmerkorrektion.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Mode Auto / On / Off Off Indstiller tilstanden for flimmerkorrektion.

Frequency 50Hz / 60Hz 60Hz
Indstiller frekvensen for den strømkilde, der forsyner det lys, der
forårsager flimmer.
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SteadyShot

Sætter indstillinger for billedstabilisering.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting
Active / Standard /
Off

Off

Indstiller funktionen til billedstabilisering.

Bemærk!

Aktiveres når der monteres et kompatibelt objektiv.

Ved indstilling til Active eller Standard kan uventet adfærd forekomme
under panorering/hældning.
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Base Setting

Indstiller basisindstillinger.

Relateret emne

Konfiguration af grundlæggende betjening
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Indstiller optagelsestilstanden.

Se "Indstilling af optagelsestilstand" i
"Konfiguration af grundlæggende betjening".

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Indstiller farveskala for optagelse/output i tilstanden
Custom.
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Rec Format

Sætter indstillinger for optagelsesformat.

[RAW Output Format]-indstillinger

Standard værdier vises med fed.
Vilkårene under hvilke, [RAW Output Format] ikke kan indstilles, er udeladt.

[Video Format]-indstillinger

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Vælger systemfrekvensen.

Imager Scan
Mode

FF / S35 FF Vælger billeddanners størrelse.

Codec
RAW / RAW & XAVC-I / XAVC-I / XAVC-
L

XAVC-I

Indstiller Codec for klipoptagelse/-afspilning.

Bemærk!

Når [Imager Scan Mode] er indstillet til
[S35], kan [RAW] og [RAW & XAVC-I]
ikke vælges.

RAW Output
Format

De tilgængelige indstillinger varierer
afhængigt af indstillingerne for
[Frequency].

Se "[RAW Output Format]-
indstillinger" herunder.

–

Indstiller størrelsen af RAW-billedet til
output til en ekstern RAW-optager.

Bemærk!

Når [Codec] er indstillet til [RAW & XAVC-
I], skifter [Video Format]-indstillinger
sammen med indstillingen [RAW Output
Format].

Video
Format

De tilgængelige indstillinger varierer
afhængigt af indstillingerne for
[Frequency], [Imager Scan Mode] og
[Codec].

Se "[Video Format]-indstillinger"
herunder.

– Indstiller billedstørrelsen og bithastigheden.

Frequency Imager Scan Mode Codec Indstilling

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW/RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW/RAW & XAVC-I 4096×2160
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Standard værdier vises med fed.
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Frequency Imager Scan Mode Codec Indstilling

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I/XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Indstiller Log-optagelsestilstanden (se "Indstilling af optagelsestilstand" i "Konfiguration af grundlæggende betjening").

Relateret emne

Konfiguration af grundlæggende betjening
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Indstiller farveskalaen for Log-optagelsestilstande
([Flexible ISO], [Cine EI Quick], [Cine EI]).

Embed
LUT File

On / Off On Slår 3D LUT-fil (CUBE-fil) metadata optagelse til/fra.
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Simul Rec

Indstiller samtidige optagelsesindstillinger for 2 sprækker (se "Samtidig optagelse til hukommelseskort A og B (2-slot Simul
Rec)").
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off
Tænder/slukker for 2-slot
samtidig optagelsestilstand.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:<Slot
A> 2nd Rec Button:<Slot B> / Rec Button:
<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot
A> <Slot B>

Tildeler de optagelsesknapper,
der bruges til at betjene hvert
optagelsesmedie.
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Proxy Rec

Indstiller proxy-optagelsesindstillinger (se "Proxyoptagelse").
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter proxyoptagelsestilstanden til On/Off.

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 Vælger den lydkanal, der skal optages til proxydata.
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Interval Rec

Indstiller intervaloptagelsesindstillinger (se "Optagelse af video med afbrydelser (Interval Rec)").
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off

Sætter intervaloptagelsestilstand til
On/Off. (Hvis denne tilstand indstilles til
On, indstilles alle andre specialtilstande til
Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sek.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min.)
1 / 2 / 3 / 4 / 6 / 12 / 24 (time)

1
Indstiller intervallet mellem optagelser i
optagelsestilstanden Interval Rec (når
Interval Rec er indstillet til On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
De tilgængelige indstillinger varierer
afhængigt af rammefrekvensen for
det valgte videoformat.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Indstiller antallet af billeder, der skal tages
pr optagelse i optagelsestilstanden
Interval Rec (når Interval Rec er indstillet
til On).
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Picture Cache Rec

Indstiller optagelsestilstand for billedcache (se "Sådan optages cachede billeder (Picture Cache Rec)").

Relateret emne

Sådan optages cachede billeder (Picture Cache Rec)
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter billedcachefunktionen til On/Off.

Cache Size
Short / Medium /
Long / Max

Max
Indstiller tiden til akkumulering af billeder i
billedcachehukommelsen (billedcachens optagelsestid).

Cache Rec
Time

– –
Viser tiden til akkumulering af billeder i billedcachehukommelsen
(billedcachens optagelsestid).
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SDI/HDMI Rec Control

Sætter indstillingerne for optagelseskontrollen SDI/HDMI.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting
Off / SDI/HDMI
Remote I/F / Parallel
Rec

Off

Indstiller start/stop-styring af optagelse på en ekstern enhed via
SDI/HDMI-outputsignalet.
Off: Anvend ikke fjernbetjening.
SDI/HDMI Remote I/F: Start/Stop-styring af optagelse for en ekstern
tilsluttet enhed, når der ikke er indsat medier i enheden. Ikke
synkroniseret med billednøjagtighed til medie i enheden.
Parallel Rec: Start/Stop-styring af optagelse for en ekstern tilsluttet
enhed, når der er indsat medier i enheden. Synkroniseret med
billednøjagtighed til enhedsmedier.

Bemærk!

For styring vha. HDMI-outputsignal indstilles [TC/Media] > [HDMI TC
Out] > [Setting] til [On] i kameramenuen.
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Assignable Button

Indstiller funktionsopgaver til tildelelige knapper (<1> til <9>) og [Focus Hold Button].
Følgende funktioner kan tildeles.
[Off]: Ingen funktionsopgave.
[Base ISO/Sensitivity]: Skifter billedsensorens basisfølsomhed.
[AGC]: Sætter AGC-funktionen til On/Off.
[Push AGC]: Aktiverer AGC-funktionen, mens der trykkes på knappen.
[ND Filter]

I variabel tilstand: Justerer ND-filtertransmittansen. Tryk og hold nede for at skifte mellem Clear/Manual/Auto.
I forindstillet tilstand: Tryk og hold nede for at skifte forindstillinger.

[ND Filter Position]: Skifter ND-filtre.
[Auto ND Filter]: Sætter den automatiske ND-filterfunktion til On/Off.
[Push Auto ND]: Aktiverer automatisk ND-filterfunktionen, mens der trykkes på knappen.
[Auto Iris]: Sætter irisfunktionen til On/Off.
[Push Auto Iris]: Aktiverer den automatiske iris-funktion, mens der trykkes på knappen.
[Bokeh Control]: Slår bokeh-kontrolfunktionen til/fra.
[Auto Shutter]: Sætter den automatiske shutter-funktion til On/Off.
[AE Level/Mode]: Justerer AE-niveauet. Tryk og hold nede for at skifte AE-tilstanden.
[Backlight]: Skifter mellem Backlight og Standard.
[Spotlight]: Skifter mellem Spotlight og Standard.
[Preset White Select]: Skifter den forindstillede værdi for hvidbalance.
[ATW]: Sætter ATW-funktionen til/fra.
[ATW Hold]: Sætter driften af ATW-funktionen på pause.
[AF Speed/Sens.]: Skifter indstilling for AF-overgangshastighed og indstilling for AF-motivskiftfølsomhed.
[Focus Setting]: Indstiller fokusområdet.
[Face/Eye Detection AF]: Skifter ansigtsregistrerings AF-indstillinger.
[Push AF Mode]: Skifter indstillingen for tilstanden Push AF.
[Push AF/MF]: I MF-fokustilstand aktiveres AF, mens der trykkes på knappen. I AF-fokustilstand aktiveres MF, mens der
trykkes på knappen.
[Focus Hold]: I AF-fokustilstand er fokus fast, mens der trykkes på knappen.
[S&Q Motion]: Sætter tilstanden Slow & Quick Motion til On/Off. Indstiller optagelseshastigheden, når du trykker og holder
den nede.
[LUT On/Off]: Sætter LUT-funktionen til On/Off. Det skiftende mål indstilles vha. [Shooting] > [LUT On/Off] > [LUT On/Off
Button Target].
[SteadyShot]: Skifter mellem Active, Standard og Off.
[Crop Select]: Skifter Imager Scan Mode. Skift aktiveret inden for intervallet uden at ændre optagelsesformatet.
[Rec]: Starter/stopper optagelse.
[Picture Cache Rec]: Sætter billedcachens optagelsestilstand til On/Off.
[Rec Review]: Sætter optagelsesgennemgangsfunktionen til On/Off.
[Clip Flag OK]: Udfører Add OK. Tryk to gange for at udføre Delete Clip Flag.
[Clip Flag NG]: Udfører Add NG. Tryk to gange for at udføre Delete Clip Flag.
[Clip Flag Keep]: Udfører Add KEEP. Tryk to gange for at udføre Delete Clip Flag.
[Slot Select]: Skifter mellem hukommelsessprække (A) og (B).
[Color Bars]: Sætter farvebjælkerne til On/Off.
[DURATION/TC/U-BIT]: Skifter mellem Time Code, Users Bit og Duration.
[Display]: Sætter skærmindikatorerne til On/Off.
[Lens Info]: Skifter indikatoren for feltets dybde.
[Video Signal Monitor]: Skifter videosignalmonitoren (f.eks. en kurveformsmonitor).
[Marker]: Sætter markørfunktionen til On/Off.
[Thumbnail]: Viser/Forlader miniatureskærmen.
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[Auto Upload (Proxy)]: Sætter automatisk overførsel af proxy-filer til On/Off.
[Direct Menu]: Viser/Forlader den direkte menu.
[User Menu]: Viser/forlader User-menuen.
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Scene File

Indstillinger relateret til scenefiler (se "Filmning med det ønskede udseende").
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Recall – –

Indlæser en Scene-fil, der er gemt i den
interne hukommelse, og anvender
indstillingerne som de aktuelle indstillinger for
billedkvalitet.

Store – –
Gemmer den aktuelle billedkvalitetstilstand
som en Scene-fil i den interne hukommelse.

Delete – – Sletter en Scene-fil, der er gemt i den interne
hukommelse.

Preset
Recall

Når Shooting Mode er indstillet til
Custom og Target Display er indstillet til
SDR(BT.709): S-Cinetone / Standard / Still
/ ITU709/ 709tone
Når Shooting Mode er indstillet til
Custom og Target Display er indstillet til
HDR(HLG): HLG Live / HLG Natural

–
Anvender forudindstillede indstillinger for
billedkvalitet (ikke-genskrivelige) som de
aktuelle indstillinger for billedkvalitet.
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Base Look

Angiver indstillinger, der er relateret til basisudseendet.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Select

Når Shooting Mode er indstillet til
Custom og Target Display er
indstillet til SDR(BT.709): S-
Cinetone / Standard / Still / ITU709
709tone/ User1 til User16
Når Shooting Mode er indstillet til
Custom og Target Display er
indstillet til HDR(HLG): HLG Live /
HLG Natural / User1 til User16
Når Shooting Mode er indstillet til
Log-optagelsestilstand: s709 /
709(800) / S-Log3 / User1 til User16

Når Shooting Mode er
indstillet til Custom og Target
Display er indstillet til
SDR(BT.709): S-Cinetone
Når Shooting Mode er
indstillet til Custom og Target
Display er indstillet til
HDR(HLG): HLG Live
Når Shooting Mode er
indstillet til Log-
optagelsestilstande: s709

Vælger et basisudseende.

Delete – – Sletter det valgte basisudseende.

Delete
All

– – Sletter alle basisudseender.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Indstiller input gamut for det valgte
basisudseende vha. [Select].

Output BT.709 / HLG BT.709
Indstiller output farvegamut for det
valgte basisudseende vha. [Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Indstiller
eksponeringsreferenceværdien for
det valgte basisudseende vha.
[Select].
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Reset Paint Settings

Nulstiller menuindstillingerne [Paint/Look], undtagen basisudseendet.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Reset without Base
Look

Execute / Cancel –
Nulstiller menuindstillingerne [Paint/Look], undtagen
basisudseendet.
Execute: Udfør funktion.
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Black

Indstiller sorte indstillinger.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Master Black −99.0 til +99.0 ±0.0 Indstiller masternivauet for sort.

R Black −99.0 til +99.0 ±0.0 Indstiller R-sort-niveauet.

B Black −99.0 til +99.0 ±0.0 Indstiller B-sort-niveauet.
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Knee

Sætter indstillinger for knækorrektion.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting

Når Target Display er
indstillet til SDR(BT.709):
On / Off / ---
Når Target Display er
indstillet til HDR(HLG): On /
Off / ---

Når Target Display er
indstillet til
SDR(BT.709):Off
Når Target Display er
indstillet til HDR(HLG): Off

Sætter funktionen knækorrektion til On/Off.

Bemærk!

Kun aktiveret, når [Base Look] > [Select] er
indstillet til [Standard], [ITU709], [709tone],
[HLG Live], eller [HLG Natural].

Auto
Knee

Når Target Display er
indstillet til SDR(BT.709):
On / Off / ---
Når Target Display er
indstillet til HDR(HLG): On /
Off / ---

Når Target Display er
indstillet til
SDR(BT.709):On
Når Target Display er
indstillet til HDR(HLG): Off

Sætter den automatiske knæfunktion til On/Off.

Bemærk!

Kun aktiveret, når [Base Look] > [Select] er
indstillet til [Standard], [ITU709], eller
[709tone].

Point 75% til 109% 90% Indstiller knæpunktet.

Slope −99 til +99 ±0 Indstiller knæets hældning.
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Detail

Angiver indstillinger for justering af detaljer.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off On Sætter detaljefunktionen til On/Off.

Level −7 til +7 ±0 Indstiller detaljeniveauet.

Manual
Setting

On / Off / --- Off Sætter funktionen til manuel justering af detaljer til On/Off.

H/V Ratio −2 til +2 ±0

Indstiller balancen mellem horisontal (H) detalje og vertikal (V)
detalje for manuel justering af detaljer.

Bemærk!

Dette punkt varierer afhængigt af softwareversionen.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Indstiller balancen mellem sorte (B) detaljer for områder med lav
luminans og hvide (W) detaljer for områder med høj luminans for
manuel justering af detaljer.

Limit 0 til 7 7
Indstiller grænseniveauet for detaljen for manuel justering af
detaljer.

Crispening 0 til 7 0 Indstiller klarhedsniveauet for manuel justering af detaljer.

High Light
Detail

0 til 4 0
Indstiller detaljeniveauet for områder med høj luminans for
manuel justering af detaljer.

I softwareversion 1.00 er menupunktet [V/H Balance]. I softwareversion 1.10 eller nyere er menupunktet [H/V Ratio]. Indstillingsintervallet er uændret
fra −2 til 0 til +2, men effekten på billedkvaliteten er forskellig.
Softwareversion 1.00: Jo højere den indstillede værdi er, desto højere er den horisontale (H) detalje.
Softwareversion 1.10 eller nyere: Jo højere den indstillede værdi er, desto højere er den vertikale (V) detalje.
Efter opdatering fra softwareversion 1.00 til 1.10 eller nyere overtages [All File], [Scene File] og andre indstillinger, men med omvendt polaritet
(billedkvaliteten bevares).
Hvis du har registreret menupunktet [V/H Balance] i menuen [User], vil det automatisk blive erstattet af menupunktet [H/V Ratio] i menuen [User] efter
opdatering af softwaren.

*1
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Matrix

Sætter indstillinger for matrix-korrektion.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

User Matrix On / Off Off Sætter funktionen brugermatrix-korrektion til On/Off.

User Matrix Level −99 til +99 ±0 Justerer farvemætningen for hele billedet.

User Matrix Phase −99 til +99 ±0 Justerer farvetonen (fase) for hele billedet.

User Matrix R-G −99 til +99 ±0 Indstiller en brugerdefineret R-G-brugermatrix.

User Matrix R-B −99 til +99 ±0 Indstiller en brugerdefineret R-B-brugermatrix.

User Matrix G-R −99 til +99 ±0 Indstiller en brugerdefineret G-R-brugermatrix.

User Matrix G-B −99 til +99 ±0 Indstiller en brugerdefineret G-B-brugermatrix.

User Matrix B-R −99 til +99 ±0 Indstiller en brugerdefineret B-R-brugermatrix.

User Matrix B-G −99 til +99 ±0 Indstiller en brugerdefineret B-G-brugermatrix.
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Multi Matrix

Sætter indstillinger for multimatrix-korrektion.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off
Sætter funktionen multimatrix-korrektion til
On/Off.

Reset Execute / Cancel –
Nulstiller farvetonen og -mætningen for hver
aksefarve til standardværdierne.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− /
YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Vælger Axis.

Hue −99 til +99 ±0 Indstiller farvetonen for den farve, der bruges
til Multi Matrix-korrektion.

Saturation −99 til +99 ±0
Indstiller mætningen af den farve, der bruges
til Multi Matrix-korrektion.

318
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Interchangeable Lens Digital Camera
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P/T Acceleration

Indstillinger relateret til acceleration for panorerings-/hældningsfunktioner.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Ramp
Curve

1 til 9 8
Indstiller acceleration/deceleration for
panorerings-/hældningsfunktioner. Jo større antallet er, desto højere er
accelerationen.
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Timecode

Sætter indstillinger for tidskode.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Mode Preset / Regen / Clock Preset

Indstiller driftstilstanden tidskode.
Preset: Starter driften fra en forudindstillet værdi.
Regen: Starter driften fra tidskoden for enden af det forrige
klip.
Clock: Bruger det interne ur som tidskode.

Run Rec Run / Free Run Rec Run Rec Run: Kører kun under optagelse.
Free Run: Kører altid, uanset optagelsesfunktionen.

Setting – –
Indstiller tidskoden til en vilkårlig værdi.
Set: Indstil værdien.

Reset Execute / Cancel –
Nulstiller tidskoden til 00:00:00:00.
Execute: Udfør funktion.

TC
Format

DF / NDF DF
Indstiller tidskode-formatet.
DF: Drop-billede
NDF: Ikke-drop-billede
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TC Display

Sætter indstillinger for visning af tidsdata.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Display Select Timecode / Users Bit / Duration Timecode Skifter visning af tidsdata.
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Interchangeable Lens Digital Camera
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Users Bit

Angiver indstillinger, der er relateret til bruger-bit.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Mode Fix / Time Fix

Indstiller bruger-bit-tilstand.
Fix: Bruger en vilkårlig fast værdi i bruger-bits.
Time: Bruger den aktuelle time, det aktuelle minut og det aktuelle
sekund i bruger-bits.

Setting – – Indstiller bruger-bit til en vilkårlig værdi.
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HDMI TC Out

Angiver indstillinger relateret til tidskode-output ved brug af HDMI.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off
Angiver, om tidskoden skal sendes til enheder til andre formål, ved
hjælp af HDMI.
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Interchangeable Lens Digital Camera
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Clip Name Format

Sætter indstillinger relateret til navngivning og sletning af klip.
Når [Auto Naming] er indstillet til [Cam ID + Reel#], bestemmes de første fire tegn af klipnavne for hvert optagelsesmedie.
Når et nyt optagelsesmedie indsættes, eller når det seneste klip på optagelsesmediet ikke stemmer overens med [Camera
ID] eller [Reel Number] indstillingerne, blinker klipnavnet for at underrette dig.
Når [Auto Naming] er indstillet til [Title], kan du bruge en vilkårlig tegnstreng, som den første del af klipnavnet.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Auto
Naming

Kam-ID + spolenr. / Title

Vælger klipnavnets format.
Kam-ID + spolenr.: Kamera-ID + spolenummer +
billednummer + dato + vilkårlig streng
Title: Vilkårlig streng angivet af [Title Prefix] + klipnummer

Camera
ID

A til Z A

Indstiller kamera-ID, der anvendes til at generere klipnavne.

Bemærk!

Kan kun konfigureres, når [Auto Naming] er indstillet til [Cam
ID + Reel#].

Reel
Number

001 til 999 001

Indstiller spolenummerdelen, der anvendes til at generere
klipnavne.

Bemærk!

Kan kun konfigureres, når [Auto Naming] er indstillet til [Cam
ID + Reel#].

Camera
Position

C / L / R C

Indstiller den første del af tegnet for billednummer, der
anvendes til at generere klipnavne.

Bemærk!

Kan kun konfigureres, når [Auto Naming] er indstillet til [Cam
ID + Reel#].

Title
Prefix

nnn_(nnn er de sidste 3
cifre i serienummeret)
(Maks. 7-cifret skærm)

nnn

Indstiller titeldelen (4 til 46 tegn) af klipnavnet.
Åbner skærm til angivelse af en tegnstreng.

For yderligere oplysninger om indstilling af titler og
tegnindtastningsskærmen, se "For at indstille titlen"
nedenfor og "Angivelse af en tegnstreng".

Bemærk!

Kan kun konfigureres, når [Auto Naming] er indstillet til [Title].
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Til indstilling af [Title Prefix]

Relateret emne
Angivelse af en tegnstreng
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Number
Set

0001 til 9999 0001

Sætter det 4-cifrede talsuffiks for klipnavnet.

Bemærk!

Kan kun konfigureres, når [Auto Naming] er indstillet til [Title].

Vælg tegnet for at indsætte markørpositionen i området [Title Prefix] fra tegnvalgområdet vha. piletasterne i
GUI-kontrolpanelet (tegn er fremhævet), og tryk på [Set]-knappen i GUI-kontrolpanelet.

Det valgte tegn indsættes, og markøren flyttes til højre.

1

Gentag trin 1 for at indstille titlen.

Brug [BS] efter behov.

2

Når du har indstillet titlen, tryk på [Done] for at lukke skærmen til angivelse af tegn.

For info om drift på tegnindtastningsskærmen se "Angivelse af en tegnstreng".

Følgende tegn kan vælges.
!#$%()+.-.;=@[ ]^_~ mellemrum
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Interchangeable Lens Digital Camera
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Update Media

Opdaterer ledelsesfilen på hukommelseskort (se "Gendannelse af hukommelseskort").

Relateret emne

Gendannelse af hukommelseskort
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Media(A) Execute / Cancel –
Opdaterer administrationsfilen på hukommelseskortet i
sprække A.
Execute: Udfør funktion.

Media(B) Execute / Cancel –
Opdaterer administrationsfilen på hukommelseskortet i
sprække B.
Execute: Udfør funktion.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Format Media

Formaterer (initialiserer) hukommelseskort (se "Formatering (initialisering) af hukommelseskort").

Relateret emne
Formatering (initialisering) af hukommelseskort
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Media(A) Full Format / Quick Format / Cancel – Formaterer hukommelseskortet i sprække A.

Media(B) Full Format / Quick Format / Cancel – Formaterer hukommelseskortet i sprække B.
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Interchangeable Lens Digital Camera
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Media Life

Viser hukommelseskortenes resterende liv.

Bemærk!

Kræver hukommelseskort, der understøtter visning af resterende medieliv.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Media(A) – – Viser det resterende liv på hukommelseskortet i sprække A.

Media(B) – – Viser det resterende liv på hukommelseskortet i sprække B.
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Interchangeable Lens Digital Camera
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Output Format

Angiver indstillinger for outputformat.

Relateret emne
Output-formater og -begrænsninger
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

SDI For yderligere oplysninger om indstillinger se "Output-
formater og -begrænsninger".

– Indstiller opløsningen for SDI- og
HDMI-output.HDMI –
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display On/Off

Sætter indstillinger for visningselementer.
Vælg On for at vise et skærmpunkt. Vælg Off for at skjule et skærmpunkt.

Punkt Indstilling af underpunkt Fabriksstandard

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

Auto Exposure Mode On / Off On
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Punkt Indstilling af underpunkt Fabriksstandard

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Interchangeable Lens Digital Camera
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Video Signal Monitor

Indstiller videosignalmonitor.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting Off / Waveform / Vector / Histogram Off Indstiller type for videosignalmonitor.

Level Marker 1 0% til 109% 70% Indstiller niveauet af luminans niveaumarkør 1.

Level Marker 2 0% til 109% 100% Indstiller niveauet af luminans niveaumarkør 2.
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Interchangeable Lens Digital Camera
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Marker

Indstiller markørvisningsindstillinger.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off On Sætter visningen af alle markører til On/Off.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Vælger farven på markørsignalet.

Center
Marker

1 / 2 / 3 / 4 / Off Off Vælger midtermarkøren.

Safety
Zone

On / Off Off Sætter sikkerhedszonemarkøren til On/Off.

Safety Area 80% / 90% / 92.5% / 95% 90%
Vælger størrelsen af sikkerhedszonemarkøren
(som en procentdel af den samlede
skærmstørrelse).

Aspect
Marker

Line / Mask / Off Off Vælger formatmarkørtypen.

Aspect
Mask

0 til 15 12
Indstiller niveauet for videosignalet uden for
markøren.

Aspect
Safety
Zone

On / Off Off Sætter formatsikkerhedszone-markøren til On/Off.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Vælger størrelsen af formatsikkerhedszone-
markøren (som en procentdel af den samlede
skærmstørrelse).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9
/ 17:9 / 1,66:1 / 1,85:1 / 2,35:1 /
2,39:1 / Custom

2.39:1 Indstiller tilstanden, når formatmarkøren vises.

Custom
Aspect
Ratio

Indtast et tilfældigt tal. 01.00:01.00

Indstiller formatforholdet til en vilkårlig værdi.

Bemærk!

Aktiveret når [Aspect Select] er indstillet til
[Custom].

Guide
Frame

On / Off Off Sætter guidebilledvisning til On/Off.

100%
Marker

On / Off Off Sætter 100% -markøren til On/Off.

User Box On / Off Off Sætter brugerboksmarkør-visningen til On/Off.

User Box
Width

3 til 479 240
Indstiller brugerboksens markørbredde (afstand fra
midten til venstre og højre kant).
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

User Box
Height

3 til 269 135
Indstiller brugerboksens markørhøjde (afstand fra
midten til øverste og nederste kant).

User Box H
Position

−476 til +476 0
Indstiller den horisontale position for midten af
brugerboksens markør.

User Box V
Position

−266 til +266 0
Indstiller den vertikale position for midten af
brugerboksens markør.
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Interchangeable Lens Digital Camera
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Audio Input

Angiver indstillinger for lydinput.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

AUDIO IN
Select

MIC / LINE MIC Vælger typen af enhed forbundet til AUDIO IN-stikket.

Phantom
Power +48V

On / Off Off Viser status af +48 V phantom power-strømforsyning.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Viser inputkilden til optagelse på kanal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Skifter inputkilden til optagelse på kanal 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1 Skifter inputkilden til optagelse på kanal 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Skifter inputkilden til optagelse på kanal 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Indstiller referenceoptagelsesniveauet for XLR-mikrofoninput
fra AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Indstiller referenceoptagelsesniveauet for XLR-mikrofoninput
fra AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Vælger referenceinputniveauet, når [AUDIO IN Select] er
indstillet til LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB Vælger optagelsesniveauet for 1 kHz-referencetonesignalet.

CH1 Wind
Filter

On / Off Off
Aktiverer/Deaktiverer vindreduktionsfilteret til optagelse på
kanal 1.

CH2 Wind
Filter

On / Off Off
Aktiverer/Deaktiverer vindreduktionsfilteret til optagelse på
kanal 2.

CH3 Wind
Filter

On / Off Off
Aktiverer/Deaktiverer vindreduktionsfilteret til optagelse på
kanal 3.

CH4 Wind
Filter

On / Off Off Aktiverer/Deaktiverer vindreduktionsfilteret til optagelse på
kanal 4.

CH1 Level
Control

Auto / Manual Auto
Vælger automatisk justering af lydinputniveau eller manuel
justering for optagelse på kanal 1.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

CH2 Level
Control

Auto / Manual Auto
Vælger automatisk justering af lydinputniveau eller manuel
justering for optagelse på kanal 2.

CH3 Level
Control

Auto / Manual Auto
Vælger automatisk justering af lydinputniveau eller manuel
justering for optagelse på kanal 3.

CH4 Level
Control

Auto / Manual Auto
Vælger automatisk justering af lydinputniveau eller manuel
justering for optagelse på kanal 4.

CH1 Input
Level

0 til 99 49 Indstiller inputniveauet for optagelse på kanal 1.

CH2 Input
Level

0 til 99 49 Indstiller inputniveauet for optagelse på kanal 2.

CH3 Input
Level

0 til 99 49 Indstiller inputniveauet for optagelse på kanal 3.

CH4 Input
Level

0 til 99 49 Indstiller inputniveauet for optagelse på kanal 4.

Master Input
Level

0 til 99 99 Indstiller master lydinputniveauet.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Vælger begrænseregenskaben for store inputsignaler, når
lydinputniveauet justeres manuelt.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Indstiller tilstanden for automatisk justering af niveau for
optagelse på kanal 1 og kanal 2. Når indstillet til Stereo, er
AGC forbundet mellem kanaler.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Indstiller tilstanden for automatisk justering af niveau for
optagelse kanal 3 og kanal 4. Når indstillet til Stereo, er AGC
forbundet mellem kanaler.

AGC Spec
−6dB / −9dB / −12dB
/ −15dB / −17dB

−6dB Vælger AGC-egenskaben.

1kHz Tone on
Color Bars

On / Off Off

Sætter 1 kHz-referencetonesignalet til On/Off, når der vises
farvebjælker.

Bemærk!

Når den er indstillet til [On], indstilles 1 kHz-
referencetonesignalet til optagelse på kanal 3 og kanal 4, selv
om [CH3 Input Select] og [CH4 Input Select] er indstillet til
[Off].
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Sætter indstillinger for lydoutput.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

HDMI/Stream Output
CH

CH1/CH2 / CH3/CH4 CH1/CH2
Indstiller kombinationen af lydkanaler for
HDMI-/streaming-output.
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Interchangeable Lens Digital Camera
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Display Clip Properties

Viser skærmen med klipegenskaber.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Display Clip Properties – – Viser skærmen med klipegenskaber.
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Interchangeable Lens Digital Camera
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Set Clip Flag

Sætter indstillinger for klipmærke.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Add OK – – Tilføjer et OK-mærke.

Add NG – – Tilføjer et NG-mærke.

Add KEEP – – Tilføjer et KEEP-mærke.

Delete Clip Flag – – Sletter alle mærker.
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Interchangeable Lens Digital Camera
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Lock/Unlock Clip

Sætter indstillinger for klipbeskyttelse.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Select Clip – – Vælger og låser/oplåser et klip.

Lock All Clips – – Låser alle klip.

Unlock All Clips – – Oplåser alle klip.
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Interchangeable Lens Digital Camera
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Delete Clip

Sletter klip.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Select Clip – – Sletter det valgte klip.

All Clips – – Sletter alle klip.
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Interchangeable Lens Digital Camera
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Transfer Clip

Overfører klip.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Select Clip – – Overfører valgte klip.

All Clips – –

Overfører alle klip.

Bemærk!

Der kan registreres op til 200 overførselsjob.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip (Proxy)

Overfører proxyklip.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Select Clip – – Overfører proxyklip svarende til de valgte klip.

All Clips – –

Overfører proxyklip, der svarer til alle klippene.

Bemærk!

Der kan registreres op til 200 overførselsjob.
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Interchangeable Lens Digital Camera
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Filter Clips

Sætter indstillinger for klip, der skal vises.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

OK – – Vis kun klip, der har et OK-mærke.

NG – – Vis kun klip, der har et NG-mærke.

KEEP – – Vis kun klip, der har et KEEP-mærke.

None – – Vis kun klip, der ikke har et mærke.

All – – Viser alle klip, uanset om der er nogen mærker.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Customize View

Skifter skærmvisningen for miniaturen.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Skifter de oplysninger, der vises under
miniaturer.
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Interchangeable Lens Digital Camera
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Color Bars

Sætter indstillinger for farvebjælke.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter farvebjælkerne til On/Off.

Type ARIB / 100% / 75% / SMPTE ARIB Vælger farvebjælketypen.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Genlock

Konfigurerer genlock-statusdisplay (se "Synkronisering af videosignalets fase (genlock))".

Relateret emne
Synkronisering af videosignalets fase (genlock)
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Reference Internal / External(HD) / External(SD) – Viser genlock-referencesignalets type.

347



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Indstiller optagelse/tally lampeindstillinger (se "Tilslutning af tally-signal").

Relateret emne

Tilslutning af tally-signal
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Tally Lamp
Brightness

High / Low / Off High Indstiller lysstyrke af optagelses-/tally-lampen.

G Tally Lamp Enable / Disable Enable Aktiverer/deaktiverer G-tally-lampen.

Tally Control External / Internal Internal

Vælger målet for accept af enhedens optagelses-/tally-
lampestyringsinformation.
External: Tally-styring fra udenfor kameraet.
Internal: Styring via kameraoptagelsesfunktion.
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Rec Review

Indstiller optagelsesgennemgang (se "Gennemsyn af optagelse (Rec Review)").

Relateret emne

Gennemsyn af optagelse (Rec Review)
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting 3s / 10s / Clip 3s
Indstiller tid for afspilning af klip, der lige er optaget til
optagelsesgennemsyn.
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Zoom

Indstiller zoom-indstillinger ("Justering af zoom").
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Indstiller typen af zoom.
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Lens

Sætter indstillinger, der er relateret til objektiver.

Relateret emne
Åndedrætskompensation
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Lens Calibration Execute / Cancel –
Udfører den funktion, der retter forskelle i zoompositionen
pga. forskelle i individuelle objektiver ved brug af et power
zoom-objektiv.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Indstiller retningen for zoomringsbetjening.

Bemærk!

Kun aktiveret ved brug af et E-mount-objektiv, der
understøtter skift af retning for zoomring.

Shading
Compensation

Auto / Off Auto Indstiller den automatiske kompensation for skygge.

Chroma
Aberration Comp.

Auto / Off Auto
Indstiller den automatiske kompensation for kromatisk
aberration.

Distortion Comp. Auto / Off Auto Indstiller den automatiske kompensation for forvrængning.

Breathing
Compensation

Auto / Off Off
Indstiller objektivets åndedrætskompensation.

Se "Åndedrætskompensation".

Distance Display Meter / Feet Meter
Indstiller visningsenhederne til objektivoplysninger og
fokusposition.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Indstiller visningsformatet for zoompositionen.
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APR

Udfører APR.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

APR Execute / Cancel –

Kører APR (Automatic Pixel Restoration) for automatisk justering af
billedsensoren.
Execute: Udfør funktion.

Bemærk!

Sæt altid objektivdækslet på, før APR køres.
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Wired LAN

Sætter indstillinger, der er relateret til kabelbaserede LAN-forbindelser.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

HTTP Port – 80 Viser HTTP-adgangsporten.

Detail
Settings

– –
Viser egenskaberne for den kabelbaserede LAN-
forbindelse.

DHCP
On / Off

On Viser, om DHCP er aktiveret (On) eller deaktiveret (Off).

IP Address – Viser enhedens IP-adresse, når [DHCP] er indstillet til
[Off].

Subnet Mask –
Viser enhedens undernetmaske, når [DHCP] er indstillet til
[Off].

Gateway – Viser standardgateway, når [DHCP] er indstillet til [Off].

DNS Auto
On / Off

On Viser indstilling for automatisk DNS.
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File Transfer

Indstillinger relateret til filoverførsler (se "Om filoverførsel").

Relateret emne

Om filoverførsel
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Auto Upload
(Proxy)

On / Off Off Tænder/slukker for automatisk upload af proxy-fil.

Default
Upload
Server

Server Settings1 til
3 > Display Name

–

Vælger overførselsserveren for filer. Den server, der vælges her,
bliver destinationen for automatisk overførsel af proxyfiler og
destinationen for overførsel af filer fra miniatureskærmen.
Viser indstillingerne [Display Name] konfigureret i [Server
Settings1 til 3].

Clear
Completed
Jobs

Execute / Cancel –
Rydder fuldførte overførselsjob fra listen.
Execute: Udfør funktion.

Clear All Jobs Execute / Cancel –
Rydder alle overførselsjob fra listen.
Execute: Udfør funktion.

View Job List – – Viser listen over overførselsjob.
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Language

Indstiller visningsproget.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Select – –
Indstiller visningsproget.
Set: Indstil værdien.
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Clock Set

Indstiller interne urindstillinger.

Bemærk!

Når denne indstilling ændres fra kameramenuen, skal du slukke for strømmen til enheden og genstarte enheden. Der kan opstå
uventet adfærd, hvis strøm-standby igangsættes ved brug af den infrarøde fjernbetjening eller webappen.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Time Zone UTC− 12:00 til UTC + 14:00 –
Indstiller tidsforskellen fra UTC i enheder på 30
minutter.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY YYMMDD

Vælger visningsformatet for datoer.
YYMMDD: År, måned, dag
MMDDYY: Måned, dag, år
DDMMYY: Dag, måned, år

12H/24H 12H / 24H 24H
Vælger visningsformatet for uret.
12H: 12-timerstilstand
24H: 24-timerstilstand

Date – –
Indstiller den aktuelle dato.
Set: Indstil værdien.

Time – –
Indstiller det aktuelle klokkeslæt.
Set: Indstil værdien.
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Hours Meter

Viser den akkumulerede driftstid.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Hours(System) – – Viser de akkumulerede driftstimer (kan ikke nulstilles).

Hours(Reset) – – Viser de akkumulerede driftstimer (kan nulstilles).

Reset Execute / Cancel –
Nulstiller den akkumulerede kørselstid til 0.
Execute: Udfør funktion.
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ISO/Gain Indstillinger og standardværdier

Intervallet af [ISO/Gain<L>]-indstillinger og standardværdier varierer afhængigt af [Mode], [Base Look] > [Select] og [Base
Sensitivity]-indstillinger.
Standardværdier i tabellerne vises med fed.

Når [Mode] er indstillet til [ISO]

Når [Base Look] > [Select] er indstillet til [S-Cinetone], [Standard], [ITU709], [709tone] eller [Still]

Når [Base Look] > [Select] er indstillet til [HLG Live] eller [HLG Natural]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[Low]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Når [Base Look] > [Select] er indstillet til [User1] til [User16]

Når [Mode] er indstillet til [dB]

Et tal i intervallet −3dB til +30dB i 1dB stigninger kan konfigureres.
Standardværdien er 0dB.
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Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[Low]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[Low]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit Indstillinger og standardværdier

Intervallet af [AGC Limit]-menuindstillinger og standardværdier varierer afhængigt af [Mode], [Base Look] > [Select] og [Base
Sensitivity]-indstillingerne.
Standardværdier i tabellerne vises med fed.

Når [Mode] er indstillet til [ISO]

Når [Base Look] > [Select] er indstillet til [S-Cinetone], [Standard], [ITU709], [709tone] eller [Still]

Når [Base Look] > [Select] er indstillet til [HLG Live] eller [HLG Natural]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[Low]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[Low]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Når [Base Look] > [Select] er indstillet til [User1] til [User16]

Når [Mode] er indstillet til [dB]

Vælg fra 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Standardværdien er 15dB.
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Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[Low]

Når [ISO/Gain/EI] > [Base Sensitivity] er indstillet til
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Indstillinger for billedkvalitet, der gemmes for hver optagelsestilstand

Den aktuelle status for konfigurationspunkter relateret til billedkvalitet gemmes for hver af følgende optagelsestilstande. Når
du ændrer optagelsestilstand, anvendes de tilsvarende indstillinger, der er gemt, som måloptagelsestilstand.

Custom-tilstand SDR(BT.709) målskærm
Custom-tilstand HDR (HLG) målskærm
Log-optagelse (Cine EI, Cine EI Quick, Flexible ISO)

De konfigurationspunkter relateret til billedkvalitet, der gemmes for hver optagelsestilstand, vises i de følgende tabeller.
"Ja" angiver, at en indstilling er gemt, og "Nej" angiver, at en indstilling ikke er gemt. "Ja" over flere kolonner indikerer fælles
indstillinger.

Punkt

Optagelsestilstand

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Optagelsesmenu

ISO/Gain/EI

ISO/Gain Ja1) Ja Nej

Exposure Index Nej Nej Ja Ja

Base Sensitivity Ja Nej

Base ISO Nej Ja4) Nej3) Ja4)

White
Preset White Ja Ja

Andet end ovenfor Ja

White Setting Ja

Offset White Ja Nej

LUT On/Off Nej Ja

Noise
Suppression

Setting(Custom) Ja Ja Nej

Level(Custom) Ja Ja Nej

Setting (Cine EI/Flex.
ISO)

Nej Ja

Level (Cine EI/Flex.
ISO)

Nej Ja
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Punkt

Optagelsestilstand

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look-menu

Base Look

Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE
niveauforskydning2) Ja

Black Ja Ja Nej

Knee
Auto Knee Ja Nej Nej

Andet end ovenfor Ja Ja Nej

Detail Ja Ja Nej

Matrix Ja Ja Nej

Multi Matrix Ja Ja Nej

Separate ISO-følsomhedsindstillinger gemmes for både Custom-tilstand SDR(BT.709) og HDR (HLG).1)

Indstillinger gemmes for hver basisudseende og afhænger ikke af optagelsestilstanden.2)

Basis ISO følsomhedsændringer i forbindelse med eksponeringsindeks.3)

Almindelig indstillingsværdi i Flexible ISO og Cine EI optagelsestilstande.4)
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Konfiguration af webmenu

Tryk på [Settings]-driftsskærmens skiftefane for at vise skærmen med indstillinger.
Brug skærmen indstillinger til at konfigurere de forskellige opsætningspunkter på enheden, inklusive de første indstillinger,
netværksindstillinger, optagelses-/afspilningsindstillinger vha. webmenuen.

Menuen består af følgende menuer.

Menukonfiguration og hierarki

Niveau 1 Niveau 1 beskrivelse Niveau 2

Shooting Indeholder indstillinger relateret til filmning. Focus

Project Indeholder grundlæggende projektindstillinger.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File
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Niveau 1 Niveau 1 beskrivelse Niveau 2

Paint/Look Indeholder indstillinger relateret til billedkvalitet. Base Look

Pan-Tilt Indeholder indstillinger relateret til panorering/hældning.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Indeholder indstillinger relateret til video-output og skærmvisning.
Output Format

Output Display

Audio Indeholder indstillinger relateret til lyd. Audio

Technical Indeholder indstillinger for tekniske elementer.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Indeholder indstillinger relateret til netværk.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection

Stream Indeholder indstillinger relateret til streaming.

Stream

Video Stream

Audio Stream
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Bemærk!

[Accessibility] er kun tilgængelig på modeller til Nordamerika.
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Niveau 1 Niveau 1 beskrivelse Niveau 2

Maintenance Indeholder enhedsindstillinger, f.eks. ur og sprog.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Webmenu-funktioner

Tryk på [Settings]-driftsskærmens skiftefane for at vise indstillingsskærmen og konfigurere de forskellige opsætningspunkter,
inklusive indledende indstillinger, netværksindstillinger, optagelses-/afspilningsindstillinger vha. webmenuen.
Konfigurér indstillinger i webmenuen på en tablet vha. touch eller på en pc med musen.
Tryk på menuen for de punkter, du vil konfigurere for at vise opsætningspunkterne og deres indstillinger i den menu.

Konfigurationsmetode

Valg af værdi

Tryk på radioknappen for et punkt. Radioknappen for et valgt punkt vises i orange.

Punkt On/Off

Menu (niveau 1)1.

Menu (niveau 2)2.

Indstillinger3.
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Tryk på kontakten for at tænde/slukke for punktet. Kontakten er orange, når punktet er tændt, og hvid når den er slukket.

Valg af værdi fra en liste

Tryk på rulleknappen, og vælg et punkt fra den viste liste.

Numerisk værdivalg

Tryk på < eller > for at ændre den numeriske værdi. Hvis den numeriske værdi er understreget, kan du også indtaste en
numerisk værdi direkte.

Indtastning af tegn/tal

Konfiguration på separat skærm
Tryk på knappen for at udføre opsætningen på en separat skærm.

Vejledningsmeddelelse

Information, der hjælper dig med at konfigurere nogle indstillinger og meddelelser, der henleder opmærksomheden på
brugeren, vises.

Gem en indstilling

Når du er færdig med at konfigurere en indstilling, skal du trykke på [OK]-knappen for at gemme indstillingen.
Tryk på [Cancel]-knappen for at ændringer af en indstilling og vende tilbage til den forrige indstilling.
Tryk på [Reload]-knappen for at opdatere skærmen.

Bemærk!

Hvis du trykker på [Reload]-knappen, før du gemmer en indstilling, vil ændringer af indstillingen blive annulleret.

Hvis du går til en anden side, før du gemmer en indstilling, vil ændringer af indstillingen blive annulleret.
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Focus

Indstiller fokusindstillinger.

Relateret emne
Indstilling af fokusmotivet manuelt (AF Assist) vha. webappen
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Push AF Mode
AF / Single-shot
AF(AF-S)

AF Indstiller skub autofokus-tilstand.

Touch
Function in MF

Tracking AF / Spot
Focus

Tracking AF
Indstiller funktionen, når kameraets billedskærm berøres i MF-
tilstand.

AF Assist
Control

On / Off On

Ved indstilling til [On], kan du bruge fokusglideren i webappen
under autofokus til at justere fokuspositionen.

For yderligere oplysninger se "Indstilling af fokusmotivet
manuelt (AF Assist) vha. webappen".

Bemærk!

Dette punkt er kun aktiveret, når [AF Assist] er indstillet til [On] i
kameramenuen.
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Base Setting

Indstiller basisindstillinger.

Relateret emne

Konfiguration af grundlæggende betjening
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Indstiller optagelsestilstanden.

Se "Optagelsestilstand" i "Konfiguration af
grundlæggende betjening".

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Indstiller farveskala for optagelse/output i tilstanden
Custom.
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Rec Format

Sætter indstillinger for optagelsesformat.

[RAW Output Format]-indstillinger

Standard værdier vises med fed.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Vælger systemfrekvensen.

Bemærk!

Hvis frekvensen er ændret, vil kameraet
genstarte. Efter genstart genindlæses
siden i webbrowseren.

Imager Scan
Mode

FF / S35 FF Vælger billeddanners størrelse.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Indstiller Codec for klipoptagelse/-afspilning.

Bemærk!

Når [Imager Scan Mode] er indstillet til
[S35], kan [RAW] og [RAW & XAVC-I] ikke
vælges.

RAW Output
Format

De tilgængelige indstillinger varierer
afhængigt af indstillingerne for
[Frequency].

Se "[RAW Output Format]-
indstillinger" herunder.

–

Indstiller størrelsen af RAW-billedet til output
til en ekstern RAW-optager.

Bemærk!

Når [Codec] er indstillet til [RAW & XAVC-
I], skifter [Video Format]-indstillinger
sammen med indstillingen [RAW Output
Format].

Video
Format

De tilgængelige indstillinger varierer
afhængigt af indstillingerne for
[Frequency], [Imager Scan Mode] og
[Codec].

Se "[Video Format]-indstillinger"
herunder.

– Indstiller billedets størrelse.

Frequency Imager Scan Mode Codec Indstilling

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW/RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW/RAW & XAVC-I 4096×2160
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Vilkårene under hvilke, [RAW Output Format] ikke kan indstilles, er udeladt.

[Video Format]-indstillinger

Standard værdier vises med fed.
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Frequency Imager Scan Mode Codec Indstilling

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I/XAVC-I 4096×2160P
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Simul Rec

Indstiller samtidige optagelsesindstillinger for 2 sprækker (se "Samtidig optagelse til hukommelseskort A og B (2-slot Simul
Rec)").

Relateret emne

Samtidig optagelse til hukommelseskort A og B (2-slot Simul Rec)
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off
Sætter samtidig optagelse til On/Off og indstiller optagelsens
destinationsmedie.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Viser optagelsesknappen for hvert optagelsesmedie.
Indstil [Project] > [Simul Rec] > [Rec Button Set] i
kameramenuen.2nd Rec

Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Indstiller proxy-optagelsesindstillinger (se "Proxyoptagelse").
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter proxyoptagelsestilstanden til On/Off.
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Interval Rec

Indstiller intervaloptagelsesindstillinger (se "Optagelse af video med afbrydelser (Interval Rec)").

Relateret emne
Optagelse af video med afbrydelser (Interval Rec)
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off

Sætter intervaloptagelsestilstand til
On/Off. (Hvis denne tilstand indstilles til
On, indstilles alle andre specialtilstande til
Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sek.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min.)
1 / 2 / 3 / 4 / 6 / 12 / 24 (time)

1
Indstiller intervallet mellem optagelser i
optagelsestilstanden Interval Rec (når
Interval Rec er indstillet til On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
De tilgængelige indstillinger varierer
afhængigt af rammefrekvensen for
det valgte videoformat.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Indstiller antallet af billeder, der skal tages
pr optagelse i optagelsestilstanden
Interval Rec (når Interval Rec er indstillet
til On).
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Picture Cache Rec

Indstiller optagelsestilstand for billedcache (se "Sådan optages cachede billeder (Picture Cache Rec)").

Relateret emne

Sådan optages cachede billeder (Picture Cache Rec)
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter billedcachefunktionen til On/Off.

Cache Size
Short / Medium /
Long / Max

Max
Indstiller tiden til akkumulering af billeder i
billedcachehukommelsen (billedcachens optagelsestid).

Cache Rec
Time

– –
Viser tiden til akkumulering af billeder i billedcachehukommelsen
(billedcachens optagelsestid).
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All File

Udfører ALL filfunktioner (Se "Lagring og indlæsning af konfigurationsdata").
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Load All
File

– –

Indlæs en ALL-fil i enheden fra enheden, der kører webappen.

Bemærk!

Når en ALL-fil er indlæst i enheden, vil enheden genstarte. Efter
genstart genindlæses siden i webbrowseren.

Save All
File

– –
Gem enhedens indstillinger til enheden, der kører webappen som
en ALL-fil.
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Base Look

Du kan indlæse et basisudseende i enheden.
En liste over tilgængelige basisudseender vises på skærmen. Det nuværende anvendte basisudseende er angivet af en ●
markør til venstre for basisudseendets nummer.

[No.]: Basisudseende-nummer
[Base Look Name]: Basisudseende-navn
[Input]: Basisudseende-inputsignal
[Output]: Basisudseende-outputsignal
[AE Level Offset]: Basisudseende-eksponeringsreferenceværdi

For at tilføje et basisudseende
Tryk på [Import]-knappen for at importere et nyt basisudseende. Følg instruktionerne på skærmen.
Efter import indstilles passende værdier for [Input], [Output] og [AE Level Offset]. For yderligere oplysninger se "Importering
af et ønsket basisudseende".

Relateret emne
Importering af et ønsket basisudseende
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P/T Speed

Indstillinger relateret til panorerings-/hældningshastigheden.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Speed
Step

Normal /
Extended

Extended

Indstiller antallet af hastighedstrin for panorerings-/hældningsdrevet.
Normal: Hastighed kan angives vha. et 24-trins interval. Brug denne
indstilling for kompatibilitet med eksisterende Sony-fjernkameraer.
Extended: Hastighed kan angives vha. et 50-trins interval.

Speed
Mode

Normal / Slow Normal

Indstiller hastighedstilstanden for panorerings-/hældningsdrevet.
Kun aktiveret når [Speed Step] er indstillet til [Normal].
Normal: Fungerer i et interval med normal hastighed (minimum til
maksimum (60 grader/sekund)).
Slow: Fungerer i et interval med lav hastighed (minimum til maksimum
(40 grader/sekund)).
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P/T Acceleration

Indstillinger relateret til panorerings-/hældningshastigheden.

5-041-958-93(1) Copyright 2022 Sony Corporation

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Acceleration 1 til 9 8
Indstiller acceleration/deceleration for
panorerings-/hældningsfunktioner. Jo større antallet er, desto
højere er accelerationen.
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P/T Range Limit

Indstiller indstillinger relateret til begrænsning af panorerings-/hældningsbevægelsen.
Indstil panorerings-/hældningsfunktionens bevægelsesgrænser vha. den følgende skærm.

Bemærk!

Når enheden er tændt, eller panorerings-/hældningsnulstilling er udført, ignoreres denne grænseindstilling for intervallet. Denne
funktion kan ikke bruges til at undgå forhindringer nær enheden.

Sæt [Setting]-kontakten i positionen On.

Panorerings-/hældningsbevægelsens grænsefunktion bliver aktiveret.

1

Tjek billedet vha. panorerings-/hældningsknapperne på kameraet.2

For at indstille positionerne for begrænsning af funktionen trykkes på [Left], [Right], [Up], [Down] > [Set Current
Value]-knappen i disse positioner.

[Left]: Venstre side af kameraet
[Right]: Højre side af kameraet
[Up]: Toppen af kameraet
[Down]: Bunden af kameraet

3
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Bemærk!

Kamerapositioner udenfor grænsepositionerne kan ikke gemmes som en forindstilling.

Hvis [Pan-Tilt] > [P/T Direction] > [Ceiling]-indstillingen ændres, vender positionsindstillingerne for den konfigurerede grænse tilbage til
fabriksstandard.

Indstillingen kan ikke ændres under afspilning, under miniaturevisning, når en panorerings-/hældningsfejl forekommer, når
panorering/hældning ikke initialiseres, og når panorering/hældning er låst.
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Grænsepositionerne er indstillet og vist som numeriske værdier (vinkel).
Tryk på [Reset]-knappen for de individuelle positioner for at annullere en grænse.

Tryk på [OK]-knappen.

Panorerings-/hældningsfunktionen er begrænset til at blive indenfor de konfigurerede grænsepositioner.

4
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P/T Direction

Indstillinger relateret til panorerings-/hældningsretningen.

Bemærk!

Når en ændret [Ceiling]-indstilling anvendes, slettes alle forindstillede positioner, da panorerings-/hældningskoordinaterne ville blive
vendt om.

Panorerings-/hældningsintervallet ændres som vist i det følgende diagram afhængigt af [Ceiling]-indstillingen.

A: Når [Ceiling] er indstillet til [Off]
B: Når [Ceiling] er indstillet til [On]

5-041-958-93(1) Copyright 2022 Sony Corporation

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Ceiling On / Off Off

Når enheden er monteret på et skrivebord, skal den sættes på [Off].
Når enheden er monteret på et loft, skal den sættes på [On]. Når
[Ceiling] er indstillet til [On], er [Pan Direction] automatisk indstillet til
[Opposite].

Pan
Direction

Normal /
Opposite

Normal
Indstiller panoreringsretningen. Når indstillingen ændres, vendes
retningen om.

Tilt
Direction

Normal /
Opposite

Normal
Indstiller hældningsretningen. Når indstillingen ændres, vendes
retningen om.
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P/T Preset

Angiver indstillinger, der er relateret til forindstillinger af kamera.

Pan-Tilt
Indstiller hastighed for forudindstillinger.

Default
Indstiller standardværdier, som konfigureres når en forudindstillingsposition gemmes.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Indstiller om forindstillede hastigheder er konfigureret separat
eller bruger en fælles hastighed.

Pan-Tilt Speed
for Common

1 til 50 50

Indstiller den almindelige hastighed for forindstillinger.

Bemærk!

En maksimum kørehastighed på 24 anvendes, hvis en værdi på
25 eller højere indstilles, når [Pan-Tilt] > [P/T Speed] > [Speed
Step] indstilles til [Normal].

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Pan-Tilt Speed
for Separate

1 til 50 50
Indstiller hastigheden for forudindstillinger, når valgmetoden til
hastighed for forudindstillinger.er indstillet til [Separate].

Zoom Sync On / Off On
Indstiller om panorerings-/hældnings- og zoomfunktion er
synkroniserede, når der gendannes en forudindstillet position.

Zoom Speed 0 til 32767 32767 Indstiller zoomhastigheden.

Focus Recall On / Off On Indstiller om fokusindstillinger gendannes eller ej.

MF Speed 0 til 32767 32767 Indstiller fokushastighed for manuel fokus.
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Output Format

Angiver indstillinger for outputformat.

Relateret emne
Output-formater og -begrænsninger
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

SDI For yderligere oplysninger om indstillinger se "Output-
formater og -begrænsninger".

– Indstiller opløsningen for SDI- og
HDMI-output.HDMI –
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Output Display

Angiver indstillinger, der er relateret til outputsignaler.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

SDI On / Off Off Indstiller, om menu og status er integreret i SDI-outputsignalet.

HDMI/Stream On / Off On

Indstiller, om menu og status er indlejret i HDMI-outputsignalet.

Bemærk!

Denne indstilling anvendes også på HDMI-outputtets signalbillede,
streaming-outputbillede og billedet i webappens
kamerabilledpanel.
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Audio Input

Indstillinger relateret til CH1 og CH4-lydinput.

Indstiller master lydinputniveauet. Masterniveauet for lydindgang anvendes til alle kanaler 1 til 4.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Level
Control

Auto / Manual Auto
Vælger automatisk eller manuel justering af
lydinputs niveau.

Level 0 til 99 49 Indstiller inputniveauet.

Input
Select

AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 og CH3: AUDIO IN
CH1
CH2 og CH4: AUDIO IN
CH2

Indstiller lydinput-kilden.

Bemærk!

CH1 er indstillettil [AUDIO IN CH1] (fast).

Wind Filter On / Off Off Slukker/tænder for vindstøjsreduktionsfilter.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Master 0 til 99 99 Indstiller master-inputniveauet.
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Audio Output

Angiver indstillinger, der er relateret til lydoutput.

Bemærk!

Denne indstilling anvendes også på streaming-outputlyd.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

HDMI/Stream Output
CH

CH1/CH2 / CH3/CH4 CH1/CH2
Indstiller kombinationen af lydkanaler for
HDMI-/streaming-output.
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Tracking Data Output

Indstiller indstillinger relateret til sporingsoplysninger (free-d protokolklage) output.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Transfer Mode
Off / Always / On
Demand

Off Vælger sporingsinformation outputmetode.

Camera ID 0 til 255 255 Indstiller enhedens ID.

Destination
Address

IPv4-adresse –
Når [Transfer Mode] er indstillet til [Always], indstilles
destinations IP-adresse for sporingsinformation.

Destination
Port

1024 til 65534 40000 Når [Transfer Mode] er indstillet til [Always], indstilles
destinationsport for sporingsinformation.

Listen Port 1024 til 65534 40000
Når [Transfer Mode] er indstillet til [On Demand], indstilles
portnummeret på enheden til at lytte til anmodninger fra klienter.
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Tally

Indstiller optagelse/tally lampeindstillinger (se "Tilslutning af tally-signal").

Relateret emne

Tilslutning af tally-signal
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Tally Lamp
Brightness

High / Low / Off High Indstiller lysstyrke af optagelses-/tally-lampen.

G Tally Lamp Enable / Disable Enable Aktiverer/deaktiverer G-tally-lampen.

Tally Control External / Internal Internal
Vælger målet for accept af enhedens optagelses-/tally-
lampestyringsinformation.
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IR Remote

Angiver indstillinger, der er relateret til den infrarøde fjernbetjening.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off On
Aktiverer/deaktiverer enhedens drift fra den infrarøde
fjernbetjening.
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RCP/MSU

Konfigurerer indstilling, når der er tilsluttet en RCP/MSU (valgfri).
Se "Tilslutning af RCP/MSU (valgfri)" for flere oplysninger.

Bemærk!

Konfigurer indstillinger på RCP/MSU efter behov.

En MSU er påkrævet for et system med flere kameraer.

Når du bruger flere MSU-enheder, skal du opsætte en MSU-enhed som masteren og indstille alle andre MSU-enheder som klienter.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

CNS Mode
Off / Bridge / MCS /
PC Control

Off Indstiller forbindelsestilstand for RCP/MSU.

Master IP
Address

IPv4-adresse 0.0.0.0
Indstiller IP-adressen for masterenheden under opbygning af
et LAN-baseret system med flere kameraer.

Camera No. Camera No. (1 til 96) 1 Indstiller et unikt kameranummer i systemet under opbygning
af et LAN-baseret system med flere kameraer.
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Lens Controller

Indstiller indstillinger for en tilsluttet objektiv styreenhed (valgfri).
For oplysninger se "Tilslutning af en objektiv styreenhed".

Bemærk!

Når [Setting] er ændret, vil enheden genstarte. Genindlæs siden i webbrowseren.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Indstiller om objektiv styreenheden skal bruges eller ej (valgfri).

Mode 0 til 15 0

Indstiller driftstilstanden for objektiv styreenheden (valgfri).
Værdier i området 0 til 15 er tilgængelige, men de faktiske værdier som
kan vælges, vil variere afhængigt af objektiv styreenheden (valgfri). Se
brugsanvisningen til objektiv styreenheden for at få yderligere
oplysninger.

Reverse On / Off Off Skifter rotationsretning for objektiv styreenheden (valgfri).

Initialize – – Starter objektivets styreenhed (valgfri).
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Camera Name

Indstillinger relateret til kameranavnet (enhedsnavn).

Op til otte (0 til 8) af de følgende tegn kan indtastes for Camera Name.
Alfanumeriske tegn
Symboler (mellemrum !#$`*+-./;<=>?@[\]^_`{|})
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Camera Name – FR7 Indstiller kameranavnet.
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User

Angiver indstillinger, der er relateret til brugeradgang til enheden.

Indstillinger relateret til administratorer (Administrator) (påkrævet)

Indstillinger relateret til generelle brugere (User 1 til User 9) (ekstraudstyr)
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

User Name – admin Indstiller brugernavnet.

Current
Password

– –
Når adgangskoden ændres, indtastes den nuværende
adgangskode.

New Password – – Indtast den nye adgangskode igen.

Re-Type
Password

– – Indtast den samme adgangskode igen for bekræftelse.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

User Name – – Indstiller brugernavnet.

Current
Password

– –
Når adgangskoden ændres, indtastes den nuværende
adgangskode.

New Password – – Indtast den nye adgangskode igen.

Re-Type
Password – – Indtast den samme adgangskode igen for bekræftelse.
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Wired LAN

Status
Viser netværksstatus.

IPv4
Angiver indstillinger, der er relateret til IPv4-netværket.

IPv6
Angiver indstillinger, der er relateret til IPv6-netværket.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Host Name – – Viser værtsnavnet.

MAC Address – – Viser enhedens MAC-adresse.

Ethernet Status – –
Viser den nuværende
kommunikationshastighed.

IP Address – – Viser enhedens IP-adresse.

Subnet Mask – – Viser enhedens undernetmaske.

Gateway – – Viser enhedens IPv4 standard gateway.

Primary DNS Server – – Viser enhedens primære DNS-server.

Secondary DNS
Server

– – Viser enhedens sekundære DNS-server.

IPv6 Address 1 – – Viser enhedens IPv6 adresse 1.

IPv6 Address 2 – – Viser enhedens IPv6 adresse 2.

IPv6 Gateway – – Viser enhedens IPv6 standard gateway.

Link-local IPv6
Address

– – Viser enhedens IPv6 link-lokal adresse.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

DHCP On / Off On Tænder og slukker for [DHCP]-funktionen.

IP Address – – Indstiller IPv4-adressen, når [DHCP] er indstillet til Off.

Subnet
Mask

– – Indstiller undernetmasken, når [DHCP] er indstillet til Off.

Gateway – –
Indstiller IPv4 standard gateway, når [DHCP] er indstillet til
Off.
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Common
Angiver indstillinger, der er fælles for IPv4-/IPv6-netværk.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Obtain an IP Address
Automatically

On / Off On Sætter automatisk IPv6-adresserekvirering til On/Off.

IP Address – –
Indstiller IPv6-adressen, når [Obtain an IP Address
Automatically] er indstillet til Off.

Prefix Length – –
Indstiller præfiks når [Obtain an IP Address
Automatically] er indstillet til Off.

Gateway – – Indstiller IPv6 standard gateway, når [Obtain an IP
Address Automatically] er indstillet til Off.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

HTTP Port 80, 1024 til 65534 80 Indstiller HTTP-portnummeret.

DNS Auto On / Off On
Indstiller om DNS-adresserne skal hentes fra DHCP-
serveren.

Primary DNS
Server

IPv4-/IPv6-adresse –
Angiv den primære DNS-server, når [DNS Auto] er
indstillet til Off.

Secondary DNS
Server

IPv4-/IPv6-adresse –
Angiv den sekundære DNS-server, når [DNS Auto] er
indstillet til Off.
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File Transfer

Angiver indstillinger, der er relateret til filoverførsler.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Auto
Upload
(Proxy)

On / Off Off Tænder/slukker for automatisk upload af proxy-fil.

Default
Upload
Server

Server Settings1 til
3 > Display Name Server Settings1

Vælger overførselsserveren for filer. Den server, der vælges her,
bliver destinationen for automatisk overførsel af proxyfiler og
destinationen for overførsel af filer fra miniatureskærmen.
Viser indstillingerne [Display Name] konfigureret i [Server
Settings1 til 3].

398



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

FTP Server 1 til 3

Angiver indstillinger, der er relateret til FTP-overførsler.
Indstillingerne er fælles for FTP Server 1 til 3.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Display Name – –
Indstiller det visningsnavn, der vises i opsætningsmenuen for
overførselsdestinationen.

Service – – Viser servertypen.

Host Name – – Angiver værtsnavnet for overførselsdestinationsserveren.

Port 21, 990, 1024 til
65534

21 Angiver portnummeret for overførselsdestinationsserveren.

User Name – –
Angiver brugernavnet til godkendelse af forbindelsen til
overførselsdestinationsserveren.

Password – –
Angiver godkendelsesadgangskoden for forbindelsen til
overførselsdestinationsserveren.

Passive Mode On / Off Off Sæt passiv tilstand til On/Off.

Destination
Directory

– – Angiv navnet på overførselsdestinationsmappen.

Using Secure
Protocol

On / Off Off
Indstiller, om der skal bruges (On) eller ikke bruges (Off)
sikker FTP-overførsel.

Root Certificate – –

Indlæser rodcertifikat for sikker FTP-overførsel.
Tryk på [Load]-knappen og vælg et rodcertifikat på den viste
skærm.
Tryk på [Delete] for at slette det indlæste rodcertifikat.

Root Certificate
Status

– – Viser certifikatets indlæsningsstatus.

Reset – – Nulstiller [Server Settings]-indstillingerne til standard.
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SSL

Angiver indstillinger, der er relateret til SSL.

SSL
Aktiverer/deaktiverer SSL-funktionen.

SSL Server Authentication
Angiver indstillinger, der er relateret til SSL-servergodkendelse.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Function
Disable / Enable / Enable (Allow HTTP connection for
some clients)

Disable
Aktiverer/deaktiverer SSL-
funktionen.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external certificate

–
Angiver installationsmetoden til SSL-
servercertifikatet.

Status – –
Viser gyldigheden af SSL-servercertifikatet, når
[Certificate Options] er indstillet til [Use a self-signed
certificate (For test use)].

Issuer DN – –
Viser navnet på udstederen af SSL-servercertifikatet,
når [Certificate Options] er indstillet til [Use a self-
signed certificate (For test use)].

Subject DN – –
Viser navnet på SSL-servercertifikatets subjekt, når
[Certificate Options] er indstillet til [Use a self-signed
certificate (For test use)].

Available Period – –
Viser den gyldige periode for SSL-servercertifikatet,
når [Certificate Options] er indstillet til [Use a self-
signed certificate (For test use)].

Extended Key
Usage

– –
Viser den udvidede nøglebrugsmetode, når
[Certificate Options] er indstillet til [Use a self-signed
certificate (For test use)].

Delete – –

Denne knap vises, når [Certificate Options] er
indstillet til [Use a self-signed certificate (For test
use)].
Sletter det installerede SSL-servercertifikat.

Import – –
Installerer et eksternt SSL-servercertifikat fra en liste,
når [Certificate Options] er indstillet til [Use an
external certificate].

Private Key
Password

– –
Indstiller adgangskoden til SSL-servercertifikatets
private nøgleoplysninger, når [Certificate Options] er
indstillet til [Use an external certificate].
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Reset – –
Denne knap rydder skærmen med den private
nøgleadgangskode til indtastning af en ny
adgangskode.

Self-Signed
Certificate
Generation

– –

Tryk på [Generate]-knappen for at generere et
selvsigneret certifikat, når [Certificate Options] er
indstillet til [Use a self-signed certificate (For test
use)].
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Vejledning til hjælp
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Referer Check

Angiver indstillinger, der er relateret til Referer-tjek.

Exception List
Angiver indstillinger, der er relateret til undtagelsesliste for Referer-tjek.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off On Aktiverer/deaktiverer Referer-tjekfunktionen.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

No. 1 til 10 – Angiver undtagelsesnummeret fra listen.

Host
Name

– – Angiver værtsnavnet for undtagelsen.

Port
Number

– – Angiver portnummeret for undtagelsen.

Set – –
Tryk for at registrere den konfigurerede undtagelse i
undtagelseslisten.

Delete – –
Vælg en undtagelse, du ønsker at slette, og tryk på knappen for at
slette den registrerede undtagelse fra undtagelseslisten.
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Vejledning til hjælp
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Brute Force Attack Protection

Angiver indstillinger relateret til forebyggelse af brute force attack.

Når en angriber registreres, vises angriberens listeoplysninger.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Setting On / Off On Tænder og slukker for [Brute Force Attack Protection]-funktionen.

Count 3 til 100 8
Angiver antallet af forsøg, der vil betragtes som et angreb.
Aktiveret når [Setting] er indstillet til On.

Release
Mode Always / Timer Timer

Indstiller frigivelsesbetingelsen.
Aktiveret når [Setting] er indstillet til On.
Always: Slet ikke fra angrebslisten.
Timer: Slet fra angrebslisten, efter frigørelsestiden, som er
indstillet vha. [Release Time], er udløbet.

Release
Time

30 til 86400 s 60

Indstiller frigivelsestiden.
Aktiveret når [Setting] er indstillet til On.
Når Release Mode er indstillet til [Timer], slettes indtastninger fra
angrebslisten, efter frigørelsestiden er udløbet.
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Stream

Indstiller streamingindstillinger (se "Om Streaming").

Stream Setting
Angiver indstillinger, der er relateret til streamingprotokollen.

Bemærk!

For at bruge RTMP, indstil [Stream] > [Audio Stream] > [Setting] til [On] på forhånd.

RTSP
De følgende punkter vises, når [Stream Setting] er indstillet til [RTSP].
Angiver indstillinger, der er relateret til RTSP-streaming.

RTMP
De følgende punkter vises, når [Stream Setting] er indstillet til [RTMP].
Angiver indstillinger, der er relateret til RTMP-streaming.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX / Off RTSP Vælger streamingprotokollen.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Port Number 554, 1024 til 65534 554 Indstiller RTSP-portnummeret.

Time Out 0 til 600 60
Angiver timeout for Keep Alive-kommandoen til RTSP-
streaming.

Authentication On / Off On Slår RTSP-godkendelsesfunktionen til/fra.

Video Port
Number 1

1024 til 65534 51000 Indstiller portnummer for at sende video 1 til RTSP
unicast streaming.

Video Port
Number 2

1024 til 65534 53000
Indstiller portnummer for at sende video 2 til RTSP
unicast streaming.

Audio Port
Number

1024 til 65534 57000
Indstiller portnummer for at sende lyd til RTSP unicast
streaming.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Server URL – –
Indstiller RTMP eller RTMPS-forbindelsesdestinationens
URL.

Stream Key – – Indstiller stream key opnået fra RTMP-server.
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SRT
De følgende punkter vises, når [Stream Setting] er indstillet til [SRT-Caller] eller [SRT-Listener].
Angiver indstillinger, der er relateret til SRT-streaming.

NDI|HX
De følgende punkter vises, når [Stream Setting] er indstillet til [NDI|HX].
Sætter indstillinger, der er relateret til NDI|HX.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Root
Certificate

– –

Indlæser rodcertifikat nødvendigt for tilslutning med RTMP-
server.
Tryk på [Load]-knappen og vælg et rodcertifikat på den
viste skærm.
Tryk på [Delete] for at slette det indlæste rodcertifikat.
Status vises i [Root Certificate Status].

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Destination – –
Indstiller forbindelsesdestinationens URL, når enheden
fungerer som en caller.

Port
Number

1024 til 65534 4201
Indstiller portnummeret til lytning, når enheden fungerer som
en listener.

Latency 20 til 8000 ms 120 Indstiller reaktionstid.

TTL 1 til 255 64 Indstiller TTL-værdien.

Encryption Off / AES128 / AES256 Off
Aktiverer/deaktiverer kryptering og indstiller
krypteringsmetoden.

Passphrase
0 eller streng af 10 til
79 tegn

0
Indstiller adgangssætning anvendt til kryptering.
Tryk på Reset for at rydde den indtastede adgangssætning.

ARC On / Off On Tænder/slukker for Adaptive Rate Control.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

License – – Viser installationstilstanden af NDI-licensnøglen.

Source Name – – Viser NDI-kildenavnet.

Group On / Off Off Slår NDI-grupperingsfunktionen til/fra.

Group Name – –
Vises, når NDI-grupperingsfunktionen er på On.
Indstiller gruppenavnet.

Discovery Server
1

– – Indstiller NDI discovery server 1.

Discovery Server
2

– – Indstiller NDI discovery server 2.

Multicast Mode On / Off Off Tænder/slukker for multicast streaming.
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Relateret emne
Om Streaming
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Multicast Prefix 239.255.0.0 239.255.0.0
Vist når [Multicast Mode] er indstillet til On.
Indstiller præfiks til brug med multicast streaming.

Multicast
Netmask

255.255.0.0 255.255.0.0
Vist når [Multicast Mode] er indstillet til On.
Indstiller netmasken, der bestemmer multicast-
adresseintervallet.

Multicast TTL 1 til 256 3
Vist når [Multicast Mode] er indstillet til On.
Indstiller TTL-værdien til multicast streaming.

Multi-TCP Mode On / Off Off Sætter Multi-TCP-tilstand til On/Off.

Unicast UDP
Mode

On / Off On Sætter Unicast UDP-tilstand til On/Off.
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Video Stream

Angiver indstillinger, der er relateret til video-codec-streaming.

Video Stream 1
Angiver indstillinger, der er relateret til video codec 1.

Video Stream 2

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Codec 1 H.264 / H.265 H.264 Indstiller codec til billede 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Indstiller billedstørrelse til billede 1.

Frame Rate 1

For yderligere oplysninger om
understøttede rammehastigheder se
"Indstilling af Video Codec til
streaming".

–
Indstiller rammehastighed for billede
1.

I-Picture Mode 1 Time / Frame Time
Indstiller IDR-rammens
indsættelsesinterval for billede 1 som
en tid eller antal rammer.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Vist når [I-Picture Mode 1] er indstillet
til Time.
Indstiller IDR-rammens
indsættelsesinterval til H.264 og
H.265 som en tid.

I-Picture Ratio 1 15 til 300 rammer 30

Vist når [I-Picture Mode 1] er indstillet
til Frame.
Indstiller IDR-rammens
indsættelsesinterval til H.264 og
H.265 som et antal rammer.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Indstiller H.264 eller H.265 profil.

Bit Rate
Compression
Mode 1

CBR / VBR VBR Indstiller bithastigheds
komprimeringstilstand for billede 1.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 / 24000
/ 32000 / 50000 / 64000 / 80000 kbps

16000

Vist når [Bit Rate Compression Mode
1] er indstillet til On.
Indstiller bithastighedens målværdi,
når bithastighedens
komprimeringstilstand er indstillet til
CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Indstiller H.264 eller H.265 kvalitet.
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Angiver indstillinger, der er relateret til video codec 2.

Video Stream 3
Angiver indstillinger, der er relateret til video codec 3.

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Codec 2 H.264 / H.265/ Off Off Indstiller codec til billede 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Indstiller billedstørrelse til billede 2.

Frame Rate 2

For yderligere oplysninger om
understøttede rammehastigheder se
"Indstilling af Video Codec til
streaming".

–

Vist når [Codec 2] ikke er indstillet til
Off.
Indstiller rammehastighed for billede
2.

I-Picture Mode 2 Time / Frame Time

Vist når [Codec 2] ikke er indstillet til
Off.
Indstiller IDR-rammens
indsættelsesinterval for billede 2 som
en tid eller antal rammer.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Vist når både [Codec 2] ikke er
indstillet til Off og [I-Picture Mode 2] er
indstillet til [Time].
Indstiller IDR-rammens
indsættelsesinterval til H.264 og
H.265 som en tid.

I-Picture Ratio 2 15 til 300 rammer 30

Vist når både [Codec 2] ikke er
indstillet til Off og [I-Picture Mode 2] er
indstillet til [Frame].
Indstiller IDR-rammens
indsættelsesinterval til H.264 og
H.265 som et antal rammer.

Profile 2 H.264: high / main / baseline
H.265: main

– Indstiller H.264 eller H.265 profil.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Vist når [Codec 2] ikke er indstillet til
Off.
Indstiller bithastigheds
komprimeringstilstand for billede 2.

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 / 24000
/ 32000 / 50000 / 64000 / 80000 kbps

8000

Vist når både [Codec 2] ikke er
indstillet til Off og [Bit Rate
Compression Mode 2] er indstillet til
[On].
Indstiller bithastighedens målværdi,
når bithastighedens
komprimeringstilstand er indstillet til
CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Vist når både [Codec 2] er indstillet til
H.264 og [Bit Rate Compression
Mode 2] er indstillet til Off.
Indstiller H.264 eller H.265 kvalitet.
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Relateret emne

Indstilling af Video Codec til streaming

5-041-958-93(1) Copyright 2022 Sony Corporation

Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Codec 3 JPEG JPEG
Indstiller codec til billede
3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Indstiller billedstørrelse til
billede 3.

Frame
Rate 3

For yderligere oplysninger om understøttede
rammehastigheder se "Indstilling af Video Codec til
streaming".

–
Indstiller rammehastighed
for billede 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Indstiller kvaliteten.
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Vejledning til hjælp
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Audio Stream

Angiver indstillinger, der er relateret til streaming audio codec.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Setting On / Off Off Sætter lydstreaming-output til On/Off.

Codec AAC (128 kbps) / AAC (256 kbps) AAC (128 kbps)
Vist når [Setting] er indstillet til On.
Indstilling af audio codec til streaming.
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Language

Indstiller visningsproget.

Bemærk!

De tilgængelige sprog kan variere afhængigt af land eller region.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Language – – Indstiller visningsproget.
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Accessibility

Angiver indstillinger relateret il lydaflæsning (tekst til tale).

Bemærk!

Denne funktion er kun tilgængelig på modeller, der sælges i Nordamerika. Skærmens aflæserfunktion kan kun anvendes, når sproget
er indstillet til engelsk (fra udgivelsesdatoen).

Aktivér skærmens aflæserfunktion af webbrowseren på enheden ved at køre webappen.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Screen
Reader

On / Off Off 
Slukker/tænder for aflæserfunktionen i kameraets
billedpanel i webappen.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1 /
Fast2 / Fast3 / Fast4

Normal

Indstiller hastigheden for skærmens
aflæserfunktion.
En prøvepassage læses højt ved den
konfigurerede hastighed.

Speech
Volume

1 til 15 7

Indstiller skærmlæserfunktionens volumen i
webappen.
En prøvepassage læses højt ved den
konfigurerede volumen.
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Clock Set

Indstiller interne urindstillinger.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Current Date
& Time

– –
Viser den nuværende tid konfigureret på
enheden.

PC Clock – –
Viser det nuværende klokkeslæt på tablet eller
pc brugt til konfiguration.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd Angiver visningsformatet til dato og klokkeslæt.

12 h / 24 h 12 h / 24 h 24 h
Angiver tidspunktet til 12-timers/24-timers
visningsformat.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

–
Angiver konfigurationsmetoden til dato og
klokkeslæt.

yy-mm-dd
hh:mm:ss

yy: 19 til 37
mm: 01 til 12
dd: 01 til 31
hh: 00 til 23
mm: 00 til 59
ss: 00 til 59 (sekunder)

–
Vist når [Time Setting] er indstillet til Manual
setting.
Angiver dato og tid manuelt.

NTP Auto On / Off Off

Vist når [Time Setting] er indstillet til
Synchronize with NTP.
Indstiller om IP-adressen på NTP-serveren skal
hentes fra DHCP-serveren.

NTP Server IPv4-/IPv6-adresse eller værtsnavn –

Vist når både [Time Setting] er indstillet til
[Synchronize with NTP] og [NTP Auto] er
indstillet til Off.
Angiver NTP-serveren brugt til
tidssynkronisering.

Time Zone UTC− 12:00 til UTC + 14:00 – Vælger tidszonen.
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Reset

Starter enheden.

Reboot
Genstarter enheden.

Reset
Nulstiller enhedens indstillinger.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Reboot Execute –

Genstarter enheden.
Execute: Udfør funktion.

Bemærk!

Efter genstart genindlæses siden i webbrowseren.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

All Reset (except for
Network Settings)

Execute –

Nulstiller enhedens indstillinger (undtagen
netværksindstillinger).
Execute: Udfør funktion.

Bemærk!

Importerede basisudseender og LUT-filer er nu slettet.

Network Reset Execute –

Nulstiller enhedens netværksindstillinger.
Execute: Udfør funktion.

Bemærk!

Efter udførsel af Network Reset vil enheden genstarte.
Efter genstart genindlæses siden i webbrowseren.

Factory Default Execute –

Vender enhedens indstillinger tilbage til fabrikkens
standard tilstand.
Execute: Udfør funktion.

Bemærk!

Efter udførsel af Factory Default vil enheden genstarte.
Efter genstart genindlæses siden i webbrowseren.
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Information

Viser kamera- og objektivoplysninger. Bruges også til at opdatere software.

Camera
Viser kamerainformation og opdaterer software.

Lens
Viser objektivinformation og opdaterer software.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Model
Name

– – Viser kameraets modelnavn.

Serial
Number

– – Viser kameraets serienummer.

Version
Number – – Viser kameraets softwareversion.

Version Up – –

Tryk på [Choose File]-knappen, og følg vejledningen på
skærmen for at opdatere kamerasoftwaren.

Bemærk!

Efter opdatering vil enheden genstarte. Efter genstart
genindlæses siden i webbrowseren.

Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

Model
Name

– – Viser objektivets modelnavn.

Serial
Number

– – Viser objektivets serienummer.

Version
Number

– – Viser objektivets softwareversion.

Version Up – –

Tryk på [Choose File]-knappen, og følg vejledningen på
skærmen for at opdatere objektivsoftwaren.

For yderligere oplysninger se "Opdatering af software til E-
mount-objektivet".

Bemærk!

Efter opdatering af objektivet vil enheden genstarte. Efter
genstart genindlæses siden i webbrowseren.
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Relateret emne
Opdatering af software til E-mount-objektivet
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System Log

Angiver indstillinger, der er relateret til systemloggen.

Den hentede log vises som vist herunder.

Relateret emne
Opdatering af software til E-mount-objektivet
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Indstiller niveauet for tilføjelse af et register til
systemloggen.

Log Size 200 til 1024 1024
Indstiller størrelsen af logfilen, der skal gemmes i
systemloggen.

Download as
File

– –
Tryk på [Download]-knappen, og gem systemloggen
på en tablet eller computer fra den viste skærm.
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HTTP Access Log

Angiver indstillinger, der er relateret til HTTP-adgangsloggen.
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Punkt Indstilling af underpunkt Fabriksstandard Beskrivelse

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Indstiller niveauet for tilføjelse af et register til HTTP-
adgangsloggen.

Log Size 200 til 1024 1024
Indstiller størrelsen af logfilen, der skal gemmes i
HTTP-adgangsloggen.

Download
as File

– –
Tryk på [Download]-knappen, og gem HTTP-
adgangsloggen på en tablet eller computer fra den
viste skærm.
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Service

Indhenter enhedsinformation om enheden. Brug, når du kontakter en Sony-servicerepræsentant.
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Punkt Indstilling af
underpunkt Fabriksstandard Beskrivelse

I agree to download
device information.

– –

Sæt et flueben her, hvis du samtykker med at hente
enhedsoplysninger, og tryk på [OK]-knappen.
Tryk på den viste [Download]-knap. Webbrowseren vil
downloade en fil ved navn deviceinformation.dat
øjeblikkeligt.

Bemærk!

Efter download vil enheden genstarte. Genstart manuelt,
hvis enheden ikke genstartes automatisk. Efter genstart
genindlæses siden i webbrowseren.
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EULA

Viser End User License Agreement (EULA).
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Software

Viser softwarelicensen.
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Tilslutning af eksterne skærme og optagelsesenheder

For at vise optagede billeder eller afspilningsbilleder på en ekstern skærm, indstilles video-outputtypen for den eksterne
skærm, og et passende kabel benyttes til tilslutning af monitoren.
Du kan også tilslutte en ekstern optagelsesenhed og optage outputsignalet fra enheden.
Du kan vise de samme oplysninger, som er synlige i kameraets billedpanel, f.eks. statusoplysninger og menuer, på en
ekstern monitor. Indstil den ønskede systemtype for skærmvisningen på On vha. [Monitoring] > [Output Display] i
webmenuen.

Bemærk!

Hvis en monitor, som er tilsluttet HDMI-stikket, ikke understøtter HDMI-outputformatet, som er konfigureret vha. [Monitoring]-menuen i
webmenuen eller kameramenuen, vil kamerabilledet ikke blive vist i webappen. Der kan heller ikke streames video.

Du kan indstille både [Output Display] > [SDI] og [HDMI/Stream] til [Off], men det vil forhindre brugen af kameramenuen og
funktionerne, der afhænger af skærmvisningen. Derudover vil enhedens fejlnotifikationer blive begrænset til lamperne (tændte eller
blinkende) på enheden, og visningen af notifikationsmærket øverst til højre i webappen. For at kunne se den detaljerede status
indstilles [Output Display] til [On].

Tip!

[Output Display] > [SDI] er indstillet til [Off] og [HDMI/Stream] er indstillet til [On] som fabriksstandard. For at bruge streaming som
hovedvideo indstilles [SDI] til [On] og [HDMI/Stream] til [Off], og kamerastatus overvåges på en SDI-monitor.

SDI OUT-tilslutning (BNC-type)

Indstil outputformatet vha. [Monitoring] i webmenuen eller kameramenuen.
Brug et kommercielt tilgængeligt 75 Ω koaksialkabel til tilslutning.

Bemærk!

Kontroller, at forbindelsen mellem enheden og den eksterne enhed er jordforbundet, før du tænder for enhederne.

Det anbefales, at enheden og den eksterne enhed tændes efter tilslutning af 75 Ω koaksialkablet.
Hvis den eksterne enhed skal sluttes til enheden, mens enheden er tændt, skal du tilslutte 75 Ω koaksialkabel til den
eksterne enhed først og derefter slutte det til enheden.

For at begynde at optage på enheden og den eksterne enhed samtidigt
Med SDI-signaloutput aktiveret indstilles [Project] > [SDI/HDMI Rec Control] > [Setting] til [SDI/HDMI Remote I/F] eller
[Parallel Rec] i kameramenuen for at aktivere output af et REC-udløsersignal til den eksterne enhed forbundet til SDI OUT-
stikket. Dette vil synkronisere optagelse på den eksterne enhed med enheden.

Bemærk!

Hvis en tilsluttet ekstern enhed ikke understøtter et REC-udløsersignal, kan enheden ikke anvendes.

Når [Project] > [SDI/HDMI Rec Control] > [Setting] er indstillet til [SDI/HDMI Remote I/F] i kameramenuen, udsendes REC-
udløsersignalet, når der ikke er noget optagelsesmedie indsat i øjeblikket, og optagelsesknappen START/STOP betjenes.

HDMI OUT-stik (Type A-tilslutning)

Indstil output-On/Off-indstillingen og outputformatet i [Monitoring]-menuen i kameramenuen.

For at begynde at optage på enheden og den eksterne enhed samtidigt
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Med HDMI-signaloutput aktiveret, indstilles [TC/Media] > [HDMI TC Out] > [Setting] til [On] og [Project] > [SDI/HDMI Rec
Control] > [Setting] til [SDI/HDMI Remote I/F] eller [Parallel Rec] i kameramenuen for at aktivere udsendelse af et REC-
udløsersignal til den eksterne enhed tilknyttet HDMI OUT-stikket. Dette vil synkronisere optagelse på den eksterne enhed
med enheden.

Bemærk!

Hvis en tilsluttet ekstern enhed ikke understøtter et REC-udløsersignal, kan enheden ikke anvendes.

Når [Project] > [SDI/HDMI Rec Control] > [Setting] er indstillet til [SDI/HDMI Remote I/F] i kameramenuen, udsendes REC-
udløsersignalet, når der ikke er noget optagelsesmedie indsat i øjeblikket, og optagelsesknappen START/STOP betjenes.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Tilslutning med en RCP/MSU

Nogle af funktionerne i enheden kan styres via fjernadgang ved at slutte et fjernbetjeningspanel (RCP) såsom RCP-
3500/3501 eller en masteropsætningsenhed (MSU) såsom MSU-3500 til enheden via et LAN-kabel.
Tilslutningsmetoden vil variere afhængigt af konfigurationen af relaterede enheder og applikationen.

For detaljer om en én-til-én-forbindelse mellem enheden og en RCP henvises der til "Én-til-én-forbindelse mellem
enheden og en RCP".
For detaljer om tilslutning af flere kameraer vha. en MSU eller kamerakontrolsoftware henvises der til "Brug af enheden i
et miljø med flere kameraer med en MSU/fjernbetjeningssoftware til kamera".

Relateret emne

Én-til-én-forbindelse mellem enheden og en RCP

Brug af enheden i et miljø med flere kameraer med en MSU/fjernbetjeningssoftware til kamera

5-041-958-93(1) Copyright 2022 Sony Corporation
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Én-til-én-forbindelse mellem enheden og en RCP

Bemærk!

Se "Liste over understøttede funktioner", og konfigurer enheden, så den opfylder driftsbetingelserne for de funktioner, du vil bruge, og
aktivér derefter forbindelsen med en RCP vha. følgende procedure.

Relateret emne
Liste over understøttede funktioner

5-041-958-93(1) Copyright 2022 Sony Corporation

Tænd hver enhed.1

Indstil [Technical] > [RCP/MSU] > [CNS Mode] til [Bridge] i webmenuen på kameraet.2

Konfigurerer følgende indstillinger på RCP.

Se RCP'ens brugsanvisning for at få yderligere oplysninger om konfiguration.

3

Indstil forbindelsestilstanden til Bridge-tilstand.1.
Registrer kameraets IP-adresse.2.
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Brug af enheden i et miljø med flere kameraer med en MSU/fjernbetjeningssoftware til
kamera

Du kan tilslutte flere kameraer vha. en MSU eller fjernbetjeningssoftware til kamera.

Bemærk!

Se "Liste over understøttede funktioner", og konfigurer enheden, så den opfylder driftsbetingelserne for de funktioner, du vil bruge, og
aktivér derefter forbindelsen med en MSU eller fjernbetjeningssoftware til kamera vha. følgende procedure.

Relateret emne
Liste over understøttede funktioner
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Tænd hver enhed.1

Konfigurer systemnetværksindstillingerne vha. MSU eller fjernbetjeningssoftware til kamera.

Se brugsanvisningen til MSU eller fjernbetjeningssoftware til kamera for at få yderligere oplysninger om konfiguration.

2

Konfigurer følgende indstillinger vha. [Technical] > [RCP/MSU] i webmenuen på kameraet.3

Hvis du bruger en MSU, skal du indstille [CNS Mode] til [MCS]. Hvis du bruger fjernbetjeningssoftware til kamera,
skal du indstille [CNS Mode] til [PC Control].

1.

Indstil IP-adressen til master-MSU'en eller fjernbetjeningssoftwaren til kameraet i [Master IP Address].2.
Indstil kameranummeret for det kamera, som vil blive registreret, i [Camera No.].3.
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Liste over understøttede funktioner

Følgende tabel viser de understøttede funktioner og deres tilhørende driftsbetingelser.

Betjeningspanel Enhedens funktioner Driftsbetingelser

IRIS Manuel justering af iris –

AUTO IRIS Slår Auto Iris til/fra –

ND
Skifter ND-filterets forudindstillede position
(Clear/Preset1 til Preset3)

Denne funktion aktiveres, når [Shooting] > [ND
Filter] > [Mode] er indstillet til [Preset] i
kameramenuen.

MASTER GAIN
Manuel justering af forstærkning (3 dB
enheder)

Aktiveret, når både optagelsestilstand er indstillet til
Custom-tilstand, og [Shooting] > [ISO/Gain/EI] >
[Mode] er indstillet til [dB] i kameramenuen.

WHITE (R/B)
Manuel justering af hvidbalance (R Gain/B
Gain)

Aktiveret når [White Mode] er indstillet til [Memory
A(R/B)] eller [Memory A(T/T)].WHITE (Color

Temp)

Manuel justering af hvidbalancen
(farvetemperatur/-tone)

RCP – [Color Temp]: Hvidbalance
farvetemperatur
RCP – [Balance]: Hvidbalance-toneværdi

ATW
Slår ATW (automatisk sporing af hvidbalance)-
funktionen til/fra

Aktiveret, når optagelsestilstanden er indstillet til
Custom-tilstand.

BLACK R/B Justerer sortbalancen
Aktiveret, når optagelsestilstanden er indstillet til
Custom-tilstand.
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Bemærk!

Konfigurer enheden, så den opfylder driftsbetingelserne for de funktioner, du vil bruge, og aktivér derefter forbindelsen med en
RCP/MSU. Hvis driftsbetingelserne justeres, efter forbindelsen er aktiveret, kan der opstå utilsigtet adfærd.

5-041-958-93(1) Copyright 2022 Sony Corporation

Betjeningspanel Enhedens funktioner Driftsbetingelser

MASTER BLACK Justering af masterniveauet for sort

Aktiveret, når optagelsestilstanden er indstillet til
Custom-tilstand.
H/V Ratio og Crispening er aktiveret, når
[Paint/Look] > [Detail] > [Manual Setting] er
indstillet til [On] i kameramenuen.

DETAIL

Slår detaljefunktionen til/fra
Indstilling af detaljeniveauet
Indstilling H/V Ratio
Indstilling Crispening

User Matrix

Slår funktionen brugermatrix-korrektion
til/fra
Indstilling af matrix-korrektionsværdier (R-
G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Slår funktionen multimatrix-korrektion til/fra
Indstilling af farvetonen og mætningen for
den farve, der bruges til multimatrix-
korrektion

Knee

Slår funktionen til korrektion af knæpunktet
til/fra
Slår funktionen for automatisk knæpunkt til/fra
Indstiller knæpunktet og knæhældningen

BARS Slår farvebjælkerne til/fra

SHUTTER

Slår lukkerfunktionen til/fra
Indstilling af lukkerhastighedsværdien
(Slå autolukker til/fra, indstille lukkervinkel,
indstille langsom lukker, indstilling af ECS
ikke understøttet).

Bemærk!

RCP-lukkerindstillingerne vises muligvis
ikke, afhængigt af den konfigurerede
lukkerhastighedsværdi.

RCP-lukkerindstillingerne vises muligvis
ikke korrekt, hvis lukkeren ikke kan
betjenes fra RCP.

Når autolukker er aktiveret, vil autolukker fortsætte
med at køre, selvom du slår lukkeren til/fra eller
ændrer lukkerhastighedsværdien fra RCP.
Når lukkeren er indstillet til [Angle], understøttes
funktionen til at slå lukkeren til/fra eller ændre
lukkerhastighedsindstillingen fra RCP ikke.

428



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Om drift vha. en RM-IP500 fjernbetjening (ekstraudstyr)

Du kan betjene enheden vha. en Sony RM-IP500 fjernbetjening, der kører softwareversion 2.2 eller senere. Enhederne
kommunikerer vha. VISCA over IP (LAN).
Afhængigt af hvad der skal betjenes, kan det være nødvendigt at se enhedens skærm. Forbered en monitor, der kan bruges
til at tjekke skærmvisningen.
De følgende funktioner understøttes af en RM-IP500 fjernbetjening.

Vælger målkameraet
Justerer indramningen (panorering, hældning, zoom)
Justerer fokus (ekskluderer touch-betjening)
Registrerer og genkalder forindstillede positioner
Betjener enhedens menu (ekskluderer webmenuen)
Justering af lysstyrken
Justerer hvidbalancen
Justerer sortbalancen
Justerer lydinputniveauet
Starter/stopper optagelse
Udfører de tildelelige knappers funktioner

For yderligere oplysninger om RM-IP500, se brugsanvisningen til RM-IP500.

Tip!

Ved brug af en RM-IP500 benyttes panelpladen til denne enhed, som følger med RM-IP500.

RM-IP500 (brug af panelplade til denne enhed)

5-041-958-93(1) Copyright 2022 Sony Corporation

429



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tilslutning af en RM-IP500 Fjernbetjening

For nærmere oplysninger om tildeling henvises til brugsanvisningen til RM-IP500.
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Indstil SETUP-kontakt 3 på enheden til positionen ON for at aktivere VISCA over IP-kommunikation.

Bemærk!

Kontaktens indstilling anvendes, når enheden tændes næste gang.

1

Slut RM-IP500 til samme netværk som enheden.2

Følg proceduren i RM-IP500 brugsanvisning for at konfigurere VISCA over IP (LAN) forbindelse på RM-IP500.

Tildel denne enhed vha. RM menu > AUTO IP SETUP > ASSIGN CAM.

3

Tildel denne enheds funktioner til knapper og greb som påkrævet ved brug af følgende RM-menupunkter
tilhørende RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Om synkronisering med en ekstern enhed

Ved optagelse vha. flere enheder kan enhederne synkroniseres til et specifikt referencesignal eller tidskode via GENLOCK-
stikket på enhederne.

For yderligere oplysninger om genlock se "Synkronisering af videosignalets fase (genlock)".
For yderligere oplysninger om synkronisering af tidskoder se "Låsning af tidskoden til andre enheder".

Relateret emne
Synkronisering af videosignalets fase (genlock)

Låsning af tidskoden til andre enheder

5-041-958-93(1) Copyright 2022 Sony Corporation
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Synkronisering af videosignalets fase (genlock)

Du kan levere et referencesignal til GENLOCK-stikket for at aktivere genlock.
Inputreferencesignalerne, der kan bruges, varierer afhængigt af systemfrekvensen for det valgte optagelsesformat.

Du kan tjekke den eksterne synkroniseringsstatus vha. [Technical] > [Genlock] > [Reference] i kameramenuen.

Bemærk!

Hvis referencesignalet er ustabilt, kan genlock ikke opnås.

Subcarrier er ikke synkroniseret.
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Systemfrekvens af optagelsesformat Understøttede inputreferencesignaler

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Låsning af tidskoden til andre enheder

Sæt den enhed, der leverer tidskoden, i en tilstand, hvor tidskodeoutputtet bliver ved med at køre (f.eks. Free Run eller
Clock).

Bemærk!

Tjek, at den medfølgende referencetidskode og referencevideosignalet er i et faseforhold, der overholder SMPTE-tidskodestandarden.

Når der arbejdes med ekstern lås, opnår tidskoden øjeblikkeligt låsning med den eksterne tidskode, og den eksterne tidskodeværdi
vises i datavisningsområdet. Du må dog ikke starte optagelsen med det samme. Vent et par sekunder, indtil tidskodegeneratoren
stabiliserer sig, før du optager.

Hvis frekvensen for referencevideosignalet og rammefrekvensen på enheden ikke er den samme, kan der ikke opnås låsning, og
enheden fungerer ikke korrekt. Hvis dette sker, vil tidskoden ikke opnå en vellykket låsning med den eksterne tidskode.

Hvis den eksterne tidskode er frakoblet, kan den skifte med et billede pr. time i forhold til referencetidskoden.

For at frigøre den eksterne lås
Skift indstillingen af [TC/Media] > [Timecode] i kameramenuen.
Ekstern synkronisering frigøres også, hvis systemfrekvensen ændres, og når du starter optagelse i en særlig
optagelsestilstand (Slow & Quick Motion eller Interval Rec).

5-041-958-93(1) Copyright 2022 Sony Corporation

Indstil følgende i [TC/Media] > [Timecode] i kameramenuen.

Indstil [Mode] til [Preset].
Indstil [Run] til [Free Run].

1

Tryk på en tildelelig knap, der er tildelt funktionen [DURATION/TC/U-BIT], for at få vist tidskoden på skærmen.2

Levér et HD- eller SD-referencevideosignal til GENLOCK-stikket og referencetidskoden til TC IN-stikket.

Enhedens tidskodegenerator opnår låsning med referencetidskoden, og "EXT-LK" vises på skærmen.
Når der er gået ca. ti sekunder efter at tidskoden låste, opretholdes den eksterne låsetilstand, selv hvis den eksterne
referencetidskodekilde frakobles.

3
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Tilslutning af en ekstern mikrofon eller ekstern lydenhed

Du kan indlæse signalet fra en ekstern mikrofon eller ekstern lydenhed og integrere lyden i enhedens optagede video eller
output-video.

Tilslut en ekstern mikrofon eller ekstern lydenhed vha. et XLR-kabel.

Når lyden er indstillet til [LINE] vha. [Audio] > [Audio Input] > [AUDIO IN Select] i kameramenuen, fungerer AUDIO IN-
stikket som AUDIO IN CH-1-stikket og AUDIO IN CH-2-stikket.

1

Ben nr. Funktion

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Sluk for enheden, og tilslut XLR-kablet til AUDIO IN-stikket.2

Indstil SETUP-kontakt 2 til at aktivere phantom power-strømforsyning som påkrævet.

Skift +48 V strømforsyningen (phantom power) som beskrevet herunder.
Kontakt 2
Angiver om +48 V strømforsyning (phantom power) er tændt/slukket, når en lydinputenhed er tilsluttet.

3

Indstilling Beskrivelse

OFF
(standard)

Dette slukker for +48 V phantom power-forsyningen og indstiller LINE- eller MIC-indgang som CH-1
og CH-2 lydkilde.

ON Dette tænder for +48 V phantom power-forsyningen, og indstiller phantom power-forsyningens
kompatible mikrofon som CH-1 og CH-2 lydkilde.

434



5-041-958-93(1) Copyright 2022 Sony Corporation

Bemærk!

Indstilling af denne kontakt til ON-positionen og tilslutning af en mikrofon, der ikke er kompatibel med en +48 V-kilde, kan
beskadige den tilsluttede enhed. Kontroller indstillingen, før du tilslutter enheden.

Tænd for enheden, og indstil den tilsluttede enhed vha. [Audio] > [Audio Input] > [AUDIO IN Select] i
kameramenuen.

4

435



Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Håndtering/Redigering af klip ved hjælp af en computer

Du kan administrere/redigere klip vha. en computer.

Import af klip med brug af en kortlæser (ekstraudstyr)

Tilslut en CFexpress Type A-kortlæser eller SD-kortlæser til din computer, og brug software, der understøtter denne enheds
optagelsesformat, såsom Catalyst Browse, til at importere klippene.

Anvendelse af et ikke-lineært redigeringssystem

I et ikke-lineært redigeringssystem er redigeringssoftware (ekstraudstyr), der understøtter de formater, som enheden optager,
påkrævet.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Udsender et optisk fibersignal

Du kan udsende et SDI-signal konverteret til et optisk signal ved at tilslutte et SFP+ modul (ekstraudstyr) til enhedens
OPTICAL-stik. Brug et SFP+-modul, der matcher hvert formats signalbånd.
Signalbånd

4K (59.94p, 50p): 12G
4K (udover 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (udover 59.94p, 50p): 1.5G

Bemærk!

Brug et modul, der overholder de følgende standarder.

SFF-standarder
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI-standarder
ST297/ST292/ST424/ST425/ST2081/ST2082

Det samme signal som SDI-udgangsstikket sendes ud til SFP+-modulet.

Enheden understøtter ikke optisk fibersignal-input.

Brug et SFP+-modul til optisk fibersignal-output. Kontakt din forhandler eller Sony-servicerepræsentant for at få oplysninger om
godkendte SFP+-moduler.
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* Strømniveau I (1,0 W)
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Tilslutning af tally-signal

Dette emne beskriver tally-signalkontrol.

Oplysning af tally-lampen vha. et signal fra en fjernbetjening

Du kan belyse tally-lampen vha. en VISCA over IP-kommando fra en ekstern enhed såsom RM-IP500.
Indstil [Technical] > [Tally] > [Tally Control] til [External] i webmenuen eller kameramenuen.

Belysning af tally-lampen fra en ekstern enhed

Du kan belyse tally-lampen på enheden med rødt eller grønt fra en ekstern enhed såsom RM-IP500 eller en omskifter. Du
kan styre tally vha. kommandoerne, der transmitteres over netværket, eller bruge et tally-signalinput på enhedens OPTION-
stik.
Indstil [Technical] > [Tally] > [Tally Control] til [External] i webmenuen eller kameramenuen.
Ved indsendelse af et tally-signal på OPTION-stikket, kortsluttes 7 til GND (enten ben 4 eller 5) til at oplyse tally-lampen med
grønt, eller ben 8 til GND (enten ben 4 eller 5) til at belyse tally-lampen med rødt.

Bemærk!

Når [Tally Control] er indstillet til [External], er enhedens optagelsesstatus ikke angivet af tally-lampen.

Når en rød og grøn tally indsendes samtidigt, lyser tally-lampen på enheden rødt.

OPTION-stiks specifikationer

Ben nr. Signalretning Signalspecifikationer

1 – RS-232C TX-signal (for objektiv styreenhed)

2 – RS-232C RX-signal (for objektiv styreenhed)

3 OUT

Grøn tally-lampes output
Output på lavt niveau når grøn tally-lampe er tændt.
Hi-Z (åbent afløb-output) når grøn tally-lampe ikke er tændt.

4 – GND (Jord)

5 – GND (Jord)

6 OUT

Rød tally-lampes output
Output på lavt niveau når rød tally-lampe er tændt.
Hi-Z (åbent afløb-output) når rød tally-lampe ikke er tændt.
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Oplysning af tally-lampen på en ekstern enhed vha. et signal fra enheden

Du kan oplyse tally-lampen på en ekstern enhed vha. et signal fra enheden ved at forbinde ben 3 og 6 til OPTION-stikket
som vist herunder.
OPTION-stik ben 3 og 6 tilslutningseksempel

Bemærk!

Anvend ikke spænding på ben 7 og 8.

Forbind ikke en ekstern enhed, der kan anvende spænding på OPTION-stikket.

Hvis der påføres en tilløbs- eller omvendt spænding, der overstiger normeringen, på ben 3 eller 6, kan det forårsage funktionsfejl, røg
eller brand.

Indstil outputsignalet vha. [Technical] > [Tally] > [Tally Control] i webmenuen eller kameramenuen.
[Internal]: Enhedens optagelsesstatus
[External]: Logical-AND af røde/grønne tally-signaler modtaget af enheden via IN-signalet og fjernbetjeninger.

5-041-958-93(1) Copyright 2022 Sony Corporation

Ben nr. Signalretning Signalspecifikationer

7 IN
Grøn tally-lampe eksternt kontrolinput
Kortslutning til jord (ben 4 eller 5) får tally-lampen på enheden til at lyse grønt.

8 IN
Rød tally-lampe eksternt kontrolinput
Kortslutning til jord (ben 4 eller 5) får tally-lampen på enheden til at lyse rødt.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Udsende sporingsdata (free-d)

Enheden kan udsende panorerings/hældnings-/zoom, fokus og iris sporingsoplysninger, synkroniseret til et
synkroniseringssignal.
Dataoutputtet er i overensstemmelse med free-d-protokollen, en industristandard. Du kan vælge outputmetoden, vælge
mellem konstant output og output efter anmodning fra klienter. Vælg outputmetoden i overensstemmelse med dit VR/AR-
system.

Dataoutputformat

Tip!

Tekniske oplysninger gives i "Integrationsmanual for free-d". Kontakt en salgsrepræsentant fra Sony.

Sporingsdata der udsendes af enheden indbefatter følgende data, i henhold til formatet angivet i Type D0/D1 i free-d-
protokollen.
Type D0 – poll/command

Type D1 – kameraposition/orienteringsdata

Kontrollér at enheden er tændt.1

Indstil sporingsdata outputmetoden.

For konstant output

For output efter anmodning fra klienter

2

Indstil [Technical] > [Tracking Data Output] > [Transfer Mode] til [Always] i webmenuen.1.
Indstiller enhedens ID i [Camera ID].2.
Angiv outputdestination IP-adressen i [Destination Address].3.
Angiv outputdestination portnummeret i [Destination Port].4.
Tryk på [OK]-knappen.5.

Indstil [Technical] > [Tracking Data Output] > [Transfer Mode] til [On Demand] i webmenuen.1.
Indstiller enhedens ID i [Camera ID].2.
Angiv portnummeret til at lytte til anmodninger fra klienter i [Listen Port].3.
Tryk på [OK]-knappen.4.

Symbol Indhold Beskrivelse

<D0> Message type

<CA> Camera ID

<CD> command

Understøtter følgende kommandoer:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Bemærk!

Sporingsdata kan blive forsinkede eller værdier opdateres muligvis ikke i de følgende situationer:

Under udsendelse af RAW-video
Når S&Q Motion er tændt
Når kameramenuen vises
Når miniaturebilledskærmen vises
Når der afspilles optagede klip
Når webmenuen vises
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Symbol Indhold Beskrivelse

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Panoreringsvinkel (−170° til +170°)

<TH><TM><TL> Camera Tilt Angle Hældningsvinkel (−30° til +195°)

<RH><RM><TL> Camera Roll Angle Ikke understøttet (altid 0)

<XH><XM><XL> Camera X-Position Ikke understøttet (altid 0)

<YH><YM><YL> Camera Y-Position Ikke understøttet (altid 0)

<HH><HM><HL> Camera Height Ikke understøttet (altid 0)

<ZH><ZM><ZL> Camera Zoom Brændvidde

<FH><FM><FL> Camera Focus Fokusafstand

<SH><SL> Spare/User Defined Irisposition

<CK> Checksum
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tilslutning af en objektiv styreenhed

Du kan betjene zoom for et manuelt zoomobjektiv fra webappen, RM-IP500 (valgfri), eller fra den infrarøde fjernbetjening,
ved at tilsluttet en kommercielt tilgængelig objektiv styreenhed (valgfri), som er kompatibel med denne enhed.
For oplysninger om tilslutning af en objektiv styreenhed, se betjeningsvejledningen for objektiv styreenheden.
For oplysninger om justering af zoom vha. en objektiv styreenhed, se "Justering af Zoom vha. en objektiv styreenhed".

Bemærk!

Før du bruger en objektiv styreenhed, skal du læse betjeningsvejledningen til objektiv styreenheden grundigt og sørge for at du forstår
dens brug fuldt ud. Sony påtager sig intet ansvar for erstatningskrav i forbindelse med brug af en objektiv styreenhed.

Clear Image Zoom er ikke tilgængelig, når en objektiv styreenhed er aktiveret. Det anbefales at du indstiller Clear Image
Zoomhastighed til 1.0× eller at deaktivere Clear Image Zoom.

Når objektiv styreenheden er aktiveret, kan kamera indramningsfunktioner ikke optages eller afspilles.

Relateret emne
Justering af Zoom vha. en objektiv styreenhed

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justering af Zoom vha. en objektiv styreenhed

Brug følgende procedure til at montere en objektiv styreenhed (valgfri) eller til at justere zoom.

Sådan kontrolleres status for objektiv styreenhed
Tryk på  (kamerastatus)-knappen i det fælles område på webapp-skærmen for at vise kamerastatusskærmen.

Tilslut en objektiv styreenhed til OPTION-tilslutning på forbindelsesblokken for enheden.

Se brugsanvisningen til objektiv styreenheden for at få yderligere oplysninger om montering.

1

Opsæt objektiv styreenheden til dit zoomobjektiv.

Se brugsanvisningen til objektiv styreenheden for at få yderligere oplysninger.

2

Lås panorering/hældning på enheden og montér zoomobjektivet.

For yderligere oplysninger se "Montering af et objektiv".

3

Juster objektivstyreenheden, så den kan styre zoomobjektivet.4

Oprethold kamerahovedets fremad/bagud-balance, så glidebasen er vandret.

Se brugsanvisningen til objektiv styreenheden og "Montering af et objektiv".

5

Indstil [Technical] > [Lens Controller] > [Setting] til [On] i webmenuen og tryk på [OK]-knappen.

Enheden genstarter. Vent indtil panorerings/hældnings nulstillingsfunktion er udført.

6

Tryk på  (Start objektiv styreenhed)-knappen på  (Others)-fanen i kameraets kontrolpanel på
live funktionsskærmen for webappen.

Objektiv styreenheden flytter for at påvise zoomområdet. Se brugsanvisningen til objektiv styreenheden for at få
yderligere oplysninger.
Når  (fejl på objektiv styreenhed) indikation skifter til  (objektiv styreenhed klar) øverst til venstre på kameraets
billedpanel, er klargøringen fuldendt.

Bemærk!

Bemærk objektivets grænsefunktion, når objektiv styreenheden startes.

7

Juster zoom vha. [Zoom]-skyderen i webappen eller zoom-betjeningsknapperne for den infrarøde
fjernbetjening.

8
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Du kan kontrollere status for objektiv styreenhed på denne skærm.

Bemærk!

Når du skifter objektivet skal objektivets styreenhed startes.

Clear Image Zoom er ikke tilgængelig, når en objektiv styreenhed er aktiveret. Det anbefales at du indstiller Clear Image
Zoomhastighed til 1.0× eller at deaktivere Clear Image Zoom.
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Status Beskrivelse

Off Brug power zoom på et E-mount objektiv.

Communication
Error

Der opstod en kommunikationsfejl mellem enheden og objektiv styreenheden.
Kontrollér forbindelsen mellem enheden og objektiv styreenheden, se betjeningsvejledningen til
objektiv styreenheden og start objektivets styreenhed.

Uninitialized Udfør opstart.

Initializing Vent indtil opstarten er udført.

Initialization
Failed

Kontrollér forbindelsen mellem enheden og objektiv styreenheden, se betjeningsvejledningen til
objektiv styreenheden og start objektivets styreenhed.

Working Kontrollér zoom vha. objektiv styreenheden.

Rotation Error
Det gemte zoom-bevægelsesområde og objektivets bevægelsesområde passer muligvis ikke. Start
objektivets styreenhed.

System Error Kontrollér forbindelsen mellem enheden og objektiv styreenheden, se betjeningsvejledningen til
objektiv styreenheden og start objektivets styreenhed, eller tænd enheden og objektiv styreenheden.Unknown Error
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forholdsregler ved brug

Forholdsregler under transport og indpakning
Når enheden transporteres eller indpakkes, skal følgende forhold opretholdes og det bør undgås, at udsætte den for stærke
vibrationer eller stød.

Fjern objektivet og påsæt hætten.
Efter at have flyttet kamerahovedet (A) til forsiden, drej kamerahovedets låsehåndtag (B) i retning af pilen for at låse
kamerahovedet.

Placer kamerahovedet så det vender mod forsiden og lås ved hjælp af panorerings-/hældningslåsehåndtaget.

Fjern tilslutningskablerne.

Kondensation
Hvis enheden bringes direkte fra et koldt sted til et varmt sted, eller hvis omgivelsestemperaturen pludselig stiger, kan der
dannes fugt på overfladen af og/eller inden i enheden. Dette kaldes kondensation. Hvis der opstår kondensation, skal
enheden slukkes, og den må ikke bruges, før fugtdannelsen er væk. Betjening af enheden, mens den er fugtig, kan medføre
beskadigelse.

Kamera-CMOS-billedsensor-fænomen

Bemærk!

Følgende fænomener, der kan forekomme på billeder, er specifikke for billedsensorer. De indikerer ikke en funktionsfejl.

Hvide pletter
Selvom billedsensorerne fremstilles med yderst præcise teknologier, kan der i sjældne tilfælde genereres fine, hvide
pletter på skærmen, forårsaget af kosmiske stråler osv.
Dette er relateret til princippet om billedsensorer og er ikke en fejlfunktion. Udfør APR regelmæssigt.
De hvide pletter ses især i følgende tilfælde:

Ved anvendelse ved en høj omgivelsestemperatur
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Når du har øget forstærkningen (følsomhed)
Flimmer
Hvis der filmes under belysning produceret af lysstofrør, natriumlamper, kviksølvdamplamper eller LED-lamper, kan
skærmen flimre, eller farverne kan variere.

Objektiv og panorerings-/hældningsenheder
Hvis objektivet og panorerings-/hældningsmekanismen ikke betjenes i en længere periode, kan viskositeten af fedtet, som
påføres indvendigt, forøges, hvilket kan forhindre mekanismens bevægelse. Betjen objektivet og
panorerings-/hældningsmekanismen jævnligt.

På forbrugsdele
Ventilatoren og det indbyggede genopladelige batteri er forbrugsdele, som kræver periodisk udskiftning.
Ved brug ved rumtemperatur er den normale udskiftningscyklus omkring 5 år. Denne udskiftningscyklus er dog kun
vejledende og betyder ikke, at levetiden for disse dele garanteres.
Kontakt et Sony-servicecenter eller din forhandler for detaljer om delens udskiftning.

Den forventede levetid for vekselstrøms- adapteren og dens elektrolytiske kapacitor er omkring 5 år ved normale
brugstemperaturer og normal brug (8 timer pr. dag, 25 dage pr. måned). Hvis brugen overstiger den normale
brugsfrekvens, kan den forventede levetid falde tilsvarende.

Periodiske inspektioner anbefales for at holde enheden korrekt kørende og forlænge dens brugbare levetid. Kontakt en
service- eller salgsrepræsentant fra Sony for yderligere information om inspektioner.

Vedrørende det indbyggede, genopladelige batteri
Enheden har et indbygget genopladeligt batteri til lagring af dato, klokkeslæt og andre indstillinger, selv når enheden er
slukket. Det indbyggede, genopladelige batteri vil være opladet efter 24 timer, hvis enheden er tilsluttet en stikkontakt ved
hjælp af vekselstrømsadapteren, eller hvis enheden er strømforsynet via PoE++, uanset om enheden er tændt eller slukket.
Det genopladelige batteri vil være helt afladet på cirka to måneder, hvis vekselstrømsadapteren ikke er tilsluttet
strømforsyningen. Brug din enhed efter opladning af batteriet. Selvom det genopladelige batteri ikke er opladet, påvirkes
driften af enheden imidlertid ikke, så længe du ikke har brug for at registrere datoen.

Anvendelses- og opbevaringssteder
Opbevar på et plant, ventileret sted.
Undgå at bruge eller opbevare enheden de følgende steder.

Placeringer der er udsat for regn eller vand (inklusive under tagudhæng)
Udendørs og steder der overstiger 40 °C
Husk, at temperaturen i en bil med lukkede vinduer om sommeren i varme klimaer nemt kan overstige 50 °C.
Placeringer der er koldere end 0 °C.
På fugtige eller støvede steder. Steder, hvor enheden kan blive udsat for regn
Placeringer der er udsat for vibrationer eller stød
Placeringer hvor stråling, røntgenstråler og stærke magnetiske felter genereres.
Tæt på radio- eller tv-sendere, der producerer stærke elektromagnetiske felter.
I direkte sollys eller tæt på varmeovne i længere perioder

Bemærkning om laserstråler
Laserstråler kan beskadige CMOS-billedsensoren. Hvis du optager en scene, der omfatter en laserstråle, skal du passe på
med ikke at lade laserstrålen blive ledt ind i kameraets CMOS-billedsensor. Særligt kan kraftige laserstråler fra medicinsk
udstyr eller andre enheder forårsage skader på grund af reflekteret lys og spredt lys.

Forebyggelse af elektromagnetisk interferens fra bærbare kommunikationsenheder
Brug af bærbare telefoner og andre kommunikationsenheder i nærheden af denne enhed kan resultere i funktionsfejl og
interferens med lyd- og videosignaler. Det anbefales, at de bærbare kommunikationsenheder i nærheden af denne enhed
slukkes.

Placer ikke dette produkt i nærheden af medicinsk udstyr
Dette produkt (inklusive tilbehør) indeholder magnet(er), som muligvis kan interferere med pacemakere, programmerbare
shuntventiler til hydrocephalusbehandling eller andet medicinsk udstyr. Placer ikke dette produkt i nærheden af personer,
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som anvender sådan medicinsk udstyr. Konsulter din læge inden du anvender dette produkt, hvis du anvender nogen former
for sådan medicinsk udstyr.

Sikkerhedsforanstaltninger
SONY ER IKKE ANSVARLIG FOR NOGEN FORM FOR SKADE FORÅRSAGET AF MANGLENDE OVERHOLDELSE AF
SIKKERHEDSFORHOLDSREGLER PÅ TRANSMISSIONSENHEDER, UUNDGÅELIGE DATALÆK FORÅRSAGET AF
TRANSMISSIONSSPECIFIKATIONER ELLER ENHVER TYPE SIKKERHEDSPROBLEMER.
Afhængigt af driftsmiljøet kan uautoriserede tredjeparter på netværket have adgang til enheden. Når enheden tilsluttes til
netværket, skal du sørge for at bekræfte, at netværket er sikkert beskyttet.
Når enheden bruges, mens den er koblet på netværket, anbefales det på det kraftigste, ud fra et sikkerhedsperspektiv, at
tilgå vinduet Kontrol via en webbrowser og ændre indstillingerne for adgangsbegrænsning fra de fabriksindstillede
værdier. Det anbefales også, at du bruger en adgangskode med en tilstrækkelig lang tegnstreng, som andre har svært
ved at gætte, samt at du opbevarer den sikkert.
Når dette produkt kobles på et netværk, skal opkoblingen ske via et system med en beskyttelsesfunktion, som f.eks. en
router eller firewall. Hvis opkoblingen sker uden en sådan beskyttelse, kan der opstå sikkerhedsproblemer.

Strømforsyning
Enheden er ikke udstyret med en strømkontakt. For at slukke for enheden skal du tjekke, at alle driftsfunktioner er
afsluttet, og at enheden er på standby. Dernæst frakobles vekselstrømadapteren. Når man anvender PoE++
strømlevering, frakobles LAN-kablet.
Hvor det er muligt, benyttes en strømkilde fra et sted, hvor det er nemt at indsætte og fjerne strømledningen.
Hvis du bruger en udgang på et støvet sted, skal du regelmæssigt rengøre området omkring udgangen for at forhindre
sporing.
Afbryd strømforsyningen når den ikke er brug.

Forholdsregler for bevægelige dele
Sørg for, at fremmeddele ikke kommer ind i bevægelige dele.
Påfør ikke for stor belastning, når delene flyttes med hænderne. Hvis du gør det, vil det medføre en fejlfunktion.
Afbryd ikke de bevægelige dele, når de er i bevægelse. Hvis du gør det, kan det medføre en kvæstelse eller fejlfunktion.
Bevægelige dele fungerer måske ikke normalt, hvis enheden ikke bruges i en længere periode. Betjen enhedens
panorerings-/hældningsfunktioner regelmæssigt.

Forholdsregler for vedvarende drift
Enheden kan køre 24 timer om dagen, 365 dage om året (strøm standby-tilstand).
Udfør altid en optagelsestest og kontrollér, at enheden fungerer normalt.

Løbende optagelse i perioder over 24 timer er ikke garanteret.
Hvis der optages i mere end 24 timer, skal enheden sættes i standby-tilstand og derefter genstartes.

Bemærk, at Sony ikke er ansvarlig for nogen form for kompensation for indholdet af billeder, hvis du ikke kan optage på
grund af enhver funktionsfejl under brug af denne enhed.
Kontrollér altid, at enheden fungerer korrekt, før du bruger den. SONY ER IKKE FORPLIGTET TIL AT YDE NOGEN
FORM FOR ERSTATNING INKLUSIVE, MEN IKKE BEGRÆNSET TIL KOMPENSATION ELLER REFUSION PÅ
GRUND AF TAB AF NUVÆRENDE ELLER MULIG INDTJENING FORÅRSAGET AF SVIGT I DENNE ENHED, ENTEN I
LØBET AF GARANTIPERIODEN ELLER EFTER UDLØB HERAF, ELLER AF EN HVILKEN SOM HELST ANDEN
ÅRSAG.
SONY KAN IKKE GØRES ANSVARLIG I FORBINDELSE MED KRAV AF NOGEN ART, SOM REJSES AF BRUGERE AF
DENNE ENHED ELLER AF TREDJEPARTER.
SONY KAN IKKE GØRES ANSVARLIG FOR AFBRYDELSEN ELLER OPHØRET AF NOGEN TYPE SERVICE I
FORBINDELSE MED DENNE ENHED, SOM KAN FOREKOMME, UANSET DE TILGRUNDLIGGENDE
OMSTÆNDIGHEDER.

Forholdsregler for optagelsesfunktionen
Foretag altid en prøveoptagelse og kontrollér, at den blev udført korrekt. SONY ER IKKE FORPLIGTET TIL AT YDE
NOGEN FORM FOR ERSTATNING INKLUSIVE, MEN IKKE BEGRÆNSET TIL KOMPENSATION ELLER REFUSION
PÅ GRUND AF SVIGT I DENNE ENHED ELLER DENS OPTAGEMEDIE, ELLER ANDRE MEDIE- ELLER
OPBEVARINGSSYSTEMER TIL INDSPILNING AF INDHOLD AF ENHVER ART.
Kontrollér altid, at enheden fungerer korrekt, før du bruger den. SONY ER IKKE FORPLIGTET TIL AT YDE NOGEN
FORM FOR ERSTATNING INKLUSIVE, MEN IKKE BEGRÆNSET TIL KOMPENSATION ELLER REFUSION PÅ
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GRUND AF TAB AF NUVÆRENDE ELLER MULIG INDTJENING FORÅRSAGET AF SVIGT I DENNE ENHED, ENTEN I
LØBET AF GARANTIPERIODEN ELLER EFTER UDLØB HERAF, ELLER AF EN HVILKEN SOM HELST ANDEN
ÅRSAG.
SONY KAN IKKE GØRES ANSVARLIG I FORBINDELSE MED KRAV AF NOGEN ART, SOM REJSES AF BRUGERE AF
DENNE ENHED ELLER AF TREDJEPARTER.
SONY KAN IKKE GØRES ANSVARLIG FOR TAB, REPARATION ELLER GENSKABELSE AF DATA AF NOGEN ART,
DER ER OPTAGET PÅ DET INTERNE LAGRINGSSYSTEM, OPTAGELSESMEDIER ELLER NOGET ANDET MEDIE-
ELLER LAGRINGSSYSTEM.
SONY KAN IKKE GØRES ANSVARLIG FOR AFBRYDELSEN ELLER OPHØRET AF NOGEN TYPE SERVICE I
FORBINDELSE MED DENNE ENHED, SOM KAN FOREKOMME, UANSET DE TILGRUNDLIGGENDE
OMSTÆNDIGHEDER.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output-formater og -begrænsninger

Dette emne beskriver outputformat og -begrænsninger.

Bemærk!

Opløsningen af outputformatet er begrænset af indstillingerne af [Project] > [Rec Format] > [Frequency], [Codec] og [Video Format] i
webmenuen eller kameramenuen.

Output-formatets opløsning er også begrænset af kombinationen med S&Q-billedhastigheden. Foruden tabellen med SDI OUT/HDMI
OUT-tilslutningens outputformater nedenfor ændres HDMI-outputtet til Full HD eller lavere, når alle de følgende betingelser er opfyldt.

[Shooting] > [S&Q Motion] > [Setting] er indstillet til [On]
[Shooting] > [S&Q Motion] > [Frame Rate] er højere end 60fps

Når betingelserne ovenfor opfyldes, nedtones valgmulighederne for HDMI-output 4096×2160P og 3840×2160P for [Monitoring] >
[Output Format] > [SDI/HDMI], og de kan ikke vælges.

Billedet udsendes ikke, hvis en højere opløsning end afspilningsbilledets opløsning konfigureres.

SDI OUT/HDMI OUT-tilslutningens outputformater

Når systemfrekvensen er 50/59.94 Hz

Indstilling Valgbart outputformat

Optagelses-/Afspilningstilstand
RAW-outputopløsning/

Intern
optagelsesopløsning

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(standard)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(standard)
1920×1080i
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Når systemfrekvensen er 25/29.97 Hz

Indstilling Valgbart outputformat

Optagelses-/Afspilningstilstand
RAW-outputopløsning/

Intern
optagelsesopløsning

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Output stoppede)
720×480P2)

720×576P3)

Skærmvisningen må ikke overlejres.1)

Når systemfrekvensen er 59.942)

Når systemfrekvensen er 503)
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Når systemfrekvensen er 23.98 Hz

Indstilling Output Format (outputopløsning)

Optagelses-/Afspilningstilstand RAW-outputopløsning/
Intern optagelsesopløsning SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (standard)

3840×2160
(RAW) (3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (standard)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (standard) 1920×1080i (standard)

3840×2160

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (standard) 1920×1080i (standard)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Indstilling Output Format (outputopløsning)

Optagelses-/Afspilningstilstand RAW-outputopløsning/
Intern optagelsesopløsning SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (standard)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (standard)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (standard) 1920×1080P (standard)

3840×2160
3840×2160 (2SI)

3840×2160P
1920×1080P

1920×1080P (standard) 1920×1080P (standard)

1920×1080 1920×1080P (standard) 1920×1080P (standard)
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Når systemfrekvensen er 24 Hz

5-041-958-93(1) Copyright 2022 Sony Corporation

Indstilling Output Format (outputopløsning)

Optagelses-/Afspilningstilstand RAW-outputopløsning/
Intern optagelsesopløsning SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (standard)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (standard)

4096×2160P
1920×1080P (standard)
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fejlfinding

Strømforsyning

Billedoutput

Symptom Årsag Løsning

Enheden
tændes ikke.

Vekselstrømadapteren er ikke ordentligt tilsluttet DC IN-
stikket.

Indsæt strømledningen, så langt som den kan
komme.

Vekselstrømledningen er ikke indsat i
vekselstrømadapteren eller vekselstrømstikket.

Indsæt strømledningen, så langt som den kan
komme.

LAN-kablet er ikke tilsluttet korrekt mellem PoE++
strømleveringen og enheden.

Tjek, at kablet er indsat, indtil det klikker.

LAN-kablet er forbundet med OPTION-stikket, men ikke
med LAN-stikket.

Tilslut LAN-kablet med LAN-stikket på den
rigtige måde.

Enheden er forbundet med en strømleveringsenhed,
der ikke understøtter PoE++ (IEEE802.3bt, Type 4,
klasse 8).

Tilslut en strømleveringsenhed, der
understøtter PoE++ (IEEE802.3bt, Type 4,
klasse 8).

Det samlede strømforbrug overstiger maksimal
vurdering af PoE++ strømleveringsenheden.

Se brugsanvisningen til PoE++
strømleveringsenheden.

Et netværkskabel med kategorivurdering, der ikke
understøtter PoE++ strømlevering, er tilsluttet.

Brug et netværkskabel i kategori 5e eller
højere, forbundet med LAN-stikket.

Kameraet, PoE++ strømleveringsenhed og perifere
enheder er ikke jordforbundet.

Forbind kameraet, PoE++
strømleveringsenhed og perifere enheder til
jord.

Symptom Årsag Løsning

Intet billede er
udsendt.

Tilsluttede enheder er ikke ordentligt forbundet.
Forbind de tilsluttede enheder
korrekt.

Indledende opsætning blev ikke afsluttet.
Afslut den indledende opsætning
vha. webappen.

Intet billede er
udsendt fra HDMI-
stikket.

Et signal, der ikke er understøttet af HDMI-
outputdestinationsenheden, konfigureres.

Skift indstillingen af HDMI-
outputformatet, eller brug en
enhed, der understøtter
outputsignalet.

Et kabel, der ikke understøtter output HDMI-standarden,
bliver anvendt.

Brug et kabel, der understøtter
output HDMI-standarden i brug.
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Fjernbetjening

Infrarød fjernbetjening

Symptom Årsag Løsning

Intet billede er
udsendt fra SDI-
stikket.

Et kabel, der ikke understøtter output SDI-standarden, bliver
anvendt.

Brug et kabel, der understøtter
output SDI-standarden i brug.

Monitoren, der er forbundet med SDI-stikket, understøtter
ikke outputsignalet.

Brug en monitor, der understøtter
output SDI-standarden.

Optagelsesformatet er indstillet til RAW-output.
Skift optagelsesformatet til en
anden indstilling end RAW-output.

HDMI-output er indstillet til SD-opløsning.
Indstil HDMI-output til en anden
opløsning end SD.

Intet billede er
udsendt fra den
optiske fiber, eller
billedet er forvrænget.

Modulet, der bliver brugt, overholder ikke SFF- eller SMPTE-
standarder, eller strømniveau I (1,0 W).

Se "Udsender et optisk
fibersignal".

Intet billede er
udsendt eller er
forvrænget, når
ekstern synk.
anvendes.

Et eksternt synk.-signal, der er egnet til det konfigurerede
videosignalformat, indsendes ikke.

Indsend et eksternt synk.-signal,
der er egnet til det konfigurerede
videosignalformat.

Der er støj i lyden.

Kameraet, PoE++ strømleveringsenhed og perifere enheder
er ikke jordforbundet.

Forbind enhedens, PoE++
strømleveringsenhed og perifere
enheder til jord.

Enheden bliver benyttet i et miljø med enheder, der
genererer stærke elektriske og magnetiske felter (såsom
tv-/radio-antenner, amatørradiosendere,
klimaanlægsmotorer, strømforsyningstransformere).

Man skal holde sig væk fra
enheder, der genererer stærke
elektriske og magnetiske felter.

Objektivet, objektivets støtte og drivenheden er i kontakt
med enheden eller et objektiv i det omkringliggende miljø, og
unormal støj udsendes.

Montér objektivet korrekt.

Tjek for forhindringer i
nærheden af kameraet.

Symptom Årsag Løsning

Infrarød fjernbetjening fungerer ikke, når den
trykkes ned.

Infrarød fjernbetjening er deaktiveret.
Indstil [Technical] > [IR
Remote] > [Setting] til [On] i
webmenuen.

Batteriet er blevet afladet eller
batteripolariteten er ukorrekt.

Betjen den infrarøde
fjernbetjening i nærheden af
enhedens IR-sensor. Hvis
LED-lyset blinker, skal batteriet
udskiftes.

Indledende opsætning blev ikke
afsluttet.

Afslut den indledende
opsætning vha. webappen.
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RM-IP500

Webapp

Symptom Årsag Løsning

Panorerings-/hældningsbetjeningshastighed
er langsom.

Panorerings-/hældningshastighed fra
den infrarøde fjernbetjening er sat på
normal tilstand.

Sæt SETUP-kontakt 4 til ON-
positionen på
forbindelsesblokken for
enheden.

Betjening målrettede et andet kamera end
det tilsigtede.

Det infrarøde signal blev modtaget af et
andet kamera end det tilsigtede.

Indstil [Technical] > [IR
Remote] > [Setting] til [Off] i
webmenuen på kameraet, som
du ikke ønsker at styre.

Symptom Årsag Løsning

Kamera kan ikke betjenes fra RM-
IP500 Fjernbetjening.

Strømforsyningen til kameraet
er ikke tilsluttet.

Tjek, at POWER-lampen på enheden lyser grønt
eller orange.

Kameraet eller fjernbetjeningen
er ikke forbundet med
netværket.

Tjek forbindelserne til enheden og fjernbetjening.

Indledende opsætning af
kamera blev ikke afsluttet.

Afslut den indledende opsætning vha.
webappen.

VISCA over IP-kommunikation
er ikke aktiveret.

Sæt SETUP-kontakt 3 til ON-positionen på
enhedens stikpanel og genstart enheden.

IP-adressen til kameraet blev
ændret.

Tjek Ip-adressen til kameraet vha. [Network] >
[Wired LAN] i webmenuen eller kameramenuen.

Ip-adressen til kameraet blev
ændret vha. AUTO IP SETUP på
RM-IP500 Fjernbetjening.

Mindst 20 minutter er gået,
siden kameraet blev startet.

Genstart enheden. IP-adressen kan ændres vha.
AUTO IP SETUP inden for de første 20 minutter
efter at have startet enheden.

455



Symptom Årsag Løsning

Kan ikke forbinde vha. en
webbrowser.

Et kategori 5e eller højere LAN-
kabel er ikke tilsluttet.

Tilslut et kategori 5e eller højere LAN-kabel.

Ikke forbundet til LAN korrekt
eller forbundet netværk fungerer
ikke normalt.

Tjek, at Link LED til LAN-stikket lyser op. Hvis
Link LED ikke lyser op, skal du kontakte din
netværksadministrator.

Strømforsyningen til kameraet er
ikke tilsluttet.

Se "Power Supply"-afsnittet ovenfor.

En gyldig IP-adresse er ikke
konfigureret til enheden.

Udfør en netværksnulstilling.

Den konfigurerede IP-adresse er
i brug på en anden enhed.

Tjek, at IP-adresserne til perifere enheder er
unikke.

Den konfigurerede
undernetmaske matcher ikke
den anvendte
netværksundermaske.

Udfør en netværksnulstilling.

Enheden bliver tilgået på det
samme lokale netværk via en
proxy server.

Skift konfigurationen, så en proxy-server ikke
bruges.

Den konfigurerede standard
gateway til enheden er ukorrekt.

Udfør en netværksnulstilling.

Den indtastede URL er ukorrekt. Indtast den korrekte URL, og prøv igen.

HTTP-porten er ukorrekt.

Vis kameramenuen på en ekstern monitor, og
tjek indstillingen af [Network] > [Wired LAN] >
[HTTP Port]. Hvis en anden værdi end 80
konfigureres, tilføjes HTTP-portnummer til
værtsnavnet eller IP-adresse indtastes i
webbrowseren.
Eksempel: Hvis HTTP Port er indstillet til 8080,
indtastes http://<IP Address>:8080

HTTP-portnummeret til enheden
bliver filtreret eller blokeret.

Skift HTTP-portnummeret til enheden til en port,
der ikke bliver filtreret eller blokeret.

Gammel cache i webbrowseren
har en negativ effekt.

Slet cache fra webbrowseren.

Kan ikke forbinde til webappen vha.
2D-kode (QR-kode).

Enheden, der bruges,
understøtter ikke mDNS.

Brug en enhed, der understøtter mDNS.
Ved brug af en enhed, der ikke understøtter
mDNS, indtastes IP-adressen direkte i en
webbrowser.

Tabletten eller computeren er
forbundet til et andet netværk
end kameraet.

Forbind tabletten eller computeren til det samme
lokale netværk som enheden.

Kan ikke forbinde til webappen ved
manuelt at indtaste URL.

Enheden, der bruges,
understøtter ikke mDNS.

Brug en enhed, der understøtter mDNS.

Tabletten eller computeren er
forbundet til et andet netværk
end kameraet.

Forbind tabletten eller computeren til det samme
lokale netværk som enheden.
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Symptom Årsag Løsning

Godkendelsesskærmen vises
kontinuerligt.

Det korrekte brugernavn og
adgangskode blev ikke indtastet.

Indtast det registrerede brugernavn samt
adgangskoden. Hvis du har glemt den
registrerede brugerinformation, se "RESET-
kontakt" i "Forbindelsesblok" for at initialisere
brugerinformationen til netværksforbindelsen.

Brugernavnet og adgangskoden
kan have være ændret af en
bruger, der er logget ind vha. en
anden webbrowser.

Tjek det korrekte navn og adgangskode med
enhedsadministratoren.

Kamerabillede vises ikke i
webappen.

HDMI-output af kameraet er sat
til 720×480 eller 720×576.

Skift opløsningen af enhedens HDMI-output.

En HDMI-monitor, der ikke
understøtter kameraets HDMI-
outputsignal, er tilsluttet.

Fjern HDMI-monitoren, eller brug en HDMI-
monitor, der understøtter HDMI-
outputindstillingerne.

Enheden blev genstartet, og
sessionen blev frakoblet.

Vent et minut, og genindlæs webbrowseren.

Gammel cache i webbrowseren
har en negativ effekt.

Slet cache fra webbrowseren.

Opløsning af kamerabilledet vist i
webappen er lav.

Opløsningen til videostream 3,
anvendt af webappen, er sat
lavt.

Øg værdien vha. [Stream] > [Video Stream] >
[Size 3] i webmenuen.

Kameramenuen ses ikke, når du
trykker på [Menu]-knappen.

Kameramenuen er konfigureret,
så den ikke bliver indlejret i
HDMI-outputsignalet.

Indstil [Monitoring] > [Output Display] >
[HDMI/Stream] til [On] i webmenuen.

Værdien af en indstilling på
indstillingsskærmen er ikke
opdateret/vist ordentligt.

Indstillingsskærmen i webappen
afspejler ikke automatisk
indstillingerne, som er ændret i
en anden webapp.

Tryk på [Reload]-knappen i bunden af
indstillingsskærmen i webappen. Værdierne for
indstillingerne på den viste opsætningsskærm
genindlæses og opdateres.

De midlertidige internetfilers
indstillinger har en effekt.

Slet cache fra webbrowseren.

Kan ikke downloade
konfigurationsfil eller logfil.

Download-filfunktionen i
webbrowseren er deaktiveret.

Aktivér download-filfunktionen i webbrowseren.

Indstillinggskærmen i webappen er
tilgængelig, men kan ikke udføre
funktioner på live driftsskærmen og
afspilningsskærmen.

Webappens driftskærm er låst.
Indstil driftslåskontakten øverst til højre i
webappen i  (Drift oplåsning)-positionen.

Webapp-skærmen tager noget tid
om at blive vist.

Enhedens streamingbillede
bliver set af flere brugere
samtidigt.

Reducér antallet af brugere, der kan tilgå
webappen samtidigt.
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Billedtagning

Kamera

Panorering/hældning

Symptom Årsag Løsning

Billede er forvrænget eller rykker
sig.

Videoinformationen er ikke
transmitteret ordentligt pga.
tilstopning i
kommunikationsstien.

Reducér streaming bithastigheden, indstil [Video
Stream 3] > [Size] til den mindste indstilling,
eller reducér hastigheden for at skabe en
margen i kommunikationsbåndet.

Flere webbrowsere kører på
tabletten og optager
hukommelsen.

Luk alle webbrowsere, der kører i baggrunden.

Der er for mange åbne
webbrowserfaner, hvilket
forsinker funktionen.

Luk alle faner der ikke bruges.

For stor ophobning af
webbrowser-cache og
browserhistorik forsinker
funktionen.

Slet cache fra webbrowseren.

Symptom Årsag Løsning

Billede ser forvrænget ud i begyndelsen og
slutningen af
panorerings-/hældningsdriften.

Billedet kan blive forvrænget, hvis
billedstabiliseringsfunktionen af objektivet
er tændt.

Sluk for objektivets
billedstabiliseringsfunktion.

Synsvinkel ændret uden brugerfunktion. Objektiv ånder korrekt. Se "Åndedrætskompensation".

Kan ikke betjene fokus, zoom eller iris.
Indstillingerne af kontakterne på
objektivet kan være ukorrekte.

Se "Tjekker objektivets
kontakter".

Symptom Årsag Løsning

Kan ikke nulstille
panorering/hældning.

Panorerings-/hældningslåsehåndtaget
er i positionen LOCK.

Skub panorering/hældning-låsehåndtaget til
positionen UNLOCK.

Kamera stopper ikke i den
forventede position.

Kamerablok er ude af balance.

Flyt kamerablokken frem/tilbage til en
passende position som beskrevet i
"Montering af et objektiv", og tænd igen for
enheden.

Et objektiv, der ikke understøtter
panorering/hældning, er monteret.

Se objektivets kompatibilitetsoplysninger,
fastgør et objektiv, der understøtter
panorering/hældning, og tænd så for
enheden igen.

Kan ikke udføre panorering/hældning-
nulstilling. Udfør en panorerings-/hældningsnulstilling

som beskrevet i "Nulstilling af
panorering/hældning".

En uventet kraft blev anvendt på
kamerahovedet, og forårsagede en
panorerings-/hældningskontrolfejl.
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Symptom Årsag Løsning

Kamera vender ikke tilbage til
forsiden, når der trykkes på

 (panorering/hældning
startposition)-knappen.

Loftsmonteringstilstand er blevet
aktiveret.

Indstil [Pan-Tilt] > [P/T Direction] > [Ceiling] i
webmenuen ifølge den reelle installation, og
tænd igen for enheden. Når
forbindelsesblokken er monteret på et loft, vil
den være foran på kameraet.

Panorerings-/hældningsfunktionen
er begrænset.

Panorerings-/hældningsintervalgrænsen
er konfigureret.

Ryd
panorerings-/hældningsgrænseindstillingerne
efter behov, som beskrevet i "P/T Range
Limit".

En uventet kraft blev anvendt på
kamerahovedet, og forårsagede en
panorerings-/hældningsfejl.

Udfør en panorerings-/hældningsnulstilling
som beskrevet i "Nulstilling af
panorering/hældning".

Panorerings-/hældningsfunktion
bevæget i den modsatte retning.

Loftsmonteringstilstand er anderledes
end den reelle monteringstilstand.

Indstil [Pan-Tilt] > [P/T Direction] > [Ceiling] i
webmenuen ifølge den reelle installation.

Indstillingerne relateret til
panorerings-/hældningsretning blev
ændret.

Tjek [Pan-Tilt] > [P/T Direction]-
indstillingerne i webmenuen.

Billede bevæger sig ikke glat i
begyndelsen og slutningen af
panorerings-/hældningsdriften.

Panorerings-/hældningsfunktionens
acceleration/deceleration er for høj.

Reducér panorerings-/hældningsfunktionens
acceleration/deceleration for at gøre
bevægelsen i begyndelsen og slutningen af
panorerings-/hældningsfunktionen glattere
vha. [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] i webmenuen eller kameramenuen.
Bemærk, at det vil betyde, at objektivet tager
længere tid om at nå maksimum hastighed.

Panorerings-/hældningsfunktion
stoppet.

Kamerablok er ude af balance.

Flyt kamerablokken frem/tilbage til en
passende position som beskrevet i
"Montering af et objektiv", og tænd igen for
enheden.

Indstilling af rampekurven
(acceleration/deceleration) er for høj til
det monterede objektiv.

Hvis et stort objektiv er monteret, reduceres
værdien af [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] i webmenuen eller
kameramenuen.

Et stort objektiv bliver brugt. Kontakt din Sony-supportrepræsentant.

Enhed er obstrueret, når
panorering/hældning betjenes.

Klemmehåndtaget til objektivets
støttepiedestals fastgørelsesskrue
rammer kameraet.

Drej klemmehåndtaget til objektivets
støttepiedestals fastgørelsesskrue, så det
peger op.

Klemmehåndtaget til objektivstøtten
rammer kameraet.

Drej klemmehåndtaget til objektivstøtten, så
det peger op.

Kamerahovedets låsehåndtag rammer
kameraet.

Kontrollér, at kameraets hovedlåsehåndtag
er i positionen LOCK.
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Optagelse/Afspilning

Symptom Årsag Løsning

Unormal støj forekommer under
panorerings-/hældningsdrift.

Kameraet er ude af balance.
Flyt kamerahovedet frem/bagud til en
passende position, så glidebasen er vandret.

Indstilling af rampekurven
(acceleration/deceleration) er for høj til
det monterede objektiv.

Hvis et stort objektiv er monteret, reduceres
værdien af [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] i webmenuen eller
kameramenuen.

Kamerahovedet er ikke fastgjort i en
position, og der er en bevægelig støj
under drift.

Indstil kameraets hovedlåsehåndtag i
positionen LOCK.

Kan ikke gemme en forudindstillet
position.

En forudindstilling kan ikke gemmes,
hvis Clear Image Zoom kører.

Indstil Clear Image Zoom hastigheden
tilbage til 1×. (tilstand, hvor hastigheden ikke
vises til højre for  (Zoom-hastighed))

Indramning er forskudt, når en
forudindstillet position afspilles.

Temperaturen i miljøet kan have ændret
sig betydeligt mellem lagring af den
forudindstillede position og dens
afspilning.

Gem den forudindstillede position igen.

Objektivkalibrering ikke udført.
Kør kalibreringen vha. [Technical] > [Lens] >
[Lens Calibration] i kameramenuen.

Et andet objektiv er påsat, end det
objektiv der blev brugt da
forudindstillingen blev gemt. Eller
zoompositionen for manuel zoom er
anderledes.

Gem den forudindstillede position igen.

Kontrolblokkens indramning i
webappen er udtonet og kan ikke
betjenes.

Panorerings-/hældningsfunktionen er
ikke tilgængelig, mens
miniatureskærmen vises og under
afspilning.

Vis afspilningskontrolskærmen og forlad
miniatureskærmens visning, eller stop
afspilning.

Panorerings-/hældningsfunktionen er
ikke tilgængelig, når kamerabilledet ikke
kan vises i webappen.

Se "Web App" i "Fejlfinding".

Panorerings-/hældningslåsehåndtaget
er i positionen LOCK.

Skub panorering/hældning-låsehåndtaget til
positionen UNLOCK.

"Execute Pan-Tilt Reset" vises
under indramningskontrolpanelet i
webappen.

En uventet kraft blev anvendt på
kamerahovedet, og forårsagede en
panorerings-/hældningsfejl.

Udfør en panorerings-/hældningsnulstilling
som beskrevet i "Nulstilling af
panorering/hældning".

Symptom Årsag Løsning

Optagelsen starter ikke,
når START/STOP-knappen
til optagelse aktiveres.

Hukommelseskortet er fuldt.
Udskift hukommelseskortet med et, der har
tilstrækkelig plads.

Hukommelseskortet skal gendannes.
Gendan hukommelseskortet som beskrevet i
"Gendannelse af hukommelseskort".

Optagelses-/tally-lampen konfigureres
som en tally-lampe, så
optagelsesstatus kan ikke bestemmes
af lampen.

Konfigurér optagelses-/tally-lampen til at fungere
som en optagelseslampe som beskrevet i
"Tilslutning af tally-signal".
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Filoverførsel

IP-streaming

Symptom Årsag Løsning

Lydoptagelse er ikke
mulig.

En mikrofon er ikke tilsluttet.
Tilslut en mikrofon eller lydenhed til AUDIO IN-
stikket på forbindelsesblokken.

Indstillingen [Master Input Level] er på
minimum værdi.

Justér [Master Input Level].

Den optagne lyd er
forvrænget.

Indstillingen af lydniveauet er for høj.

Justér [CH1 Input Level] til [CH4 Input Level] og
[Master Input Level].

Når der anvendes en mikrofon i et støjende miljø,
såsom en begivenhed med live musik, skal man
først justere [AUDIO IN CH1 MIC Ref.] og [AUDIO
IN CH2 MIC Ref.].

Den optagne lyd har et højt
støjniveau.

Indstillingen af lydniveauet er for lav.
Justér [Audio Input Level] og [Audio] > [Audio] >
[Audio Input] > [AUDIO IN CH1 MIC Ref.] eller
[AUDIO IN CH2 MIC Ref.]-indstillinger.

Klip kan ikke afspilles.

Klippet undergår redigering.
Klip kan ikke afspilles, hvis du har ændret filnavne
eller mapper, eller hvis klippet er i brug på en
computer. Dette er ikke en fejl.

Klippet blev optaget med et andet
kamera end denne enhed.

Klip optaget med et andet kamera end denne
enhed kan muligvis ikke afspilles eller vises i
forkert størrelse. Dette er ikke en fejl.

Symptom Årsag Løsning

Filoverførsel
mislykkes.

Brugernavnet og adgangskoden til
serveren er muligvis ikke korrekt.

Brugernavnet og adgangskoden til serveren er muligvis
ikke korrekt. Indtast de korrekte indtastninger.

Symptom Årsag Løsning

Streaming ikke tilgængelig.

Brugernavn og adgangskode
indtastet i klientappen for at vise
streaming fra enheden er forkert.

Hvis streamingformatet til enheden er indstillet til
[RTSP], [SRT-Listener], eller [NDI|HX], er det
nødvendigt at indtaste det brugernavn og den
adgangskode, som er indstillet for denne enhed i
klientappen. Angiv korrekt brugernavn og
adgangskode.

Streamingprotokollen er ikke
indstillet.

Vælg målprotokollen vha. [Stream] > [Stream Setting] i
webmenuen.

Seks eller flere RTSP-sessioner er
blevet indstillet.

Angiv antal sessioner til fem eller færre.

UDP-portnummer er ikke indstillet
korrekt.

Indstil portnummer og andre indstillinger til
målprotokollen vha. [Stream] > [Stream] > [Stream
Setting] i webmenuen.

UDP-kommunikation er blokeret. Tjek sikkerhedssoftwarens indstillinger.

Lyd bliver ikke streamet.
Lydoutput-streaming er indstillet til
[Off].

Indstil [Stream] > [Audio Stream] > [Setting] til [On] i
webmenuen.
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Forbindelse med eksterne enheder

Ekstern synkronisering

Tally

Symptom Årsag Løsning

Streaming blev frakoblet.
Protokolindstillingen eller
streaming-codec-indstillinger blev
ændret under streaming.

Indstil protokolindstillingen og streaming-codec-
indstillinger, før streaming startes.

Billedstørrelse på [Video
Stream 1] kan ikke
indstilles til 4096×2160
eller 3840×2160.

Billedstørrelse er 1920×1080, når
[Output Format] er indstillet til
HDMI.

Billedstørrelse til streaming kan ikke være højere end
HDMI-billedstørrelsen. Skift HDMI-billedstørrelsen vha.
[Monitoring] > [Output Format] i webmenuen.

Rammehastighed på
[Video Stream 1] kan ikke
indstilles til 60 FPS eller 50
FPS.

Streamingens rammehastighed er
sat til 29.97 eller lavere.

Rammehastigheden som bruges til streaming er
begrænset af systemfrekvens. Skift systemfrekvensen
vha. [Rec Format] > [Frequency] i webmenuen.

[Video Stream 3] kan ikke
tilgås.

[Video Stream 3] understøtter ikke
RTSP/SRT/NDI.

Brug [Video Stream 1] eller [Video Stream 2].

RTSP/SRT-skærm er ikke
opdateret/vist ordentligt.

Portnummeret som bruges til
RTSP eller SRT bliver filtreret eller
blokeret.

Skift RTSP- eller SRT-portnummeret til en port, der ikke
bliver filtreret eller blokeret af enheder, der modtager
stream. Eller skift portnummeret, der bruges til RTSP
eller SRT på enheden.

Billede er forvrænget eller
rykker sig.

Videoinformationen er ikke
transmitteret ordentligt pga.
tilstopning i kommunikationsstien.

Reducér streamings bithastighed, eller indstil [Video
Stream 2] codec ([Codec 2]) til [Off] for at skabe en
margen i kommunikationsbåndet.

Videopakkernes rækkefølge er
ændret i kommunikationskanalen.

Brug den samme internetleverandør på både enhedens
og modtagerens side.

Ikke registreret som NDI-
enhed.

Streamingprotokollen er ikke
indstillet til NDI|HX.

Streamingprotokollen skal indstilles til NDI|HX for at
registrere enheden som en NDI-enhed. Indstil [Stream]
> [Stream Setting] til [NDI|HX] i webmenuen.

Kan ikke bruges som en
NDI-enhed.

En NDI|HX-licens er ikke
installeret.

Installér en NDI|HX-licens. Du kan tjekke, om der er en
NDI|HX-licens vha [Stream] > [Stream] > [Stream
Setting] > [NDI|HX] > [License] i webmenuen.

Symptom Årsag Løsning

Kan ikke
synkronisere til
ekstern kilde.

Et eksternt synk.-signal, der er egnet til
det konfigurerede videosignalformat,
indsendes ikke.

Indsend et eksternt synk.-signal, der er egnet til det
konfigurerede videosignalformat.

Enhed er dobbelttermineret.
Enheden har en indbygget 75 Ω terminator. Forbind
enheden direkte med en signalkilde (en-til-en), eller
brug en fordeler (splitter).
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Objektiv styreenhed

Relateret emne

Udsender et optisk fibersignal

Forbindelsesblok

Åndedrætskompensation

Tjekker objektivets kontakter

Montering af et objektiv

Nulstilling af panorering/hældning

P/T Range Limit

Gendannelse af hukommelseskort

Tilslutning af tally-signal

5-041-958-93(1) Copyright 2022 Sony Corporation

Symptom Årsag Løsning

Tally-lampe
lyser ikke.

Tally-lampens lysstyrke er sat på Off.
Indstil den rette lysstyrke vha. [Technical] > [Tally] > [Tally
Lamp Brightness] i webmenuen.

Optagelses-/tally-lampen er konfigureret
som en optagelseslampe.

Konfigurér optagelses-/tally-lampen til at fungere som en
tally-lampe som beskrevet i "Tilslutning af tally-signal".

RM-IP500 er forbundet, og VISCA over IP er
deaktiveret.

Sæt SETUP-kontakt 3 til ON-positionen på
forbindelsesblokken for enheden.

OPTION-stikkets forbindelser er ukorrekte,
eller målbenet er ikke kortsluttet til GND.

Kortslut ben 7 eller 8 på OPTION-stikket til GND som
beskrevet i "Tilslutning af tally-signal".

Symptom Årsag Løsning

[Communication Error]
vises i 
(kamerastatus).

Kameraet kan ikke
kommunikere med
objektivets styreenhed.

Kontrollér forbindelsen mellem enheden og objektivets styreenhed,
tænd enheden og objektivets styreenhed.

[Rotation Error] vises i
 (kamerastatus).

Der opstod en
rotationsfejl i objektivets
styreenhed.

Det gemte zoom-bevægelsesområde og objektivets
bevægelsesområde passer muligvis ikke. Start objektivets
styreenhed.
Hvis problemet fortsætter, bedes du kontakte repræsentanten for
objektiv styreenhedens producent.

[System Error] vises i
 (kamerastatus).

Der opstod en systemfejl
i objektivets styreenhed.

Kontrollér forbindelsen mellem enheden og objektiv styreenheden,
se betjeningsvejledningen til objektiv styreenheden og start
objektivets styreenhed, eller tænd enheden og objektiv
styreenheden.
Hvis problemet fortsætter, bedes du kontakte repræsentanten for
objektiv styreenhedens producent.

[Unknown Error] vises i
 (kamerastatus).

Der opstod en ukendt fejl
i objektivets styreenhed.

Kontrollér forbindelsen mellem enheden og objektiv styreenheden,
se betjeningsvejledningen til objektiv styreenheden og start
objektivets styreenhed, eller tænd enheden og objektiv
styreenheden.
Hvis problemet fortsætter, bedes du kontakte repræsentanten for
objektiv styreenhedens producent.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fejl-/advarselsmeddelelser

Hvis en advarsel, forsigtighedsregel eller driftsbetingelse, der kræver bekræftelse, opstår på enheden, vises en meddelelse i
kameraets billedpanel, og POWER-lampen samt NETWORK-lampen på forpanelet samt optagelses-/tally-lampen begynder
at blinke.

Bemærk!

Optagelses-/tally-lampens blinkeangivelse aktiveres kun, når både [Technical] > [Tally] > [Tally Control] er indstillet til [Internal] og [Tally
Lamp Brightness] ikke er indstillet til [Off] i webmenuen eller kameramenuen.

Fejlmeddelelser

Hvis POWER-lampen og NETWORK-lampen blinker som beskrevet herunder, tages de følgende foranstaltninger.

Enheden stopper driften, når følgende type visning forekommer.

Advarselsmeddelelser

Følg de angivne instruktioner, hvis følgende visning udsendes.

POWER-
lampe

NETWORK-
lampe Årsag og løsning

Blinker
langsomt
orange

Blinker
langsomt grønt

Enheden kan ikke fungere ordentligt. For yderligere oplysninger se [Maintenance] >
[System Log] i webmenuen. Hvis problemet fortsætter, selv efter enheden er sat i
standby-tilstand eller strømmen slukkes og tændes igen, så kontakt din Sony-
servicerepræsentant.

Blinker
hurtigt
orange

Blinker hurtigt
grønt

En funktionsfejl opstod på enheden. Kontakt din Sony-servicerepræsentant.

Meddelelsesvisning Optagelses-/indikatorlampe Årsag og løsning

E + fejlkode Hurtig blinken

Angiver en abnormitet i enheden. Optagelse stopper, selv hvis
●REC vises i kameraets billedpanel.
Sluk for enheden, og kontroller, om der er problemer med
tilsluttede enheder, kabler eller medier. Hvis fejlen fortsætter, når
enheden tændes igen, bedes du kontakte din Sony-
servicerepræsentant. Muligvis udsendes der ikke en fejlvisning
eller advarselslyd, afhængigt af enhedens status.

Meddelelsesvisning Optagelses-/indikatorlampe Årsag og løsning

Temperature High Blinker
Den interne temperatur er høj.
Sluk for camcorderen, og lad den køle ned, før du bruger den
igen.

Media Temperature
High

Blinker
CFexpress-kortets temperatur er høj.
Udskift kortet, eller lad det køle af, inden du bruger det igen.
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Advarsels- og driftsmeddelelser

Følgende advarsels- og betjeningsmeddelelser kan blive vist midt på skærmen. Følg de givne instruktioner for at løse
problemet.

Meddelelsesvisning Optagelses-/indikatorlampe Årsag og løsning

Voltage Low Blinker DC IN-spændingen er lav (niveau 1). Kontroller strømkilden.

Insufficient Voltage Hurtig blinken
DC IN-spændingen er for lav (niveau 2). Optagelse er
deaktiveret.
Tilslut en anden strømkilde.

Media Near Full Blinker
Den resterende kapacitet på hukommelseskortet er ved at være
lav.
Udskift ved først givne lejlighed.

Media Full Hurtig blinken
Klip kunne ikke optages eller kopieres, fordi der ikke er nogen
resterende kapacitet på hukommelseskortet.
Udskift straks.

Clips Near Full Blinker
Antallet af yderligere klip, der kan optages på et
hukommelseskort, er ved at være lavt.
Udskift ved først givne lejlighed.

Clips Full Hurtig blinken

Det maksimale antal klip, der kan optages på
hukommelseskortet, er nået.
Det er ikke muligt at optage eller kopiere flere klip. Udskift
straks.

Last Clip Recording Blinker
Det klip, der optages i øjeblikket, er det sidste klip, der kan
optages, da det maksimale antal klip er nået.
Forbered et nyt hukommelseskort.

Media(A) Life Near
End1) Blinker Hukommelseskortet er ved at være udtjent. Udskift ved først

givne lejlighed.

Media(A) Life End1) Hurtig blinken Hukommelseskortet er udtjent. Udskift straks.

Media(A) Near Full1) Blinker Når Simul Rec-funktionen anvendes

Media(A) Full1) Hurtig blinken Når Simul Rec-funktionen anvendes

Media(A) Clips Near
Full1) Blinker Når Simul Rec-funktionen anvendes

Media(A) Clips Full1) Hurtig blinken Når Simul Rec-funktionen anvendes

Media(A) Last Clip
Rec1) Blinker Når Simul Rec-funktionen anvendes

(Ingen visning) Blinker
Der opstod en ukendt fejl i objektivets styreenhed.
Tjek status i kamerastatus i webappen.
For yderligere oplysninger, tjek systemlog i webappen.

"(B)" vises for kortet i sprække B.1)
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Visningsmeddelelse Årsag og løsning

Backup Battery End
Please Change

Backup-batteriets resterende kapacitet er utilstrækkelig.
Tilslut enheden til en strømforsyning i mindst 24 timer for at oplade
backup-batteriet.

Unknown Media(A)1)

Please Change

Et hukommelseskort, der er blevet opdelt, eller et hukommelseskort
med flere klip end der kan håndteres af enheden, blev sat i.
Kortet kan ikke bruges i enheden og skal udskiftes.

Cannot Use Media(A)1)

Unsupported File System

Et kort, der bruger et andet filsystem eller et uformateret kort, blev
indsat.
Kortet kan ikke bruges i enheden og skal udskiftes eller formateres
ved hjælp af enheden.

Media Error
Media(A) Needs to be Restored1)

Der opstod en fejl på hukommelseskortet, og kortet skal gendannes.
Gendan hukommelseskortet.

Media Error
Cannot Record to Media(A)1)

Hukommelseskortet kan være beskadiget og kan ikke længere
bruges til optagelse.
Afspilning er mulig, så det anbefales at tage en kopi og udskifte
hukommelseskortet.

Media Error
Cannot Use Media(A)1)

Hukommelseskortet kan være beskadiget og kan ikke længere
bruges til optagelse eller afspilning.
Kortet kan ikke bruges i enheden og skal udskiftes.

Media(A) Error1)

Recording Halted
Playback Halted

Optagelse og afspilning blev stoppet, fordi der opstod en fejl under
brug af hukommelseskortet.
Hvis problemet fortsætter, bedes du udskifte hukommelseskortet.

Media Reached Rewriting Limit
Change Media(A)1)

Hukommelseskortet er udtjent.
Tag en sikkerhedskopi, og udskift kortet med det samme. Hvis du
fortsætter med at bruge kortet, kan kortet muligvis ikke optage eller
afspille.
Se brugsanvisningen til hukommelseskortet for at få yderligere
oplysninger.

The specified address is invalid. Den angivne adresse er ugyldig.
Kontroller, at indstillingen er korrekt.

Cannot Use Specified Port Number
Det angivne portnummer er ugyldigt.
Kontroller, at indstillingen er korrekt.

Lens I/F Error(xx:xx)

Der blev registreret en fejl i objektivets I/F-kommunikation, da der
blev sat et E-mount-objektiv på.
Kontroller status for forbindelsen med E-mount-objektivet.
Hvis problemet fortsætter, bedes du kontakte din Sony-
servicerepræsentant med fejlkoden (fem tegn i parentes).

Cannot add auto upload job of Proxy file because
maximum number of upload jobs was reached.

Det maksimale antal overførselsjob er nået.
Ryd eventuelle uønskede job. Destinationen for automatisk
overførsel for proxy-filer kan også være forkert. Kontroller, at
indstillingen er korrekt.

Fan Stopped

Vifte er stoppet.
Tjek, om der er støv eller andet.
Hvis fejlen fortsætter, efter støvet er fjernet, bedes du kontakte din
Sony-servicerepræsentant.

"(B)" vises for kortet i sprække B.1)
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RTMP streaming fejlinformation

Følgende fejlinformation kan blive vist på enheden. Udfør følgende handlinger efter behov.

SRT streaming fejlinformation

Følgende fejlinformation kan blive vist på enheden. Udfør følgende handlinger efter behov.

5-041-958-93(1) Copyright 2022 Sony Corporation

Fejlkode
Beskrivelse Løsning

RTMP RTMPS

1002
1004

2002
2004

Kan ikke tilsluttet til RTMP-server.
Kontrollér, at URL-serverindstillingen er korrekt.
Kontrollér netværksforbindelsen.

1003 2003 Kan ikke løse domænenavnet.
Kontrollér, at URL-serverindstillingen er korrekt.
Kontrollér DNS-serverforbindelsen.

–
2005
2008

CRL-fejl
Kontrollér, at URL-serverindstillingen er korrekt.
Kontrollér at forbindelsesdestinationen er et pålideligt websted.

2006 Fejl i CA-certifikat
Kontrollér, at urindstillingen er korrekt.
Kontroller, at CA-certifikatet er korrekt.

– 2007
Et CA-certifikat er ikke installeret.
Servercertifikat godkendelsesfejl.

Installér et CA-certifikat.
Kontrollér at forbindelsesdestinationen er et pålideligt websted.

4002 RTMP-session blev afbrudt.
Enheden kan været blevet afbrudt på RTMP-serversiden.
Kontrollér at indstillingerne passer med tjenestens anbefalede
codec-parameter.

4003
Netværksforbindelseskvaliteten er
lav. Kontrollér netværksforbindelsen.

Andet Andre fejl.

Fejlkode

Beskrivelse LøsningSRT-
Caller

1001 Uventet fejl Enheden fungerer muligvis ikke normalt. Tænd enheden.

1002
Kommunikation afbrudt pga. ændring i
indstillingerne

Kommunikationen blev afbrudt pga. ændringer i
indstillingerne.
Genopret forbindelsen.

5001 Uventet fejl Enheden fungerer muligvis ikke normalt. Tænd enheden.

5005 Forbindelsesfejl Kontrollér, at forbindelsesdestinationen er korrekt.

5006 Krypteringsfejl Kontrollér, at krypteringsindstillingen er korrekt.

5007 Uventet fejl
Enheden fungerer muligvis ikke normalt. Tænd enheden.

5008 Uventet fejl

5009 Overførselsfejl
Enheden blev afbrudt under kommunikation.
Kontrollér netværksforbindelsen.
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Liste over menupunkter

De følgende tabeller oplister menupunkterne i enheden.

Signaturforklaring
"Kameramenu" og "webmenu"
●: Tilgængelig
▲: Nogle elementer tilgængelige
–: Ikke tilgængelig

"All File" og "Scene File"
Ja: Gemt element i en ALL-fil eller scenefil
Nej: Elementet ikke gemt

"All Reset (except for Network Settings)"
Når [Reset] > [Reset] > [All Reset (except for Network Settings)] i webmenuen udføres:
Ja: Initialiseret element (ekskluderer netværksindstillinger)
Nej: Ikke relevant

"Network Reset"
Når [Reset] > [Reset] > [Network Reset] i webmenuen udføres:
Ja: Initialiseret element (netværksindstilling)
Nej: Ikke relevant

"Factory Default"
Ja: Elementnulstilling til fabriksstandard
Nej: Ikke relevant

Shooting

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

ISO/Gain/EI ● – Ja Ja Ja Ja Ja

ND Filter ● – Ja Ja*1 Ja Nej Ja

Shutter ● – Ja Ja Ja Nej Ja

Iris ● – Ja Ja Ja Nej Ja

Auto Exposure ● – Ja Ja*2 Ja Nej Ja

White ● – Ja Ja*3 Ja Nej Ja

White Setting ● – Ja Nej Ja Nej Ja

Offset White ● – Ja Nej Ja Nej Ja

Focus ● ▲ Ja Nej Ja Nej Ja

S&Q Motion ● – Ja Nej Ja Nej Ja

LUT On/Off ● – Ja Nej Ja Nej Ja
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Project

Paint/Look

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Noise
Suppression

● – Ja Ja Ja Nej Ja

Flicker Reduce ● – Ja Nej Ja Nej Ja

SteadyShot ● – Ja Nej Ja Nej Ja

[Mode] kan ikke anvendes*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] kan ikke anvendes*2

[Preset White] kan ikke anvendes*3

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Base Setting ● ● Ja Nej Ja Nej Ja

Rec Format ● ● Ja Nej Ja*1 Nej Ja

Cine EI/Flex.ISO
Set

● – Ja Nej Ja Nej Ja

Simul Rec ● ● Ja Nej Ja Nej Ja

Proxy Rec ● ▲ Ja Nej Ja Nej Ja

Interval Rec ● ● Ja*2 Nej Ja Nej Ja

Picture Cache
Rec

● ● Ja*2 Nej Ja Nej Ja

SDI/HDMI Rec
Control

● – Ja Nej Ja Nej Ja

Assignable
Button

● – Ja Nej Ja Nej Ja

All File – ● Nej Nej Nej Nej Nej

[Frequency] kan ikke anvendes*1

[Setting] kan ikke anvendes*2

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Scene File ● – Nej Nej Nej Nej Nej

Base Look ● ▲ Ja*1 Nej Ja*1 Nej Ja*1

Reset Paint
Settings

● – Nej Nej Nej Nej Nej

Black ● – Ja Ja Ja Nej Ja

Knee ● – Ja Ja Ja Nej Ja
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Pan-Tilt

TC/Media

Monitoring

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Detail ● – Ja Nej Ja Nej Ja

Matrix ● – Ja Ja Ja Nej Ja

Multi Matrix ● – Ja*2 Ja*2 Ja Nej Ja

LUT-data importeret som basisudseende kan ikke anvendes*1

[Axis] kan ikke anvendes*2

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

P/T Speed – ● Nej Nej Ja Nej Nej

P/T
Acceleration

● ● Nej Nej Ja Nej Nej

P/T Range
Limit

– ● Nej Nej Ja Nej Nej

P/T Direction – ● Nej Nej Ja Nej Nej

P/T Preset – ● Nej Nej Ja Nej Nej

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Timecode ● – Ja*1 Nej Ja Nej Ja

TC Display ● – Ja Nej Ja Nej Ja

Users Bit ● – Ja*1 Nej Ja Nej Ja

HDMI TC Out ● – Ja Nej Ja Nej Ja

Clip Name
Format

● – *2 Nej Ja Nej Ja

Update Media ● – Nej Nej Nej Nej Nej

Format Media ● – Nej Nej Nej Nej Nej

Media Life ● – Nej Nej Nej Nej Nej

[Setting] kan ikke anvendes*1

[Auto Naming] kan anvendes, [Camera ID] kan ikke anvendes*2

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Output Format ● ● Ja Nej Ja Nej Ja
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Audio

Thumbnail

Technical

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Output
Display

– ● Ja Nej Ja Nej Ja

Display
On/Off

● – Ja Nej Ja Nej Ja

Video Signal
Monitor

● – Ja Nej Ja Nej Ja

Marker ● – Ja Nej Ja Nej Ja

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Audio
Input

● ▲ Ja Nej Ja Nej Ja

Audio
Output

● ▲ Ja Nej Ja Nej Ja

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Display Clip
Properties

● – Nej Nej Nej Nej Nej

Set Clip Flag ● – Nej Nej Nej Nej Nej

Lock/Unlock Clip ● – Nej Nej Nej Nej Nej

Delete Clip ● – Nej Nej Nej Nej Nej

Transfer Clip ● – Nej Nej Nej Nej Nej

Transfer Clip
(Proxy)

● – Nej Nej Nej Nej Nej

Filter Clips ● – Nej Nej Nej Nej Nej

Customize View ● – Ja Nej Ja Nej Ja

Punkt
(niveau

2)
Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Color
Bars

● – *1 Nej *1 Nej Ja

Genlock ● – Nej Nej Nej Nej Nej

Tally ● ● Ja Nej Ja Nej Ja
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Network

Stream

Punkt
(niveau

2)
Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Rec
Review

● – Ja Nej Ja Nej Ja

Zoom ● – Ja Nej Ja Nej Ja

IR
Remote

– ● Nej Nej Ja Nej Ja

Lens ● – Ja Nej Ja Nej Ja

APR ● – Nej Nej Nej Nej Nej

[Type] kan anvendes, [Setting] kan ikke anvendes*1

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Camera Name – ● Nej Nej Nej Nej Ja

User – ● Nej Nej Nej Ja Ja

Wired LAN*1 ▲ ● Nej Nej Nej Ja Nej

File Transfer ● ▲ Ja Nej Ja Ja Ja

FTP Server 1 – ● Nej Nej Ja Nej Ja

FTP Server 2 – ● Nej Nej Ja Nej Ja

FTP Server 3 – ● Nej Nej Ja Nej Ja

SSL – ● Nej Nej Nej Ja Ja

Referer Check – ● Nej Nej Nej Ja Ja

Brute Force Attack
Protection

– ● Nej Nej Nej Ja Ja

Ikke konfigurerbar vha. kameramenuen (kun skærm)*1

Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Stream
Setting

– ● Nej Nej Ja*1 Nej Ja*1

Video
Stream

– ● Ja Nej Ja Nej Ja

Audio
Stream

– ● Ja Nej Ja Nej Ja

[NDI|HX] > [License] kan ikke anvendes*1
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Maintenance
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Punkt
(niveau 2) Kameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Language ● ● Ja Nej Ja Nej Ja

Accessibility – ● Ja Nej Nej Nej Ja

Clock Set ● ● Ja*1 Nej Ja*2 Nej Ja

Reset – ● Nej Nej Nej Nej Nej

Hours Meter ● – Nej Nej Nej Nej Nej

Information – ● Nej Nej Nej Nej Nej

System Log – ● Nej Nej Nej Nej Ja

HTTP Access
Log

– ● Nej Nej Nej Nej Ja

Service – ● Nej Nej Nej Nej Nej

EULA – ● Nej Nej Nej Nej Nej

Software – ● Nej Nej Nej Nej Nej

Dato- og tidsoplysninger kan ikke anvendes*1

[Time Zone], dato- og tidsoplysninger kan ikke anvendes*2
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forudindstillet positions gemte punkter

"Ja" angiver en indstilling, der er gemt for den forudindstillede position, og "Nej" angiver en indstilling, der ikke er gemt.

Panorerings-/hældningspunkter

Zoom-punkter

Fokuspunkter

Vis placering Punkt Gem motiv

Indramningskontrolpanel på live-driftsskærm
Panorerings-/hældningsposition Ja

[Pan-Tilt Speed] Nej

[Pan-Tilt] i webmenuen

[P/T Speed] Nej

[P/T Acceleration] Nej

[P/T Range Limit] Nej

[P/T Direction] Nej

[P/T Preset] > [Pan-Tilt] Nej

[P/T Preset] > [Default] > [Pan-Tilt Speed] Ja1)

Indstillingsværdierne ved lagring af en forudindstillet position, gemmes som værdier for den pågældende forudindstillede position. Efter værdierne er
gemt kan de ændres for hver forudindstillet position. For oplysninger, se "Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), for
forudindstillingspositioner der anvender webappen".

1)

Vis placering Punkt Gem motiv

Indramningskontrolpanel på live-driftsskærm
Zoom-position (fokusafstand) Ja

[Zoom Speed] Nej

[Pan-Tilt] > [P/T Preset] > [Default] i webmenuen
[Zoom Sync] Ja1)

[Zoom Speed] Ja1)

[Technical] > [Zoom] i kameramenuen [Zoom Type] Nej

Indstillingsværdierne ved lagring af en forudindstillet position, gemmes som værdier for den pågældende forudindstillede position. Efter værdierne er
gemt kan de ændres for hver forudindstillet position. For oplysninger, se "Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), for
forudindstillingspositioner der anvender webappen".

1)

Vis placering Punkt Gem
motiv

Kameraets billedpanel på live-
driftsskærmen

Sådan spores et motiv angivet til Realtime Tracking AF Nej

Angivne koordinater til spot focus Nej
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Relateret emne

Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når en forudindstillingsposition genoprettes

5-041-958-93(1) Copyright 2022 Sony Corporation

Vis placering Punkt Gem
motiv

 (Focus)-fanen på live skærmen

[Touch Focus]-kontakt Nej

[Auto Focus]-kontakt Ja

[Focus Hold]-knaptilstand Nej

[Push AF/MF]-knaptilstand Nej

[Face/Eye Detection AF] Ja

[AF Subj. Shift Sens.] Ja

[AF Transition Speed] Ja

Fokusposition Ja1)

[Shooting] > [Focus] i webmenuen

[Push AF Mode] (inklusive indstillinger der bruger tildelelige
knapper) Nej

[Touch Function in MF] Nej

[AF Assist Control] Nej

[Pan-Tilt] > [P/T Preset] > [Default] i
webmenuen

[Focus Recall] Ja2)

[MF Speed] Ja2)

[Shooting] > [Focus] i kameramenuen

Indstilling af fokusområdestørrelse og -position vha. [Focus
Area]

Ja

Indstilling af fokusområdeposition vha. [Focus Area (AF-S)] Ja

Ikke gendannet når [Auto Focus]-kontakten er sat på On. Gendannet når sat på Off.1)

Indstillingsværdierne ved lagring af en forudindstillet position, gemmes som værdier for den pågældende forudindstillede position. Efter værdierne er
gemt kan de ændres for hver forudindstillet position. For oplysninger, se "Ændring af overførselshastigheden (panorering-hældning/zoom/fokus), når
en forudindstillingsposition genoprettes".

2)
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Blokdiagrammer

Audio Input

Audio Output

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Opdatering af software til E-mount-objektivet

Du kan opdatere softwaren til et E-mount-objektiv ved hjælp af enheden.
Se på webstedet for objektivet for at få oplysninger om objektiver, der kan opdateres, og den tilhørende software.
Software er opdateret vha. webmenuen.

Bemærk!

Udfør ikke de følgende handlinger, før opdateringen er fuldført.

Frakobling af netværket
Fjernelse af et objektiv
Sluk for strømmen

Hvis en meddelelse vises, som angiver, at opdateringen mislykkedes, skal du tjekke den viste beskrivelse og forsøge at opdatere igen.

5-041-958-93(1) Copyright 2022 Sony Corporation

Monter et E-mount-objektiv til enheden.1

Tjek [Maintenance] > [Information] > [Lens] > [Model Name] og [Version Number] i webmenuen.

Softwarens versionsnummer for E-mount-objektivet vises på siden.
Tjek softwarens versionsnummer, og opdatér softwaren som påkrævet.

2

Download objektivets softwareopdateringsfil til Windows (.exe-udvidelse) til enheden, der kører webappen.3

I [Maintenance] > [Information] > [Lens] > [Version Up], tryk på [Choose File]-knappen, og vælg den
downloadede opdateringsfil.

4

Følg instruktionerne på skærmen.5
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montering af objektivets dæksel over frigivelsesknappen

Du kan forhindre utilsigtet fjernelse af objektivet ved at montere dækslet til objektivets frigivelsesknap, som følger med CIB-
PCM1-loftsbeslaget (ekstraudstyr) til objektivets frigivelsesknap.

Bemærk!

Dette forhindrer ikke objektivet i at blive fjernet helt.

Relateret emne

Montering af et objektiv

5-041-958-93(1) Copyright 2022 Sony Corporation

Montér et objektiv.

For yderligere oplysninger om montering af et objektiv se "Montering af et objektiv".

1

Før panorerings-/hældningslåsehåndtaget til LOCK-positionen for at låse kamerahovedets
panorering/hældning.

2

Flyt kamerablokken til en position, så objektivets udskubningsdæksel kan monteres.3

Fastgør objektivets udskubningsdæksel, så det dækker objektivets frigivelsesknap.4

Fastgør objektivets udskubningsdæksel vha. fastholdelsesskruen.5
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Licenser

MPEG-4 AVC Patent Portfolio License

DETTE PRODUKT ER LICENSERET I HENHOLD TIL AVC-PATENT-PORTEFØLJELICENSEN TIL PERSONLIG
ANVENDELSE AF EN FORBRUGER ELLER ANDRE IKKE AFLØNNEDE ANVENDELSER TIL
(i) INDKODNING AF VIDEO I OVERENSSTEMMELSE MED AVC-STANDARDEN ("AVC-VIDEO") OG/ELLER
(ii) AFKODNING AF AVC-VIDEO, DER BLEV INDKODET AF EN FORBRUGER INVOLVERET I PERSONLIG AKTIVITET,
OG/ELLER SOM BLEV MODTAGET FRA EN VIDEOUDBYDER LICENSERET TIL AT LEVERE AVC-VIDEO.
DER ER IKKE TILDELT LICENS, HELLER IKKE IMPLICIT, TIL NOGEN ANDEN BRUG. YDERLIGERE OPLYSNINGER KAN
FÅS FRA MPEG LA, L.L.C. SE HTTP://WWW.MPEGLA.COM

Opnåelse af software under GPL/LGPL-licensen

Dette produkt anvender software, som GPL/LGPL gælder for. Dette informerer dig om, at du har ret til at få adgang til, ændre
og omfordele kildekode for disse softwareprogrammer under betingelserne i GPL/LGPL.
Kildekoden er tilgængelig på internettet. Brug følgende URL-adresse, og følg vejledningen til download.
https://oss.sony.net/Products/Linux/
Vi foretrækker, at du ikke kontakter os om indholdet af kildekoden.

μT-Kernel-kildekode

Dette produkt bruger kildekoden af μT-Kernel under T-License 2.1 tildelt af TRON Forum (www.tron.org).

5-041-958-93(1) Copyright 2022 Sony Corporation
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Vejledning til hjælp

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Specifikationer

Generelt

Masse
Ca. 4,6 kg (kun hoveddel)
Ca. 6,0 kg (inklusive SELP28135G-objektiv)

Dimensioner
Se "Udvendige mål".

Strømkrav
19,5 V DC
PoE++ (overensstemmelse med IEEE802.3bt type 4 klasse 8)

Strømforbrug
19,5 V DC: 80,0 W (maks)
PoE++: 71,3 W (maks)　

Driftstemperatur
0 °C til 40 °C

Opbevaringstemperatur
−20 °C til +60 °C

Optagelsesformat (video)
XAVC Intra
XAVC-I 4K/QFHD-tilstand: VBR, 600 Mbps (maks.) bithastighed, MPEG-4 AVC/H.264
XAVC-I HD-tilstand: CBG, 223 Mbps (maks.), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD-tilstand: VBR, 150 Mbps (maks.) bithastighed, MPEG-4 H.264/AVC
XAVC-L HD 50-tilstand: VBR, 50 Mbps (maks.), MPEG-4 H.264/AVC
XAVC-L HD 35-tilstand: VBR, 35 Mbps (maks.), MPEG-4 H.264/AVC

Optagelsesformat (lyd)
LPCM 24-bit, 48 kHz, 4-kanals

Optagelseshastighed

XAVC Intra
XAVC-I 4K-tilstand: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD-tilstand: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD-tilstand: 1920 ×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD-tilstand: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50-tilstand: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 35-tilstand: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Optagelses-/Afspilningstid
XAVC Intra
XAVC-I QFHD-tilstand: 59.94P, ca. 30 minutter (vha. CEA-G160T)
XAVC-I HD-tilstand: 59.94P, ca. 78 minutter (vha. CEA-G160T)

XAVC Long
XAVC-I QFHD-tilstand: 59.94P, ca. 115 minutter (vha. CEA-G160T)
XAVC-L HD 50-tilstand: 59.94P, ca. 155 minutter (vha. CEA-G80T)
XAVC-L HD 35-tilstand: 59.94P, ca. 210 minutter (vha. CEA-G80T)

Bemærk!

Optagelses-/Afspilningstiden kan variere afhængigt af anvendelsesforhold og hukommelsesegenskaber. Optagelses- og
afspilningstiden er for en kontinuerlig optagelse som et enkelt klip. De faktiske tider kan være kortere afhængigt af antallet af optagne
klip.

Panorering/Hældningsdrev-sektion

Minimum panoreringshastighed: 0,02 gr./s
Minimum hældningshastighed: 0,02 gr./s
Maksimum panoreringshastighed: 60 gr./s
Maksimum hældningshastighed: 60 gr./s
Panoreringsinterval: −170 gr. til +170 gr.
Hældningsinterval: −30 gr. til +195 gr.
Støjkriterie-bedømmelse: NC35 eller lavere
Forindstillede positioner: 100

Kamerasektion

Billedenhed
35mm fuld ramme (35,6 × 23,8 mm), Exmor R CMOS-sensor

Antal pixels
Ca. 12,9 megapixels (total pixels)
Ca. 10,3 megapixels (reelle pixels)

Autofokus
Detektionsmetode: Fasedetektion/Kontrastdetektion

Interne ND-filtre
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineær variabel ND: 1/4ND til 1/128ND

ISO-følsomhed
ISO 800/12800 (Cine EI -tilstand, D55-lyskilde)

Objektivmontering
E-mount

Breddegrad
15+ stop

Lukkerhastighed
64F til 1/8000 sek. (23.98P)
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Lukkervinkel
5,6° til 360°, 2 til 64 billeder

Langsom og hurtig bevægelse
XAVC QFHD: 1 fps til 120 fps
XAVC HD: 1 fps til 240 fps
XAVC 4K: 1 fps til 60 fps
XAVC HD (S35): 1 fps til 120 fps

Hvidbalance
2000 K til 15000 K

Forstærkning
−3 dB til +30 dB (intervaller på 1 dB)

Baseudseende
S-Cinetone, Standard, Still, ITU709 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Lydsektion

Samplingfrekvens
48 kHz

Kvantisering
24-bit

Frekvensrespons
XLR-input MIC-tilstand: 20 Hz til 20 kHz (±3 dB eller mindre)
XLR-input LINE-tilstand: 20 Hz til 20 kHz (±3 dB eller mindre)

Dynamisk område
XLR-input MIC-tilstand: 80 dB (typisk)
XLR-input LINE-tilstand: 90 dB (typisk)

Forvrængning
XLR-input MIC-tilstand: 0,08% eller lavere (−40 dBu inputniveau)
XLR-input LINE-tilstand: 0,08% eller lavere (+14 dBu inputniveau)

Input-/Output-sektion

Inputs
DC IN

EIAJ-overensstemmelse, 19,5 V jævnstrøm

AUDIO IN

XLR-type, 5-benet, hun
LINE / MIC / MIC+48V omskiftelig
MIC: Reference −30 dBu til −80 dBu

GENLOCK IN

BNC-stik, 1,0 Vp-p, 75 Ω

TC IN
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BNC-stik

Outputs
SDI OUT

BNC-stik, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Type-A-stik

OPTICAL output-tilslutning

Overholder SFP+
* Enheden understøtter ikke optisk signalinput.

Input/output
LAN-tilslutning

RJ-45, 1000BASE-T

OPTION-tilslutning

RJ-45 tally-input/-output-tilslutning

Mediepladssektion

CFexpress Type A/SD-kortsprække (2)

Medfølgende tilbehør

Vekselstrømsadapter (1)
Netledning (1)
Infrarød fjernbetjening (1)
Hætte til hoveddel (1) (fastgjort på enheden)
HDMI-kabelholdeplade (1)
Hæfte med vejledning før brug af dette apparat (1)
Garantihæfte (1)

Eksterne dimensioner

Dimensioner er skønsmæssige værdier.
Enhed: mm

Kameraets hoveddel
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Loftsbeslag
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Design og specifikationer kan ændres uden forudgående varsel.

5-041-958-93(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Varemærker

 er et varemærke tilhørende Sony Group Corporation.
XAVC og  er registrerede varemærker tilhørende Sony Group Corporation.
Ordene HDMI og HDMI High-Definition Multimedia Interface og HDMI-logoet er varemærker eller registrerede
varemærker tilhørende HDMI Licensing Administrator, Inc. i USA og andre lande.
Microsoft og Windows er varemærker eller registrerede varemærker tilhørende Microsoft Corporation i USA og/eller andre
lande.
Mac og macOS er registrerede varemærker tilhørende Apple Inc. i USA og andre lande.
"Catalyst Browse"-logoet er et varemærke eller registreret varemærke tilhørende Sony Group Corporation.
IOS er et varemærke eller registreret varemærke tilhørende Cisco i USA og andre lande, og benyttes under licens.
iPadOS, Safari og iPad er varemærker tilhørende Apple Inc., registreret i USA og andre lande og regioner.
Android og Google Chrome er varemærker eller registrerede varemærker tilhørende Google LLC.
Wi-Fi er et registreret varemærke tilhørende Wi-Fi Alliance.
SDXC-logoet er et varemærke tilhørende SD-3C, LLC.
CFexpress- og CFexpress Type A-logoet er varemærker tilhørende CompactFlash Association.
NewTek™ og NDI® er varemærker eller registrerede varemærker tilhørende NewTek, Inc.
JavaScript er et registreret varemærke tilhørende Oracle og/eller dets associerede selskaber.
Intel, Intel-logoet og Intel Core er varemærker tilhørende Intel Corporation eller dets datterselskaber.
QR Code er et varemærke tilhørende Denso Wave Inc.
Alle andre firmanavne og produktnavne er registrerede varemærker eller varemærker tilhørende deres respektive ejere.
Varemærke-elementer er ikke angivet med ™- eller ®-symboler i dette dokument.
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